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INTRODUCTION 


ABOUT THIS MANUAL 

This is a manual for version 3 of the Studio Audio Disk Editor - SADiETM - software. Separate 
booklets are provided to cover hardware installation and networking. 

SADiE3 has been designed to be simple and intuitive to learn and use. Despite this, you will find 
this manual and the on-screen help valuable in explaining the concepts underlying the system, 
suggesting methods of going about common tasks and as a technical reference. 

We have tried to keep the manual as concise and clear as possible. In.a comprehensive and 
professional system such as SADiE, there are different ways of performing different tasks and you 
will develop your own methods as you become more familiar with the system. 

The manual is set out in the following chapters, which are referred to in the text in italics: 

Getting Started explains the concepts behind the system and the terminology used and gives you a 
quick guide to getting your system working for you. The Tutorial provides a step-by-step guide to 

editing the practice tape provided. We recommend that you do this bit to save time later. 

The next chapters provide detailed guides to the common tasks of Recording, Using the PlayList, 
Arranging an EDL, Editing, Mixing and File Management. 

Specific Applications contains notes on operations relevant to more specialised areas of work. For 
example: CD pre-mastering; Autoconforming for video post-production and syncing film rushes. 

Customising SADiE explains the settings you can change to affect the way the system works or 
appears on the screen. 

Appendix A . Windows Basics is a reference for users who are not familiar with th~ Microsoft® 
Windows® 3.1 or Windows 95 operating systems. 

The remaining Appendices provide technical reference sections and a Glossary of relevant 
terminology. 

Throughout the manual we have used the following symbols in the margin: 

The button to be pressed on the screen using the mouse, together with its name, which' 1 the ttAl 
is printed in bold capitals: e.g. FRED. 

For other operations on the screen using the mouse. 

For operations using the hardware controllers. These will usually follow the me c desl 'iption 
and the controller's button nan1es will also be printed in bold. The SHIFT button is usee; in 
conjunction with other buttons (e.g. SHIFT + MUTE is the solo function), but it does nc c need t. · 
be held down to affect the first subsequent button press. The function keys Ft-F1:l can be set by 
the user. See Chapter 9, Customising SAD£. 

Hardware controller users should also read all the mouse instructions. 

The computer keyboard is used for typing in names, and for Hotkeys, which are 'lsefu! SllOftCutS 
to many functions. They can be customised to your own preference and so are nc refer· .d to at 
every point in the manual -look up the default Hotkey settings in Chapter 9. 

On the keyboard we often use the Shift key (often marked fi), the Ctr!' (Contro: key, the Alt . 
Key and the Return (..1) key, which is duplicated by the Enter key. 
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Ctr!' +X means hold the Control key while pressing the X key. 

Please take a little time to read this manual- it will payoff in time saved later. If you cannot fLnd 
the answer to a problem here, then see Appendix Ffor how to get technical support. 

Graham Puddifoot Nov 96 
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LICENCE AGREEMENT 

This legally binding agreement is between you - the end user, dealer or distributor - and Studio 
Audio and Video Ltd (referred to here as Studio Audio). 

Studio Audio retains ownership in all its software in any form and its use by you is governed 
exclusively by this agreement, which is to be interpreted and enforced under English law . This 
agreement also sets out the limited warranties provided by Studio Audio in relation to the 
software. You agree to the terms of this agreement by installing and!or using the software 
package. 

If you do not agree with the terms of this agreement, do not install the software onto your hard 
disk. Return the software together with all documentation, packaging and associated hardware 
purchased for a full refund, less any handling charges notified to you by your distributor. 

STUDIO AUDIO SOFTWARE LICENCE 

Studio Audio makes this software ("the software") available for the support of the hardw?re 
product (the hardware) with which it is supplied. The software comprises executable programs 
which perform specific tasks and tools. The sale price of the digital audio system includes the 
software licence fee. 

The use of the software with any hardware other than that manufactured by Studio Audio (with 
the exception of the computer system to which the hardware is physically attached) is expressly 
forbidden . 

You may: 

1. 	 Make safety backup copies of the software and transfer the software to the hard disc of the 
computer or computers to which the supplied hardware is to be connected, provided that 
these copies are not supplied to any third party. 

2. 	 Use the software programs and tools on the machine or machines onto which they have been 
copied as permitted in item 1 above. 

You must not: 

1. 	 Disclose or make the software available in any form to third parties. 

2. 	 Reverse engineer, decompile, disassemble or otherwise inspect the workings of software in 
object or executable fonn. 

3. 	 Assign the benefit of this agreement to any third party. 

4. 	 Use the software in any application where there is risk of life or accidental harm to persons. 

5. 	 Distribute the software to any third party without the express written permission of Studio 
Audio and Video Limited. 

TERMINA nON 

1. 	 You terminate this licence by selling some or all the hardware with which it is supplied. 
Studio Audio will provide a new software licence to the purchaser on payment of a 
registration and licence fee. 

2. 	 You also terminate this agreement by violating any of its conditions. 

3. 	 The licence fee is not refundable on termination. 

iii 
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4. 	 On termination, all copies of the software in your possession must be destroyed, and the 
original disks returned to Studio Audio. 

MEDIA WARRANTY AND EXCLUSION OF WARRANTY ON 
SOFTWARE 

I. 	 The physical media on which the software is distributed is supplied with the same warranty 
conditions as the hardware. The software is made available with no warranties whatsoever. It 
is up to the you to determine that the software is suitable for the purposes to which you 
intend to put it. Whilst every effort is made to ensure its correctness, Studio Audio cannot 
anticipate all the uses to which the software may be put. Studio Audio does not accept any 
liability for the software failing to perform in any way, whether by design or through 
negligence and whether used on its own or in conjunction with other software. 

2. 	 Neither Studio Audio nor its employees, distributors, or anyone involved in the manufacture 
or supply of the software shall be liable for any losses due to the use of, misuse of or the 
inability to use the software whether direct, indirect, consequential or incidental. 

3. 	 Any liability that may be determined to be Studio Audio's or its employees', distributors' or 
others shall be limited to the purchase price of the hardware with which this software is 
supplied and which together comprise SADiE. 

lAW 

1. 	 This agreement is governed by English law. In the event that any terms are found to be invalid 
by a court of law, the remainder of the agreement remains in force to the extent that it can be 
interpreted. 

2. 	 This agreement is the entirety of the agreement between you and Studio Audio. No verbal or 
written variation is in force, whether to vary to the terms of this agreement, or to imply any 
suitability of the software for any specific purpose. 

All queries relating to this agreement should be addressed in writing to the registered office. 

iu 
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11 - GETTING STARTED 


DIGITAL AUDIO EDITING 

Traditional analogue audio is a continuously varying electrical signal representing (analogous to) 
the soundwaves that produced it. This is stored on tape as a vary ing magnetic image and on vinyl 
as physical variations in the wall oi the groove. With digital audio, this signal is sampled 
(measured) very frequently (typical sampling rates are 44.1 and 48 kHz, or thousand·times-a­
second) and so converted to a stream of numbers. These numbers are kept in binary form that 
consists of only Is and Os which can be stored on digital audio tape or a computer storage 
medium. They can later be read back and re-converted to recreate the analogue waveform exactly. 
Digital audio is not subject to the same deterioration as analogue and is in a form which can be 
manipulated by computer software. 

In SADiET>I , the digital audio is stored on dedicated "SCSI" hard disk drives. The SADiE 
software can achieve complex editing and mixing operations by telling the computer to find and 
play back different sections of the audio on the SCSI disks at different times, or simultaneously. 
This has the effect of cutting sections out, varying the running order and mixing sections 
together, although the material recorded on the SCSI disks actually remains unchanged. it is just 
the instructions for replaying it that we are altering. The great advantage of this is that edits can 
always be undone and many different versions can be produced, hence the term "non-<lestructive 
editing". 

SADiE 	SYSTEMS 

A system will comprise a host computer running the SADiE software which displays the user 
interface on a colour monitor and tells the system what you want it to do, and the specialised 
audio hardware, appropriate to the system you have bought. 

The hardware consists of DSP (Digital Signal Processing) cards connected directly to one or more 
SCSI hard disk drives which store the digital audio. 

The DSP cards are dedicated to handling the audio to professional standards, leaving the 
computer's power for the control and display functions of the interface, which is modelled on the 
familiar concepts of a multitrack tape machine, razor blade, mixing desk, etc. 

Just like a tape recorder, the system has inputs for recording material in and outputs for playing it 
out again. The difference is you can do a lot more with it while it's in SADiE. 

Details on connections, etc. can be found in the hardware installation booklet for your system. 

SADiE 	BASICS - PLEASE READ THIS BIT! 

NOTE: 	 The software uses the Microsoft® Windows® 3.1 or Windows 95 operating systems. If 
you are not familiar with Windows and the use of a mouse, it would be a good idea to 
go through the "Windows Fundamentals" chapter of the Microsoft Windows User 
Guide or die "Visual Glossary" in "Introducing Windows 95". Alternatively, there is a 
brief guide in Appendix A . Windows Basics, at the end of this manual. 
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SADiE is moddled very closely on the traditional studio concepts of a multitrack tape machine 
and mixing desk. These are represented by the Playlist and the Mixer. There is a flexible routing 
path between the system's physical inputs, the Streams of the Playlist, the Mixer's channel strips 
and the physical outputs. Audio processing such as EQ and Dynamics may be done in the Mixer 
and can be automated, whilst "outboard" units provide other processes. Most editing functions 
are done in the Playlist and a Trim Editor is available for detailed edit adjustment. 

TERMINOLOGY 

Track A Track is a whole, original audio recording, held on a SCSI disk as a sound file, and running 
from when you started recording to when you stopped. It is identified by a name and will remain 
on the disk until deliberately deleted. It has properties set when it is recorded, such as whether 
stereo or mono, what sample rate, etc. Don't confuse it with the term "track" as applied to 
multitrack tape machines (see Streams, below) - it's closer to the "track" on an LP or CD and 
recalls SADiE's origins as a simple stereo music editor! 

Clip A Clip is any part of (which may be aU oQ a Track and can have its own name. It is not actually a 
separate recording, but a set of instructions to replay between in and out points within the 
relevant Track, at what level and with what lengths (and types) of fade-in and fade-out. 

Clipstore A Clipstore is simply a list of Clips. You will find whole Tracks here, in a folder labelled "Source 
Audio Tracks" and may also choose to use it to store clips that you have topped and tailed for 
later use. This is like keeping a load of small reels of leadered tape inserts on the shelf before you 
put them into a piece of work. Different Clipstores can be saved for different projects. 

NOTE: 	 Deleting a Clip from a Clipstore does not mean you have deleted any audio, as the 
Track will still be on the SCSI disk. You will have simply deleted one particular 
version. (in and out points, fades and overall level) of how to replay the audio. 

EDL An Edit Decision List . This is the list of instructions that the system uses to play back the 
required Clips at the required times. It is a computer file that will need to be saved and can be 
later loaded and modified, just like a document on a word processor. You can think of the EDL as 
your script, cue sheet or running order, and the Tracks as the raw material. An EDL is 
graphically displayed in SADiE by the Playlist, where it is created by arranging Clips in the 
required order. 

EDL Entry When Clips are placed in the Play list they become EDL Entries as they then have a particular 
EDL replay time. Any changes made to an EDL Entry (such as level changes or adjustments to 
the in and out points) then only apply to that particular occurrence of the Clip and will not affect 
Clips in the Clipstore, or other EDL Entries of the same Clip. 

Playlist The window on the screen which shows you graphically the work you are creating (i.e. the EDL). 
It acts as your tape machine and you will see EDL Entries as coloured blocks like bits of tape, or 
as profiles showing the level of the audio, positioned to be replayed when the current-time cursor 
passes over them like a playback head. Fade-ins and fade-outs are shown as slopes to the front and 
rear of the blocks. Editing is done by making "cuts" which divide Entries into two, so that one or 
the other can be removed, or the in and out points can be adjusted to fine edit the audio. 

Streams EDL Entries in the Playlist are placed on Streams, each of which is routed to a channel strip of 
the Mixer to control the playback of the audio. A stereo Entry sits across any two adjacent 
Streams, a mono Entry only needs one. The Streams are therefore similar to the tracks of a 
multitrack tape machine but allow editing and overlapping within individual Streams and moving 
audio Entries around in time. There is no limit to the number of Streams you can add to the 
Playlist, only to the number of Entries the hardware of your system can play at once. The 
Streams are independent of the physical outputs of your hardware system and are routed to them 
by SADiE's Mixer. 
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Project 	 A Project is a useful way of looking after your work on a job-by-job basis. EDLs, the layout of 
the internal Mixer which plays them and Clipstores are all stored as components of a SADiE 
Project. A list of relevant Tracks is also kept for each Project. 

MOUSEWORK: 

We will use the following terms for using the mouse: 

Click 	 Press and release the left mouse button once. To" press" an on·screen button, 
point at it and single-click. 

Double-click 	 Quickly press and release the left mouse button twice. 

Right-click 	 Press and release the right mouse button. 

Drag 	 Click and hold the left mouse button over the chosen item, move it with the 
mouse to a new position, then release the button. 

Right-button clicking with the mouse over many areas gives you a menu of alternatives for that 
part of the screen - remember to try this everywhere! 

USER MANAGEMENT 

There is a separate User Management application (program) for multi-user installations where 
security is important. This can only be run by designated System Administrators and allows the 
database of users and their passwords to be altered. Appendix E describes the use of this 
application. 

User management provides: 1. Password security to stop unrecognised users starting SADiE. 

2. Privilege levels for different SADiE users· some users may be 
allowed to record and edit, others to play back only. 

The Project system described in Chapter 7, File Management, also restricts access to Projects to 
certam users. 

If you do not need the full user management facility, the first time you run SADiE3, you will be 
asked for your user name and logged as the single user. To later add the security of a password, 
select "Change Password" in the File menu. 

ST A R TING SADiE 

In this manual , the illustrations assume that your computer is running with a display resolution 
of 800 x 600. If you want to change this, see "Changing Screen Resolution" in Chapter 9, 
Customising SADiE. 

Turn on your computer and let the software boot itself up. If you have bought a Turnkey system, 
or if you selected the option when you installed the software (described in Appendix B), SADiE 
will run automatically. If not: 

• 	 Windows 95: Hit the Start button I Programs I SADiE Disk Editor group and select 
SADiE v3. 

The first thing that happens is that you are presented with a box to log-in to the system. If you 
are starting SADiE for the first time, you will be asked your name. In a multi-user installation 
that has been already set up, you will need to type your name and password. 
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The following Project Start-up box will appear: 

SAD,E3 Project St,utup f7 

Select "Create a new Project" as this will keep together all the work you do in the following 
tutorial. 

A box will appear asking you to name the Project. Type "Tutorial" as the Project name (replacing 
the default "projname" in the box) and click the "Create" button. 

If you have more than one SCSI disk on your system you will now be asked which disk you want 
to record onto. Select one from the list or check the "Least Full Disk" box and click "OK". 

The main SADiE window will now appear. 
-

NOTE: 	 We recommend that Windows95® users hide the taskbar in order to maximise the 
available screen area for SADiE. 
If your taskbar is appearing on top of the SADiE window, right-dick on the taskbar 
and select "Properties". Under the "Taskbar Options" section, deselect" Always on 
top". 
You can then activate the start button by pressing Ctr! +Esc., and switch between 
applications with Alt +Tab. 

Error! Main Document Only.:4 



SADiE Usn Manllal vJ.7 	 Chapter 1 - GeUing S14rud 

THE DISPLAY 

Mixer 
tool bar 

} P'ayl;,' 

.... 	Transport 
Controls 

The main SADiE window, filling the whole screen, has a title bar and menu bar in common with 
most Windows applications. 

The menu bar contains words which produce drop-down menus with commands for setting-up, 
file handling and display functions - for example, the File menu is displayed by clicking on the 
word "File". Windows has quick keyboard shoncuts to all menu commands: Press Alt + the 
underlined letter on the word in the menu bar, then the underlined letter of the command you 
want. SADiE's menu commands are listed in the Index under each menu name, with references to 
the relevant sections of the manual. 

For most common tasks, however, the system has been designed to be operated by pressing on­
screen buttons (by pointing and clicking with the mouse), or by using the hardware controllers. 
Buttons on the screen have a 3-D appearance and should look "depressed" ® in their ON 
position. 

Additionally, most menu commands and button actions can be programmed to be performed by 
SADiE's own Hotkeys on the computer keyboard and hardware controller function buttons (see 
Chapter 9, Customising SADiE). 

At the bottom of the screen, the status bar describes buttons when you point at them. It can also 
be customised to display and control cenain settings affecting the way SADiE is working. 

The rest of the screen is a work area within which are displayed windows such as the Playiist, 
Mixer and Clipstore. Like all windows, these can be opened, closed, moved around or re-sized 
with the mouse. Different arrangements of your screen can be stored as desktop files, and 
reloaded when you want. This will be very useful when switching between tasks, and is covered 
in chapter 9, Customising SADiE. 

For now, let's stick with the default desktop supplied. However many windows are on screen, 
one will be the active one, indicated by a coloured title bar. 
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• 	 Clicking with the mouse within a window always makes it become the active one and appear 
on top of any that may overlap it. The list at the bottom of the Window menu shows all open 
windows and is useful for quickly making active an obscured one or restoring to size a 
minimised one. 

• 	 On the hardware controllers the WINDOW button cycles through them. 

NOTE: 	 Many of the menu bar commands are defined by whichever is the active window. For 
example "Save" under the File menu will save the EDL file when the Playlist is the 
active window, and the Clipstore file when the Clipstore is active. 

Each window has one or more toolbars containing buttons relevant to it. These toolbars can be 
attached to different parts of the window, hidden, or floated and moved somewhere else on the 
screen. Floating toolbars always appear on top of windows. Right-click over the toolbar to see the 
options, but let's stick with the default desktop for the time being. The icons on buttons are 
shown in faint outline when their actions are not available. 

Rewind F-Fwd Stop Play Rec Pause 

The Transport Controls are a permanently active, floating toolbar used to contml the whole 
system. Therefore they will always have a coloured title bar and appear on top of any overlapping 
windows. The tabs along the top choose which sections of the Controls are displayed. The basic 
Transport section contains familiar tape-machine type buttons, a current-time display and an 
ONLrNE button which enables timecode and external machine synchronisation. On the keyboard, 
the spacebar duplicates Play and Stop. 

You can close the Transport Controls when you don't need them taking up screen space, and 
reopen them again under the "View" menu. A miniature current-time display and Play and Stop 
buttons can be displayed on the status bar by selecting it in SADiE's Setup window (see Chapter 
9, Customising SADiE). 

PLAY, STOP RECORD, PAUSE and ONLINE are duplicated on the hardware controllers. 

ON·SCREEN HELP 

Resting the mouse pointer over a button displays the button name in a yellow box and the status 
bar at the bottom of the screen describes its action. Consequently, we have not given a button-by­
button description in this manual. Click on "Help" in the menu bar to open the full help file. 

TUTORIAL 

This section will take you through a simple recording and editing session using the cassette tape 
provided. We recommend that you do this bit to save time later. The editing involved is the kind 
you might do in Radio - i.e. we are not concerned at this stage with maintaining sync to pictures ­
but it will serve as a good exercise whatever your area of work. You need to have already been 
through the "Starting SADiE" section above. 
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CONNECTIONS 

Connect a line level signal from an audio cassette player (via a mixing desk if you wish) to 
analogue inputs 1&2. Connect outputs 1&2 to your monitoring system (see the hardware 
installation booklet for details). 

RECORDING THE MATERIAL INTO SADiE 

You are about to record three Tracks. First, a voice piece that will require editing, then two short 
pieces of music to mix in with the edited speech. 

For simplicity, we are going to treat all the audio for this tutorial as stereo, so you should create a 
stereo Stream in the Playlist at this point: Right-dick over the small Stream control buttons of 

Select "Merge into Stereo Stream". 
Streams 1 and 2 will then be combined 
into a stereo Stream with a single set of 
control buttons. 

Now do the same on Stream 3 and merge 
Streams 3 and 4 into a stereo Stream, 
which we will use later. 

Stream 1. 

NOTE: In future you should identify mono material and save space on your audio disk by 
recording it as mono Tracks. This is covered in Chapter 2, Recording. 

• Open up the Record section of the Transport Controls by clicking on the Record tab. 

Record 
Tab 

• Press "Setup" which will open the Audio section of SADiE's Setup-window. 
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• 	 Select the input source to "Analogue" (as you are using SADiE's analogue inputs), the Sample 
Rate to 44.1 or 48kHz (whichever your workplace uses most) and the input resolution to 
16bps. 

NOTE: If you are not sure which sample rate to use it is worth consulting your engineering 
staff. Choosing the wrong sample rate when recording can give you problems later on. 

• Close the Setup window. (if you don't yet know how to close a window, you should read 
AppendixA - Windows Basics). 

• Name the Track "Voice" by clicking in the Transport Controls' white name box and typing it 
in, ending with the Enter key (.J). You can use the Backspace key to correct mistakes. 

RECORD ENABLE 

• Press the small RECORD-ENABLE button on the stereo Stream 1&2 of the Playlist. This will 
tell SADiE to record a stereo Track and automatically place it on those Streams. 

PAUSE 

• Press the PAUSE button (on the Transport Controls or on the hardware controller); SADiE 
will go into "record-pause", with the record button flashing. Play the cassette and you will be 
able to monitor it through SADiE and check the input level on the meters of Mixer channels 
1&2. As this is an analogue input it may be necessary to adjust the level at the playback 
machine or mixing desk to avoid overloading SADiE's Analogue-to-Digital converters, which 
would produce a permanently distorted recording. 

RECORD 

• Rewind the cassette and play it again from the beginning. When you hear the words" ... start 
recording now ... ", press the RECORD button to start SADiE recording - you will see the time 
display counting. 
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• 	 The speech is three minutes long. When you hear the words U forty-one calories ... ", press 
the STOP button and stop the cassette player. You have now recorded a Track called "Voice­

STOP 	 and a stereo EDL Entry with the same name will appear on the stereo Stream 1&2 of the 
Playlist. 

• 	 Now you are going to record the music, so enter the name "Music!" for the new Track, as 
above. 

• 	 Press the RECORD button, and restart the cassette player (if you got the level right for the 
speech, it wilt be fine for the music on this tape, so no need to check it again). The music is 
about 30 seconds long. 

• 	 When the music stops, rush to the nearest chair and sit down. Failing that, press STOP and 
stop the cassette again. Now you've recorded another track and there will be a second EDL 
Entry in the Playlist. 

• 	 Repeat to record a third Track, naming it "Music2".At the end of the second piece of music, 
stop both SADiE and the cassette machine. 

• 	 Finally, release the RECORD-ENABLE button on Stream 1&2. 

PLAYING THE EDL 

You have already created an EDL, as SADiE automatically placed Entries of the whole of all 
three Tracks in the Playlist. 

ZOOM Press the horizontal ZOOM OUT button a few times so that you can see all three Entries. 
~ 
OlIT IN On the hardware controller, select ZOOM and adjust with the wheel. 

~ 

Mouse time display Scrollbar Current-time 
r.1Ir!':or 

Zoom 
Ollt 

DBL-CUCK 
TO ZERO 
LOCATE 

Double-click on the STOP button - this is a very useful zero-locate function. The current-time 
cursor wiJl return to zero - as shown by the Transport Controls' time display. 

Press SHIFf + END: - the current-time cursor wiJllocate at the start of the first EDL Entry . 
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You can now play back the EDL by pressing PLAY, or using the keyboard spacebar which 
dupIicates Play and Stop functions. Notice the current-time cursor moving left to right across 
the Playlist, which will scroll automatically, and the current-time display in the Transport 
Controls or hardware controller reflecting the EDL time in the time bar at the top of the 
Playlist. The REWIND, FAST·FWD, STOP, PLAY and PAUSE buttons will do what you expect, but 
there is a much faster way of getting around in the Playlist: 

Double-click in the white area of the time bar (notice that the exact time you are pointing to is 
indicated by the mouse time display). Playback will start immediately from that point. 

NOTE: 	 If you miss the white time bar and double-click on the grey bar marked 'Audio Unit A' 
directly underneath, you will find the streams of the playlist underneath will disappear . 
This is supposed to happen - double clicking on this divider bar hides that section of 
the play list. There's no need to worry, your streams are still there - just double click 
again on the grey 'Audio Unit A' bar to make them re-appear. 

Single-click anywhere in the time bar to stop playback. 

Single-click anywhere in the time bar when playback is stopped to locate the current-time cursor 
to that point. 

To access points not currently in the window, scroll the display by using the scroUbar along the 
bottom of the Playlist. You can single click or hold down the little arrow buttons, or click in the 
bar either side of the moving box. When the system is playing back it will override you in order 
to keep the current time in view. (Scrollbars are a standard Windows feature - see Appendix A . 
Windows Basics.) 

Deselect ZOOM and move the scrubwheel to locate the current-time cursor to the desired point 
and press PLAY. (For quick locating, make sure the wheel is not in jog or shuttle mode, as selected 
by the SCRUB button.) The window will scroll automatically. 

You can zoom in and out both horizontally and vertically with the two pairs of magnifying glassImI1 buttons. This is a useful way of getting at different parts of the EDL as well as changing yourZOOM 
overall view. 

Hit ZOOM (horizontal) or SHIFf + ZOOM (vertical) and use the wheeL 

NOTE: The Playlist will always stay centred on the position of the cursor, so reposition it 
before zooming in, if necessary. 

Practise getting around the Playlist, to play different sections. Other ways of locating to given 
points are covered in Chapter 3, Using the Playlisl. 

ARRANGING YOUR EDL 

Right, now let's change the order of your Entries so that the speech comes after both pieces of 
music. Set the ZOOM level so that all three Entries are in view.: 

Click on the Entry "Voice" to select it. It will turn red. You can now drag it with the mouse to a 
later location in the EDL and drop it after UMusic2". 

NOTE: 	 Red is a warning! After moving the selected Entry using the mouse, it is a very good 
idea to deselect it by clicking on a blank, grey area of a Stream, or by holding the Shift 
key and clicking on the selected Entry again. This keeps it safe from being moved 
accidentally. 
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You can select more than one Entry for moving by holding the Shift key whilst clicking on them, 
or by dragging across them with the mouse to draw out a box that covers them. Be careful that 
you don't try to do this on an Entry that is already selected, because you wiJI then be moving it. 

Another way of moving an Entry is to select it and then press CUT and it will be removed from ~ the EDL to a temporary "paste buffer". Press PASTE and you can position the mouse where you 
ClIT 

want to re·insert it (the mouse pointer changes to a reel of tape) and paste it back in with a single 
~ click. 
COpy 

Pressing COpy instead of CUT wouldn't remove the Entry from the EDL, but would still copy it fiI 
PASTE to the paste buffer, allowing you to paste it in somewhere else and so repeat that section of audio. 

After pasting, the Entry is still in the paste buffer, so you could paste in more copies of it as well. 

CUT, COpy and PASTE will therefore move, remove and allow you to repeat Entries in the EDL 
in just the same way as you would with text on a word processor. 

Move the current-time cursor with the wheel so that it is over the Entry "Voice" . Press 
EDIT/SELECT to select the Entry. It will turn red. Now press CUT and it wiJI be removed from 
the EDL to a temporary paste buffer. Move the cursor to a new position, after the Entry 
"Music2" and press PASTE. "Voice" will be re-inserted after "Music2". 

NOTE: 	 When hitting EDIT/SELECT, make sure that the IN HOT and OUT buttons above the 
wheel have not been pressed and lit, otherwise you will enter editing mode, covered 
later. 

SHIFT + EDIT/SELECT will deselect the Entry under the cursor or add other Entries for multiple 
selection. Other Entries can be selected with the PREVIOUS and NEXT buttons. Pressing 
EDIT/SELECT with no Entries under the cursor deselects them all. If you have the CLIP button 
selected and lit, the wheel will select Entries in turn. 

Press this button on the Playlist toolbar to reveal:~ 
SHOW 
AUTOPLACE 
TOOUlAR 

The Autoplace toolbar. The first three buttons control the SLIP feature. Press the first, ENABLE 

SLIP button and then the third, SLIP RIGHT button. 

Select an EDL Entry. When it turns red, all following Entries will turn dark blue indicating that 
they will move with the red one. Try it. 

SLIP LEFT and SLIP RIGHT preselect whether previous and/or following Entries will be slipped 
when ENABLE SLIP is pressed. This is essential when you have many Entries in the EDL and you 
want to open or close up gaps without disturbing previous or following edits. On other occasior ~ 
you will want to move an Entry on its own and will then turn SLIP off. 

To move an Entry to the left so that it butts up to the one before it, select it (red) and press 

REMOVE 
REMOVE GAP. The SLIP feature will apply if enabled. 

GAP 
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Once you have pre-selected SLIP LEFf and/or SLIP RIGI-IT with the mouse as above, SLIP on the 
hardware controller enables/disables the feature_ With SLIP on, you will find that cutting and 
pasting Entries causes Entries to the right to slip accordingly. Use the default Hotkey - F6 on the 
keyboard - to remove gaps to the left of the selected Entry. 

If you make a mistake whilst working on your EDL, you can step backwards through your 
actions by pressing UNDO. REDO steps you forward again. The number of actions you can undo 
(maximum 25) is adjustable in the Undo section of the Setup window. This is displayed from the 
View menu. 

The UNDO button is at the bottom right of the panel and SHIFf + UNDO is redo. 

Practise moving your Entries about in the Play list. 

NOTE: 	 It is actually helpful to have the first Entry in your EDL starting some time after 00:00, 
so you can easily start playback just before it by double-clicking in the time bar. The 
Entry will also have room to move to the left during certain editing operations. To 
arrange this, move the whole EDL to the right a bit by moving the first Entry with 
Slip Right enabled. 

In future, if you position the cursor at a point after 00:00 before you start recording, 
the first Entry will automatically appear there. 

When you have practised enough, leave yourself with just the three Entries starting some time 
after 00:00, and in the following order: "M usic 1", "Voice" then "M usic2". 

SA VING YOUR WORK 


At this point, if you were doing something more exciting than this tutorial, you might have 

created a complex EDL arrangement, so this is a good time to save your work as a file on the 

computer's internal DOS drive. 


~ Select "Save Project" from the Project menu. 


Make the Project window active with the WINDOW button - it's the one with the. icon - and 

press the SAVE button. The Project window can stay minimised when you do this. 


Alternatively, on the computer keyboard press Alt, P, S. to use the Project menu Save command. 


This command will save all the components of your "Tutorial" Project, including the EDL you 

have created so far. 

II 

EDITING THE SPEECH 

Make sure that SLIP Left and Right are enabled, as described above. 

Press SHOW ALL PROFILES in the top left corner of the Playlist to change the EDL Entries from 
blocks to profiles showing a visual display of the audio you are going to edit. 

SHOW ALl.. 

PROFIL.ES 


Press function key F12 to show all profiles 

Experiment with playing the EDL and changing the horizontal and vertical zoom settings. You 
should be able to identify words and spaces in the Entry "Voice" as the cursor passes over them. 
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Display the Edit section of the Transport Controls. You can turn off the Record section, now 
that you 've finished with it. 

Scrub....meel 

Click with the mouse over the scrubwheel and, holding the mouse button down, move the mouse 
up and down. This is shuttle mode - like spooling forwards and backwards across the heads of a 
tape machine - the more you move the mouse, the faster you go. Move the mouse from left to 
right and you will switch to jog mode - like nudging the reels of a tape machine backwards and 
forwards . Practice this on the speech as you are now going to find and mark two edit points 
between which you want to remove the audio, just like on a V." tape machine. 

From the start of the speech, scrub to find where you want to come out for the first edit - just 

~ . before the words "Jellied shrimp" - and release the mouse button. Then press the RAZOR CUT 
RAZORClJT button. Scrub to where you want to come back in - immediately before the retake of the words 

"Jellied shrimp" - and press RAZOR CUT again. Use the ZOOM buttons to find a suitable degree of 
magnification. Don't worry too much about being very accurate, as this is non-destructive editing 
- you can always use UNDO to go back and have another go, or adjust the edit later. 

You will see that you have now divided the EDL Entry "Voice" into three. To complete the edit 
you need to remove the middle Entry, (between the two razor cuts you have just made) and join 
up the remaining bits. 

Select the middle Entry by clicking on it, turning it red, and press CUT TO PASTE. It will be 
removed from the EDL and, if you have SLIP on as suggested, the following Entries will be i?J 

ClJTTO 
PA~ 	

automatically moved forward to butt up to the first one. Play over the edit. If you don't !.ike it, 
press UNDO (two or three steps) and do it again. 

NOTE: 	 Although you have just deleted an Entry from the EDL, no audio has been lost from 
the system. The original Track is unaffected - you have just removed the instructions to 
play that part of it in this particular EDL. 

On the hardware controller the SCRUB button toggles the scrubwheel through jog, shuttle and 
the normal move cursor modes, as indicated by the LEDs to the right of the wheel. Choose jog or 
shuttle, use the wheel to locate your two edit points and press RAZOR to mark a cut at each. Then 
move the cursor over the Entry now formed between them, press EDIT/SELECT to turn it red and 
CUT to remove it. Keep SLIP on, so that the gap is automatically joined up. Move the cursor back 
with the wheel and PLAY over the edit. If you don't like it, UNDO (up to three steps) and do it 
agam. 
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That's all there is to cut·and-splice editing with SADiE. Do a few more edits to get the hang of it, 
but leave some until later when we'll try another method. 

After all that editing, save the Project again. 

ADJUSTING EDITS 

Play through the edits you have done so far. Let's just pretend for a moment that you are not yet 
God's Gift To Hard Disk Editing and there is an edit that you'd like to tweak a bit. To do this 
you need to go into Playlist Editing mode: 

PLAYUST 
EDITING MODE 

Press the PLA YLIST EDITING MODE button on the Play list toolbar and select the earlier of the two 
Entries at the edit point to be adjusted. The AUDIO SCRUB button in the Transport Controls 

AUDIO needs to be down if you want to hear the edit as you adjust it. 
SCRUB 

Position the mouse over the Entry just before the edit, so that its pointer changes to a &]¢­
symbol, then click and scrub with the mouse - you can jog or shuttle, just as you did over the 
scrubwheel. Adjust the out-point (the "left hand" side of the edit) . The Entry being adjusted turns 
a brighter red. 

Now select the Entry after the edit, get the ¢~ symbol and scrub to adjust its in-point (the 
right hand side of the edit). 

Listen to the result by playing over the edit in the normal way, or by using the PLAY TIlROUGH 

PLAY edit preview button in the Transport Controls. 
"n-iRI'I, '(;H 

NOTE: Whilst making adjustments, it is sometimes helpful to listen to just one side of an edit. 
You can do this with the PLAY TO and PLAY FROM edit preview buttons. TO FROM 

You can now adjust other edits by selecting the Entries before or after them and scrubbing with 
the appropriate mouse symbol. 

Come out of PLAYLIST EDmNG MODE by releasing the button. 
PLA~" 
EDfTlNG MODE 

Using the hardware controller, first find the edit you want to adjust. This is, as always, the join 
between two EDL Entries. 

Check that the EDLISOURCE button in the top row is selected to source (light on). This will mean 
you are editing radio-style rather than working to picture sync. (For more detail, see Chapter 5, 
Editing.) Make sure SLIP is still on. 

First we will work on the left hand side of the edit, which means adjusting the out-point of the 
left hand Entry, so select OUT. The in, hot and out edit point buttons are directly above the 
wheel - the "hotspot" is covered in Editing. 

With the wheel, position the current-time cursor over the left hand Entry and press 
EDIT/SELECT. Because you have selected an edit point, SADiE will automatically go into Playlist 
Editing mode as well as selecting the Entry. 

Select jog or shuttle mode with the SCRUB button and adjust the out-point with the wheel. 

Now press NEXT. This will select the in-point of the next Entry (i.e. the right-hand side of the 
edit). Adjust it with the wheel. 

Listen to the edit by pressing the PREVIEW button, adjust the two sides if necessary. 
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Press EDIT/SELECT again to turn Plavlist Editing mode off, thus confirming the edit, or use NEXT 
or PREVIOUS to move to other edits. 

BOTH AT THE SAME TIME! 

The swots in the front row of the class may have realised that you can use t' ~ above method of 
adjusting edits to remove the unwanted material in the first place. 

• 	 Listen to more of the speech. As soon as you hear the next mistake which will need editing, 
make a single razor cut. This can be done on the fly during playback, or whilst ~huttling 
through. The initial cut doesn 't have to be accurate as you are going to adjust it straight away. 

• 	 Stop playback, if necessary. 

• 	 Go into Playlist Editing mode and adjust the out point 0eft-hand side of the edi.) as before. 

• 	 Now go to the right hand side of the edit by selecting the next entry. You can lose all the 
unwanted audio by slipping it "into the cut" as you shuttle along to fincl, and set, the in-point 
exactly as described above. Remember playing tape out onto the floor? Jt's just like that , 
except you don't have to worry about treading on it. 

Use whichever method you prefer to do the rest of the edits in the speech. It is easier to remove 
very small bits (de-umming, for instance) with Playlist Editing. 

NOTE: 	 For hardware controller users it is generally safest to confirm each edit by pressing 
EDIT/SELECT to turn Playlist Editing off. You are then free to use the wheel without 
spoiling the last edit. 

If you do leave Playlist Editing mode on, you will find that each time you do a new 
RAZOR-cut, you should immediately select the OlIT point (on the Transport Controls 
or hardware controller). This will position the cursor at the new edit point. 

Lastly, you can "top and tail" the speech by using Playlist Editing to trim the in-point of the first 
Entry and the out-point of the last. 

Save the Project again. 

NOTE: 	 It is worth noting that the original, unedited, Tracks that you recorded are always 
available in the Clipstore. Restore your Clipstore window to normal size and you will 
see them in a folder labelled "Source T racks Folder". 

So, if you wanted to start the editing exercise allover again, you could take originals 
out of the Clipstore. This is covered in chapter 7, File Management. 
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GROUP 
ENT1UE.S 

MIXING IN THE MUSIC 

You should now have and EDL Entry called " Music1 "j another called "Music2" and lots of 
Entries called "Voice" as the result of your editing. 

Although not essential, for this exercise it is a good idea to group all the "Voice" Entries together. 
First select them all. You can do this by dragging across them with the mouse, but perhaps it 
would be easier to select all the Entries in the EDL and then deselect the two music ones: 

• 	 Click on ~Edit" on the menu bar, then "Select All" (or press Alt, E, S on the keyboard). 

• 	 Deselect the two music Entries by holcling Shift on the keyboard while clicking on them with 
the mouse. (On the hardware controller make sure no in, hot or out edit points are selected, 
position the current-time cursor over the Entries and press SHIff + EDITISELECT.) 

Press GROUP SELECTED EDL ENTRIES. They will be redrawn as a single block in the Playlist and 
can therefore be moved around together easily . . 

NOTE: Groups will always appear as blocks, rather than profiles, as they may consist of 
Entries overlapping each other. 

Now move the music Entries to Streams 3&4 so you can control them with separate faders:­

• 	 Turn SLIP off, as you want to move them without moving the speech. 

• 	 Select the two entries and use Ctr! + W on the keyboard or ASSIGN +F2~ on the hardware 
controller to move them down to Streams 3&4. 

• 	 Position them so that the EDL starts with" Music 1", then the edited Voice group, starting 
before "Music1" ends, and finally "Music2", starting before the speech begins. 

At any time you can break a group back down into its component Entries by selecting it and ~ 
UNGROUP pressing the UNGROUP button. Do this now to view the profile of the speech again. 

If you play your EDL now, the levels will quite obviously be wrong, as the music will drown out 
the speech where they overlap. Time to do a mix. 
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Automation toolbar 

The Mixer works just like a studio mixing desk with a multitrack tape machine. The default 
MLxer you have on screen contains a channel strip to control each Stream and two more acting as 
stereo masters by controlling the Mixer's internal busses 1&2. So this Mixer's routing 
arrangement is: 

Stream 1 -7 fader, strip 1 -7 
Stream 2 -7 fader, strip 2 -7 
Stream 3 -7 fader, strip 3 -7 

Internal Bus 1 -7 master fader. strip9 -7 Ol.tpo..t 1Stream 4 -7 fader, strip 4 -7 
Internal Bus 2 -7 master fader, strip1 0 -7 oIip0..4 2Stream 5 -7 fader, strip 5 -7 

Stream 6 -7 fader, strip 6 -7 }
Stream 7 -7 fader, strip 7 -7 
Stream 8 -7 fader, strip 8 -7 

NOTE: An internal bus can be thought of as a subgroup within the mixer. 
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With the mouse, it is easier to have a single fader controlling both channels of audio for the stereo 
Entries, so let's create stereo Mixer strips to go with the merged Playlist Streams:­

• 	 Right-click on Mixer strip I, just above the fader, and select "Merge into Stereo Strip". 
This will combine two separate Mixer strips into a single stereo one controlling Streams I & 2 

Stream 
number 

• Repeat to merge the strips controlling Streams 3 and 4 into a Stereo strip. Note that the strip 
numbers are now different from the numbers of the Streams that they control. 

If you are using hardware controllers, merging strips is perhaps less necessary as you have the 
added dexterity of separate fingers on separate faders. However merging streams does give you 
"more" faders on the panel. 

ENABLE 
AUTOMATION m 

Press the ENABLE AUTOMATION button on the Mixer configuration toolbar. 

Make sure that the Mixer is the active window (coloured title bar). If not, use the WINDOW 

button. Then hit AUTO to enable the automation. 

The automation toolbar will be added to the Mixer. 

~ 
KEEP MODE 

For this tutorial, make sure that the KEEP button is down, as this will let you try just one 
automation mode. 

Play the Playlist from just before Musicl. As you see the first words of the speech coming up you 
can fade down Streams 3&4 for a voice-over, and finally fade out the music completely. 

Play over that section again: your fader movements wiU be reproduced and your mix replayed. 

iNOTE: 	 Because the fader movements you make are being recorded as changes to the EDL, you 
can use UNDO to go back a step and do the first mix again, or improve on it by playing 
it and making small adjustments. 

Go to the end of the Playlist and do a mix to fade Music2 in under the last words of the speech. 

When you are (reasonably) satisfied with the result, save the Project again. This will save all the 
components of the Project - i.e. the EDL, with its editing, Stream layout and fader automation; 
and also the new Mixer layout. 
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NOTE: 	 Each time you save the EDL within the Project, you are overwriting the previously 
saved version. If you want to be able to return to an earlier version of an EDL, you 
need to save the new one with a different name. To do this, make the Playlist active 
and select "Save As" from the File menu. You can then type in a different name, thus 
creating a second EDL within this Project. 

When you make any File command, the type of file to be opened, closed, or saved is 
determined by which window is active. 

THE FINISHED PRODUCT 

If you are pleased with what you have done, you can dub it onto another medium - say aDAT or 
y." tape - by playing the EDL and recording from SADiE's digital or analogue outputs 1&2. 

If you choose to use SADiE's digital outputs, you may need to set the digital output format: 

• 	 In the menu bar, choose View I Setup Window. From the list on the left, double-click on 
"Audio" and select "Further Audio Settings". 

• 	 In the "Output Format" section, select SPDIF or AES/ EBU to match the format requir b~' 
your recorder's digital input. 

NOTE: 	 On XS / XACT systems, the selected format is actually available on both the XLR 
connector on the Breakout Panel and the phono (RCA) socket on the rear of the 
computer, although it is standard to use the XLR for AES/EBU and the phono sockec 
for SPDIF. 

SHUTTING SADiE DOWN 

It is important to shut down the software correctly and only turn off your computer when you 
have done so. If you simply turn off the power when SADiE is running, you risk losing ';I.-ork or 
even damaging the audio disk. 

If you are using Windows® 3.1: 

1. 	 Close the SADiE main window by 

• 	 double-clicking on the box on the left of SADiE's main window title bar - or 

• 	 selecting "Exit" from the File menu - or 

• 	 pressing Alt +F4 on the keyboard. 

SADiE will warn you if there are any EDLs, Clipstores, Projects, etc. that have not been saved 
since they were last altered. 

2. 	 You will now be returned to Program Manager (if you have any other applications running, 
use Alt + Tab to switch back to Program Manager). Close Program Manager in the same way. 

3. 	 You will be asked if you want to end your Windows session. Click OK. 

4. 	 When the screen goes blank, with "C:\>" displayed, it is safe to turn off the power. 
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If you are using Windows95®: 

1. 	 Close the SADiE main window by 

• 	 clicking on the close button. on the right of SADiE's main window title bar. 

• 	 double·dicking on icon on the left of SADiE's main window title bar - or 

• 	 selecting "Exit" from the File menu - or 

• 	 pressing Ait + F4 on the keyboard. 

SADiE will warn you if there are any EDLs, Clipstores, Projects, etc. that have not been saved 
since they were last altered. 

2. 	 Click on the "Start" button on the Windows95 taskbar, select "Shutdown" and "Yes" to 

shutting down the computer. 

3. 	 Windows95 will tell you when it is safe to turn off the power. 
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12 - RECORDING 


OVERVIEW 


NOTE: 	 IMPORTANT! If you want to be able to return to using SADiET>I version 2.2 for any 
reason, don't format your audio disks to SADiE3 standard. SADiE3-formatted disks 
cannot be used with v2 software. SADiE2-formatted disks can be used with either, 
although you will lose certain v3 features. See the File Formats section in chapter 7, 
and the note on multi-channel Tracks below. 

When you record a Track (SADiE's name for an audio file) you are always recording directly to 
one of your SCSI disks. There are two ways of doing this. If you record using the Playlist and 
Transport Controls, SADiE will place the Track as a Playlist Entry in sync. with the position of 
the current-time cursor during recording. This is like recording to a multitrack tape machine. 
Alternatively, you can use the Background Recording window which doesn't place the Track in a 
Playlist, but actually lets you work on and replay another Playlist while recording. In either cas , 
the Track will always be available in the relevant Clipstore's Source Audio Tracks folder, or 
available to be imported into the Tracklist of any Project, so that you can paste it into any 
Playlist. 

MULTI-CHANNEL TRACKS 

SADiE labels Tracks that you record in one of three ways: Mono, Stereo, and Multi-channel. 
Multi-channel Tracks are made up of individual mono or stereo parts. 

For example, using octavia, you might want to record eight-channels of drums, from a stereo 
pair of overheads and six individual mono mics. The resulting multi-channel Track will be made 
up of one stereo and six mono parts. As a single Track, it will be treated as a whole when moved 
around the system, but the component parts are accessible by opening up the tree structure in the 
Clipstore, or using the UNGROUP button . 

The parts of multi-channel tracks are identified by the name of the Stream to which they were 
recorded - so you may want to rename Streams before recording (see Chapter 4, A rranging an 
EDL). 

NOTE: 	 SADiE version 2 did not support multi-channel Tracks. If you record them to SADiE2­
formatted disks, next time you start SADiE they will appear as separate mono or stereo 
Tracks. You will then have to place them in Playlists at the same start time, anc:l group 
them before moving them around. 
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RECORDING TO THE PLAYLIST 

NOTE: 	 If you have already been using a Play list and now want to record unrelated material for 
different work, you may want to open up a new, empty Playlist to record into. This 
can be done under the File menu. However, it is more useful to create a new Project· 
this will give you a new Playlist and set you up for keeping track of all your work. See 
Chapter 7, File Management. 

1. 	 Open the Record section of the Transport Controls. 

2. 	 Press SETUP which takes you directly to the Audio section of the main Setup window, so that 
you can check or change:· 

• 	 The input source that you are recording (AES Digital, SPDIF Digital, Analogue or Optical 
digital). Depending on your hardware, some of these options may not be available. 

• 	 The input sample rate and resolution. 

NOTE: 	 With analogue input, the sample rate and resolution will determine how the signal is 
converted to digital audio. XS/XACT converters are limited to 16·bit, octavia system 
converters can convert at 20-bit resolution. Of course, you can use external converters 
to convert an analogue signal to other sample resolutions before being feeding it to 
SADiE as a digital input. 

With digital input, SADiE's sample rate needs to match that of the input signal, 
otherwise your material will play back at the wrong speed, and the profile will not line 
up with the audio. SADiE wilfwarn you if the current sample rate does not match that 
of the incoming digital audio. The sample resolution can be set lower. than that of ~e 
digital input signal, in which case the extra bits will be discarded. 

3. 	 Enter a name for the Track you are about to record by clicking in the white Track name box. 
Finish with the Enter key (.J). On SADiE2-formatted disks you are limited to 8 characters. 

• 	 The AlJfOTAKE button adds a two-character take number to the name and this number 
increases automatically each time you enter record. This saves you retyping a name each 
time when you are recording multiple takes. For the purposes of this manual, we are 
assuming that you have autotake ticked, so that if you go into record repeatedly, there is 
no need to type a new Track name. If you don't have autotake set, when you go into 
record and the current Track name exists already, you will be warned and will have to 
change the name in order to carry on recording. 
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• 	 The RETAKE button lets you delete the last take and so keep the take number for the ne:c 
attempt. 

• 	 PROPERTIES brings up a box showing details that will be stored with the Track, some oi 
which you may want to enter or change at the time of recording. See the next section fo~ a 
description of each. 

4. 	 Check that the RECORD SOURCE button for each Stream that you want to record onto is se: 
correctly. 

• You can change the recording source by pressing the button and selecting from the dro 
box that appears. 

• 	 Normally you will be recording direct from the system's physical inputs, but you can al , 
record from the outputs of Streams, internal busses, or the whole system. This enables y .)u 

to "bounce.aown" material in SADiE, or use a Mixer channel strip to apply EQ, dynami.-~ 

processing or digital level control to the input before it is sent to the recording Stream. (5..1.! 

the Routing section in Chapter 6, Mixing and Processing.) 

[I 5. Press the RECORD ENABLE buttons on the Stream(s) you want to record onto. 
REC 
ENABLE • 	 If you have "E to E" selected in the Mixer section of the Setup window, you will now be 

able to monitor and check the level of the input signal. See "Recording Levels", below. 

NOTE: With the "Number of channels" set to "Auto" in the Propenies box described below. 
the number of Streams enabled will determine the type of Track:­

Recording onto one mono Stream creates a mono Track. 

Recording onto a stereo Stream creates a stereo Track. 

BUT recording onto two mono Streams creates a 2-channel Track. If you are using.2 
disks these will appear as two separate Tracks after restaning SADiE. 

Recording onto one stereo Stream and six mono Streams will create an eight-channel 
Track made up of one stereo and six mono pans. See "Multi-channel Tracks", above. 

N.B . If the material you are recording into SADiE is mono, don't record it as a stereo Track, 
otherwise you will be using twice as much disk space as necessary. 

6. 	 Press RECORD to stan recording immediately, or play the Playlist (you will be in record­
standby and the record button will flash) and hit RECORD to drop in ("punch-in") on the fl:' RECORD 

(see "Dropping in", below). 

• 	 Pressing PAUSE before you press record will put you in record-standby mode, with input 
monitoring.lf you press PAUSE while you are recording the current Track will end. A neVi 
one will begin when you release the pause button again.The small time display at the 

bottom of the Transport Controls shows the DURATION so far of the Track being recorded. 
or the amount of REMAINING time available on the relevant audio disk, depending which 
button is selected above it. 

7. 	 Press STOP to stop recording. 

TRACK PROPERTIES 

The Properties box displays, and allows editing of, information that will be stored with e:· .~ 
Track. After recording, it can be accessed from the listing of Tracks in the Disk Management or 
Project window. 
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• 	 Fonnat: You can select the file format of the Track to be recorded here. See the File Formats 
section of chapter 7, File Management. If you leave this set to Native, SADiE will use the 
recording format appropriate to the formatting of the disk being used. 

• 	 Number of channels: When set to" Auto", recording onto stereo Playlist Streams creates 
stereo Tracks (or parts of multi-channel Tracks) and recording onto mono Streams creates 
mono Tracks (or parts). You can override this by setting "Stereo" or "Mono" manually. 

• 	 The Reel Name and Track Number boxes are used when Autoconforming - described in 
Chapter 8, Specifu: Applications. 

• 	 The Start Time and Length are for later display only. 

• 	 The Sample Rate and Resolution will normally follow the input settings in the Setup 
window. However, you can set this Track to be recorded at a lower sample resolution than 
the current input setting. 

NOTE: You can record with varispeed on, but only if you are recording analogue. This may 
be useful for performing frame-rate conversion using the 24/25 and 25/24 pre-sets. 

• 	 Selecting half (or quarter) Quality level causes only one out of every two (or one out of every 
four) samples to be recorded, thus effectively halving or quartering the sample rate. Used 
when recording or bouncing down to produce W A V files. 

• 	 Emphasis sets either of the two standard emphasis flags for the Track. 

• 	 The Backup references for the Track will be displayed in the Tracklist in the appropriate 
Project window - see the section on Archiving in Chapter 7, File Management. 

• 	 Comments can be entered for the Track, if recorded to a SADiE3-formatted disk. These will 
then be displayed for later viewing of the Track Propenies box. 

RECORDING LEVELS 

The meters on the Mixer strips for the relevant Streams and output busses show the level of the 
signal at SADiE's inputs when their faders are at normal settings (O.OdE). Mixer strips that are 
being used to control inputs show the input level regardless of fader position. There are overload 
margin indicators at the top of each meter to show the accumulated peak level. Reset them by 
double-clicking on their display. 

If you do set up a Mixer strip to control the system input (as described in the Routing section of 
Chapter 7, Mixing and Processing), it is possible to apply digital level control to the recording. 
However, this control is after the analogue-to~igital conveners, so any adjustments necessary to 
analogue input signals in order to avoid overloading or under-modulating the conveners must be 
made externally (e.g. on your mixing desk). 

Adjusting the fader of a such a Mixer input strip will affect the level recorded on the audio disk. 
Note that you can overload the recording if you increase the level, so watch the meters. You can't 
improve a noisy signal that results from convening analogue at too Iowa level. 

If you don't apply any input level adjustment, digital input signals will be optimally transferred as 
1: 1 copies. 
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RECORDING IN NON-REAL TIME 

Certain recording operations - such as internal bouncing down with processing - are not restricted 
to real-time operation by the need to work at the same rate as the equipment supplying the audio 
input. When NON-REAL TIME is selected, these tasks will be carried out as fast as possible. Of 
course, if you want to listen to the audio as it is recorded, you must work in real time. 

MAKING CUTS DURING RECORDING 

~ The RAZOR-cm and SCISSORS buttons will work during recording, dividing the Entry that is 
RAZOR-CUT 

being placed in the Playlist. This can be a useful way of marking edit points that you will need to 
return to later. 

SCISSORS 

If you operate the PAUSE button during recording, you can "edit-out" the incoming signal until 
you release it again. Recording will resume as a new Track. , so you must use Autotake, otherwise 
SADiE will assume you want to re-record using the previous Track name. 

Note: Razor cuts can be made automatically when reading DAT IDs - see Chapter 8 Specific 
Applications; DA T & CD IDs 

OVERDUBBING 

When you record into a Playlist that already has EDL Entries in it, these will be replayed. So you 
can, for example, record a singer on Stream 3 in sync. with - and listening to - a stereo guitar 
already recorded on Streams 1&2; or a voice-over on Stream 1, while hearing a music bed already 
on Streams 3&4. You can even use the automation to record a mix of the level changes to the 
music bed while you record the voice-over. When overdubbing, you will probably want to drop 
into and out of record as described below. 

DROPPING IN AND OUT OF RECORD 

Once you have record-enabled your chosen Stream(s), you can drop into record (or "punch-in") 
manually as follows: 

1. 	 Play the EDL from any point (the Record button will flash red to indicate that you are in 
record-standby) . You will not be monitoring the input, unless you have selected E-to-E mode 
in the Mixer section of the Setup window. 

2. 	 Hit the record button when you want to drop in. If there is an EDL Entry on the Stream at 
this point, SADiE will replace it with an Entry of the new recording up to the point where 
you... 

3. 	 Drop out by pressing the play button again . 

NOTES: 	As this is non-destructive, the underlying recording has not been erased. It is still 
available by using Undo, when using any of SADiE's editing modes or returning to a 
previously saved EDL - and the whole Clip or Track can still be found in the Clipstore. 
If you don't want to replace an EDL Entry, record on a different Stream. 

You cannot use the record-enable buttons on each Stream to actually drop in. These 
must be pre-set, and the record button used to do the drop. 
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Automatic drop-ins (or "punch-ins") can be set up as follows: 

1. Open the L-R locators section of the Transport Controls: 

2. 	 Set the Left and Right locators to the points you want to drop into and out of record. There 
are several ways you can do this: 

• 	 Click on the L and R buttons to set them to the current time, either on the fly during 
playback, or when stopped. The red indicator will show that a point is stored in the 
button memory. The time displays show the EDL time set. Or: 

• 	 Hold the Shift key and click at the required point in the Playlist time bar. Use the left and 
right mouse buttons for L and R points respectively. 

Ooce set, clickiog on a button will locate to that point (not allowed during playback) and 
markers will appear in the Playlist time bar to show the position of each. Dragging these with 
the mouse will adjust the points. Other ways to adjust them are described in Chapter 3, Usin g 
the Playlist. 

3. 	 Press the DROP·IN button. Once you have record-enabled your chosen Stream(s), when you 
play the EDL, SADiE will drop into record at the Left locator point and drop out at the 

DROP·IN 
Right. 

Pressing LOOP causes playback to repeat between the left and right locator points. In the 
Transport Controls section of the Setup window (accessible from the View menu), you can set 

LOOP 	 pre- and post-roll times. These determine how much of the EDL SADiE plays either side of the L 
and R points. 

Thus you can repeat a section, recording in sync. each time, until you have the take you want. A 
new Track is created for each drop-in. 

NOTE: SADiE actually records a second or two after any drop-out and a second or two before 
an automatic drop-in. These pre- and post- handles allow later edit adjustment. 

Double-click on an L or R button, or click while holding the Ctr! key, to clear its memory. 

BACKGROUND RECORDING 

In many ways this is the quickest and easiest way to record a mono or stereo Track that you can 
then access from the Source Audio Tracks folder in the Clipstore. What's more, you can carry 00 

other work in a Playlist while the new Track is being recorded. 

As with recording to the Playlist, described above, first make sure you have the correct settings in 
the Audio section of the main Setup window. This is accessible from the "View" menu or from 
the SETUP button in the Transport Controls. 
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1. 	 Open up the Background Recording dialogue box from the "View" menu. 

2. 	 Enter a name for the Track you are about to record by clicking in the white Track name box. 
Finish with the Enter key (.J) . On SADiE2-formatted SCSI disks you are limited to 8 
characters. 

• 	 The AlITOTAKE button adds a two character take number to the name and this number 
increases automatically each time you enter record. This saves you retyping a name each 
time when you are recording multiple takes. 

• 	 The PROPERTIES burton is described under Playlist recording. 

J. 	 Select whether to record a Stereo or Mono Track. 

NOTE: If the material you are recording into SADiE is mono, don't record it as a stereo Track, 
otherwise you will be using twice as much disk space as necessary. 

4 . 	 Press the INPUT selection button to determine which inputs you are recording from. 

5. 	 The MONITOR selection button determines what outputs you can monitor the recol 'ding on. 
Note that if you intend to play anything through your current Mixer while background 
recording, you cannot monitor the recording on the same outputs used for the Mixer. 

6. 	 Press START to begin recording. 

• 	 Check the recording level on the meters. Any adjustments necessary to analogue input 
signals in order to avoid overloading the system's analogue-to-digital converters fY':ust be 
made externally (e.g. on your mixing desk). 

• 	 Depending which you select, either the DURATION of the Track being recorded, or the 
REMAINING time available on the audio disk will be displayed in the small time display. 

7. 	 CLOSE the box and recording will continue in the background while you do something else. 

8. 	 To stop recording, open the window again and press STOP. 

• 	 Alternatively, if you select SPECIFY LENGTH, you can use the time display below to ~ nter 
the length of time that the recording is to last. It will then stop automatically. 
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TIME STAMPING 

When recording into the Playlist, the position of the current-time cursor as you record indicates 
the "time-stamp" that will be applied to the Track. You can see the start time that is recorded in 
the Track Start column in the Clipstore. So, when you are recording in sync. - either by being 
synchronised to external equipment, or by overdubbing in sync. with other material in the 
Playlist - the new T rack will always carry a record of its correct EDL position. If you move it, or 
store it in a Clipstore, it can always be replaced in a Playlist in the correct sync. by using the 
"Autoplace by Track start" function. 

When background recording, the Track will be time-stamped from 00:00:00. 

The Time-stamp of an entire track can be changed, using RESYNC TRACK. This is a permanent 
change, there is no way of undoing this process; this is potentially a very dangerous thing to do 
unless you are sure that you want to do it. 

This function is found in the Entry menu by Right-mouse clicking on a single EDL entry. It 
works by changing the Track Start time of the Source Track so that the currently selected entry 
becomes perfectly in sync .. 

EDLs find the correct audio to play by searching the associated Source Tracks for the correct 
Entry Time range, and so if you change the timestamp you will change the Entry times. EDLs 
that reference the track you are resyncing will be adjusted to use the new Entry times BUT only 
if they are open when the resync track process takes place. If an EDL that uses the track is 
closed, it will have no knowledge of the sync change, and thus will play the wrong audio, or not 
be able to find the Entry time range if it now no longer exists. 

For these reasons, the undo history is re-set when you resync a track. 

INPUT MONITOR WINDOW 

The Input Monitor Window reports on the state of the digital inputs to the system. On enabling 
a digital input, the top box of the window wi]'] display Channel Status information and the list 
below will log errors if and when they appear. The logging will tell you the time of day if there is 
no playback, or the EDL time if an error is logged during recording. If the error has an EDL time, 
double clicking on that line in the list will locate the EDL to the correct position. 
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If you tick 'Pop up automatically on error' you can hide the window and it will re-appear should 
anything need reporting. 

The Input Monitor Window can be accessed from the VIEW menu. 

NOTE; Errors may be caused by poor connections or dropouts on digital tape and are often 
detected when DAT machines are in pause or shuttle modes. 

CHOOSING A DISC FOR RECORDING 

When recording, it's possible to record to one specified disk drive, to alternate disk drives when 
you record, or if you have a Multi-card system to choose a different drive for each unit. 

When you start a project, with a system which has more than one disk drive, you will be offen­

the Audio Disk Selection Window. You can also see this window by pressing the Ii:!l button on 
the Project Window toolbar. 

Audio Disk Selection 101 Project Recording EJ 

This lists the recordable drives attached to your system. 

This window will open up, defaulting to Use specified disk(s) and if you select a drive and press 
OK, then that will be chosen for every recording. 

Use least full local disk allows you to record to whichever drive has the most space remaining. 

Use each local disk in tum will choose a different drive for every track when SADiE goes into 
record. The number of tracks depends on how many streams are involved, how they are grouped 
(a stereo track is one track not two) and what file format you are recording to. So if for instance 
you are recording 8 tracks and you have 4 disks connected, then each disk will record 2 tracks, 
and thus the load on the disks is evenly spread. If your disks start to become full, for multi-track 
recordings, your maximum record time is the time remaining on the most full disk drive. 

Tracks that are recorded at the same time are grouped together in the playlist and can be 
manipulated and edited as if they are one single, many-channel clip. You can separate these clips 
out and regroup them, as long as they are still in the same time relationship to each other. This 
applies to multi-unit and multi-disk recordings as well as those on single unit systems.(See also 
Chapter 12 . Multiple Audio Units) 
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13 - USING THE PLAYLIST 


THE PLA YLIST DISPLAY 
Mono EDL Entry Crossfade Time bar 

block 

commerts 

border 10 

stream control Drag border 10 Mono EDL Ertry 
buttons revealihide stream cursor shown as profile 

control buttons 

SHOWING ENTRIES AS PROFILES 

~ The SHOW ALL PROFILES button in the top left-hand corner of the Playlist switches between 
SHOW All displaying all EDL Entries as solid blocks and waveform profiles. PROFILES 

The small control button on each Stream does the same for that Stream only. 

NOTE: The Stream control buttons can be revealed or hidden by dragging the border between 
them and the Streams themselves, or by using the scrollbar beneath them. 

Function key FI2 acts as SHOW ALL PROFILES. 

There are 8 different types of waveform profile available, visually boosting different parts of the 
dynamic range. You can change the profile type from the Play list menu to find one more suitable 
to the audio you are working with. Note that this only appears on the menu bar when the 
Playlist is the active window. 

NOTES ON PROFILES: 

• 	 The profile display for higher zooms can be altered to suit your personal preference. As 
default, the higher resolution Horizontal zooms from zoom level 16 to 21 are drawn as a bar 
graph but there is an option in the Playlist Display Setup page (under the View menu, select 
Settings; Playlist; Playlist Display) - 'Show Higher zoom waveforms as lines' which will 
display these as a point-to-point line graph. 

• 	 Depending on the performance of your pc, the profiles may update slowly when you are 
playing the playlist, particularly at the higher horizontal zooms above zoom 15. As default, 
when you press play whilst viewing at a zoom level greater than 15, the waveforms are not 
displayed again until you press stop, however you can choose 'Keep updating profiles when 
playing (slow)' in the Playlist Display Setup, and SADiE will attempt to re-draw the screen 
whilst playing. 
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• 	 The highest three horizontal zooms - zooms 21 - 24 are the only zooms at which you will be 
able to see single samples. These zooms are always drawn as point-ta-point lines. 

SCROLLING AND ZOOMING 

When moving around the Playlist to access different partS of your EDL, you may want to change 
which part or how much of it is displayed. 

To do this, you will either need to scroll it so that a different part is in the window, or change its 
magnification by zooming in or out of the display. Don't forget that you can also change the size 
of the whole Playlist window (see Appendix A - Windows Basics). 

There are two Playlist scrollbars with attached zoom buttons. The one along the 
bottom of the Stream display scrolls and zooms horizontally so that you can view 
a later or earlier part of the EDL. The one at the right-hand side scrolls and zooms 
vertically so that you can reveal Streams that are not currently in view. 

OCk or hold Drag box Click either side of Zoom Zoom 
down tor tine tor coarse box 10 scroll by one OIJ In 

sCfonin9'. scrolling . window's width . 


You can press the zoom buttons repeatedly, until you reach maximum or minimum 
magnification. 

Alternatively, under the Playlist menu (when the Playlist is the active window), you can jump 
directly between different levels of horizontal and vertical magnification. These zoom menus are 
also available if you hold the CTRL key down when you click on the normal zoom buttons with 
the mouse. 

Select ZOOM for horizontal magnification, SHiFf + ZOOM for vertical magnification, and adjust 
with the wheel. 

Without ZOOM or CLIP, or STREAM selected and without Jog or Shuttle modes selected by the 
SCRUB button, the wheel will move the current-time cursor up and down the Playlist, which will 
scroll accordingly. In this mode, all the small LEDs by the wheel will be off. 

NOTES: During playback you can zoom in or out, but you cannot override the automatic 
scrolling that keeps the current time on view_ 


The Playlist will always stay centred on the position of the cursor. Reposition it before 

zooming in, if necessary. 


At the extreme settings of zooming out, all Entries are shown as blocks and not 

profiles. 


If you want to quickly switch between two different vertical and horizontal zoom 

settings, save them in two different Desktops (see the Desktops section in Chapter 9, 

Customising SADiE). You can then switch between the Desktops by using the keyboard 

shortcuts to the Desktop menu:- Press Ait + D, followed by the number of the desktop 

file listed. 
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There is another way you can change the way the profiles on screen look. For instance if your 
audio is very quiet, the waveform on screen may be very small, or alternatively if the audio is 
very high level and not terribly dynamic it may look like a thick straight line. Under the Playlist 
menu, the Display Profile Mode option offers 8 alternative ways of viewing the profile - the high 
numbers will make lower level audio look 'fatter'. Type 1 is the default. 

SPLITTING THE VIEW OF THE PLA YLIST 

If you drag the right hand edge of the Playlist (inside the scrollbar) inwards, you can open up a 
second view of the Play list that has its own zoom buttons, scrollbar and current time cu Uf . This 
could be useful if you want to jump back and forth between different places in the EDL or have 
one view in close and the other showing you a larger section. Using the mouse will switch 
between active views. 

STREAM UNITS 

Streams are grouped into units, which may be closed down or opened up for display by double 
clicking on the unit name. See "Unit 1" in the picture above, immediately above the name button 
for Stream 1. If the Mixer contains faders that control internal busses or physical inputs, there . 
will be Streams in a separate "Mixer only" unit. This is to display and edit automation data for 
those faders - no audio Entries can be placed on these Streams. 

FADE DISPLA YS 

The Playlist Display section of the Setup window, described in Chapter 9, Customising SADiE, 
provides two options of which way up fade-outs, and so crossfades, are drawn: 

·Show fades as cuts" ·Show fades as splices" 

DISPLAYING COMMENTS FOR EACH ENTRY 

Right-clicking on the Stream also lets you show or hide any comments you want to associate Vo-ith 
the Entry - "three, four" in the above example. The comments are written in the Clip Details 
Window described in Chapter 4, Arranging an EDL. 

PLA YING THE EDL 

__-­Current-time 
display 

Rewind F-Fwd Stop Play Rec Pause 

The Transport Controls are a permanently floating toolbar, so they will a1wa: :: appear on top of 
other windows. You can hide them by clicking on their close button IBI, and display them agdin 
from the View menu. 
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If you don't need the full Transport Controls, the status bar at the bottom of the screen can 
contain a simple Play/Stop/Current·time display version. To show it, from the View menu select 
the Setup window and go to the Status Displays section under "General". 

The Transport Controls apply to the active window, so to play the EDL, the Playlist needs to be 
active (with a coloured title bar) . If it is not, click anywhere in the Playlist or use the hardware 
controller's WINDOW button to select it. 

The PLAY. STOP and PAUSE buttons in the Transport Controls arc duplicated on the hardware 
.~ controllers. Note that there may be a brief delay when pressing PLAY while SADiE'" compiles 

PlAY 
the current EDL. 

PLA Y and STOP are also activated by the spacebar on the computer keyboard_ 

PAUSE, when released, gives you an instant start. 
PAUSE 

PLAY is activated by double-clicking in the time bar (see Locating, be'low). 

STOP is activated by single-clicking in the time bar. 

The ONLINE button in the Transport Controls and on the hardware controller has two 
functions: 

1. 	 It enables timecode synchronisation (master or slave as selected in the Sync. section of the 
Setup window). 

2. 	 It enables 9-pin external machine control of any of up to four machines. These can be selected 
individually by right-clicking on the button. The 9-pin section of the Setup window sets 
which 9-pin channels these are connected to. 

SOLOING AND MUTING STREAMS 


Each Stream has its own control buttons on the left for soloing and muting individual streams. 
~ 
SOLO MUTE 	 They duplicate the solo and mute buttons controlling those Streams on the Mixer strips or 

hardware controllers. 

There is a Ml.JfE button above each fader. SHIff + MUrE is solo. 

NOTE: 	 Solo and Mute buttons are grouped when you group their faders in the Mixer (see J 
Chapter 6, Mixing and Processing). .L....--....-~~~____,

V ARISPEED PLAYBACK 

Use the View menu to display the Setup window, and then select the Audio section. 

The Varispeed controls in the Sample Rate part of the window adjust the Record or Playback 
speed up to a maximum of plus or minus 10%. Whereas an analogue tape machine does this by 
varying the speed of the capstan motor, SADiE varies the current playback sample rate. 
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Varispeed is enabled by clicking on the check button and the speed is controlled by the knob 
Reset below. Click and drag it up-down to adjust. A small fader will pop up to indicate the setting and 

the numerical display on the right will indicate the percentage speed change. Double-clicking 
keeps the pop-up fader on view and allows you to adjust it more finely (click on a grey bit of the 

Drag 	 window to lose the fader) . You can also adjust the setting by entering a percentage value directly 
into the numerical display in any of the following ways:­

L 	 Click, hold and drag the mouse up or down over the digits on either side of the decimal point. 
Their value will increase or decrease - the more you move the mouse, the faster they change. 
Release to set the new value. 

2. Use the up/down arrows beside the display to nudge its value by whole percentage points. 
Nudge Hold Crrl to nudge by decimal points. 

3. 	 Double-click on the time display itself and directly type in a new value ending with the 
keyboard Return/Enter key. 

You can now turn varispeed off and retain the setting for the next time you turn it on again . 

The square button drops down a selection list of useful pre-set varispeed settings, for example to 

convert from 24 frames per second to 25 and vice versa. Select "User" to return to adjustment 
with the knob. It may be useful to do this during recording. 

NOTE: 	 As varispeed works by changing the sample rate, the digital output from SADiE will be 
non-standard and may not be accepted by other digital equipment, especially DAT 
machines. SADiE's Digital to Analogue converters will work from about 30kHz to 

50kHz to produce a valid analogue output, although they may temporarily mute if you 
change the varispeed setting too quickly. 

Varispeeding individual Clips or EDL Entries by amounts much greater than 10% can 
be done with the Resampling section of the Process window (see Chapter 6, Mixing and 
Processing). 

TRANSMISSION MODE 

This is a means of locking out the keyboard and mouse to prevent accidents during an important 
playback. 

To enter Transmission Mode, either 

1. 	 Hold Ctr! whilst starting playback in the usual way, or 

2. 	 Use the keyboard Hotkey that is set in the Hotkeys section of the Setup window after starting 
playback. The default is Ait +x. 

The following box will appear: 

The only way to change anything now is to click on one of the two buttons. 
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LOCATING 

There are several ways of locating the current-time cursor to points in the EDL: 

Time 
bar 

USING THE TIME BAR 


Double-click in the white time bar area at the top of the Playlist to start playback immediately 

from that point. The mouse time display will show the exact time you are pointing to. 


Single-dick anywhere in the time bar to stop playback. 


Single-click in the time bar when playback is stopped to locate the current-time cursor to that 

point. 


NOTE: Scroll or zoom out to access parts of the EDL that are not currently on view (see The 
Playlist Display, above). 


You can also move around the Playlist using the Text EDL. See Chapter 4, Arranging 

anEDL. 


USING THE CURRENT-TIME DISPLA Y 

CLick, hold and drag the mouse up or down over any field of digits in the time display (i.e. the 
hours, minutes or seconds, etc.). Their value will increase or decrease - the more you move the 
mouse, the faster they change. Release to set the new value and locate the current-time cursor. 

Or: 

Double-click on the current-time display. 

The box that pops up allows you to: 

1. 	 Directly type in the time that you want to locate to (or use the mouse cursor to drag across 
and overwrite only part of the displayed value). End with the keyboard Return/Enter key. 

2. 	 Click on "Zero" to Zero-locate, followed by "OK". 

3. 	 Use the up / down arrows to adjust the time. These nudge the lowest units. Hold the 
keyboard Shift to nudge seconds, Ctr! to nudge minutes. Finish with "OK". 
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USING THE TRANSPORT CONTROL BUTTONS 

Double-clicking on the stop button is a useful and quick zero-locate. 
DBl-CUCK TO 
ZEJlO-lOCAIT 

The rewind and fast-forward buttons are latching, with the speed of wind increasing the longer 
they operate. Using the time bar as described above is usually quicker and easier for most 
operators. 

USING HOTKEYS 

There are two very useful default Hotkeys on the computer keyboard: 

"Home" will locate to the stan of the first Entry in the EDL. 

"End" will locate to the end of the last Entry. 

USING THE HARDWARE CONTROLLER 

Without Jog or Shuttle modes selected by the SCRUB button, the wheel will move the current­
time cursor up and down the Playlist. The scale of movement is related to the magnification of 
the Playlist, so use zoom if necessary (see The Playlist Display, above) . The current-time display 
in the Transport Controls and the EDL time display on the hardware controller will indicate the 
exact time you are locating. 

NOTE: To move the current-time cursor, make sure that neither ZOOM nor CLIP, nor STREAM 

modes are selected. The small LEDs by the wheel should aU be off. 

END will locate to the end of the last Entry in the EDL. 

SHIFf + END will locate to the stan of the first Entry. 

LOCATING TO IN OR OUT POINTS OF EDL ENTRIES 

The current-time cursor will locate to the in or out point (whichever button is down in the 
Transport Controls) of the previous or next EDL entry on any enabled Stream when you use 
these keyboard Hotkeys: 

Select previous Entry (default is Ctr! + Alt + B). 

Select next Entry (default is Ctr! + Ait + N). 

See Chapter 9, Customising SADiE, for Hotkey settings. 

PREVIOUS and NEXT buttons do the same as the Hotkeys described above. 

~.."'~J 

AUDIBLE SCRUBBING 

To quickly search audibly through the Playlist: 

Reveal the Edit section of the Transport Controls: 
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Scrubwheel 

Click and hold the mouse button over the scrubwheel: 

• 	 Moving the mouse up/down gives you forward! reverse shuttle. The more you move irom 
your original position, the faster it goes. 
This is like spooling tape against the heads. 

• 	 Moving the mouse right/left gives you forward!reverse jog. 

This is like nudging the reels back and forth. 


• 	 You can move between jog and shuttle modes without releasing the mouse button. 

Select jog or shuttle mode with the SCRUB button. (Make sure you haven't got STREAM CUP or 
ZOOM selected.) The LEDs next to the wheel indicate the mode. Then use the wheel! 

FIXED SPEED SCRUBBING 

There are hot-keys available for putting the Playlist (or Trim window ,or clips in the Clipstore) 
into audible scrub at a fIXed speed. 

By default, these are set to be on the numeric key·pad of the keyboard (you must have Num 
Lock On), and three different fixed speeds can be set up at once. For instance Key 1 and 3 will 
play backwards and forwards at half-speed, 4 and 6 will do the same at normal speed, and 7 and 8 
at double speed. 

The key assignments are set in the usual Hotkey section of Setup, under Transport· Edit Controls .. 
The three speeds can be changed in the Setup page too, this time under the Scrub Setup sub­
section of Transport Controls. 

STORING AND RECALLING LOCATOR POINTS 

~ The Tr·ansport Controls let you set up: 

• 	 A pair of Left and Right points for looping and drop-ins; 

• 	 Ten numbered locator points and 

• Any number of named locator points. 


Open the L&R and the Locators sections of the Transport Controls: 
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Tr.''In :port Corrlr 01: r.< 

f- Left locator time display 

f- Right locator time display 

f- Numbered locatOfS 

f- Named locator time display 

f- Named locator name box 

LEFT, RIGHT and 1·10 numbered locator points: 

• 	 These are set from the current time by clicking on their buttons. This can be done on t ·e fly 
(during playback), or when stopped. The red indicator will show that a point is stored i.l e 
button memory. The L and R points have time displays to show their EDL times . 

• 	 The L and R points can also be set by holding Shift and clicking at the required point in the 
time bar with the left and right mouse buttons respectively . 

• 	 Once set, click on a locator button to locate to that point. (Not allowed during playback.) 
Clicking on Z will locate to zero. 

• 	 Double·dick on a button, or click while holding the Ctrl key, to clear its memory. 

NOTE: Shift + FI-FI0 on the computer keyboard are the default Hotkeys for locator buttons 
1-10. 	 I 

}'larkers will appear in the Playlist time bar to show the position of these locator points: 
_ 	 _ __ ~~.< __ _ ______ • _ _ __ • _r_ 

00:38:20 00:38:30 00:38:40 

Pressing LOOP causes playback to be repeated between the left and right locator points. 
LOO P 

Pressing the DROP·IN button causes SADiE to drop into record at the Left locator point and drop 
out at the Right (see Chapter 2, Recording). The pre- and post-roll times for these are set in the

DROp·IN 
Transport Controls section of the Setup window (accessible from the View menu). 
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Named locator points: 

• 	 Click in the white name box at the bottom of the Transport Controls and type in a name 
("endsting" in the above example) . 

• 	 Each time you press GET, SADiE will store a locator point with the name you typed and a 
G number added to it. E.g. endsting [01], endsting [02], etc. The EDL time of the point currently 

in the name box is displayed above it. 

• 	 You can type in a new name at any time and stan storing points with that name. 

• 	 Press ..El next to the name box to drop down a list of an your named locator points and select 
the one you next want to locate. It will appear in the name box. 

• Press GO to locate to the point in the name box. 

• 	 Press DEL to delete the :locator in the name box. The next one in the list will replace it. Repeat 
to delete them all. 

~ Adjusting stored locator points: 

The Left, Right and currently displayed named locator can all have their values adjusted or reset 
by using their time d isplays in the following ways: 

1. 	 Click, hold and drag the mouse up or down over any field of digits in the time display (i.e . the 
hours, minutes or seconds, etc.). Their value will increase or decrease· the more you move the 
mouse, the faster they change. Release to set the new value. 

2. 	 Use the up/ down arrows beside the display to nudge its value by the lowest units. Hold Shift 
to nudge seconds, Ctr! to nudge minutes . 

3. Double-click on the time display itself. 

0004:19.122 

The box that pops up allows you to: 

• 	 Directly type in a new value (or use the mouse cursor to drag across and overwrite only 
pan of the displayed value). End with the keyboard Return/ Enter key . 

• 	 Click on "Zero" to set to 00:00:00, followed by "OK". 

• 	 Click on "Cur Time" to set to the current time, followed by "OK". 

• 	 Use the up/ down arrows to adjust the time, as in no. 2 above, followed by "OK". 

4. 	 The Land R locator points can also be adjusted by dragging their markers in the Playlist time 
bar. 

On the hardware controllers press LOCATE followed by FI-FIO to set or go to locators 1-10, and 
LOCATE +F\ I and FI2 for the Left and Right locators. Tore-set a stored locator point, press 
SHIff + LOCATE + FI-FI2 

INOTE: Locator memories are stored with the EDL, and apply to only that EDL. 
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14 - ARRANGING AN EDL 


Stream controt buttons ­
Current-time cursor 

Mouse time-display 

Time bar 

Stereo Entry on 
~~If-+- Stereo Stream 

Mono Entry on 
Mono Stream 

.!r.~~+- Mono Stream 

reveal/hide by dragging border 

The EDL in SADiEnI is like a word processor document: When you iirst switch SADiE on and 
create a new Project, the system will open a Playlist window containing an empty EDL named 
after the Project. You can then build up the EDL by recording directly into it, or by pasting in 
Clips from the Clipstore. Alternatively, you may open an existing Project and EDL to play back 
or do further work on. 

NOTE: After making any changes in the Playlist, you will need to save the EDL. This is 
described in Chapter 7, File MarUlgement. 

Whether you are rearranging EDL Entries that were not recorded in their fir ::u playback order, 
building an EDL from the Clipstore or creating different versions of the same material, you will 
want to move Entries around, add them to and remove them from the Playl " . 

Where you place Entries horizontally in the Playlist determines at what time they are played 
back in the EDL. The choice of where you place them vertically - i.e. on whi('h Stream they are 
placed - will depend on how you want to group them for control by the Mixe•. It's very easy to 
move Entries around in time and between Streams, so you can always change your mind! 

NOTE: You can place as many Entries as you like on top of each other on the same Stream, 
although this will not make them easy to view. 
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PLAYLIST STREAMS 


EN ABLING/OISABLING STREAMS 

I-IJis~~~d Stream 

Enabled streams 

Stream name buttons 

The Stream name button displays the Stream name and enables/disables that stream for the 
editing, SLIP and hardware controller operations described in the following sections. Disabled 
streams are shown darker grey. The Playlist will start with all Streams enabled. Holding the Shift 
key when clicking this button acts on the group of Streams above it that are all the same status. 
This is like using the Shift key to select items from a list in most Windows applications. 
Additionally there is a 'reverse' enabling function - if you hold the CTRL key when clicking the 
stream button, then this stream will be enabled and all other streams will be disabled. 

NOTE: The border between the Stream control buttons and the Streams themselves can be 
dragged to the left or right to hide or reveal the buttons. 

On the hardware controller select STREAM and use the wheel or PREVIOUS/NEXT to highlight a 
Stream, then hit EDIT/SELECT to enable/disable it. SHIFf + EDIT/SELECT acts on the group of 
Streams above it that are all the same status. 

CHANGING THE LAYOUT OF STREAMS 

You may want more or fewer Streams than your current Playlist contains. There is no limit to 
the number of Streams a Playlist may contain, only to the number of Entries the system 
hardware can play back at the same time, with the required processing. 

You can also merge any number of Streams so that they can be controlled together and reduced in 
height to save display space. 

Stereo Streams can be added to the Playlist or created my merging two mono Streams. When you 
record onto a stereo Stream, you create a Stereo Track, whereas recording onto two mono 
Streams produces a two-channel Track. This will remain as two separate tracks on audio disks 
formatted under SADiE version 2. (See Chapter 2, Recording.) 

~ Right-click over the small Stream control buttons:­
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stream control buttons "Merge Into Stereo Stream" merges two 
adjacent Streams. (Odd numbered Streams are merged with the one after, and even numbered 
Streams with the one before.) 

"Merge Selected Streams" merges all enabled Streams together. 


"Rename Stream" is described below. 


"Insert Streams" will insert a pair before odd numbered Streams or after even numbered ones, and 

renumber all Streams accordingly. 


"Remove Stream" will remove the one you clicked on and renumber them. 


When Streams are merged, they retain separate channels of audio but are linked in the following 

ways: 


• 	 They have a single set of Stream control buttons, so they can be muted, soloed, 
enabled/disabled together. Merging Streams is also useful when recording multi-channel 
inputs into octavia, as you can use a single record enable button. 

NOTE: The mute and solo buttons of merged Streams are linked to those of all Mixer strips to 
which they are routed. 

• 	 Automation data on merged Streams is edited together. Stereo Streams are therefore necessary 
if you want to edit automation data for left and right channels of stereo material together (see 
"Editing Fader Automation Data" in Chapter 6, Mixing and Processing) . 

Right-clicking on merged Streams gives you options to change how they are displayed and to 
ungroup them again:­

Stereo Streams 	 Multiple Streams 

NOTE: Be careful if choosing to view one channel only, as there may be audio material coming 
up that you won't see. 
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A NOTE ABOUT STEREO ENTRIES: 

Stereo EDL Entries can be placed on any odd/even pair of adjacent mono Streams as 
well as on stereo Streams. Audio editing will always affect both channels unless the 
Entry is deliberately split into two mono ones with the UNGROUP button described 
below. However, we recommend that you use stereo Streams in your Playlist for the 
following reasons: 

• 	 Recording onto stereo Streams creates stereo Tracks. 

• 	 Mixer automation for stereo material is edited on both channels. 

• 	 Single Stream control buttons are easier to use. 

A stereo Stream can be routed to either two mono Mixer strips or a stereo strip. 

TEMPLATES 

If you wish to save your customised Playlist to be used again, save it as a TEMPLATE (see 
Chapter 9 Playlist and Mixer Templates) under the FILE menu. 

RENAMING STREAMS 

The Stream name appears on the long name button on the left hand side. By default, Streams are 
labelled with ascending numbers, but you can change this to any 8-character name: Right-click 
over the small Stream buttons and select "Rename Stream", type in the new name, followed by 
Return (~. To avoid confusion, don't give the same name or number to different Streams! 

NOTE: 	 The layout of Playlist Streams· how many merged Streams, single Streams and their 
names· is saved when you save the EDL displayed in that Playlist. 


The Setup window allows you to specify the default arrangement of stereo and mono 

Streams v,-hen new Play lists are created. 


MANIPULATING EDL ENTRIES IN THE PLA YLIST 

RAZOR·CUT 

The RAZOR·CUT button in the Play list and RAZOR on the hardware controller divides the Entry 
under the current·time cursor on any enabled Stream into two at that point. This is primarily for 
editing, but can also be used to create a new Entry that you can then change in any of the ways 
described in the rest of this chapter. RAZOR-<:lJ[ 
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Mouse users have the option of using the "scissors" to make razor-cuts . Whereas the RAZOR 

button always cuts at the current-time cursor, when you press the SCISSORS button, the mouse­
SCISSORS 	 pointer will change into a dinky scissors icon with a cross to show the target point. You can then 

make a freehand cut anywhere in the PlayJist - useful if you can see exactly where to cut from the 
waveform profile . 

NOTE: 	 With the Razor, if there are Entries at the cut point on other Streams and you don't 
want them to be cut as well , disable those Streams first. The Scissors function cutS only 
on the Stream the mouse icon is over, providing a useful shortcut to disabling Streams 
before using the razor blade. 

Holding the Ctr! key whilst scissor-cutting cuts across all enabled streams. 
Right mouse clicking while you have the scissors selected, disables them and returns the 
cursor to its normal "select" mode. 

GLUE 

Any razor cut where no editing has been done to the Entries either side may be repaired: Press 
the GLUE button, position the cross-hair of the gluepot cursor icon over the join and click again. GLeE 

SELECTING ENTRIES 


To perform any function on an EDL Entry or Entries, they first need to be selected: 


To select one Entry, click on it. It will rum red to show it is selected. 


To select more than one, hold the Shift key whilst clicking on them. 


To select adjacent Entries, click, hold and drag the mouse. You will see it draw a box as you move 

it vertically and horizontally. Draw the box to cover the Entries you want to select as a b teh. 

WARNlNG: Don't start the box on an Entry that is already red, or you will find you are moving 
it! Holding the Shift key whilst drawing the box will prevent this . 

To select all the Entries in the EDL Click on "Edit" on the menu bar, then "Select All" (or press 

Alt, E, S on the keyboard) . 


To deselect individual Entries, hoJd Shift whilst clicking on them again. 


To deselect all Entries , click on a grey bit of a Playlist Stream. 


NOTE: Selected Entries are red. Red is a warning! Once selected it is quite ea...'Y to move Entries 
by mistake, so always deselect them when you have finished. 

To select Entries, do either of the following: 

1. 	 Position the current-time cursor over the required Entry (by using the wheel in the Move 
Cursor mode, i.e. with no other modes like Jog, Shuttle, Clip, Stream or Zoom selected) and 
press EDIT/SELECT. The button will cycle through selecting all Entries under the cursor on 
enabled Streams. 
Pressing SHIFf and then EDIT/ SELECT will let you select a second Entry. 
Holding SHIFf down will Jet you select more than two Entries. 
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2. 	 Select CLIP mode and use the wheel to cycle through selecting Entries on enabled Streams. 
Pressing SHIFf before using the wheel selects multiple Entries. 
Press CLIP again to exit this mode. 

3. 	 Press PREVIOUS or NEXT to select the previous or next Entries on enabled streams. If none are 
initially selected this will begin with the last or first Entry. 
Pressing SHIFf and then PREVIOUS or NEXT will let you select a second Entry. 
Holding SHIFf down will let you select more than two Entries. 

To deselect individual Entries, position the cursor over the Entry, disable all lower numbered 
Streams, press SHIFf and then EDIT/SELECT. 

To deselect all Entries, position the current-time cursor on an empty (grey) bit of the lowest 
numbered, enabled Stream and press EDIT/SELECT. 

NOTE: When several Entries are already selected, selecting a single Entry will deselect the rest. 
So, for example, pressing NEXT will quickly deselect all other Entries. 

RENAMING ENTRIES 


Right-dick over the Entry itself and select "Edit Entry Name". 


NOTE: You can also rename Entries in the Clip Details window and the Text EDL. See the 
relevant sections later in this chapter. 

CUT, COpy AND PASTE 

These techniques can be used to remove, move and add EDL Entries in exactly the same way that 
tex"t is manipulated in a word processor. 

Entries are pasted into the EDL from a temporary store called the Paste Buffer. This can be 
loaded from the Clipstore to add new Entries to the EDL, but is also loaded with Entries that you 
cut (remove) or copy from the EDL. So you to can move Entries by cutting and pasting them in 
somewhere else and you can repeat them by copying them and pasting the copy somewhere else. 

CUTTING (REMOVING) ENTRIES FROM THE EDL 

Select the Entry/Entries as described above, then:­

CUT TO Press CUT ENTRIES TO PASTE BUFFER. PASTE 

Press CUT. 

iNOTE: 	 The previous contents of the Paste Buffer are replaced each time it is loaded. If you 
want to remove an Entry from the EDL without it being loaded into the Paste Buffer, 
select it and press the keyboard Delete key, or right-dick on it and select "Delete 
Entry". This may be useful if the Paste Buffer already contains something you want to 
paste in later. 
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COPYING EDL ENTRIES TO THE PASTE BUFFER 

Select the Entry/Entries, then:-
COpy TO Press COpy ENTRIES TO PASTE BUFFER. PASTE 

Press COpy. 


PASTING ENTRIES INTO THE EDL 


NOTE: 	 The Paste Buffer first needs to be loaded from cutting or copying EDL Entries as 
described above, or with a Clip from the Clipstore, (see below). It is also possible to 
load Entries to the Paste Buffer from the Trim Editor (see Chapter 5, Editing). If it is 
not loaded, its button picture will appear faint. 

Press LOAD PASTE BUFFER TO CURSOR. When you move your mouse pointer (or cursor) over lfi the Playlist Streams, you will see that it has changed to a reel of tape with a cross indicating where PASTE TO 
CURSOR the in-point of the Entry/Entries will be positioned. The mouse time display will give you the 

exact EDL time. Click to paste the Entry/ Entries into the Playlist. 

NOTE: To cancel pasting and drop the paste symbol from the mouse pointer, press the button 
again, or right-click with the mouse. 

Pressing the PASTE TO CURRENT TIME button will place the contents of the paste buffer into the rrIJ playlist at the current time, exactly as with the PASTE button on the Hardware Controller. Undel PASTE TO 
CURRENT normal circumstances, this will be with the entries' start time to the current time, but of course, i: 
TIME 

autoplace is on, then the autoplace rules will be followed. (See Autoplace and slip later in this 
chapter) 

Use the wheel to position the current-time cursor to the time at which you want the Entry to 
start. (Make sure the wheel is not in Stream, Clip, Zoom, Jog or Shuttle modes - all the LEOs by 
it should be off.) The display in the Transpon Controls, or the EDL time display on the 
controller will show the exact time. 

Press PASTE to insen the Entry/Entries with their in-point at the current time. 

NOTE: 	 Multiple Entries cut or copied from the EOL will be pasted back with the same time 
and Stream relationships between them. 


After pasting, the Paste Buffer is not emptied, so you can paste funher copies as many 

times as you like. 


PASTING WHOLE EDLs INTO ANOTHER EDL 

The paste buffer can be loaded with an entire EDL that has been previously saved (see Chapter 7, 
File Management). On the menu bar, select File I Load to Paste. An "Open EOL" box will appear 
allowing you to select the EOL you want and then press OK. 

The PASTE button will have been pressed for you so you can immediately paste the selected EOL 
into your current EDL. This is very useful for compiling work that you have built up in sections ­
for example, edited tracks compiled into albums, scenes compiled into reels. 

MOVING ENTRIES AROUND IN THE EDL 

1. Cut and Paste them back in at a new time, as described above. 
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2. 	 Drag with the mouse:­

You can select Entries, and then simply drag them with the mouse to a new location or 
Stream. The Playlist will scroll automatically if you move the Entry near its edges. 

NOTE: While you are moving the Entry, the mouse time display will change to show the start 
time you are about to set when you "drop" it. 


Red is a warning! Once selected it is quite easy to move Entries by mistake, so always 

deselect them when you_have finished. 


3. 	 Nudge them by small amounts left/right (earlier/later in the EDL) or up/down (to different 
Streams without changing in and out times and so maintaining sync).:­

Press this button on the main Playlist toolbar to show the Autoplace tool bar. 
~ 
SHOW 
AUTOPLACE 
TOOLBAR 

The four buttons on the end of the toolbar nudge the selected Entry/Entries 
left/right/up/down. Each press of the left/right buttons nudges by a fixed amount. This can 
be set in the Playlist Nudge section of the Setup Window, which is displayed from the View 
menu. An alternative nudge amount is available by holding the Alt Key whilst nudging. 

On the computer keyboard, Ctrl + the cursor keys (the ones with the arrows) duplicates these 
nudge buttons. 

Function keys FI, F2, F3, FS are also marked with arrows indicating that they duplicate the 
Autoplace toolbar nudge buttons when pressed after the ASSIGN key. 

4. 	 Use the Clip Details Window or the Text EDL to adjust their start times. See the sections on 
these later in this chapter. 

NOTE: You can also move Entries when using Playlist Editing mode (see Chapter 5, Editing) . 

CHANGING STREAMS FOR EDL ENTRIES 

You may wish to move EDL entries to another playlist stream, without changing the EDL time. 
There are 3 different ways of achieving this. 

1. 	 If you hold the AL T key down while dragging and dropping entries with the mouse, the 
stream can be changed but the EDL time cannot. 

2. 	 The up and down buttons on the Autoplace toolbar (described above), change the stream of 
an entry, one stream at a time. 

3. 	 'Move selected clips onto stream.. ' option in the Playlist menu, forces entries to a new stream. 
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Select the new stream from the drofHiown list and whatever, and however many streams the 
entries were on previously, they will be moved, without changing the EDL time, to the new 
stream. 

ADDING NEW ENTRIES TO THE EDL FROM THE CLIPSTORE 

Click and hold on the Clip you want in the Clipstore and drag it (actually a "copy" of it) to the 
Stream and time that you want it to start in the Play list. You will see that the mouse pointer has 
changed to a reel of tape, with a cross indicating where the in-point of the Clip will be positioned. 
Release the mouse button to paste the Clip into the Playlist. This does not use the Paste Buffer. 

Or: Select the Clip in the Clipstore by clicking on it, press the LOAD TO PASTE button and then 
CUPSTORE paste it into the EDL from the Paste Buffer. The Playlist PASTE bunon will have been pressed for 
WAn TO PASTI' you! 

Use the WINDOW button to make the Clipstore the active window, then select the Clip you want 
either with the wheel or the PREVIOUS/ NEXT buttons. Press COPY. 

Return to the Play list with the WINDOW button. PASTE the Clip into the Playlist as described 
above. 

NOTE: You can place as many Entries as you like on top of each other on the same Stream, 
although this will not make them easy to view. 

REPEA TING EDL ENTRIES 


To repeat one or more Entries, either:­

1. Copy them and then paste them in at a new point, as described above. 

Or:­

2. 	 Select them, then hold the Ctrl key whilst dragging a copy to the required position. 

REMOVE GAP 

This is a useful tool for moving any selected Entry to the left (i.e. forward in time) so that it buttS 
up to the previous Entry on that Stream. The start of the selected Entry'S fade-in will be changed 

REMOVlO 
GAP 	 to coincide with the start of the preceding Entry's fade-out. 

On the keyboard this is available as a Hotkey. The default is F6. 

Remove Gap can be set to a function key FI-FI2 . See Chapter 9, Customising SADiE. The default 
is F6 

NOTE: The SLIP facility described below will automatically remove gaps left after cutting 
Entries from the EDL. 

SNAP TO CURSOR 

This is a very useful tool for synching up Entries. Right-click over the Entry you want to move 
and select either "Snap in-point to current-time" or "Snap Hotspot to current time" . The Entry 
will jump to a new position with either its Hotspot or its in-point on the current-time cursor. 
This is useful : 

• 	 On the fly whilst listening to music to run alongside speech. A voice Clip can be snapped to 
cursor during playback. 
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• 	 After positioning the current-time cursor by double-clicking on the current-time display and 
typing a new value. 

• 	 After positioning the cursor by scrubbing with the Edit section of the transport controls, 
perhaps scrubbing to picture to find a visual synch point. 

AUTO PLACE & SLIP 

All of the functions for positioning Entries described above are affected by further options 
SHOW provided on the Autoplace toolbar:­
AlJTOPL\CE 
TOOLBAR 
(ON MAIN 
PL\YUST 
TOOLBAR) 

The first three buttons control Slip. 

The first button turns the Slip function on or off. 

Preselects Slipping of Entries to the left of the selected one. 

Preselects Slipping of Entries to the right of the selected one. 

With the function on, when an Entry is selected, other Entries on enabled Streams will turn dark 
blue and will automatically be moved in the following circumstances: 

l. 	Moving an Entry by nudging, dragging it with the mouse, using Remove Gap, or by any 
editing functions will cause Slipped Entries to move with it. 

2. 	 If right-hand Slip is selected, removing an Entry from the EDL will cause later Entries to be 
brought forward by an amount equal to its duration. This means that removing an Entry 
between two cuts in continuous audio will automatically remove the gap that would 
otherwise be left. 

3. 	 If right-hand Slip is selected, pasting a new Entry into the EDL causes Entries after it to be 
moved back by an amount equal to its duration - i.e. they make room for it! 

The next group of seven Autoplace buttons provide automatic placing of Entries when they are 
either pasted into or moved within the Playlist:­

Turns the Autoplace function on or off. 

Autoplaces an Entry to butt up to the previous one on that Stream. The start of its fade-in will 
coincide with the start of the previous Entry's fade-out Oike Remove Gap). 

Autoplaces an Entry with a pre-set gap separating it from the end of the previous one. The gap 
can be set in the Playlist section of the Setup window, displayed from the View menu. 

NOTE: The above two functions are handy for roughly putting together an EDL that you are 
going to fine tune later. 

Autoplaces an Entry in sync. with the EDL time when the Track was recorded. 

NOTE: This will keep in sync. an overdubbed recording or a recording that was made while 
SADiE was slaved to timecode. 
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Autoplaces an Entry so that the Hotspot rather than the in-point goes to tbe EDL time shown by 
the mouse time display (or the current-time display when using the hardware controller). 

NOTE: 	 The Hotspot is a useful marker that you can set at a particular point within a Clip or 
Entry and then use as the reference when placing it. For example, when you place a 
sound effect of a screech of car tyres followed by a crash, it's probably the crash that 
you want to position accurately. The Hotspot may actually be outside the in and out 
points of the Entry you are placing - you wouldn't include the sound of the 
c1apperboard recorded at the start of a dialogue Track, but you can still use it as the 
Hotspot in order to place Entries from that Track in sync. To set or adjust the 
Hotspot, see Chapter 5, Editing, and the "Clip Details Window" section of this chapter. 

Autoplaces an Entry with its in-point at the current time. This can usefully lie done on the fly, 
whilst listening to the rest of the EDL to get the "feel" of where you want all Entry to start. 

NOTE: As SADiE loads the EDL into memory when you start to play it, you will not hear any 
changes you make during playback until the next time you start it. 

Autoplaces an Entry with its Hotspot at the current time. Use in the same way as the above. 

GJ 

GRO UP 

ENIlUES 


NOTE: 	 The current Autoplace and Slip settings can be displayed on the Status bar at the 
bottom of the screen. Right-clicking on them will then bring up a box to change 
settings. This avoids taking up screen space with the toolbar. 

Use the View menu to display the Setup window, double-click on "General" and select 
the Status displays section. You can then choose which displays are shown. 

GROUPING ENTRIES 

Any number of Entries may be grouped together. They will be redrawn as a single block in the 
Playlist. This may be for convenience of display, for repeated operations to the same group, or to 
avoid accidentally undoing edits . You can rename a group, and store it in a Clipstore, so a heavily 
edited piece can be stored as a single Clip. 

First select the Entries you want to group, then press GROUP SELECTED EDL ENTRIES. 

NOTE: 	 Groups cannot be drawn as profiles, as they may consist of Entries that overlap. 

When selecting lots of Entries it may be easier to select all the Entries in the EDL alld 

then deselect the ones you don't want included in the group:­

Click on "Edit" on the menu bar, then "Select All" (or press Alt, E, S on the keyboard). 
Deselect Entries by holding Shift on the keyboard while clicking on them with the 
mouse. (On the hardware controller make sure no in, hot or out edit points are 
selected, position the current-time cursor over the Entries and press SHIff + 

EDIT /SELECT.) 

Groups may be further grouped with other Entries or other groups and a hierarchy is formed. 

At any time you can break a group back down into its component parts by selecting it and 
UNGROUP pressing the UNGROUP button. -
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MAKE STEREO AND MAKE MONO 

~ To make a stereo entry into two mono entries, select the entry and push the UNGROUP button. 
L~GROUP 

To make a mono entry into a stereo entry -you can only do this if the mono entry was originally 
part of a stereo one, and therefore another leg exists. Right-mouse click on the entry and select 
MAKE STEREO. This option will only be available if the audio exists. 

NOTE: You may want to UNGROUP a multi-channel Entry into its component parts, or a 
I 	 stereo Entry into its left and right mono parts in order to treat them separately. For 

example, you might introduce a time shift between the two channels, or delete one 
channel from the EDL completely - especially useful when working with M&S stereo 
or material you thought was stereo when you recorded it, but turns out to be mono! 
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BOUNCE-DOWN 

Entries may be permanently grouped by re-recording them internally. It is possible to do this 
through the Mixer (See "Bounce-Down" in Chapter 6, Mixing and Processing), however for mOSl 
purposes, the Bounce Window provides a simpler method. 

You may choose to bounce entries down for a number of reasons: 

• 	 Convenience. You want the mixed or processed result to always appear as a single EDL Entry. 
or you don't want to bother with setting the Mixer or Automation to process the required 
Entries every time you play the EDL. 

• 	 To clear SCSI space. You want to re-record small parts of one or more much longer Tracks 
that you can then delete (as described under" AUcU6 Disk Management", in Chapter 7, File 
Management). 

• 	 There is not enough DSP power available to carry out the processing you require in real time 
and/or play the number of simultaneous Entries you require. Process and re-record the 
necessary Entries with "'Non-real time" selected in the Transport Controls' record section. 
Then you can use the processed versions in the full EDL. See Chapter 2, Recording. 

The Bounce Window can re-record a group of clips, with or without the mixer, automation or 
processing, so that they become a single mono or stereo track. There are many possibilities but 
let's follow a fairly simple example where you are re-recording some edited clips to form a 
"master" steroe track 

1. 	 First, select the clips in the EDL. We shall re-record these clips through the mixer, so check 
the mixer balance is correct. 
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2. 	 Click on the bounce icon to open the Bounce Window. 

3. 	 We shall need to enter a name for the recording. The first section of this window serves the 
same purpose as the Record tab of the Transport window. 

4. 	 Next tick Selected Clips in the Source section. The Source section tells Bounce what to re­
record - Complete EDL or Selected Streams are the other possibilities. We are making the 
new recording through the mixer and so check that olp 1&2 are chosen from the pop-up list 
- we are recording what is appearing on these outputs. 

5. 	 We must choose, in the Destination section, what's going to happen to the new track after re­
recording ­

• 	 Stream - tells Bounce to put it into the same EDL on streams specified in the pop-up list. 
• 	 Auto-replace source clips - only works in conjunction with Stream - when this is 

ticked, at the end of the bounce process, the source clips are deleted. 
• 	 Clipstore - leaves the Playlist unaffected, and places the new track into the current 

ClipslOre. 

• 	 PC Disk - this is explained below - it is unadvisable to choose this option unless you 
have a specific need to. 

6. 	 The bottom section allows you to choose Bounce in non real time. If this is selected the 
bounce will be performed as quickly as possible, but will not be audible. The other two 
options allows you to turn off automation and/or the mixer for the bounce. 

7. 	 Press Start. The process will start, and during the bounce the ball icon in the Bounce button 
will "bounce" . Be careful not to click in the time-line in the Playlist or press transport buttons 
- you will halt the bounce. 

SPECIAL BOUNCE FUNCTIONS 

1. 	 Multi-Bounce - with MULTI selected as the source for the bounce, every entry in the EDL 
will be re-recorded as a separate audio file on the disc drive. If you want a group of entries to 
become a single audio track then simply group the entries - a Group Entry is treated as 1 
entry. You must have Autotake selected - the new tracks will be automatically named using 
this function. 

2. 	 Bounce to PC Disk - the new track(s) can be recorded to the PC disk by ticking this option. 
1n the Bounce page of Setup you should set a PC Bounce Destination directory to tel'! 
SADiE where to put the new files. You will also have to set a file format for the new file(s) 
Properties in the Bounce Window opens a Track Properties Box to allow you to change this. 
Note that the chosen format must be suitable for the PC - i.e. NATIVE, SADiE2 and SADiE3 
file formats are not allowed to be recorded to the PC disk. Note that files on the PC disk 
cannot be played directly in an EDL, therefore don't bounce to the PC disk unless you have a 
specific reason to d so. However, this function (possibly in conjunction with Multi-bounce) is 
very useful, for instance, for preparing *.WA V files for multimedia productions where the 
final edited files need to be placed onto a PC disc. 

3. 	 Bounce to Audio Vault - this is an option for Audio Vault users only. 
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4. 	 Reverse bounce - The REVERSE option in the Bounce window aJlows you to make a 
backwards copy of an EDL entry or entries. Note aJso that right mouse clicking over an entry 
will initiate the Bounce window with Reverse enabled. Otherwise the Bounce window works 
in the normaJ way. Note that as usuaJ the Bounce records the Output of the mixer including 
any level changes or processing. 
Reverse cannot be used in conjunction with any Non 1-1 process, such as Re:sample or 
Timemod. 

UNDO AND REDO 

The last change that you made to the EDL can be reversed by pressing UNDO. Press UNDO ag~ in 

to reverse the change before that, and so on, stepping back through the history of your action•. 
The maximum number of undo levels is set in the Setup window and can be up to 25. 

REDO steps you back the other way after using undo. 

m The UNDO button is at the bottom right. SHIff + UNDO is redo. 

NOTES: Undo and Redo are aJso available on the menu bar under "Edit". This may be useful as 
it aJso gives a description of the operation. 


Note that the Edit menu Undo and Redo commands can aJso apply to the Mixer and 

Clipstore, if those are the active window. 


The Undo memory is cleared whenever Streams are removed from or added to a 

Play list. 


LOCKING ENTRIES TO EDL TIME 

~ As long as this button is depressed, aJl EDL Entries will be locked to EDL time and so will 
remain in sync. Entries can still be moved from Stream to Stream in aJl the usual ways, but their 

LOCK ALL 
EN1lUE.S time position in the EDL cannot be changed by dragging, nudging, or any editing operations ­
IN TIME apart, of course, from cutting and re-pasting. 


The button is labelled LOCK. 


INOTE: When LOCK is on, SLIP will be disabled. 


CLIP DETAILS WINDOW - CHANGING ENTRY CHARACTERISTICS 

The Clip Details window lets you aJter the way EDL Entries in the Playlist are replayed as well as 
providing another way to aJter their positions in the EDL and labelling. 
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NOTES: 	The Clip Details window can be equally well used to alter the details of Clips in the 
Clipstore. This will affect the way they are replayed when they come to be placed in an 
EDL. If you want to store different versions of Clips in the Clipstore, change their 
name before writing them back to it. For example, a Clip called "Splash" could be 
loaded into the Clip Details window, have its level adjusted and name changed to 
"Quiets plash " and then be written back to be used as an alternative version. 

Although each Clip Details window only refers to a single Clip or Entry, you can have 
several CDWs open at the same time. 

First select the single Entry or Clip you want to adjust. Then load it to a Clips Details window by 
pressing the button on the Playlist or Clipstore toolbar. 

NOTE: In the Playlist section of the Setup window there is an option to open the Clip Details 
window by double-clicking on the Entry. 

The window has a row of buttons along the bottom providing: 

• 	 A "Write-back" button which updates the Playlist or Clipstore with the new details. 

• 	 Buttons providing four ways of loading new Clips/Entries into the existing window for 
alteration - each is described by the on-screen help. Remember to write back one Clip's details 
before loading the next. 

• 	 A preview button for hearing the Clip/Entry with the changes you are making in real time. 

• A Close button for closing the window when you've finished with it. 

There are three tabs along the top which reveal three different sections: 

FADES 	AND LEVELS 

The Fader changes the level the Clip/Entry will be replayed at. There is a PPM next to the fader 
to check the level. 

INOTE: 	 This sets the Entry's replay level relative to others on the same Stream, which will then 
be affected by the faders of the Mixer. It is useful for changing the level of a single 
Entry without bothering with Mixer automation. 
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The Balance control is a true stereo balance, or offset, adjusting the relative levels of the left and 
right channels of stereo material. It will not be active for mono Clips/Entries. Click and drag it 
left-right to adjust. A small fader will pop up to indicate the setting. Double-clicking allows you 
to adjust the pop-up fader directly: 

Nudae Draa Centre 

The rest of this section displays the details of the fade-in (on the left) and the fade-out (on the 
right). Every Clip or Entry in SADiE has a fade-in and fade-out, the length of which can be 
adjusted from the whole of the Clip's duration right down to zero, and the curve of which 0 ,1 be 
selected from a list of 20 different types. 

NOTE: 	 The default fade-ins and fade-outs which result from starting and stopping recorcl ' j 0 ' 

and from making razor-cuts when editing can be set in the "Default Crossfade" s(c,ion 
of the Setup window, displayed from the View menu. A standard time of 21 
milliseconds/40 timecode subframes/l CD frame (the "General" section sets how times 
are displayed) will give smooth edits for most purposes. For fine edi, ing, like rcrr dvi n : 
clicks and pops, you might want to reduce this by at least half. Note that zero-length 
crossfades are likely to cause clicks unless you use the Trim Editor at its highest 
magnification to make sure the waveform either side of the edit point does not jump in 
level. 

To adjust a fade length, do either of the following: 

1. 	 Click, hold and drag the mouse up or down over any field of digits in its time display (i .e. the 
hours, minutes or seconds, etc.). Their value will increase or decrease - the more you move ( Ie 

mouse, the faster they change. Release to set the new value. 

2. 	 Use the up/down arrows beside the display to nudge its value by the lowest units. Hold Shift 
to nudge seconds, Ctr! to nudge minutes. 

3. 	 Double-click on the display. 

The box that pops up allows you to:­

• 	 Directly type in a new duration (or use the mouse cursor to drag across and overwrite only 
part of the displayed duration). End with the keyboard Return/Enter key. 

• 	 Click on "Zero" to enter zero, followed by "OK". 

• 	 Use the up/down arrows to adjust the time, as in no. 2 above, followed by "OK". 

NOTE: Fade lengths can also be adjusted graphically in the Playlist and the Trim Editor. See 
Chapter 5, Editing. 

1linear 	 .-"- 1 To change a fade type, press (he down-arrow button next to the name of the current type. 

The drop-box that appears lets you choose from twenty fade curves. Either use the scrollbars and 
select the new fade with the mouse, or type the first letter of the fade you wan t (repeat to ",cle 
through log a - log g, etc.), followed by Return/Enter on the keyboard. 

The fade curve is drawn in the box above the name. There are 7 different logarithmic and 
exponential curves. 
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"Equal Power" can be useful to achieve constant level on long cross fades of some material. 


Exponential fade-outs d, e and f are good music fades. 


Short logarithmic fade-ins are useful for taking the edge off an abrupt start of speech. 


Linear is a good default for other crossfades and edits on most material. 


Buttons are provided ~o preview just the fade-in or fade-out, with a pre-roll and post-roll time set 

in the pre/ post roll section of the Setup window. 

NOTES: 	The default iade types which result from starting and stopping recording, and from 

making razor-cuts when editing can be set in the "Default Crossfade" section of the 

Setup window, displayed from the View menu. 


Setting long Entry fade-outs {for music and effects, for example} is a useful alternative 
to using fader automation in the Mixer. 

I .. 

ENTRY TIMES 

This section displays the times at which the in-point, Hotspot and out-point oi this particular 
Entry or Clip occur in: 

1. 	 the SOURCE Track. Times define what portion of the original recording is being used for 
this Entry/Clip. 

2. 	 the EDL Times define at what time that portion will be replayed and will be blank for Clips 
in the Clipstore. 

The fade durations are also displayed here as well as the overall duration of the Entry/Clip. 
Source Duration is the length of the original Track as it was recorded'. 

All of the above times (except the source duration) can be altered in the same way as described for 
fade durations in the above section. 

The values are interactive, following the same logic as Source/ EDL Playlist editing. So, for 
instance, if you change the Entry duration, the EDL out time will change accordingly. 
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MISCELLANEOUS 

TEXT EDL 

TEXT PANE• 

Here you can change the name of a Clip/ Entry, and write text for dialogue or notes that may be 
shown alongside the Clip in the "Comments" area of the Playlist Stream. The Playlist Display 
section of the Setup window sets whether dialogue or notes are displayed. 

Use the mouse to position the cursor to enter text, or drag across text you want to over;\.' rite, 


Seven other buttons affect the way the Clip/Entry behaves, 


Protects the Entry from having its Source times changed, so it's always the same bit of audio . 


Causes all Mixer automation data in the EDL to be ignored for this Entry. 


Phase reverses the left channel of stereo Clips/Entries (or the whole mono Clip/Entry) . 


Phase reverses the right channel (for stereo Clips/Entries only). 


Slip all previous Entries and .. . 


Slip all following Entries when you write back changes that move this Entry in the EDL. These 

will initially reflect the Slip status of the Playlist but can be used to override it when writing bac k, 
just like the Trim editor's Slip buttons . 

The Playlist is a graphical representation of the EDL. Often, however, it is useful to view and e 
the EDL in text form, as a "cue-list" of Entries to be played, in order. 

DISPLA YING THE TEXT EDL 

Each Playlist has a Text EDL underneath it which can be revealed by pressing the TEXT PANE 

button, then selecting the tab marked "Text EDL", You can adjust the boundary between the tc..(t 
pane and the Playlist by dragging it with the mouse. 

NOTE: Enlarge the Playlist window by dragging its outer borders if neccessary. 


You can also open the Text EDL in a separate window: Make sure the Playlist is actiYe, 

then from the Window menu select New Window and choose Text EDL. 
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For each Entry, the Text EDL shows in columns most of the details that would be shown in its 
Clip Details window. The display scrolls vertically through the EDL and horizontally through 
the different columns. 

USING 	THE TEXT EDL 

The Text EDL is fully interactive with the Play list display, and so all the hardware controller 
functions on the Playlist will still apply. However, you can perform several operations directly on 
the Text EDL display with the mouse: 

• 	 Select Entries by clicking on the Entry number in the "Entry" column. Holding the keyboard 
Shift key whilst selecting another Entry selects all Entries between them. Holding the Ctr! 
key lets you select/deselect any number of Entries. 

• 	 Start playback from the in-point of any Entry by double-clicking on the Entry number. 

• 	 Stop playback by single-clicking on any Entry number. 

Every Entry detail that can be altered in the Clip Details window described above can also be 
altered here by double-clicking on the display in the relevant column. You can even type in a 
value in dEs for the level! Finish with the Enter key, or the Escape key to canceL 

NOTE: 	 The effect of changing EDL times in the Text EDL depends on the position of the 
global LOCK ALL ENTRIES button in the Playlist. For example: when Entries are 

LOCK All 

ENIlUES 
 'locked, setting a later start time will trim the beginning off the Entry, whereas when 

they are not locked, it will move the Entry in the EDL 

Additionally you can change Streams in the relevant column by typing in the new Stream 
number, or the lower numbered of the two Streams for a stereo Entry_ 

The following details, which relate to the original Track, cannot be changed and are for display 
only:- the Track name; Sample Rate at which it was recorded; Sample Resolution (in bits per 
sample) at which it was recorded and the Offset between its original time in the EDL during 
recording and its time in the present EDL. (Offset represents how much out of sync. it is, where 
sync_ is relevant.) 

CUSTOMISING THE TEXT EDL DISPLAY 

You can rearrange the columns in the Text EDL to suit yourself. Click on the grey column 
heading buttons and select the options that you want from the drop-box. "Insert Column" inserts 
a duplicate column which you can then redefine by clicking on its heading button and selecting 
the required display parameter from the list. "Delete Column" shouldn't really need explaining, 
should it? The width of columns can be changed by dragging the dividers between the heading 
buttons. 

PRINTING THE TEXT EDL 

The Text EDL can be printed out as arranged on screen. It will print in exactly the order 
displayed. 
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This is available under the Playlist menu - Print Text EDL 

To Printer Prints directly to the printer. Beware that in normal circumstances you are likely to 
be displaying far more Text EDL fields than will fit, width-wise on a normal sheet of paper in a 
normal (readable) sized font, and therefore you will need to customise the display before printing. 

To File. __ 'Prints' to a text file, which can be imported into another application for further 
manipulation. 

The Printing section of the SETUP WINDOW allows you to set the number of characters r:a 

line, and also the delimiting character. This is particularly useful for importing the list into a 
spreadsheet or database. 

WORKING WITH MORE THAN ONE EDL 

You may open several Playlists and create EDLs in each of them (see Chapter 7, File 
Management) . This may be useful to create alternative versions of a piece of work. 

To copy an entire EDL from one Playlist to another:­

• 	 Save the EDL in Playlist A. 

• 	 Create a new Playlist B (in the Project window, or the File menu). 

• 	 Load the saved EDL to the paste buffer (under the File menu). 

• 	 Paste it into Playlist B. 

• 	 You now have two identical EDLs and you can make different changes to each of them. 

To copy EDL Entries from one Playlist to another:· 


Either: 


• 	 If both Playlists are visible, hold the Ctr! key and the Shift key and drag the Entry from one 
Playlist to the other. 

Or: 

• 	 Copy to the paste buffer, make the other Playlist the active window and paste into it. 

DSP POWER 

You may notice that from time to time yellow or red strips appear at the top of the Playlist 
display in the grey bar marked 'Audio Unit 1', and the Playlist tilte bar may say 'unplayable'. Or 
entering playback gives you a message 'Out of DSP ... .', 'Out of DSP memory', or perhaps 'Disk 
too Slow'. 
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There is a limitation to the amount of DSP power the hardware has, but the SADiE software has 
no such limit, and allows you to make a playlist that will perhaps play on one platform but not 
on another. In some situations this may be an advantage - you could tracklay and edit on a 
cheaper, less powerful system and then transfer the project to a bigger system for mixdown and 
playout. 

The yellow (watch out !) and red (too late !) lines warn you that the DSP loading is reaching or 
has overstepped the limit for the hardware platform you are working on. These take into account 
the number of playback streams of audio ptus the number of mixer strips and processing in use. 
Yellow comes on at about 80% loading and when the Red line appears, the playlist should not 
theoretically play. These will never be 100% accurate - for instance disk fragmentation wiill add an 
unknown factor, but are intended merely as a guide to help you find out whether an EDL has 
reached the limit. The observant reader will notice that my picture above is playing through a red 
section of the EDL. 

It's wonh noting that if a red section plays when you play from where the red starts, this doesn't 
necessarily mean it will playas part of the entire EDL - the tracks that are playing beforehand do 
have an effect on playback. 

It's possible to view a list of unplayable points in the EDL. To make the EDL playable again, you 
must make some entries or EDL streams inactive -see below. 

LIST UNPLA Y ABLE POINTS 
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In the same way as you can 'capture' audio overloads, you can view a list of points in the EDL 
where the DSP is over-capacity_ See DSP Power above for reasons why the EDL may be 
'unplayable'. 

In the Playlist menu there is an option: List U nplayable Points. Selecting this will sho'" this 
window: 

Activating the check-box in the bottom left will set this window to pop-up if SADiE thinks the 
EDL is unplayable when you go into play. In that case you will also see and box labeled "Try ar:d 
Play" which will close this window and play the EDL. 

The list box in the window, lists every timecode in the EDL at which the DSP or disk is being 
asked to operate at past its maximum capacity, and approximately how much over capacity 
SADiE expects it to be Clicking on the line in the list will locate the EDL to that position in 
order that you can ascertain where the problem may be, 

The list of unplayable points can be ordered by time or by seriousness. To make the EDL 
playable, you will have to remove some entries, or processing, or alternatively you can leave 
entries in the EDL but disable them for playback, You can disable whole streams. 

INACTIVE STREAMS AND ENTRIES 

To allow you to play an unplayable Playlist, you can make either whole streams or individual 
EDL entries INACTIVE. These streams and entries will not play and thus will reduce the 
loading on the DSP. 

To make an entry Inactive (or make it Active again having previously made it Inactive) - right 
mouse click on a single entry and select MAKE CLIP INACTIVE/ ACTIVE. 

To make a whole stream Inactive or Active again, hold the AL T Key and click on the I '~ 2 
Stream Name button - the Stream name will be highlighted in Red. 

On the hardware controller select SHIFT + STREAM and use the wheel or PREVIOUS/NEXT 
to highlight a Stream, then hit EDIT/SELECT to enable/disable it. SHIFT + EDIT/SELECT 
acts on the group of Streams above it that are all the same status. 
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In the PLA YLIST MENU, there are three options to allow you to globally change the active 
setting of entries and streams: 

MAKE ALL CLIPS ACTIVE 

MAKE ALL STREAMS ACTIVE 

MAKE AU ENABLED STREAMS ACTIVE 

Inactive clips are grey if the profile is being displayed or grey but outlined in their natural colour 
(green! cyan/yellow etc.) if the profile is off. 

Note that making an entry or stream Inactive is NOT the same as muting it - a mute can always 
be played immediately when the stream is unmuted, and hence the DSP is still working to pray it 
(all be it silently). 

SCRUBBING AND DSP POWER 

Scrubbing an entire playlist will sometimes cause a 'DSP too slow' or 'Disk too slow' message, 
where the original EDL played at real-time just fine. This is because the scrub does use extra 
resources to re-process the audio in order to play at speed, and similarly a disk drive will be more 
stressed because it's having to deliver the audio data more quickly. Plug-ins will have an effect too, 
some more than others if they consume lots of DSP power. There is a Setup option that allows 
you to automatically turn off all plugin processes when you go into scrub, thus releiving the DSP 
a little to make scrubbing more possible. This will of course change the way your EDL sounds 
during the scrub ('but only the scrub), but will usually make scrubbing possible where previously 
it wasn't and so is likely to be a more convenient way of operating. 

To set this - go to the VIEW menu; Setup Window; Mixer, and tick the button 'Bypass in Scrub' 
underneath 'Plug-ins'. 

NOTES ON MULTI-TASKING 

SADiE version 3 will allow certain tasks to take place simultaneously. For instance while you are 
editing a Playlist you could be recording new audio in and copying files or backing up to a tape 
streamer in Disk Management. 

There are some limitations to this however. 
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• 	 There is only one Mixer· because there is only one set of physical inputs and outputs. If you 
are using the mixer to playa Playlist, then you cannot use the same inputs or outputs for 
recording. 
For instance if you are using Output 1&2 to monitor a background recording, you will not be 
able to use the same Outputs for the foreground operation. Note that a Bounce theoretically 
uses a pair of Outputs (the bounce operation records the output of the Output bus eithe ' ;n 
real, or non-real time) , and similarly a CDR or DDP master will use the mixer and OUt?l" _ 
bus 1&2, hence you cannot use the mixer again to play another PlayJist. 
It's not possible to play 2 EDLs simultaneously. 
Note also that the system Audio clock cannot be switched during play or record· for f·~ t ce, 
if you are set to Auto Clock, you cannot start a digital background recording whilst p' . f ir g in 
the foreground - this would require a switching of the Audio clock and:would producr - t ' itch 
on the output of the Playing EDL. 

• 	 There is a limitation to the amount of DSP power the hardware has. Thus a backgroull • 
record will reduce the number of foreground streams that are playable. However becal-.se -;opy 
and backup operations do not have to run at real-time and can in fact st ::> p periodically, these 
will take advantage of the available DSP power remaining and not effer. foreground t : - -~ . 

See also: Background Reco rding Copying Files Project Backup Project Restore 
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\5 - EDITING 


OVERVIEW 


SADiE'" provides the user with a fast and intuitive interface for editing. With stereo material, 
the two channels are always edited simultaneously - unless a stereo EDL Entry is first ungrouped 
as described under "Grouping Entries" in Chapter 4, Arranging an EDL. 

There are three editing techniques at your disposal: 

1) 	 Simple cut-and-splice editing in the Playlist uses the scrub function to accurately locate edit 
points, and make "razor-cuts", just as you would on tape. This creates separate EDL Entries so 
that unwanted material can then be removed. 

2) 	 The Playlist Editing mode allows you to make and also adjust edits by altering the in-point 
and out-point of any Entry. At the same time, you can adjust an Entry's Hotspot (see the 
Glossary for a description). 

3) 	 The Trim Editor is a separate window that works like Playlist Editing, but also provides: 

• 	 Greater viewing detail - higher magnification of profiles down to waveform level for 
removing clicks and mic. pops and the ability to see the profile of the original Track 
outside the edit points, i.e. the bits that you're not using at this point. 

• 	 The ability to adjust more than one EDL Entry simultaneously. For example, by moving 
the fade-in of one Entry and the fade-out of the next together, you can slip the crossfade 
between them along the audio. Many other possible combinations are equally useful. 

• 	 The ability to "top and tail" a Clip from the Clipstore, and to create a new Clip from an 
existing Track. 

SYNC. OR 	NON-SYNC. EDITING? 

If you work in an audio-only field like radio, when you cut out material, you will usually want to ~ slip everything else along the EDL to fill up the gap, like joining up two bits of tape. Enabling 
SUPON 

SLIP will do this for you. For safety, pre-select both left and right Slip (see" Autoplace and Slip" in 
Chapter 4, Arranging an EDL, for details). tMJ 

SUP 	 If you are working to picture, most of the time you are likely to want your audio material to be 
fixed to the EDL so that it remains in sync. This means you will have SLIP off. 

SADiE makes it easy for you to work either way, and to switch between them as necessary. 

DEFAULT CROSSFADES AT EDIT POINTS 

Whenever you make a "razor-cut" to divide an EDL Entry into two, you will actually create a 
new fade-out and fade-in at that point. SADiE can do this in either of two ways. These are set in 
the Playlist section of the Setup window (displayed from the View menu). 

• 	 Splice-cut mode. The fade-out and fade-in overlap to make a perfect crossfade. This will 
undoubtedly be what you want to do normally. 

• 	 V -cut mode. The first Entry fades out before the next starts to fade in, so there is no overlap. 
This is really only necessary when you are reaching the DSP limit of how many Entries 
SADiE can play at once. This obviously creates a "drop-out", although it is often not 
noticeable in clean speech if you are laying music or effects underneath. 
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The default fade lengths and curve types that are created when you make a razor-cut can 'be set in 
the wDefault Crossfade" section of the Setup window, displayed from the View menu. A standard 
default of 20 milliseconds/40 timecode subframes/l CD frame (the "General" Setup section sets 
how times are displayed) and a linear curve will give smooth edits for most purposes. For repeated 
fine editing, like removing clicks and pops, you might want to reduce this to under 5 
milliseconds. If you are just doing the occasional fine edit, you don't need to change the default, as 
each crossfade time is easily adjusted in the Trim Editor or Clip Details window. 

NOTE: Zero-length crossfades are likely to cau~ dicks and are best avoided. 

EDITING THE PLAYLIST WITH A MOUSE 

RAZOR 	BLADE OR SCISSORS? 

Mouse users have the option of using the "scissors" to make razor-cuts. Whereas the RAZOR·em 

button always cuts at the current-time cursor, when you press the SCISSORS button, the mouse­
RAZOIl.cur 

pointer wiIl change into a dinky scissors icon with a cross to show the target point. You can then 
make a freehand cut anywhere in the Playlist . useful if you can see where to cut from the 

SCISSORS 
waveform profile - and so skip the process of scrubbing to locate the edit point. 

NOTE: 	 The scissors cut only on the Stream the mouse icon is over. This provides a useful 
shortcut to disabling Streams before using the razor blade, as described below. Holding 
the Ctr! key whilst scissor-cutting cuts across all enabled streams. 

The following editing instructions describe scrubbing to locate and then using the razor-cut, but 
remember that the scissors have the same function. 

CUT ·AND-SPLICE EDITING 

Scrltlwheel 

1. 	 Display the Edit section of the Transport Controls by clicking on the tab at the top. 

2. 	 Click and hold the mouse button over the scrubwheel and drag it to scrub the current-time 
cursor along the EDL: 

• 	 Moving the mouse up/down gives you forward/ reverse shuttle. The more you move from 
your original position, the faster it goes. 
This is like spooling tape against the heads. 
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• 	 Moving the mouse right/left gives you forward/reverse jog. The more you move, the 
more you hear. 
This is like nudging a tape machine's reels back and forth. 

You can move between jog and shuttle modes without releasing the mouse button. 

NOTES: 	You will hear all Streams that are not muted, so you may choose to solo the 
relevant Stream(s) with the small Stream control buttons.SOLO 

If you are using machine control of a VTR, hit ONLINE in the Transport Controls 
to scrub to picture. 


Don't position the scrubwheel too near the top or bottom of the screen, or it will 

restrict the amount of movement you have for shuttling. 


Locate your edit point and release the mouse button. 

There are also Hotkeys for three fIXed forward and reverse scrub speeds and a scrub-pause. 
These are assigned to the keyboard under "Edit Controls" in the Hotkey section of the Setup 
window. The default keys are on the keyboard's number pad. The speed for each Hotkey caP 
be set in the Scrub Setup section of the Transport Controls, Setup window . 

3. Before you make a razor-cut you should disable any other Streams that have EDL Entries at 
this point which you don't want to edit. The STREAM NAME BlJITON enables/disables 
Streams for cutting. Disabled Streams are darker grey. 

4. 	 Press the RAZOR CUT button. The Entry/Entries on enabled Streams w ' 1be divided under 
the current-time cursor. 

&J 

If you are trimming an Entry's top or tail, you can now simply remove the new Entry to the left 
or the right of the razor-cut. If you are removing material internally, you will need to locate and 
make a second razor-cut so that you can remove the new Entry between them. 

5. Select (by clicking on it) the relevant Entry and remove it (CUT TO PASTE). If you have SLIPelIT·TO· 
PASTE on, the resulting gap will be automatically joined up. 

6. Play the finished edit by double-clicking in the time bar just before it. If you don't like it, US2 

UNDO and do it again or adjust it using Playlist Editing Mode, described be! w. 

PLA YLIST EDITING MODE 

In this mode, when an entry is selected in the Playlist, it will change to a wavefGrm profile and its 
in and out points and Hotspot can be adjusted. 

Playlist Editing has the following uses: 

• 	 After making a razor or scissors cut as described above, by adjusting the out-!'-oint of the 
preceding EDL Entry, and the in-point of the next, you can remove (or repeat) material at the 
edit point. The initial razor-cut doesn't even have to be that accurate, as the adjustment will 
fine-tune the edit. 

NOTE: 	 If you are using the razor to make cuts "on-the-fly" during normal speed playback, 
you may want to use the option in the Playlist section of the Setup window which 
stops playback when you make a cut. 

• 	 You can adjust an existing edit. 
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• You can adjust the join between two unrelated EDL Entries· such as the way a music Entry 
fades and speech starts over it. 

• You can adjust an Entry's Hotspot. 

1. Display the Edit section of the Transport Controls by clicking on the tab at the top. 

pon 
time display 

2. Activate Playlist Editing mode with this button on the Play list toolbar. 

PLAYUST 3. With the mouse, select the Entry on whichever side of the edit point you want to adjust. The 
EDITING 

Entry turns a brighter red. 

Aucio ScnJ:l Button Preview buttons 

NOTE: 	 The AUDIO SCRUB button needs to be down if you want to hear ,the edit point as 
you adjust it. With the button up, adjustment will be faster, as SADiE doesn't have 
to output the audio. This is sometimes useful if you can tell from the profile exactly 
what you want to do. 

MOUSE EDIT 
SELEcnON 

4. With the MOUSE EDIT SELECTION button down (the default position), depending where you 
point the mouse over the Entry, a handy little graphic at the mouse pointer will appear to tell 
you which bits of the Entry are going to move. When you click the mouse button, the IN, 

HOT, OUT and EDL/SOURCE buttons automatically select what will be adjusted as follows: 

MOliSE 

GRAPHIC 

POINT 

SELECTED 

MODE 

SELECTED 

OPERATION 

~ 
¢@ 

IN 

IN 

EDL 

SOURCE 

THE FADE IN MOVES 

THE BODY AND THE FADE OUT MOVE 

~ HOT EDL THE HOTSPOT MOVES 

/¢~\ 

&J¢­

HOT 

OUT 

SOURCE 

SOURCE 

THE WHOLE ENTRY MOVES 

THE FADE IN AND BODY MOVE 

~ OUT EElL THE FADE OUT MOVES 

The mouse graphic is probably enough to tell you what will happen when you edit, but if you 
ever want to manually select the editing adjustment by turning MOUSE EDIT SELECTION off 
(for example, to move the Hotspot when it coincides with the in point), a description of the 
two modes may be useful: 

EDLMODE 

The EDL time of the IN or OlIT point of the Entry is adjusted, as well as its time in the source 
Track. This will be most used when working to picture, as the profile (and so the audio) is 
fixed to the EDL and sync. is maintained. The HOTspot can be moved without moving the 
audio. 
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SOURCE 
MODE 

The IN or OUT point being adjusted remains at the same EDL time, but its time in the 
SOURCE Track is adjusted by slipping the profile. This will be most used for sound-only 
editing. With HOT selected, the whole entry can be moved and will scrub across the current­
time cursor. 

5. \:I.-hen you have the mouse graphic you want, click and drag the mouse over the Entry profile, 
to either jog or shuttle it, as described in "Cut-and-Splice Editing", above. When you release 
the mouse button, the edit adjustment is done! 

You can also adjust the edit in small increments by "nudging" it with the EDIT NUDGE 

buttons in the Edit section of the Transport Controls or buttons above the scrubwheel. The 
nudge steps are set in the Trim Edit Nudge section of the Setup window. There are two 
settings: 1. Pressing the buttons. 2. Holding Alt. while pressing the buttons. 

The buttons can be pressed repeatedly, or held down. You will not hear the audio when using 
them. 

NOTES: Shuttle is useful for losing large amounts of material at an edit point, just like 
dumping tape onto the floor, but you don't have to worry about stepping on it. 

Whether previous or subsequent Entries move when you release the mouse button 
will be determined by whether you have selected a SLIP mode and which Streams 
are enabled to be slipped (see the Autoplace and Slip section in Chapter 4, 
A rranging an EDL) . 

The time display in the Transport Controls edit section will show you the time of 
the IN/HOT/ OUT point being adjusted in either the EDL or the SOURCE Track, 
and both of these (or the new duration) appear alongside the Entry profile on the 
Stream. When moving the whole Entry, the Stream display shows EDL in and out 
times. 

6. 	 To hear the edit you can either play it normally, by double-clicking in the time bar just before 
it, or use the preview buttons, which playa pre-set amount either side of the edit point: 

PLA Y THROUGH plays through the edit. 
PLAY lliRU 

PLA Y TO plays just the left-hand side of the edit and 

PLAY TO 
PLA Y FROM plays just the right-hand side. These can be useful for assessing which side you still 
need to adjust. 

PLAY FROM 

PREVIEW will play the selected EDL Entry, from one edit point to the next. 

PIl£VIEW You can cancel a preview while it is playing with a second press of its button 

NOTE: There are three pre-roll and post-roll lengths available by pressing: 
1. Only the preview button . 
2. Shift + the preview button. 
3. etr! + the preview button. 

The lengths of each are pre-set in a dedicated section of the Setup window which is 

displayed from the View menu. 
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IN PRACTICE 	This is much quicker to do than to read about! 

Normal non-sync. editing (SLIP on) means making a cut, hitting the PLAYLIST 

EDmNG button, selecting and adjusting the left side of the edit with @'¢> , then 
selecting and adjusting the right side with ~. 

Editing sync. material (SLIP off) will usually mean doing the same to trim the 
ends of Entries with ~ and ~. For extra safety, you will have LOCK All 

ENTRIES on as well. 

TIP: 	 When editing the Playlist, you may want to quickly switch between two different 
vertical and horizontal zoom settings. Save them in two different Desktops (see the 
Desktops section in Chapter 9, Customising SADi£). You can then switch between the 
Desktops by using the keyboard shortcuts to the Desktop menu:- Simply press Alt + 
D, followed by the number of the desktop file listed. 

FADES AND 	CROSSFADES 

There are four more mouse symbols which let you increase the length of the fades at the in and 
out points by dragging out tbe start or the end of each fade. Overlapping them will create 
cross fades. 

Hold the keyboard Ctrl key as you move the mouse over the edit point: 

CLICK AND DRAG: 


-+/¢- THE ST ART OF THE FADE IN 


¢/+ THE END OF THE FADE IN 


+\¢- THE START OF THE FADE OUT 


¢-,. THE END OF THE FADE OUT 


The type of fade curve can be altered by displaying the Clip Details window for the Entry. See 
Chapter 4, A rranging an EDL. 

Greater flexibility for adjusting cross fades is possible with the Trim Editor. 
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EDITING THE PLA YLIST WITH THE HARDWARE CONTROLLER 

CUT-AND·SPLICE EDITING 

1. 	 First disable any Streams you do not want to cut on: 

Select STREAM and use the wheel or PREVIOUS/NEXT to highlight a Stream, then hit 
EDIT/SELECT to enable/disable it. SHIFf + EDIT/SELECT acts on the ~ of Streams above 
the highlighted one which are all the same status. 

Deselect STREAM (and make sure you do not have CLIP or ZOOM selected either). 

2. 	 Use the SCRUB button to select jog, shuttle or move cursor modes· indicated by the small 
LEDs next to the wheel - and locate your edit point with the wheel. 

Jog is the equivalent of rocking the reels of a tape recorder back and forth : The more you 
move the wheel, the more audio you hear. 

Shuttle is the equivalent of spooling the tape across the heads: The more you move the wheel, 
the faster the audio goes forward or backwards. 

Move cursor mode (all LEDs ofD lets you quickly locate the current-time cursor without 
audible scrubbing. 

There are also Hotkeys for three fixed forward and reverse scrub speeds and a scrub-pause. 
These can be assigned to the keyboard, or the hardware controller's function buttons, under 
"Edit Controls" in the Hotkey section of the Setup window. The default keys are on the 
keyboard's number pad. The speed for each Hotkey can be set in the Scrub Setup section oi 
the Transport Controls, Setup window. 

NOTE: You will hear all Streams that are not muted, so you may choose to solo the 

relevant Stream(s) . Use SHIFf + MUTE above the hardware faders. 


If you are using machine control of a VTR, hit ONLINE to scrub to picture. 


3. Press the RAZOR button. The Entry/Entries on enabled Streams will be divided under the 
current-time cursor. 

NOTE: 	 If you are trimming an Entry's top or tail, you can now simply remove the new 
Entry to the left or the righ t of the razor-cut. If you are removing material 
internally, you will need to make two razor-cuts so that you can remove the new 
Entry between them. 

4. 	 Select the relevant Entry by moving the current-time cursor over it and pressing EDIT/SELECT 

and remove it by pressing CUT. If you have SLIP on, the resulting gap will be automatically 
joined up. 

5. 	 Play the finished edit by moving the cursor back a bit and pressing PLAY. If you don't like it, 
use UNDO and do it again or adjust it using Playlist Editing Mode, described below. 

PLA YLIST EDITING MODE 

In this mode, when an entry is selected in the Playlist, it will change to a waveform profile and its 
in and out points and Hotspot can be adjusted. 

Playlist Editing has the following uses: 
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• 	 After making a RAZOR cut as described above, by adjusting the out-point of the preceding 
EDL Entry, and the in-point of the next, you can remove (or repeat) material at the edit point. 
The initial razor-cut doesn't even have to be that accurate, as the adjustment will fine-tune the 
edit. 

NOTE: 	 If you are using the razor to make cuts "on-the-fly~ during normal speed playback, 
you may want to use the option in the Playlist section of the Setup window which 
stops playback when you make a cut. 

• 	 You can adjust an existing edit. 

• 	 You can adjust the join between two unrelated EDL Entries - such as the way a music Entry 
fades and speech starts over it. 

• 	 You can adjust an Entry's Hotspot. 

There are six possible adjustments, from selecting IN, HOT, or our and either EDL or SOURCE 
mode. (Source mode is with the button LED on.) 

EDL 	 The EDL time of the IN or OlIT point of the Entry is adjusted, as well as its time in the source 
Track. This will be most used when working to picture, as the profile (and so the audio) is fixed 
to the EDL and sync. is maintained. The HOTspot can be moved without moving the audio. 

SOURCE 	 The IN or our point being adjusted remains at the same EDL time, but its time in the SOURCE 
Track is adjusted by slipping the profile. This will be most used for sound-only editing. With 
HOT selected, the whole entry can be moved and will scrub across the current-time cursor. 

1. 	 First select the edit point to be adjusted. IN, OlIT or HOT. 

2. 	 Next select the entry to be adjusted by using the wheel to move the current-time cursor over 
it and pressing EDIT/SELECT. As an edit point is already selected, this will activate Playlist 
Editing on that Entry, which will tum brighter red, and the -Edit" LED by the wheel will 
flash. 

NOTE: 	 If you have Entries on several Streams at this point, you will be selecting the one on 
the lowest numbered, enabled Stream. If necessary, disable Streams as described for 
cut·and-splice editing. If you have just made a razor-cut, you will have done this 
already. 

To avoid disabling Streams, replace the above two steps with: 

1. Select the Entry by pressing EDIT/SELECT or PREVIOUSINEXT repeatedly to cycle 
through all Entries under the cursor. 

2. Select IN HOT or OlIT. 

3. Press EDIT/SELECT again to activate Playlist Editing. 

3. 	 Adjust the edit point with the wheel. The SCRUB button will select 

Jog mode· the more you move the wheel, the more audio you hear. 

Shuttle mode - the more you move the wheel, the faster the audio goes forward or backwards. 

Move mode (no LED permanently on) - quick adjustment without audible scrubbing. This is 
sometimes useful if you can tell from the profile exactly what you want to do. 


You can also adjust the edit with various Hotkeys, which may be assigned to the keyboard or 

the HWC function buttons under Edit Controls in the Hotkey section of the Setup window: 


5:8 



SADiE U5er Manual vJ.7 	 Chapter 5· Editing 

"Nudge Edit Point" Hotkeys will adjust the edit in small increments which are pre-set in 
the Trim Edit Nudge section of the Setup window. 

There are three fixed scrub speed Hotkeys for forward and reverse adjustment, and a 
scrub-pause key. The default keys are on the keyboard's number pad. The speed for each 
Hotkey can be set in the Scrub Setup section of the Transport Controls, Setup window. 

NOTES: 	Shuttle is useful for losing large amounts of material at an edit point, just like 
dumping tape onto the floor. 

The time displays on the controller will indicate the time at which the selected edit 
point occurs in the Source Track and in the EDL. When moving a whole Entry 
(HOT + SOURCE), an on-screen display on the Stream will show the EDL in and 
out times. 

If SLIP is on, whether previous or subsequent Entries move when you finish an edit 
is determined by which Slip mode is pre-selected and which Streams are enabled to 
be slipped (see Autoplace and Slip section in Chapter 4, Arranging an EDL). 

4. 	 Press PREVIEW to play across the edit point with the pre- and post-roll times set in the Setup 
Window (under "View" on the menu bar) . Note that alternative pre- and post-roll times can 
be set in the Setup window. 

5. 	 Press EDIT/SELECT again to turn Play list Editing off and confirm the edit, or select other 
entries with NEXT and PREVIOUS. 

IN PRACTICE 	This is much quicker to do than to read about! 

For most non-sync. editing (SLIP and SOURCE on): In your chosen SCRUB mode 
locate the edit point with the wheel, press RAZOR to make a cut, move the 
cursor back a bit, hit our, then EDIT/SELECT. Adjust the left side of the edit 
with the wheel then press NEXT and adjust the right side. 

Edit sync. material the same way with SLIP off and in EDL mode. For extra 
safety, you will have LOCK on as well. 

Generally it is safest to confirm each edit by pressing EDIT/SELECT to turn Playlist Editing off. 
You are then free to use the wheel without accidentally re-adjusting the last edit. 

TIP: 	 When editing the Play list, you may want to quickly switch between two different 
vertical and horizontal zoom settings. Save them in two different Desktops (see the 
Desktops section in Chapter 9, Customising SADiE). You can then switch between the 
Desktops by using the keyboard shortcuts to the Desktop menu:- Simply press Alt + 
D, followed by the number of the desktop file listed. 

FADES AND 	CROSS FADES 

To adjust the length of fades IN or our, and overlap them to create crossfades, press CROSSFADE 
to move the inner point (i.e. the end of a fade-IN or the start of a fade-aur) and 
SHIFT + CROSSFADE to move the outer point (the start of a fade-IN or the end of a fade-our). 

The type of fade curve can be altered in the Clip Details window for the Entry, or in the Text 
EDL. See Chapter 4, A rranging an EDL. 

Greater flexibility for adjusting crossfades is possible with the Trim Editor. 
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USING THE TRIM EDITOR 


The Trim Editor can be opened and loaded with one or more Entries/Clips from the 
Playlist/Clipstore and the in and out points and fades adjusted. You then "Write Back" the edited 
version to the Playlist/Clipstore. 

You might load it with gru; Clip or Entry: 

• 	 To "top and tail" a T rack selected in the Clipstore and store it back there as a new Clip for 
later use. 

• 	 To top and tail a single Playlist Entry - removing unwanted material either side of a bit of 
dialogue, for instance. 

• 	 When you want to search through a Track to deflIle a new Clip - say you need to grab a 
breath or a word. In this instance you will probably load the Trim Editor from the Track in 
the Clipstore, define the new Clip and paste it straight into your EDL. 

You might load it with t\Vo Entries from the Playlist: 

• 	 To make fine adjustments to an edit. All edits are a join between two Play list Entries, so it is 
the Entries either side of the edit that will be loaded. 

• 	 To adjust any other join between two Entries. For example, how a piece of music fades down 
under a voice-over, or how one piece of atmosphere cross fades into the next. 

You might load it with thr~e Entries: 

• 	 To work on an edit point in some dialogue that has music running underneath. 

• 	 When you feel really clever! - Any more than three Entries is getting quite ambitious. 

OPENING THE TRIM EDITOR 

1. 	 From the Playlist or the Text EDL: 

Select the Entry or Entries you want load into the Trim Editor. Selecting Entries is described 
fully in Chapter 4, A rranging an EDL They do not have to be adjacent, or on the same 
Stream. 

OPENTIUM Press the OPEN TRIM EDITOR button on the Playlist toolbar, or the designated function 
EDITOR button on the hardware controller. 

2. 	 From the Clipstore: 

Select the Clip that you want to load. 


CllPTO Press the LOAD CLIP TO TRIM EDITOR button on the Clipstore's toolbar. 

TIUM EDITOR 

On the hardware controller, you can designate two Hotkey commands to function buttons: 
one to open the Trim Editor, and another to load the selected Clip in the Clipstore. 
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A Trim Editor window will now appear containing the Entries or Clips that you loaded. 

EDL time bar Time relative to edit 

Preview { 
selected 
Clip 

Selected 
Clip 
highlighted 

In the example above, two Entries have been loaded from the Playlist: a stereo Entry called 
"music sting" which is followed by a mono Entry called "voiceclip". The right channel of "music 
sting" is displayed below "voiceclip" so that you can zoom in on just one channel of each Entry, 
which is generally clearer and quite sufficient for editing. This viewing order can be changed - see 
"Other Trim Editor Tools" at the end of this chapter. 

The main difference in the way the Clips are displayed here is that because each is drawn on a 
different line, the profile of the whole Track that it comes from can be shown. The parts that are 
being used and will be played as Playlist Entries are in green, and the parts not being used are 
shown in grey. 

This makes it possible to see what you are losing as well as what you are keeping in - which can 
aid editing decisions, since the grey bits are always available to be pulled back into the green side 
of an edit point. 

The Trim Editor has the following features in common with the Playlist: 

• 	 An EDL time bar which you can use to start and stop playback. Unlike the Playlist, the 
current-time cursor ("playback head") is fIXed in the middle of the window while the 
waveform profile of the audio scrolls past_ There is also a second time bar which shows time 
relative to the edit point. 

NOTE: In the case of Clips loaded from the Clipstore, the EDL time bar will show the 
"time stamp" given to the source Track when it was recorded into SADiE. 

• Scrollbars to move the display horizontally and vertically. 

• Magnification buttons to zoom in or out of the display. Greater magnification is possible here 
than in the Playlist. 

NOTE: 	 When the Trim Editor is the active window, a Trim menu appears on the menu 
bar. This allows you to change profile types to find one more ~uitable to the audio 
you are working with, and to jump between zoom magnification levels. There is 
also the User Zoom function, described below, under "Other Tools". 
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• 	 A small time display showing the mouse pointer position. - The current-time display in the 
Transport Controls will show current EDL time for an active Trim Editor. 

SELECTING WHAT TO ADJUST 

Editing in the Trim Editor is just like using Play list Editing mode, with the addition of the ability 
to adjust more than one Clip or Entry at once. 

N.B. 	 As the Trim Editor can move Entries in the Playlist, just like Play list Editing, you need 
to decide whether to have the Play list sUP function on or off. However, SLIP is 
disabled when you have more than two Entries in the Trim Editor, as it would be too 
difficult to determine which one takes precedence. If you need the Slip function in this 
circumstance, use Play list Editing. 

All Clips in SADiE have three parts: a fade-in, a body and a fade-out. (Unless deliberately 
lengthened, the fades will be very short - the usual default time 'being 21 milliseconds.) 
Adjustments in the Trim Editor are made moving any of these parts in relation to the time 
shown in the time bar. 

~ To select which parts of which Clips will move, either 

• 	 Select them directly by clicking on the required parts of the profile, or 

• 	 Highlight the required Clip (it will be shown with a grey background) by clicking anywhere 
on its profile. Then select the required parts on the "bladen shaped Clip icon at the bottom of 
the window. This icon allows you to select fades when they might be too small to point at on 
the profile: 

With nothing selected, all parts are green on icon and profile. 

Hold the Shift key whilst selecting parts of Clips to: 

• 	 add them to those already selected to be moved, 

• 	 deselect them from those selected to be moved. 

Fade-in Body Fade-out 

NOTE: 	 The Edit section of the Transport Controls can also be used to control the Trim Editor 
and is fully interactive with it. The IN HOT our and EDLISOURCE buttons will select 
the corresponding parts of Clips that would move in Playlist Editing. They also move 
the display to the selected edit point. 

AUTOMATIC SELECTIONS: 
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In order to speed up the most common tasks, when two Clips are in the window, these 
selections are made automatically when using a mouse: 
• 	 SeleCling the earlier Clip selects its fade·in and body Qike adjusting out·point in 

Playlist Source Mode). 
• 	 Selecting the later Clip selects its body and fade-out Qike adjusting in-point in 

Playlist Source Mode). 
• 	 Selecting the fade-out of the earlier Clip or the fade-in of the later Clip selects 

both· i.e. the crossfade between them can be slipped against the audio. 
Hold the Shift key while selecting if you want to override the above and select only the 
part you are pointing to. 

Using the hardware controller to control the Trim Editor follows the same rules as editing in the 
Playlist . Select the Clips with the PREVIOUS and NEXT buttons, or cUP + the wheel, and select 
lN OUT or HOT points in EDl or SOURCE mode to select the corresponding parts of clips. 

When selected, fades turn dark blue and Clip bodies turn dark red - on both the icon (which is 
always representing the highlighted Clip) and the Clip profiles. Here are some examples: 

Body and fade-out will move. Same as adjusting IN-point in SOURCE mode 
¢~. 

Fade·in selected to move. If selected on one Clip only, same as adjusting [N. 

point in EDl mode ~ . 

Body only will move, thus adjusting what part of the source audio is used 
between fixed in and out points. 

Whole Clip will move in relation to EDL time. (Same as HOT + SOURCE) 

Note also that pressing the SHiFf key before PREVIOUS or NEXT will add to the selection· i.e. if 
IN- EDl mode is selected on the right hand clip, SHiFf ·PREVIOUS will add the left hand clip's 
OUT point - in other words, with two clips this selects the whole Edit point . 

ADJUSTING THE EDIT 

Once you have selected which parts to move, use the mouse or hardware controller wheel to 
move them, as in the Playlist. The mouse can be used either over the selected Clip's profile, the 
"blade" Clip icon, or the scrubwheel in the Transport Controls. 

NOTE: For mouse users, using the lN and OUT buttons and scrubwheel in the Transport 

Controls is the easiest way of moving in and out points in EDl mode. 


II To hear the audio as it moves across the edit point, press the audio scrub button (this is available 
in the Trim Editor as well as the edit section of the Transport Controls). Then move the mouse 

AUDIO 
SCRUB 	 left-right to jog and up-down to shuttle. On the hardware controller use the SCRUB button to 

select jog or shuttle mode for the wheel. 

For fine adjustment, you may prefer to use the EDIT NUDGE buttons, which will move the 
selected parts in fixed steps that you can set in the Trim Edit Nudge section of the Setup window. 
There are two settings : 1. Pressing the buttons. 2. Holding AIL while pressing the buttons. 

fDITNUDGE 
These duplicate the edit nudge buttons in the Transport Controls and can be pressed repeatedly, 
or held down. You will not hear the audio when using them. 

To hear the results of your adjustments, you can: 
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• 	 Start playback from any point in the time bar (on the hardware controller the wheel, when no 
edit points are selected, will position the display and then you can use the PLAY button). 

• 	 Use anyone of the following preview buttons, which have the advantage of playing you a pre­
set amount either side of the edit point and then returning the display to it. 

NOTE: There are three pre-roll and post-roll lengths available by pressing: 
1. Only the preview button. 
2. Shift + the preview button. 
3. Ctr! + the preview button. 

The lengths of each are pre-set in a dedicated section of the Setup window. 


The top three preview buttons duplicate those in the Transport Controls edit section, which are 
also used for Play list Editing mode: 

Plays up to the edit point . 

. Plays through the edit point. - PREVIEW button on hardware controller. 

Plays from the edit point. 

[NOTE: The "play through" preview is the one that lets you hear how the edit will sound in the 
Playlist. It also usefully resets the display to the edit point. 


The "up-to" and "from" previews are useful for determining which side of the edit 

unwanted sounds may be. 


The next three preview buttons play only the selected (highlighteg) Clip, including its out-takes 

(the grey bits) : 


Plays up to the edit point. 


Plays through the edit point. 


Plays from the edit point. 


You can cancel a preview while it is playing with a second press of its button 

The loop button will cause the selected preview action to repeat continuously. You can continue 
to make adjustments while the preview is repeating. 

There are also some special function preview buttons: 

II 


Plays the Out-takes - i.e. the grey parts of the clips around the edit point. This allows you to hear 

the sections you are "throwing away" for comparison. 


Play entire track mode - this button can only be pressed when a single clip is in the Trim Editor. 

When pushed in, you wiU hear the whole source track - both coloured and grey areas - when 
playing or previewing in Trim. 

II Preview in context - when pressed, all previews will include the other audio in the source EDL as 
well as the current contents of the Trim Editor. 


When you are happy with the adjustments, WRITE·BACK what you have done, as described below. 
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TOP-AND-TAILING AND DEFINING NEW CLIPS 

When you load only one Clip into the Trim Editor, you can top-and-tail it by adjusting its in and 
out points with the mouse or hardware controller wheel in the usual way. Use the IN and OlJf 
buttons (in the Transport Controls or on the hardware controller) to select which you are 
adjusting. 

To define a totally new Clip, load the Trim Editor with the Track from which the Clip is to 
come. You can do this either by loading the whole T rack from the Clipstore, or by loading a 

~ Play list Entry which is from the required bit of the Track. The DRAW CLIP button turns your 
DRA'ol' CUP 

mouse pointer into a pencil symbol. Drag it along the waveform profile from the new in )oint to 
the new out-point to define a new Clip. Right-clicking will turn this function off. You can make 
fine adjustments by top-and-tailing the new Clip before giving it a new name (see below) ;>nd 
writing it back to the Clipstore, or pasting it into the Playlist. 

r--------------------------------------------------------------------­
NOTE: DRAW CUP is only available when one Clip is in the Trim Editor. 

When you are happy with the adjustments, WRITE-BACK what you have done, as described below. 

ADJUSTING THE HOTSPOT 

The Hotspot of each Clip is shown as a vertical red line which can be moved: 

b\· positioning the mouse over it and, when the pointer changes to a double arr~ ),•~ 	 dragging it to a new position. The small time display will show the time you are setting. 

in the Transport Controls, by selecting HOT and EDL mode and using the scrubwheel. • 
with the hardware controller, by selecting HOT and EDL mode and using the wheel. •~ 

• in the Clip Details window (see below). 


When you are happy with the adjustment, WRITE-BACK what you have done, as described below. 


RENAMING 	CLIPS 

Double-click on the Clip name. A box will appear in which you can edit the name before writing 
the Clip(s) back. 

FADES AND CROSSFADES 


The lengths of fades of Clips in the Trim Editor can be adjusted 


• 	 by setting numerical values for them in the Clip Details window (see below). 

• 	 graphically, with the mouse on the profile display as follows: 

At each in/ out point there is actually a fade-in or fade-out (however short) and these fades 

have a start and an end. 


Move the mouse pointer over the fade. It will change to a double arro~ 


You can then move the start of a fade to the left and the end of a fade to the right, so 

lengthening the fade and setting it to where you want over the audio. 

• 	 with the hardware controller, by pressing CROSSFADE to move the inner point (i.e. the end of 
a fade-IN or the start of a fade-OlJf) and SHiFf + CROSSFADE to move the outer point (the 
start of a fade-IN or the end of a fade-OlJf). 
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Fades are shown in lighter green on the profile and turn dark blue when selected to move_ The 
type of fade curve can be altered in the Clip Details window for the Entry. 

Once the fade-out of one Clip overlaps with the fade-in of the next Clip, you have created a 
cross fade. There are two useful tools available when there are two Clips in the Trim Editor: 

• ALIGN FADES aligns the start of the later Clip's fade-in with the start of the earlier Clip's fade-out. 

.illGN MIRROR MIRROR FADES alters the length of the later Clip's fade-in to match the earlier Clip's fade-out. 
F.WES FADES 

The shape of the curve is not copied. 


Using both buttons will result in a matched crossfade between the two Clips. 


NOTE: Hold down the Shift key when pressing these buttons to align or mirror the other way 
round - i.e. altering the earlier Clip to match the later one. 

With two Clips in the window, selecting either fade automatically selects them both. Then the 
whole cross fade between two Clips can be moved easily in relation to the audio. 

When you are happy with the adjustments, WRITE-BACK what you have done, as described below. 

MAKING A LOOPABLE EDIT 


The LOOPABLE EDIT button is only available if there are two Clips in the Trim Editor. 


LOOPAlIll. EDIT 	 This function copies the fade at the start of the right hand dip to the start of the left hand dip, 

and similarly the fade at the end of the left hand clip is copied to the end of the right hand clip. 


The normal situation for using this is when you want to make a single clip loop correctly. The 

procedure is as follows: 

1. 	 Roughly razor the clip to suit. 

2. 	 Make another copy of the clip in the EDL and Remove Gap to butt the two copies together. 

3. 	 Open the Trim Editor and load the two clips. 

4. 	 Perfom the edit. 

5. 	 Pressing MAKE A LOOPABLE EDIT will copy the fade attributes for the edit that works to the 
outside points of the two clips. Now both clips are identical. 

6. 	 Write back to the EDL. 

7. 	 Make multiple copies of the clip to suit. 

This would normally be with one clip duplicated, but it will work with different pieces of audio, 
but only if they have the same timestamps. 

CLIP DETAILS 

The Clip Details window for the selected Clip can be opened by pressing CLIP DETAILS, or by 

~ double-clicking on the Clip (an option in the Trim Editor section of the Setup window). 

CUP DITAILS 

The Entry times in the window are fully interactive with adjustments to the profile in the Trim 
Editor. Other details can be adjusted here before the Clip is written back. 

The Clip Details window is described in full in Chapter 4, Arranging an EDL. 
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WRITING BACK THE FINISHED EDIT 

The Trim Editor is a temporary area for adjusting edits. Once done, the edit (and any other 
changes you have made) needs to be "written·backft to a Playlist or Clipstore which will then be 
updated . 

If you have loaded the Trim Editor from a Playlist, press WRITE BACK TO SOURCE EDL to update Ell that Playlist. (It's a sauce bottle!) 
\llUTE BACK TO 
SOURCEEDl 

If you loaded the Trim Editor: 

~ 1. From the Clipstore with a Clip that you now want to place in an EDL according to its 
COPY TO ACTIVE Track time (recorded "time stampft), or
EDl 

2. From a different EDL to the one you want to write to, 

Make the Playlist window containing the target EDL active, then press COpy TO ACTIVE EDl. 

NOTE: Before you write back, as the EDL has not yet been updated, you can play it to hear 
how the edit was before your Trim Editor adjustment. 

If you want to save the edited version of a single Clip in the Clipstore. press WRITE TO 

CLIPSTORE. You may want to rename the new version first. 
WRITE TO 
CUPSTORE 

If you want to insert the edited version{s) of Clip{s) into a Playlist at an EDL time of your~ 
\I"RJTE TO PASTE choosing, press WRlTE TO PASTE BUFFER and then paste them into the Playlist. 
BUfFER 

NOTE: 	 There is a Setup option (View menu; Setup window; Trim) to allow 'Auto close trim 
window when writing back to source. This is often more convenient when you are 
using hotkeys or the Hardware controller, and helps you to avoid opening multiple 
Trim windows by mistake. 

RE-LOADING 

When you have finished working on one edit. and have written it back, you may want to keep 
the Trim Editor open to do another one. 

NOTE: 	 The following buttons on the Trim Editor's own tool bar re-Ioad it with different 
Entries or Clips, whereas using the Trim Editor buttons in the Playlist and Clipstore 
again will open a second Trim Editor. 

LOAD FROM EDL re-loads the Trim Editor with the Entries selected (highlighted in red) in the 
Playlist or Text EDL. 

LOAD FROM EDl 

LOAD FROM CLIPSTORE re-loads the Trim Editor with the Clip selected in the Clipstore. 
LOAD FROM 
rt .TP<TORF 

LOAD LOAD PREVIOUS EDIT / NEXT EDIT re-load the Trim Editor from the same EDL, moving one m Entry backwards or forwards. Using these buttons you can easily move along the edits in the 
PREY / NEXT EDIT EDL to check or adjust them. 
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LOAD FROM PASTE BUFFER re-loads the Trim Editor with the contents of the paste buffer. This IIi 
may have been cut or copied from any EDLIPlaylist or Clipstore.

LOAD FROM 
PASlC: BUFFER 

MAKING A NEW EDIT 

Pressing the Trim Editor's own RAZOR-CUT button cuts all the Entries/Clips in the window at ~ the current time position {and can be done on the fly while playing back}. This has the same 
TRIM 
RAZOR-Ctrr 	 effect as having razor-cut them in the Playlist and loaded all the edits so formed into the Trim 

Editor. You will need to have written back your previous edit adjustment first, unless you are ..... 

WRITING BACK AUTOMATICALLY 

In the Trim Editor section of the Setup window, you can select the option to write back the 
contents of the Trim Editor to the current Playlist automaticaUy each time it is loaded ... 

• 	 with the LOAD NEXT/PREVIOUS EDIT buttons or 

• 	 by using the RAZOR-CUT button. 

This makes it quick and easy to work through an EDL while staying within the Trim Editor, if 
you wish. 

NOTE: 	 Loading with any of the other buttons does not write the current edit back 
automatically. This is so that if you make a mess of an edit in the Trim Editor, you can 
reload it from the Playlist and try again. 

MAINTAINING SYNC. 

The LOCK CLIPS button prevents you from selecting and moving the body of Clips or Entries 
while they are in the Trim Editor, and therefore safeguards accidental loss of sync. to picture or

LOCIlCUPS 
sync. with music when writing back. If the global LOCK ENTRIES button on the Playlist toolbar is 
down, this button in the Trim Editor will be down when it is loaded from that Playlist. You can 
then release the button to override the lock status for this edit only. 

SUP 	 The SUP LEIT and SUP RIGHT buttons only apply with one or with two Entries loaded. 

~ 	 The logic these buttons follow can be set with a Setup option. 
IHT I RIGHT. 

Under the Yiew menu, select ~etup Window, then click on Trim on the left side of the setup 
window. 

TRIM SUPS AUTO-FOLLOW EDL SUP SETITNGS 

• 	 When this is ticked, the positions of these buttons on opening the Trim Editor will reflect the 
SUP setting of the Playlist. They can then be changed to override the setting for this edit only. 
Sup LEFT will cause EDL Entries before the earlier one in the Trim Editor to move with it 
when writing back. Sup RIGHT will do the same for Entries after the later one. With this 
setting, you only have one global Slip setting to consider for Playlist movements, Playlist 
editing and Trim editing. 

• 	 When this is not ticked, the positions of these buttons are completely independent from the 
Sup settings in the Playlist. The settings of these buttons are held over for future Trim 
sessions. You might want to use this setting if, for instance, you do most of your editing inside 
the Trim Editor and only perform coarser manipulation in the Playlist window. This sening 
is perhaps more familiar to SADiE v2 users. 
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Note: 	 If you are working with sync. material you will want to keep Playlist and Trim Slips 
OFF, so that slipping one Entry doesn't alter the sync. of others. 
If you are working with sound-only material 0ike editing for radio) you will need to 
keep Slips ON to avoid gaps opening up in your material as you edit. 
Remember that Slip is disabled when writing back from a Trim Editor containing 
more than two Entries; if you need to slip, use Play list Editing instead. 

OTHER TRIM EDITOR TOOLS 

lID) 
SNAPSHOTS 

The four SNAPSHOT buttons allow you to store and recall four different arrangements of the 
Clips in the Trim Editor, so you can compare different attempts at an edit. Click once to take a 
snapshot, and the button will turn blue to show it has a snap stored. After making adjustments, 
click on the button again to return the Trim Editor to the stored snap. The button of the 
displayed snap will tum red. To overwrite a button with a new snap, hold Crrl. while clicking on 
It . 

NOTE: 	 Even if you don't use the snapshots, you can write back an edit to the EDL, try to 
improve it and write back again. Then the Playlist undo and redo buttons can be used 
to move through the different attempts . Any of these can then be reloaded into the 
Trim Editor. 

USER 

~ IJ)
ZOOM RETURN 

[I) 
EMPTY11UM 
EDITOR 

The USER ZOOM button turns your mouse pointer into a magnifying glass which you can use to 
draw a box around the part of the profile you want to zoom-in on. The degree of magnification 
will be determined by the size of the box you draw. The RETURN button takes you back to your 
previous magnification level. 

Empties the Trim Editor of all Clips/Entries. 

The VlEWING ORDER button is available with more than two Clips in the window. 

When it is UP, the left channels of all the stereo Clips in the Trim Editor are displayed above all 
the right channels. 

When it is DOWN, both channels of each Clip are drawn together. 
VlFWTNr. OR nFR 

NOTE: 	 For most editing, it is generally sufficient and clearer to just view one channel of each 
Clip. This is done with the button up, setting the window's size and magnification to 

show just the left (or right) channels of all the Clips in it. Have the button down when 
you want to see both channels of each Clip. 

5:19 



Chapter 5· Editing SADiE User Man_III]. 7 

REGION EDITING 

Region Editing adds another set of editing tools to your palette. The basic principle of Region 
Editing is that you firstly define a 'region' of the play list, and next perform another action on that 
region - you may want to delete it, or move it or copy it elsewhere for instance. The region is 
defined between the standard Left and Right Locators, and usually across all streams enabling you 
to more easily edit across all streams of a multi-track. 

You could use the region editing tools for removing a section of a multi-track, or for moving it or 
copying it elsewhere. Another possible use for region editing is for simple speech editing tasks ­
where you otherwise may use razor cutting and playlist editing, defining a region and deleting it 
can be very quick, particularly for repetitive tasksm. Region editing functions are available on 
hotkeys, and this can speed up operation significantly. 

ENABLING REGION EDITING 


To access Region Editing first you must be able to see the Region Editing Toolbar. 


If this is hidden, then this can be revealed in the usual way: 

From the View menu, select Toolbars, then Playlist, then click on region editing. The above 
toolbar will appear, and in the usual way you can dock it to an edge of the Play list or allow it 
float, by dragging it around the desktop, or by right mouse clicking and selecting, for instance 
'dock to top'. 
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To enable Region Editing, press the Left most button (or top-most if the toolbar is docked 

~ 
REGION 
EDmNG 
ENABLE. 

vertically) Region Editing Enable - region editing is turned on when the button is pressed in . 

DEFINING THE REGION 

Deftning the Region with the mouse 

The mouse cursor will change to a pencil 
new region. 

, tool which signifies that you are ready to define a 

To define a Region - when your mouse is the pencil' tool, click at the position in the Playlist 
where you want the region to start - it doesn't matter which stream you are over when you click­
anywhere between the time bar and the bottom of the Playlist will do - then whilst holding the 
mouse button down, drag the region rightwards, and when you reach the point at which you 
want the region to end - let go of the mouse button. The region will be coloured RED, and you'll 
notice the Left and Right locators are positioned at the start and end of the region respectively. 

To help you mark the region, you will notice that the two time displays at the bottom left of the 
playlist will be displaying current cursor position and the duration of the region respectively. 

diID 

You can also start at the end of the region and drag Jeftwards towards the start - whichever 
method is most convenient. 

Defming the Region with Hotkeys and Hardware controller 

All the region editing functions can have Hotkeys assigned. Notice that the Preview buttons are 
linked to the Transport - Edit controls; preview buttons, and similarly the Select Region Start & 
End buttons are the same as the In and Out buttons. 

Having enabled region editing, you can set the region start by setting the Left locator, and the 
region end with the Right locator, in the usual way. 

A most important factor is that the region doesn't have to start at an entry's start point - it can 
begin anywhere in the playlist and can contain any number of entries. Under normal 
circumstances in SADiE, we are manipulating EDL entries or clips, but that's not the case at the 
moment in region editing. 

To see the sort of thing we can do next - just press the Delete key on the keyboard. Assuming 
you have autoplace and slip off, you will see the region disappear, and razor cuts are made to tidy 
up the ends of the entries left behind. 

Try a few more things - undo to put the region back, now set SLIP to be RIGHT (See Chapter 4 ­
A rranging an EDL -AutopltUe and Slip). Now press Delete again. This time the region disappears, 
but the hole is filled in by slipping everything to the right, leftwards. 

Defille another region - you will still have the pencil cursor. This time press the cm button 
using the mouse. The same thing as before will happen - the region disappears and entries move 

leftwards to fill the hole. Now go to the end of the playlist and press PASTE and the mouse 
cursor changes to the usual paste icon - clicking in the Pialwill now drop a copy of the whole 

region into the Play list. Of course you can use the COpy button to leave the original region 
unchanged (and un-razored )and allow you to paste a copy of the region elsewhere in the list. 
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IlfSET 
REGIO N 
MARKERS 

~ 

ZCX>M IN 
ON REGION 

REGION 
STARTIEND 

SELECT REGION 
START lEND 
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Note: 	 You may want some streams of the EDL to be unaffected by any region editing. 
Region editing only works on streams that are enabled Qighter grey) so to make the 

region ignore a stream press its stream name button so that it's in the 'out' 
position. (See Chapter 4 . A rranging an EDL . Enabling/Disabling Streams). With region 
editing the 'CTRL-enable' function (clicking on a stream name button while pressing 
the CTRL key on the keyboard) can be a quicker method of enabling the correct 
stream· this function is a 'reverse' function and disables ALL streams apart from the 
one you've CTRL-clic\{ed on. 

ADJUSTING THE REGION 


There are many ways of adjusting the region's bounds once you have defined it. 


1. 	 Clicking with the mouse outside the region, gives you the pencil tcx>l again, and will start 
making a new region. You could use this method to redraw the region from scratch again. 

2. 	 Pressing the reset region markers button, will remove the region completely, and so 
you can redraw it from scratch again. 

3. 	 When the mouse is close to the start or end of the region, the mouse cursor will change to a 

left pointing or a right pointing arrow shaped cursor. Clicking and dragging this 
point allows you to adjust either the region start or end. 

4. 	 The region start and end are the Left and Right Locators, so changing these, in the Transport 
Controls / L&R pane in the usual way will adjust the length of the region. 

5. You can scrub the start and end of the region· either usin controls, Edit pane 

jog wheel, or using the Hardware controller wheel. The buttons determine 
which end of the region is being scrubbed. 

The Region Editing tool bar has three tools which help you zoom in on the relevant part of the 
region· the whole region or its start or end.. quickly. 

Zoom in on region· changes the zoom so that you can see the entire region in the playlist 

Zoom to region start & Zoom to region end set the zoom to horizontal zoom 15 so you can 
see some detail on the entries at the start and end of the region. 

In a similar way, the Select Region start and Select Region end buttons move the focus to the 
start and end of the region without changing zoom. Note that the Hotkeys to operate these 
buttons are the same as for Transport· EditControls; Go to In and Go to Out respectively. 
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PREVIEW 	TOOLS 

operate around the selected point ot the region - start or end as set by the I~ and r~ markers, 
and as you would expect from the icons, they play up to the point, through the point , the whole 
region, and from the point respectively 

Play Edit without Region is a special preview tool, which performs a dummy edit, then 
pu.y EDIT previews it. On pressing this button, the play list will re-draw itself, as if the region had been 
wrrnOlTT 
REGION 	 deleted, then preview from before the Left marker to after the Right marker. Having previewed, 

the playlist will undo this dummy edit, and draw itself back to where it was beforehand. You 
would normally use this tool with SLIP on, otherwise this preview will play silence for the 
duration of the region. 

OTHER REGION EDITING TOOLS 

Razor Cut Region puts a razor cut at either end of the region, and turns off region editing. !!l 
RAZORClTT 
REGION 

Region Insert Mode and Region Overwrite mode determine what happens when you paste a 
region into the play list. First you have to cut or copy a region to the paste buffer. 

In Insert mode, when you paste a region into the play list, a razor cut is made across the playlist a 
the paste position you selected, then the region is pasted at that position. Any entries underneath 
the region remain as they were. BUT - if you are in Slip (which is really how this mode isREGION 

INSERT MODE supposed to be used) then - for instance with Slip Right enabled - the entries to the right of the 
paste position are slipped left by the length of the region - in other words, the playlist is razored 
in half and slipped to make room for the region. 

In Overwrite mode, when you paste a region into the play list, entries underneath the region are 
REGION razored and deleted to fit the region in. This mode is not supposed to be used with Slip. 
OVERWlUTE 
MODE 	 Note that Insert and Overwrite have no effect if Region Editing is turned off - the normal rules 

for pasting clips into the playlist apply. 

Show sample values is a tool that is not specific to Region editing (in fact you have to turn 
Region editing off to use it). 

SHOW SAMPLE 
VALUES 
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When this button is pushed, AND the playlist is displaying at one of the highest three horizontal 
zoom levels, then the cursor changes to a 'magnifying glass' and passing tbis over the waveform 
displays the time of that sample and its sample value as a 24bit number i.e. a decimal number 
between -8388608 and + 8388607. Holding the SHIFT key down while using this tool will show 
the sample value as a hexadecimal number 

Cedar De-Click This is an optional Plug-in that uses region editing for it's manual mode of 
operation. (See the Plug-Ins section a/Chapter 6 -Mixing and Processing/or more details) 
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16 . MIXING AND PROCESSING 


THE MIXER 


DESCRIPTION 

The Mixer window in SADiETlI routes audio signals between the currently active Playlist and the 
outside world. On each Stream you can control levels, pan positions and auxiliary sends as well as 
process the audio - for example by applying EQ or compression. 

You can: 1. Set and leave these controls when playing back an EDL. 

2. Adjust them in real time during playback. 

3. Record the adjustments you make and have them reproduced using the 
Automation described later in this chapter. 

If you have closed the Mixer for your current Playlist, you can display it again with the SHOW 

MIXER button on the Playlist toolbar. &I 

SHOW 

MIXER 


NOTE: 	 In addition to using the faders of the Mixer to control the playback levels of Streams, 
you can set the level of individual EDL Entries. See "Clip Details window" in Chapter 
4, Arranging an EDL. 

The Mixer is made up of channel strips which each have an input and an output. The simplest 
Mixer strip consists of a fader, a pan control and an input selection button whose label indicates 
what that strip is controlling. Other displays and buttons may be added to the strips. 

This is the Mixer's configuration tool bar. If it is not currently displayed on your Mixer, you can 
bring it back with View I Toolbars on SADiE's menu bar. 

The first six buttons add or remove displays for every strip:­

Fader grouping buttons. See below. 

Inline process buttons. Each button represents a blank section into which you can insert processes 
like EQ and dynamics for each strip (see Processing, below). To reveal more buttons, enlarge the 
Mixer window vertically. 

Strip output selection buttons(see Routing, below). 

Phase reverse controls (see below) 

Peak level / fader level displays. 

Displays 'long faders'. In this view, all faders are twice as high as usual and thus have a twice the 
resolution - moving the fader with the mouse will give you O.20db steps instead of 0.40db as in the 
normal view. 
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The last five buttons turn on or off other Mixer displays:­

Turns on Mixer automation and displa~'s the automation toolbar (see Automation) . 

Displays the Process Palette toolbar from which you choose which processes to insert into a 
Mixer strip (see Processing) and lets you add new strips to the Mixer (see Routing). 

Displays the Routing tool bar. 

Brings up the Process Window, which acts as an "outboard rack" for other processes. See 
Processing. 

Shows the Metering Window (see this chapter, page 49) 

So Mixer strip number 2, with all its display sections, might look like this: 

~ Fader grouping button. See Grouping Fadet-$. 

lliiill~ Inline Process button. Empty at present (see Proce55inq). 

~ Input selection button. This strip is rontrolling the audio of Stream 2. 

~ Output selection button . This strip is routed to intemal bus 1&2 (see Routing). 

~ Phase F:everse Controls , and left/right channel swap for stereo strips. 

~ The peak level r:i audio through the strip. Figures above full digital coding level shown in red . 


Double-click to reset. Changes to show fader level in blue figlJ"es when fader is being moved. 
Pan Pot . Click and drag to adjust . A small fader will pop up to indicate the setting. 
Double-clicking the pan pot allows you to adjust the pop-up fader di-ectty. 

POP-UP LillER 

Fader - Drag it! 

PPM - Peak Programme level Meter display. 
Nudge Drag Certre 

Nudge the fader in 0.1 dB steps. 

Resets the faderto OdB gain (normal stop). Fader is disabled while button is down. 

Solos this diannel strip 

Mutes this channel strip . 

Each hardware controller fader panel has eight faders which control the Mixer strips indicated by 
the LEDs above them. 

ASSIGN + ~ and ~ select the next and previous bank of eight Mixer strips for control by the eight 
faders . 

SHIFf + a fader's SELECT button allows you to reassign a single fader to a different Mixer strip. 
Move the fader and the LED changes to indicate the new strip. When you let go of the fader, it is 
reassigned. Use this to set the function for the single fader on the edit panel- perhaps to control a 
stereo master strip. 

A MlTfE button is provided for each strip. 

SHIFf + MlTfE solos the strip. 

ASSIGN + l' changes all the faders from controlling level to controlling the Pan Pots. The LED at 
the top len will display "Pn" 
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ASSIGN + ..j.. changes back to level control. LED shows "Fd". 

NOTE: As you will see from the following sections, the Mixer is very flexible. You can save 
any Mixer configuration for later recall. See Chapter 7, File Management. 

GROUPING FADERS 

10,- ..j To !.ink (or "gang") on-screen faders so that they move as a group, press the FADER GROUPING 
FADE.R button on one of the strips. It will flash . You can then press the grouping buttons of other faders 
GROUPING 

you want linked with it. They will light up indicating that they are part of the group. Finally 
release the flashing button. Moving any of the faders in the group will now move them all and 
their buttons will light to indicate the link. 

Faders can be set at different levels before being linked and the offset between them is calculated 
so that they reach the bottom of their travel (fade out) together. This maintains relative stereo 
positions. Pressing any of the linked group's fader reset buttons will lose the relative offsets. 

To change the level of only one fader within a group, move it whilst holding down the keyboard 
Shift key. 

To remove a fader from a group, select one of the others in the group, then release the button of 
the fader you want to remove. Finally release the flashing button. 

NOTES: 	You can make as many groups as you like, but each fader can only be in one group. 

M ute, solo and fader reset buttons are also linked. 

Hardware controller faders are not affected by grouping when moved physically; the 
feature is designed to make it possible to move more than one fader with a mouse. The 
best way of grouping hardware faders is with your fingers! 

PHASE REVERSE CONTROLS 

The Phase Reverse Controls button on the mixer configuration tool bar, enables another set of ~ buttons for each strip in the mixer. 
PHASE 
REVf.RSE 
COl'ITROLS 
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These buttons allow you (0 reverse the phase of the audio through the strip, and in the case of 
stereo strips, the button in the middle will swap the left and right sides of the stereo signal 
through the strip. 

If the button is pushed in and red, then the function is ON. Grey buttons cannot be selected. 

Because these are potentially dangerous bunons if selected by mistake, there is an option in Setup, 
on the 'Miser Strip Display' sub·section of the 'Mixer' page to ENABLE PHASE CONTROLS. 
When this is not ticked, the phase controls cannot be displayed. 
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MIXER PROCESSING 

INSERTING PROCESSING IN MIXER STRIPS 

To allocate processes to a Mixer strip, and therefore to process the audio going through it, display 
the Process Palette toolbar. 

This shows you all the available processes you can insert inline on individual Mixer strips:­

Simply select a process on this palette, drag it across and drop it onto an inline process 

~ Expander 


~Gate 


• 

I~ 

~ 

~;;II~ Auxiliary send 
~ High-Pass EQ (Low rut) 

~ High-shelf EQ 

~ Band-pass EQ (bell) 


'II~I~ Low-shelf~ Low-pass EQEQ (High cut) 

The last three items are used to drag across and 
insert new Mixer- strips. These can be mono without pan, 
mono with pan, or stereo strips. 

Simply select a process on this palette, drag it across and drop it onto an inline process button on 
the Mixer strip. Repeat to build up the processing you want for that strip. The audio path 
through the strip is from top to bottom so the signal encounters processes inserted at the top first. 

So, if you wanted to apply compression, followed by two bands of EQ, and then take an auxiliary 
send from the audio on Stream 4 of your Playlist, you would insert those processes into the Mixer 
strip controlling Stream 4. It would then look like this:­

~~~;t~ 

~ lnline Process: Compressor 

lnline Process: High-pass filter (Low cut) 

~ lnline Process: Band-pass (bell) 

~ lnline Process: Auxiliary send 

~ Processing is being applied to Stream 4. 
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To remove an inline process from a strip, right-click on its button. 

ADJUSTING MIXER PROCESSING 

Click on any process button in the strip. This will bring up a scrolling display of the controls for 
all processes in the strip. 

The controls on the screen appear as familiar rotary knobs. Click and drag the mouse up or down 
Centre to adjust them. A small fader will pop up temporarily to indicate the adjustment and the 

numerical display on the right will indicate the exact setting value. Double<licking keeps the pop­
up fader on view and allows you to adjust it more finely (click on a grey bit of the window to lose 

Drag 	 it again). You can also adjust the setting by entering a value directly into the numerical display in 
any of the following ways:­

1. 	 Click, hold and drag the mouse up or down over the digits (on either side of the decimal 
point, where there is one). Their value will increase or decrease - the more you move the 
mouse, the faster they change. Release to set the new value. 

2. Use the up/down arrows beside the display to nudge its value by whole units. Hold Ctr! to 
Nudge nudge by decimal points. 

3. 	 Double-click on the time display itself and directly type in a new value ending with the 
keyboard Return/Enter key. 

At the top of each section are three buttons: 

A bypass button for that section. 

A name button that lets you change the section to another process. 


Bypass Process Disable A button to disable the automation for that section Name automation 

There is a bypass for all processing at the bottom of the whde display. There 
is a Setup option, in the 'Mixer Strip Display' sub-section of the 'Mixer' page, 
that allows you to alter the function of this bypass button so that only EQ's 
are bypassed, thus leaving dynamics, Aux sends and M&S unaffected. 

Press SELECT above the fader of the strip you want to adjust. The number of the strip will appear 
in the LED above the Rotary Shaft Encoders (Knobs to you and me). 

l' and -l- then move through the processes on that strip, selecting each in turn for adjustment and 
outlining its display. 

EQ and CMP select the EQ and Compressor sections directly. 

The knobs A to f now control the on-screen knobs in the selected process, from the top 
downwards. 

ASSIGN + MUfE above the relevant fader bypasses all processing. 
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The DYNAMICS processing has been designed to sound and act as much like a traditional 
analogue studio unit as possible, with a slightly "soft knee" to produce a natural effect. 

The COMPRESSOR reduces dynamic range by reducing its gain in proportion to the 
level of the signal - the higher the level, the more gain reduction. 

ATTACK sets the delay after a transient (peak) before the compressor starts 
reducing the level. 

DECAY The time after the transient before level is returned to normal. 

THRESHOLD The level above which compression is triggered. 

RATIO The amount of gain reduction then applied. 

MAKEUP GAIN Boosts output level to compensate for overall gain reduction Be 
careful as it will go very loud.! 

The EXPANDER increases the dynamic range by reducing its gain in inverse 
proportion to the level of the signal- the lower the level, the more reduction. 

ATTENUATION The delay between the signal dropping below the THRESHOLD 
and gain being reduced. 

RESTORE The delay between the signal exceeding the threshold and gain 
returning to normal . 

INPUT RANGE The input level range between the expander starting to operate 
and reaching its maximum gain reduction. 

MAX ATTEN. 	 The maximum gain reduction . 

The GATE reduces the output by a fixed amount when it falls below a given 
THRESHOLD. 

ATTACK The delay between the signal dropping below the threshold and 
the gate "shutting" and reducing the level. 

RELEASE The minimum delay before the gate will reopen. 

MAXATTEN. The amount of gain reduction when the gate is operating. 

BYPASS 	 Bypasses all processing on this Mixer strip (ASSIGN + MUTE on 
hardware controllers). 
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SADiE's EQUALISER is divided into five sections with different slope characteristics. The 
frequency controls of all sections cover the full audio bandwidth of 20Hz to 20kHz. Here is a 
control strip with all five sections: 

A low-pass filter (steep high frequency cut) with a slope of 12dB/octave. 

and 

A high-pass filter (steep low frequency cut) with a slope of 12dB/octave. 


The frequency controls set the -3dB point. 


High-shelf EQ (high frequency cut and boost) -60dB to + 20dB. 

and 

Low-shelf EQ 00w frequency cut and boost) -60dB to + 20dB. 


The frequency controls set the -3dB point. 


Band-pass EQ (bell-shaped boost and cut) -60dB to + 20dB. 


The frequency control sets the centre frequency. The Q control sets the bandwidth. 

Higher Q = narrower bell. 


The cut and boost controls operate symmetrically apart from at the extremes, where 

the -60dB cut is provided to allow "notch" filtering with high Q settings. 


Bypass button for all processing on the strip (ASSIGN + MtJfE on hardware 

controllers). 


Full frequency plots of the equaliser are provided in Appendix D. 


The AUXILIARY SEND level knob can be adjusted on the Mixer strip as wen as on 

the full control display. 


The routing button allows you to route the signal either to an internal bus or to the 

outputs - SADiE XS/XACT users will probably use outputs 3&4 (see Routing). 


Note that the bypass button for this section acts as Aux. Send on/off. 


SAVING SETTINGS 

To save the layout of the Mixer, save the Mixer setup file. This can be done with the File I Save 
command when the Mixer is the active window, or from the Project window, as described in 
Chapter 7, File Management. 

AUXIllAJlY SEND 

NOTE: Processing control settings are saved as part of the Mixer automation, described in the 
section later in this chapter. 
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You can also save Process settings and Mixer strip settings for a single strip. Right mouse click on 
the process section of a strip and this menu drops down: 

Save process settings saves the pot settings for a single process, which can be reloaded into the 
same process or one on another strip. 

Save mixer strip settings saves the whole mixer, all processes and their pot and fader settings, 
which can be reloaded onto another strip. 

TEMPLATES 

If you wish to save your customised Playlist to be used again, save it as a TEMPLATE using rhe 
FILE menu option. See ChapleT 9· Pla/ist and Mxer Templates. 
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PROCESSING STEREO 

To apply processing equally to the two channels of stereo material, it needs to be routed through 
a stereo Mixer strip. You can merge two mono Mixer strips into a stereo one by right-clicking 
over the fader:­

Then insert the required processing In the stereo strip. 

MS DECODER 

The MS DECODER allows you to simply convert audio recorded as Mid and Side into its Left 
MSDECODER and Right components. 

The knob lets you adjust the stereo width, and there is a push button for SWAP INPUTS in case 
the Mid signal is on the right side of the stereo recording. As with AUX SEND the knob can be 
adjusted on the mixer strip without opening the whole process strip. This process can only be 
added to a Stereo strip. 
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ROUTING 

DESCRIPTION 

The default routing arrangement in SADiE will cover normal recording, editing and mixing tasks, 
but the system is very flexible and can provide many more facilities. 

Creating other routing arrangements is like making connections between the different items of 
equipment in a studio. 

Connections are made in two ways: 

1. 	 By selecting from a list of possibilities for the inputs and outputs of Mixer strips and for the 
recording source for Play list Streams. 

2. By using the Routing tootbar described below. 

Note that Routing is described in a step-by-step manner in a Tutorial at the end 0/this chapter. 

The following diagram shows all the possible connections that can be made between the physical 
inputs, the Playlist, the Mixer strips, internals busses and the physical outputs. The Mixer's 
internal busses can be thought of as potential subgroups waiting to be used and will allow you to 
route signals through extra Mixer strips and thus to different parts of the system. 

PHYSICAL 

:::A~
BUSSESL~ 

PLAYLIST 
tHERNALSTREAMS ~ 

PHYSICAL -;;7 ~BUSSESOUTPUTS 

PHYSICAL?OTt-ffi INPUTS 

STREAMS 
 ~PHYSICAL 

OUTPUTS 
INTERNAL 
BUSSES 

l' 
PLAYUST STREAM MIXER STRIP MIXER STRIP 
RECORD SOURCE INPUT OUTPUT 
selection buttOl 01 selection buttm 01 seledion blitOl 01 

earn stream Mi:xa- strip '-4i:xa- strip 

l' 	 l' 

~ Clicking on the selection buttons gives you a pop-up list to select from. 

The common default routing arrangement in SADiE is to have Play list Streams recording directly 
from the physical inputs and each Stream playing through a Mixer strip. These are then routed to 
two more strips, acting as master faders (via internal busses 1 &2), and then to the required 
outputs. In other words:­

INPUTS -7 PLAYLiST STREAMS' RECORD SOURCE (selected on the Stream record source buttons), 
and 

PLAYLIST STREAMS -7 MIXER STRIPS -7 INTERNAL BUSSES 1&2 -7 "MASTER FADER" STRIPS -7 
OUTPUTS 

For 8 streams, this is done as follows: 

MIXER STRIPS STRIP INPUT STRIP OUTPUT 

1-8 	 PLA YLiST STREAMS 1-8 BUSSES 1&2 
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9 BUS 1 PHYSICAL OUTPUT 1 
10 BUS 2 PHYSICAL OUTPUT 2 

If you prefer, you can have a single stereo strip for the master fader instead of two mono strips. 
Merge them together by right-clicking over the left-hand one's fader. Repeat to separate again. 

Other arrangements can be achieved by using more internal busses. Selecting "New Bus" on any 
of the routing selection buttons creates a new, automatically numbered bus that can then be 
picked up by all other selection buttons. 

The routing toolbar is displayed by pressing the button on the Mixer configuration tool bar. 

This displays the busses you are using. Double click to open up the folders for 
each type of bus. Double clicking on stereo busses will reveal two mono busses. 
Double-click to close again. 

You can make routing connections from here by selecting a bus, hitting" load 
bus to cursor" (or by simply dragging with the mouse) and then "dropping" the 
other end of your imaginary patch cord on: a Mixer strip input or output 
button; a Process Window unit's input or OUtput button; or a Stream record 
source button. Doing this with "New Bus" will create an automatically 
numbered new bus. 

Naturally, you can only connect stereo busses to stereo strips/Streams, and 
mono busses to mono strips/Streams . 

.. .etc want more strips in your Mixer to accommodate the new busses. To add a new 
strip, drag across one of the following symbols from the Process Palette and drop it where you 
want to insert it. 

NEW FADER 
STRIPS 

Mono fader strip without pan pot. Output will be mono. 
Mono fader strip with pan pot. Output will be stereo. 
Stereo fader strip with balance (offset) control. Output will be stereo. 

To delete a whole strip, right-click near the fader. This also lets you change the fader's appearance. 

Here are some suggestions for routing arrangements: 

EQ/DYNAMICS ON RECORDING 

Instead of routing the physical inputs directly to the Play list Streams for recording, you can route 
them via a Mixer strip. This allows you to app'ly EQ or Dynamics processing before the material 
is recorded onto the hard disk. The extra routing required would be: 

INPUT ~ NEW MIXER STRIP ~ NEW INTERNAL BUS ~ PLAYLIST RECORD STREAM 

BOUNCE·DOWN 

To mix together and re-record selected Streams: 

REQUIRED PLAYLIST STREAMS ~ MIXER STRIPS ~ NEW INTERNAL BUS ~ RECORD STREAMS 

To bounce the whole Playlist, or soloed Streams: OUTPUTS ~ RECORD STREAMS 
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SUB·GROUPING STREAMS FOR PROCESSING 

REQUIRED PLAYLIST STREAMS ~ MIXER STRIPS ~ NEW INTERNAL BUS ~ NEW MIXER STRIP (with 
processing) -7 INTERNAL BUSSES 1&2 -7 MASTER FADER STRIPS ~ OUTPUTS 

EFFECTS SENDS AND RETURNS 

MIXER STRIP AUX. SENDS -7 SPARE OUTPUT ~ EXTERNAL DEVICE -7 INPUT ~ NEW MIXER STRIP ~ 
MONITORING OUTPUT 

Note that you do not have to have SADiE in record to monitor the effect return when it is 
routed like this. 

Or, if you want to record the effects return: 

MIXER STRIP AUX. SENDS ~ SPARE OUTPUT ~ EXTERNAL DEVICE ~ INPUT -7 NEW MIXER STRIP -7 
NEW INTERNAL BUS ~ RECORD STREAM 

EXAMPLE 


Here's an example of a mixer with Aux Sends set up for routing through outboard equipment : 


This is a relatively minor customisation of a Donnal 8 into 2 mixer. In this example I'm assuming 
you want to patch in an eX1ernal reverb unit. 

To create this : 

1. 	 If the toolbars don't look quite like the picture, press {bmc mix_op.bmp} to show the output 
buttons, {bmc mix_inli.bmp} to show the mixer process slots, {bmc mix-IJall.bmp} to show 
the process pallette toolbar. 

2. 	 From the process pallette, drag and drop {bmc stereo.bmp} a new stereo fader onto the mixer 
(this is strip 1 in the picture) and {bmc auxbutt .bmp} an Aux send onto each of the neX1 two 
strips for streams 1 &2. 

3. 	 Press the output button on the the new stereo fader and select Bus 1&2. 

4. 	 Press the Aux send button (it will say 'Pre' at the moment and have a blue pot on it) on strip 
number 2 (i.e. for stream 1) and the Mixer Strip will pop up, as in the picture (although the 
picture is displaying the rnxier strip for strip 3). Press 'Pre' and it w ill change to 'Post ' and 
press the button marked 'Output l' and change it to 'Output 3'. 
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5. 	 Do the same for the next strip (strip 3 for stream 2), but this time choose 'Output 4'. 

Note: 	 The example I am describing here is assuming a stereo clip on stream 1&2 is to be sent 
to, for instance, an external reverb, and that this reverb has stereo inputs. 
If the reverb has mono in and stereo out, then you should route both of t'he Aux Sends 
to Output 3. There are a number of alternative ways of routing a mixer to achieve this 
or similar but this method should show you the basic idea. 

6. 	 Connect up your reverb unit. Connect SADiE's outputs 3&4 to the inputs of the reverb, and 
connect the outputs of the reverb into SADiE's Input 1&2. Whether you do this as an analog 
or digital connect·ion will depend on your situation. If it's analog then just check your Input 
source selection in Audio Settings. If it's digital then you will have to consider clocking. 

Note on clocking: 
To send audio out from SADiE, through a digital connection to an external unit, and 
then back into SADiE, you will need to consider which unit - SADiE or the external 
unit, is the master for digital audio clocks. 
One method is to assume (or check rather !) that the external unit will lock to its input. 
If SADiE were to do the same, then this would cause a feedback loop - SADiE's locking 
to the reverb, which is locking to SADiE, which is locking to the reverb, which is 
......... . To avoid this you should set SADiE to Internal Clock (go to the VIEW menu; 
Setup Window; double click on 'Audio'; Further Audio Settings; Clock Source - select 
INTERNAL). Set SADiE's input selection to AES (or SPDIF) in Audio settings. 
Alternatively, if the external unit can be a master clock, then you would set SADiE's 
clock source to Genlock and select Input 1&2 as the source. 

Now, when you play SADiE, the Aux sends control how much of the signal on playlist streams 
1&2 are sent to the reverb, and the Fader on strip 1 controls how much reverb is returned into 
SADiE's mix. The last two strips of the mixer still control overall level because the reverb is fed 
back into the master bus (Bus 1&2). 

RE-ORGANISING THE MIXER 

You may find the mixer can get cumbersome and take up too much screen space, or perhaps you 
would like to change the order of your faders so as move related strips closer together. 

It is possible to change the layout of your mixer on the screen, in three different ways: 

1. dragging and dropping faders to move them to another position. 

2. hiding strips that are not in permanent use. 

3. minimising faders to make them smaller 
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CHANGING THE ORDER OF THE MIXER STRIPS 

To move a fader strip to a different position in the mixer, just click in any area of the strip, 
holding the mouse button down, and drop it in a new position. 

The easiest position for picking it up is the ppm meter, as most strips have an active area 
surrounding the fader itself. When you've 'caught' the strip, the cursor will change as in the 
picture, and if you drop it over the left side of another fader, it will dock to the left, or on the 
right side, it will dock right side of that strip. 

If you drag it off the edge of the mixer, the cursor will change to look like a waste bucket: 

and dropping it then will delete the strip. The strip movements, as with any other re­
organisation of the mixer can be 'undone', with the Edit menu undo function. 

HIDING & REVEALING STRIPS 
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Clicking with the right mouse button on any part of the strip will bring up strip menus, which 

have hiding options appropriate to that strip: 


Hide strip 


Reveal hidden Strip n 


and Minimise Strip & Maximise Strip which are described below. 


When a strip or several is/are hidden the line between strips is darker, and strips either side will 

have the Reveal hidden strip right mouse menu option. 


You can reveal strips, one at a time by selecting this menu option. 


You can Reveal all hidden strips by right mouse clicking on the mixer unit divider bar to the 

left of each mixer unit - this is the bar with Audio unit A in writing going vertically up the 

screen. 


Double clicking on the mixer divider bar will hide and reveal the whole mixer unit. 


MINIMISING AND MAXIMISING STRIPS 


Right mouse clicking on a strip will offer either 

Minimise strip as you can see in the picture above, or 

Maximise strip to return the strip to its normal size. 

A minimised strip shows as much information as possible in the limited space (you will notice 
there isn't room for pan-pots. You can minimise and maximise strips individually, or again by 
right mouse clicking on the mixer divider bar. 
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PLUG-INS 


THE PROCESS WINDOW 

This button on the Mixer configuration toolbar brings up a Process Window which is effectively 
an outboard rack of stereo processing units. Each of these is represented by a symbol at the [Op 
left which you drag into the empty rack space. 

For instance, drag into the rack for a stereo reverb unit 

When a process unit is in the rack, stereo internal Busses named after it will be created. These are 
normally connected to its input and output. Yau can then patch signals to and from these busses 
(as described in the Routing section above) to route them through the process. 

Each unit also has input and output selection buttons, normally connected to the busses named 
after the process. However, you can use the buttons to connect signals from SADiE's physical 
inputs, outputs and other busses directly to and from the process without going through the 
Mixer. If you do this, of course, you must remember that the Mixer busses named after the 
process are no longer connected to it! 

To remove a process unit from the rack, right-click in a blank, grey area of the unit. 

A number of processes are available. Some are provided free of charge, but other third-party plug­
ins can be purchased. Contact your dealer for availability and pricing. 

PLUG-INS 

STEREO WIDTH 


has a single width control 


STF:REO 
WlDTIi 

REVERB 

has buttons for room size plus controllable Predelay, Absorption, Reverb time, Brightness and 
Mix (of input signal and 'wet' processed signal) 
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DITHER 

offers three different types of dither. 
I~~i 
DfllU.R 

To enable any of these, drag the appropriate icon onto the '19 inch rack' and patch it into the 
mixer using the busses. 

There are of course a number of ways to connect up these effects. For instance with the reverb 
you may want to set up AUX SENDs on the mixer strips, routed to bus ReverbIn, and then drag 
a new stereo strip to route the ReverbOut bus back to the main bus. In this case you would 
probably need the reverb MIX control set to 100%. Whereas it's perhaps more appropriate to 
apply Dither 'in-line' between the main bus and the output. The choice is yours! 

Note that these three plug-ins are stereo processes. The settings of each of these can be saved and 
re-called and a later date, using the 'disc' icons. 

DEMONSTRATION PLUG-INS 

Some plug-ins, which would normally be cost options, are available for limited-period use with 
the standard software release. This allows you to try them out if you are considering purchasing 
them. 

When you first drag these plug-ins into the Process Window, you will get a message, warning you 
that it is a demo version. You have 30 minutes use of that particular plug-in. This 30 minutes 
counts down all the time the plug-in is in the process window - there is a read-out of how much 
time is remaining on the left-side "rack ear". If you remove the plug-in immediately, the count­
down stops and you can use your remaining time later. 

Demo versions are currently available for: 

• Mastering Limiter 

• Graphical EQ 

• HiDither 96 

• De~sser 

If you decide to purchase a plug-in, contact your dealer for details of how to fully enable them. 

[1]1 APOGEE UV22 SUPER CD ENCODING 
lN22 

UV22 is a process designed by Apogee for increasing the audio performance of a digital signal, 
particularly when reducing bit resolution to 16-bit, although the effects are audible on original 16­
bit recordings. 
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UV22 adds an inaudible, high frequency 'bias' to the digital stream, placing an algorithmically­
generated 'cJump' of energy around 22KHz. UV22 silently captures resolution up to and beyond 
20 bits on a standard 16-bit CD or OAT. 

U\'22 patches into the mixer in the usual way. It is recommended that this is the last process in 
the chain. 

MODE: 	 The mode selection determines how much dither is applied to the audio. Low is 2 bits 
and Normal is 3 bits. Which bits are dithered is determined by SADiE's output 
resolution - the bottom 2 or 3 bits are affected. 

AliTOBLACK: With Autoblack enabled on 16-bit resolution, when the input drops below 
-84dBFS the UV22 will tum off and output silence after about 1.S seconds. It will then 
come on again as soon as the level comes back up above -84dBFS. This is resolution 
dependant; -84db is the threshold for 16bit. At other resolutions, autoblack switches in 
when the signal drops to below 2 bits. 

Nov...: 	 This feature prevents the output going above OdB to prevent any 'clip' or 'peak' 
indicators being triggered. 

DC OFFSET REMOVAl! This removes any DC offset in the signal. It will only affect signals 
below 1Hz. 

Apogee UV22 is a third-party plug-in - contact your dealer for details of how to obtain it. 

MASTERING LIMITER 

The Mastering Limiter plug-in allows you to add gain to a signal before it is limited to a set level. 
You can define the limiting in -<iBFS to avoid overloads. The Limiter enables the audio material 
to achieve 'loudness' while avoiding digital clipping. This is achieved by analysing the waveform 
on either side of a peak and reducing the gain to avoid distortion. 

As with other normal plug-ins, this module patches into the mixing desk via the internal busses. 
There is an 'LED' array which displays the amount of gain reduction. 

There are two icons for the Mastering Limiter in the process window - one creates a mono 
process, the other is stereo. 
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GAIN 	 adjust this to add pre-gain to the signal to 'push' it into the limiter. 

LIMIT 	 sets the maximum peak level. 

RELEASE 	 sets the rdease time for the gain reduction. 

iMPACT 	 sets the r .lte of change of gain reduction. This is a little like the more familiar attack 
function but on a microscopic scale. A sound with a fast attack - say, a piano - would 
require a high impact setting, as the transient nature of the sound would need the gain 
reduction to react very quickly, whereas a smoother sound would benefit from a lower, 
more damped setting. 

HYSTERf.SIS 

increasing the value of this reduces the sensitivity of the process to avoid the limiter 
being triggered by high transient, low level, gain changes. Note that the range of this 
control is reduced as you increase the gain. 

Note that because this process performs some analysis on the audio waveform, there is a delay of 
SOms - the process must receive some audio before it can start calculating. 

The Mastering Limiter is a optional plug-in - contact your dealer for details of how to obtain it. 

GRAPHICAL EQ 
Gnphi<al 
EQ 

The Graphical EQ is an all-in-one unit comprising 4 individual parametric EQ modules, low pass 
and high pass filters, master gain, along with a graphical display of the EQ curve. 

This routes into the mixer in the usual way, using the internal busses. 

The four EQs and high/low pass operate in the same way as a normal SADiE EQ process. 

The green 'LED' bypasses the associated EQ section, without affecting the graphical 

representation. 


The CONFIGURE button allows you to choose the function of the 4 EQs - between high or low 

shelf or bandpass, and how many are enabled. 


There are 4 presets for changing the scaling of the graph where greater precision is required. 
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The CONFIGURE page also contains a preset for de-emphasis. You can save and reload settings for 

the Graphical EQ using the usual Plug-in save and load buttons. 


The Graphical EQ is a optional plug·in - contact your dealer for details of how to obtain it. 


DE· ESSER 
DE· 
ESSER The aim is to reduce a band of frequencies above a threshold level in a signal. The two methods 

used are 'ducking' and 'phase reverse'. We will look at each method in tum. 

Ducking 

Input 	 This method is basically split into a filter and a 
compressor. The filter is used to highlight the band of 
frequencies that are to be reduced The filtered signal 

,---'------, is then fed into the compressor. When the 
'--__,---_------....J compressor detects that its input signal has crossed 

over its threshold it increases the compression ratio, 

'--__ 
,-_-----'L...._--, The compression is applied to the input signal to the 

,--_------' system, so the whole signal band is reduced in level 
and not just the band described by the filter. 
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Phase reverse 

This method consists of a 
ducking method, the filter is 
frequencies that are to be 
the expander. If the expander 
reached its threshold, it 
the filtered signal. Therefore, 
should only conum the band 
This is then phase reversed 
effectively removing only the 
some compensation for the gain 
before phase reversing. 

Inpu t 

filter and an expander. As with the 
used to highlight the band of 
reduced. The filtered signal is fed into 
does not detect that the signal has 
applies a very high expansion ratio to 

the signal at the output of the expander 
of frequencies described by the ruter. 
and added to the original signal, thus 
band of frequencies selected. Note that 
ofthe filter is also applied to the signal 

How to use the processor 

General Output controls: 

Algorithm - changes between the ducking and the phase reverse methods for reducing the signal. 


Filter - Selects the type of filter to use, either bandpass or shelving filters are available. 


Compare - When this button is pressed the user can hear the signal that is being removed. 


Filter controls: 

Frequency - Selects the break frequency for the shelving filter or the centre frequency for the 

bandpass filter. 


Width - Selects the 'Q' for the filter. 


Gain - Selects the gain of the filter. 


Dynamics controls: 

Phase reverse: 

Threshold - Sets the threshold level for the expander. When the signal is below this 
threshold it is expanded. 

Reduction - Selects the percentage of the detected signal that is removed from the 
original. 


Ducking: 


Threshold - Sets the threshold level for the compressor. When the signal is above this 
threshold it is compressed. 

Ratio - Sets the steepness of the compression that is applied. A value of 1 applies no 
compression, 20 applies heavy compression. 

Make-up - Sets the compensation gain for the compressor. 
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An's' is usually contained within a band between approximately 3kHz to 8kHz. The filter is 
used to isolate this band from the rest of the signal . It should be noted that the gain of the filter 
will affect its slope. Therefore, using a high gain will not necessarily provide the best removal. 
The threshold for the dynamics section should be set to catch the worst offending esses in the 
signal, but not so that pumping can be heard . If too much reduction is applied the resulting signal 
will sound lispy and unnatural. 

The De-esser is a optional plug-in - contact your dealer for details of how to obtain it. 

HIDITHER 96 

A brief discussion of noise shaping 

When a signal is quantised some of the detail within the signal is discarded and as a result an error 
is introduced. This error can be heard as noise and is correlated to the input of the quantiser. 
The noise signal can be very noticeable to a listener if the original signal is simple or of a low 
level. It is therefore desirable to try and reduce this correlation and subsequently produce a 
random noise signal. The use of dither does just that. It linearises the non-linear transform 
characteristic of a quantiser and reduces the harmonic distortion for low level signals. To 
summarise, the use of dither has two effects on the input signal to a quantiser; firstly it reduces 
the correlation between the noise and the input signal, and secondly it increases the total noise in 
the system. In essence, dither is a low level additive signal that causes the quantised signal to jump 
randomly between quantisation levels, which when averaged by the ear forms a smooth transition 
between the levels . 

As the noise level has been raised by the addition of a dither signal, it is desirable to try and shape 
the noise to reduce the overall audible effect. Noise shaping filters are used to match the curve of 
the noise signal to that of the frequency response of the human ear. This reduces the noise signal 
where the ear is most sensitive, (between 1kHz and 8kHz) and increases the noise where the ear is 
less sensitive, (above about 14kHz). An average response is taken for the human ear and so the 
effect of noise shaping will be slightly different for each listener. When using a high sample rate, 
for example 96kHz, it is possible to keep the noise floor lower for most of the human hearing 
range and move most of the noise signal to frequencies that are completely inaudible. 

SADiE's HiDither 96 noise-shaping dither plug-in offers 5 different noise shape types, two of 
which are optimised for 96KHz audio material. The other three are designed for 48KHz & 
44.1 KHz audio. Additionally Shape 1 is designed for use with emphasis. 

On the pages that follow are the plots for a -90db sine wave at 1KHz passed through the differ nt 
HiDither algorithms. The graphs for 48K will be slightly different as HiDither uses slightly 
different filters - you can see th graph change in SADiE when you change sample rate. 
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Note: 	 shape 1 is designed to be used in conjunction with emphasis on the audio signal. This 
shape BOOSTS the dither noise, in such a way that when de-emphasis is applied (for 
instance by the CD player) both the signal AND the dither signal are de-coded. 
Therefore it is inadvisable to use this shape unless you are using pre-emphasised audio. 

HiDither 96 is an optional plug-in - contact your dealer for details of how to obtain it. 

HiDither 96 
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HiDitber 96 

AUDIO PRECISION DITHER 
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A·90dB sine wave at 1 kHz with high pass triangular dither 
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HiDither 96 

AUDIO PRECISION DITHER AMP1 (dBFS) vs FREQ(Hz) 02 MAR 9813:13:03 
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-150.0 '--_~__--'-_ _ J..__-----'_ _ --'--____'___'____-"-___'__ ______' 

This is a plot 01" a -90dB sine wave at 1kHz with high pass triangular dither using noise shape 1 at 
44.1 kHz. See note above· this noise shape is designed for use with pre-emphasised audio. 
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HiDither 96 

AUDIO PRECISION DITHER AMP1(dBFS) vs FREQ(Hz) 02 MAR 9813:17:27 
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This is a plot of a -90dB sine wave at 1 kHz with high pass triangular dither using noise shape 2 at 
44 .1kHz. 
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HiDither 96 

AUDIO PRECISION DITHER AMPl (dBFS) vs FREQ(Hz) 02 MAR 98 13:25:24 
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This is a plot of a -90dB sine wave at 1kHz with high pass triangular dither using noise shape 3 at 
44. 1kHz. 
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HiDither 96 

AUDIO PRECISION DITHER AMP1 (dBFS ) vs FREO(Hz) 02 MAR 98 13:33:04 
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This is a plot of a ·90dB sine wave at 1kHz with high pass triangular dither using noise shape .. at 
44.lkHz. 
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HiDither 96 

AMP 1 (dBFS) vs FREQ(Hz) 03 MAR 98 12:40:30 
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This is a plot of a -90dB sine wave at 1kHz with high pass triangular dither using noise shape 1 
(for high sample rates) at 96kHz. 
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HiDither 96 

AMP1 (dBFS) vS FREQ(Hz) 03 MAR 98 12:39:23 
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This is a plot of a -90dB sine wave at 1kHz with high pass triangular dither using noise shape 2 
(for high sample rates) at 96kHz. 
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CEDAR 	DE·NOISE[8 
Udar 
De-Noise: 

Designed by CEDAR, this is a broadband noise reduction system which works by removing 
from the audio signal a "fingerprint" sample that is displayed as a frequency plot called the Noise 
Reduction Curve (NRC). 

In order to use De·Noise effectively, you need to find a representative bit of noise,only signal. 
This needs to be ~~ to 1 second for best results. If necessary, copy the noise sample and repeat it in 
the P laylist, butting each Entry to the last to effectively "loop" it. 

~ Play the material and press the SAMPLE NOISE button during the period of clear noise. Release it 
to stop sampling. The noise spectrum that has been sampled will be displayed as the NRC. 

SAMPLE 

NOISE 


I NOTE: 	 No advantage is gained from a sample longer than a second, unless you deliberately 
want to average a varying noise, such as the "swishing" effect from an old disc. The 
danger of averaging, however, is that the resulting NRC will not be correct for the 
noise at any point in the noise cycle. Experimentation will payoff. 

Avoid sampling over a hard stan or end to EDL Entries as the transition to or from no 
signal may cause a transient. 

You can now replay the material and adj ust the Attenuation fader to the desired amount of noise 
reduction. 

The NRC Gain fader is normal'ly set to its mid-point of zero. At this setting the system will 
attenuate (by the set amount) the level of noise that was sampled. Increasing or decreasing the 
NRC Gain alters the sensitivity of the system to the noise sample. This can be used to fine-tune 
the result, or to compensate for higher or lower noise levels than the sample. Note that if the 
nature of the noise changes, the NRC win no longer be appropriate. 

The bypass button allows you to compare signals before and after processing. 

The graph displaying the NRC curve for the whole audible spectrum can be magnified and 
scrolled with the zoom buttons and scrollbar. 

You can switch between a linear and logarithmic frequency scale for the NRC. Using a 
logarithmic scale shows more detail at the low frequency end and will therefore be useful when 
examining the curve to remove rumble or hum. 
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The NRC can also be manipulated and re-drawn by hand:­

First select either the left, right or both channels for manipulation (applies only when using a 
stereo unit) . The selected channel's NRC will be drawn in a bolder line on the graph. CHANNEL 


SELECT 


The curve is made up of a lot of nodes, or points, about every 50Hz. These will be shown by a 
dot when the mouse pointer is over them, like the data line for fader automation. You can:­

1. Click and drag each node to manipulate the NRC. 

2. 	 Draw (drag out) a box around part of the curve and then again click and drag to raise or lower 
that section. This may be useful, say, if you have sampled some noise, but only want the 
system to remove the low-frequency component of it. 

When you raise or lower a section of the NRC, this button determines whether that section is 
IN RAllOI modified in ratio to the gain or attenuation you are applying (button up), or whether it FIXED 

maintains its shape when moved ("Fixed" - button down). 

3. Press this button and re-draw by hand part or all of the curve. When you release the button, ,l!) 
the previous curve for that section will be replaced. 

DRAW NRC 

The ~TR.C can be saved and re-Ioaded with these buttons. Thus you can set De-Noise to remove a 
previously encountered noise sample. 

Cedar De-Noise is a third-party plug-in - contact your dealer for details of how to obtain it. 

CEDAR DE-CLICK 

Ccd:lr De-Click is another process designed by CEDAR, based around techniques used in their own 
D<-Click 

products, that analyses a signal over a period of several milliseconds, and replaces clicks with an 
interpolation based on the underlying signal. 

In SADiE, De-Click can be operated by two distinct methods - Auto De-Click that automatically 
detects and processes clicks in large sections of audio, and Manual De-Click that allows you to 
highlight specific regions up to 2000 samples in length, that are either not detected or fully 
restored by the Automatic process. 

Note that although De-Click is called a 'Plug-in', operation is quite different from standard plug­
ins and you do not route the process into the mixer in the usual way_ Cedar De-Click is a third 
party plug-in - contact your dealer for details of how to obtain it. 

Auto De-Click 

Auto De-Click uses Offline Processing - a function that is similar to Bounce - i.e . audio is re­
recorded but instead of using the mixer and inline or plug-in processing, it uses a user-selectable 
process during the re-recording. 

So the procedure is similar to bounce: 

• 	 Select the audio that you want to process - the 'Source' for the bounce. 

• 	 T eU SADiE what you want to do with the finished result of the bounce - i.e. select the 
'Destination' for the bounce. 

• 	 Press START and SADiE performs the action, the result is as you specified in 'Destination'. 
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Example 

Let's assume you have a recording in the playlist recorded from a scratched record. 

Select the audio that needs to be sent to the De-Click process. You can do this by any of the 
usual methods allowed by bounce: i.e. 

Complete EDL - the whole EDL will be processed - make sure there's no clips hiding 
several hours down the playlist otherwise the bounce will take hours! 

Selected C/ip(s) - you select EDL entries in red to be processed. 

Selected Streams - enable the streams containing the audio, disable all the others. 

Between L&R Locators - use Region Editing (see Chapter 5 - Editing; Region Editing/or 
more details) to define the region of the clip(s) to be processed. 

For the sake of this example, and because we'll need Region Editing to use Manual De­
Click, I'll describe the last method, although you may find the other methods more 
appropriate. In practise you're likely to be doing the restoration before any editing 
has taken place and so Selected Clips will be fine - just click on the clip you're going 
to de-click. The region edit method gives you the advantage of being able to quickly 
top and tail the material before processing and hence you don't waste time 
processing audio that you're going to throwaway immediately. 

If this toolbar does not appear on the screen (on the Playlist windot... or floating), then you 
need to go to the VlEW menu, select TOOLBARS, then PLA YUST, then REGION 
EDITING, to display this. Then press the left-most button as shown above. 

3 Now, when your mouse is hovering over the playlist, the cursor is shown as a 

pencil. , Click where you want the region to start, and drag the mouse leftwards, and let go 
of the mouse when you reach the end, the region will be defined in red. You can now fine 
tune the beginning and end to suit, by moving the mouse cursor over the beginning or end of 
the region and dragging with the left mouse button pressed. 
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4 When you're happy that you've selected the right sections of audio, go to the VIEW menu 
again, this time select OFFLINE PROCESSING. (If Offline Processing is grey then De-Click m is not correctly installed.). Alternatively press the Offline Processing button on the playlist 

omin< 
~ng tool bar. This window will 

5 From the top, check that the settings here are correct: 

Track 	 Track name for the new recording - autotake on if you 
wish. 

Stereo/ Mono 	 To suit 

SouTce 	 For this example select 'Between L&R Locators' 

Source Output 	 Select the output(s) that the clips are currently playing back 
through. In this example I'm assuming that the clips are all 
on stream 1&2 (or just 1 if it's mono). If the source clips are 
part of a multi-track EDL, and if you're using Region 
Editing to define the source, you should enable only the 
streams that the source material is on, and disable all others. 
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Destination 	 'Stream' will be ticked_ Here you can select where the de­
clicked result will end up_ In this example, we'll tick 'Auto­
replace . .' and leave stream 1&2 selected so that the new clip 
replaces the old one. However you may choose to untick 
'Auto-replace_ . .' and put the new clip onto stream 3&4 so 
that you have both original and processed clips side by side 
in the EDL. 

&unce in non-real-time 	This will be handled automatically, and so you won't need 
to touch this. 

&unce through mixer 	 This time untick this box. If you tick this box, you will be 
able to change level, or even add additional processing (but 
not 'Non 1-1 processes i_e_ Timemod or Sample rate 
convert) as part of the De-dick process. However of course 
any other processing could effect the performance of the 
De-Click process, and so it preferable to De-Click the raw 
material. 

All this is the same as normal Bounce, but the sections below are different 

Auto De-Click 	 Select this from the drop-down list of offline processes. 

6. 	 When you're happy that these settings are correct, press ACCEPT. Note that the Offline 
Processing v.'indow , like the Bounce window, is 'exclusive' and so you won't be able to click 
the mouse any-where else in the program while this is open. If you do want to re-adjust the 
region, then press Close on the Offline Processing window first. 

7. 	 The Auto De~lick will proceed - the bottom section of Oflline Processing reporting the 
progress. 'Pre-processing' is loading up the source, 'Processing' is the actual De-click working, 
and 'Post-Processing' is returning the new audio to the specified destination in the EDL. The 
speed of operation will be effected by the performance of your PC, and its own disk drive. 

8. 	 When 'Post-Processing' reaches 100%, the new recording will be put into the EDL, and you 
can play it back to listen to the splendid results of the De-'Click process. You may have seen 
some warnings as the Auto De·Click progressed - a fairly common one is 'This track contains 
one or more clicks too long for Auto de-click to repair. Try using Manual De-click on them' If 
you get this message then take its advice - Manua] De-click will handle much longer clicks and 
so may do the trick. 

Manual De-Click 

Manual De-click is initiated by a similar method to Auto-Declick, however it must be stressed 
that Manual De-click uses a completely different algorithm to process the clicks to the Auto 
process. With Manual De-click, the user defines the click, and so Manua! De-click processes the 
whole region selected. Manual De-click can work with clicks up to 2000 samples long. 

Example 

Find the click by eye and ear while playing or scrubbing the EDL. 

2 	 Enter Region Editing, and draw across the click with the , pencil tool as above, except this 
time the area we're highlighting will be much shorter. To zoom in quickly on the click, press 

Zoom In the 'Zoom In on Region' button on the region editing toolbar. You may find that you'll have 
on RegiOQ 

to draw across the click repeatedly and press this zoom button to zoom right in onto the 
click. Try using hotkeys for this - the (default) hotkey for this is SHIFT-Z. So SHIFT-Z, draw, 
SHIFT-Z, draw etc. helps you zoom in much quicker than repeatedly pressing the normal 
zoom buttons. 
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3 	 When you're satisfied that the click is highlighted (you can audibly check the region by using 
the preview buttons on the region editing toolbar), press the 'Cedar De-Click Selection' 
button, again on the region editing tool bar. A message as shown above will appear on the 
screen briefly, and then when it disappears, the region will be replaced by a new de-clicked 
region . When you zoom out a little (Hint: try SHIFT-X - this is 'Zoom to region start' and 
will zoom the playlist out to a preset zoom level which you can set for yourself in VIEW 
menu; Setup Window; Playlist; Playlist Display) you will see that a larger area has been 
replaced. Manual De-Click always replaces with a clip around 8000 samples long, although 
only the centre region will be de-clicked. 

Note: 	 If there are repeated instances of de-clicked areas very close together in your playlist, 
then you may find that your hardware may not be able to play them. An error message 
may be 'SADiE cannot play this EDL because there is not enough DSP memory 
available'. To resolve this you will have to re-bounce all the little clips together to 
create one longer section. We'd advise that you choose a region (L&R locators) as the 
source for this 'consolidation' bounce. The Manual de-click process gives its 
replacement clips zero length crossfades, and so if you wish to bounce Selected Clips, you 
would have to set your default crossfade to zero to avoid changing the crossfade. If you 
bounce a region, all this is taken care of. 

It's important to recognise the difference between the Manual and Automatic De-Click processes­
with Manual De-Click the user identifies the click, and thus if you include areas with no click in 
your region, they will be processed as if they are clicking. An artefact of this is a possible drop in 
level if you De-Click a long region where no click exists. So it's important with Manual De-Click 
to select only the click and no extra audio on either side. 
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OFFLINE DIRECTX PROCESSING 

The Offline Processing Window (available by pressing the button on the Playlist toolbar, or by 
selecting it from the View menu) provides a way 'Bouncing' audio through a DirectX process 
running on the Pc. You operate this in a similar way to the normal Bounce process - select some 

Offli... 
Processing 	 audio in the play list, open the amine Processing window, and after the process has been 

performed the new audio will be added to the play list. 

Before any DirectX options will be offered, you must have a run·time copy of DirectX drivers 
installed along with any plug-ins you wish to use. Once they are installed, SADiE will 
automatically find t'hem and when you've chosen DirectX as the main offline process, you will be 
offered a list of available plug-ins in the DirectX Plugin drop-down menu inside the Offline 
Processing window. 

Note that (as of SADiE v}.70.01) this is a non-rea1-time process and so it is not possible to 
audition the effect of the process in real-time while adjusting the plug-in's parameters. 

Example of DirectX processing 

L 	 Select the audio clips that you wish to process. You can choose to process: Whole EDL, 
Selected Clips, Selected Streams or Between L&R Locators, as with a normal bounce. With 
this example I'll use 'Between L&R locators' and use region editing to set these locators. 
So, enable region editing by pressing the left-most (or top-most) button on the Region Editing 
toolbar. 

If this toolbar does not appear on the screen (on the window or floating), then you 
need to go to the VIEW menu, select TOOLBARS, then PLAYLIST, then REGION 
EDITING, to display this. SHIFT-R is the default hot key for this (and you don't need to view 
the toolbar.) 

2. Now, when your mouse is hovering over the playlist, the cursor is shown as a 

pencil. , Click where you want the region to start, and drag the mouse leftwards, and let go 
of the mouse when you reach the end; the region will be defined in red. You can now fine 
tune the beginning and end to suit, by moving the mouse cursor over the beginning or end of 
the region and dragging with the left mouse button pressed. (See Region Editing in Chapter 5 
lor more details). 
If you are likely to want to try a few possible Plug-in settings first, then it's advisable to select 
just a short section of audio for your 'trial' processes. The longer the audio is the longer time it 
will take to process, and so, unless you 're sure you're going to get it right first time (or the 
plug·in has no adjustable parameters), it's best to do shorter trial runs before you choose to 
process anything larger. 
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3. When you're happy that you've selected the right sections of audio, press the Offline 
Processing button on the playlist toolbar. Alternatively go to the VIEW menu again, this 

omin< time select OFFLINE PROCESSING. The left hand window in the picture below will 
Processing appear: 
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4. 	 Check that your source and destination settings are as you want them - the picture above is 
correct for this example_ 

S. 	 Choose DirectX from the drop-down list, just above 'Direct X Plugins:' Then the DirectX 
Plug-ins selection box will be enabled and you can choose which one to use. Press the 
Properties button to view the window for the Plug-in - the picture above shows the panel for a 
demo copy of the 'Waves TrueVerb'. 

6. 	 Set up the plugin, or load a preset (some plug-ins will have this facility others not) then press 
OK to close the Properties box. 

7. 	 Press Preview. Pre-processing will start and count up to 100% as the audio is passed to the Pc. 
Then Processing will stan, again counting as it progresses - this is when the actual audio 
process is taking place. During the Post-processing stage, the processed audio is being passed 
back to SADiE, and when that's complete SADiE will pray the result_ 

8. 	 If you're happy with the result, then press Accept_The processed clip will be added to the 
playlist (or will auto-replace depending or your Offline destination setting). 
Preview goes through all the motions of processing without actually putting the clip in the 
playlist, whereas Accept runs the same procedure but DOES add the clip to the playlist. 
Accept and Preview will not do unnecessary work if no change has been made to the source 
selection or Plug-in parameters_ Likewise, a Preview followed by a parameter change then 
another Preview will not run the pre-process stage again if the source hasn't changed. 

NON 1 - 1 PROCESSES 

Non one-to-one plug-in processes (or Non I-I as we shall call them) are so-called because the 
result of the process is a different length (in terms of time) from the input. 

As a general rule these are not routed in the same way as normal plug-ins - you will notice that 
they have no bus buttons to allow this. 

Instead, when you drag and drop a Non 1-1 process into the 'rack', the process will take effect 
across ALL outputs. So all playback, real-time or non-real-time, will pass through the process 

These are mostly fairly DSP intensive processes, and so only one Non 1-1 plug-in can be used at a 
time. 

There are different qualities available on some Non 1-1 processes. A lower quality process wil1 use 
less DSP power, and hence you will be able to playback more audio in real time through the 
process. But for the highest quality result, it's usually necessary to bounce the result back to hard 
disc in non-real-time, using the Bounce Window. Because the Bounce Window always re-records 
an Output, any bounce with a Non I-I process plugged in will include the Non I-I. 

SllC SAMPLE RATE CONVERTER 
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The Sample Rate Converter or SRC is a Non 1-1 process with presets to convert audio from one 
of SADiE's standard sample rates to any other. 

The five normal sample rates have a button each, and the Double button enables the double 
sample rates for 88.2KHz and 96KHz rates . 

The Audition quality is the most likely to be playable in real-time. The High quality is often 
sufficient for most high-quality applications. 

SAMPLE RATE CONVERSION TESTS 

This document presents the total harmonic distortion (THO) and noise reading for the SADiE 3 
sample rate conversion algorithm . All tests were performed with a full-scale input signal, 
performing the conversion from 48kHz to 44.1kHz. Each graph shows the signal level (the dotted 
line, corresponding with the right hand Y-axis) and the THD + noise (solid line, corresponding 
with the left hand Y-axis) . 
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Standard Quality 
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High Quality 
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Super Quality 
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24 Bit Results 

The following results show the performance of the high and super settings on 24-bit source 
material. 

High Quality 24 bit 

AUDIO PRECISION 

-50.00 

-60.00 

-70.00 

-80.00 

-90.00 

-100.0 

-110.0 

-120.0 

-130.0 

-140.0 

-150.0 
100 

F _LVl2(dBFS) & LEVEl1(dBFS) vs FREQ_1(Hz) 12 FEB 98 15:27:11 

1.000 

.5000 

0.0 

-.500 

-1.00 

-1 .50 

-2.00 

-2.50 

-3.00 

-3.50 

-4 .00 
10k 20k 

6:45 

-' -- ---­

I­

I 

I 

I 
.-­-­
I, 
I 

I 

--­

l-I- - -­ - ---. -

Ap 

I 

/, 
, 

-- ---­ / 

.. 

1k 



Chapter 6 - Mixing and Processing SADiE U~ManU41 t/J.7 

Super Quality 24 bit 
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RESAMPLER 

Rcsompler 

The Resampler Non 1-1 process uses the same algorithms as tbe SRC above, but has a different 
interface for sening the rate change. The Resampler performs a digital varispeed, changing both 
length (in terms of time) and pitch . 

All of the controls are linked and provide different methods of setting this change. 


SPEED ADJUST allows you to type in the percentage change. 


SEMITONES allows you to type in the pitch change you are trying to achieve. 


4 PRESETS automatically sets the resample for 24 to 25 frame conversion, 25-24 etc. 
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IN & OUT LENGTH 	 the In length is the total length of the Selected entries (in red) in the 
current EDL. You can type the new total length for these entries in the 
Out Length time field . 

QUALITY 	 as with the SRC, the Audition quality is the most likely to work in real­
time, but you may want to use a higher quality setting for more critical 
work. 

limcmod TIMEMOD 

The Timemod Non 1-1 process performs a change to the length (in terms of time) without 
changing pitch. 

As with the Resampler, the controls are linked and provide you with different ways of setting the 
length change. 

RAno 

4 PRESETS 

IN & OUT LENGTH 

QUALITY 

allows you to type in the percentage length change. 

automatically sets Timemod for 24 to 25 frame conversion, 25-24 etc. 

the In length is the total length of the Selected entries (in red) in the 
current EDL. You can type the new total length for these entries in the 
Out Length time field. 

The timemod quality settings refer to the frequency range that the signal 
analysis is carried out on. The oruy practical effect is on the low 
frequencies, i.e. low frequency signals are less affected when using higher 
quality settings. The 'voice' setting just analyses the signal within the 
limited bandwidth that speech signals occur. 
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PEAK METERING 

Each strip of the mixer has a line of "LEDs~ to display peak levels going through that strip. 

The Fader decimal display (the number in red in the drawing left) is a dual-purpose display. 
The information it shows depends on settings in the Setup page. You can identify what it's 
displaying by the colour of the number: 

Cyan is not displaying peaks, this is the fader level offset value. 

Green is the peak level detected through that fader. This is reset automatically only when 
you start play, or you can manually rest it by double clicking on the number 
(CTRL-double click resets ALL peak meters) 

Red is the peak level detected through an output fader, but this is greater than zero. 
Actually, it's impossible to produce an output greater than Odb, so this is the level 
SADiE has calculated it would have been. In fact this shows that there have been a 
number of sequential full scale samples on the output. This can be reset in the 
normal way. 

Yellow 	 is the peak level detected through a stream or bus fader that is greater than zero. In 
this case samples aren't truncated - because of SADiE's floating point internal 
calculations approximately lOOOdb of headroom is allowed internally. This can be 
reset in the normal way. 

In the Setup page you can choose which type of display - Fader level or Peak Hold - is being 
shown. Under the "Mixer" section, inside its sub-section "Mixer strip display", you can choose 
between: 

• Only show peak levels on output strips 

• Show fader positions on all faders 

• Show peak levels on all faders 

[NOTE: Peak displays on Output faders are post-fader; on other types of fader strip they are pre­
fader. 

Because output levels are much more critical than internal levels, the peak displays on Output 
faders are measured more frequently than those on other types of fader strip. This wilt explain 
any apparent discrepancy between for instance a stream strip peak and an output strip - it's the 
output peak that is correct. 

Output peaks are measured every 4 samples, which is adequate for most applications, however in 
extremely critical situations such as mastering, these can be switched to being measured every 
single sample. See Mixer setup - "Mixer Output PPM type" - "standard" is 4 sample, "mastering" 
is 1 sample accurate. 
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METERING WINDOW 

The Metering Window is viewed by pressing the Show Metering Window button on the Mixer [II 
Show Mruring Toolbar. This gives a separate window displaying a PPM 'LED' style meter for every physical 
Window input and output in the system. The PPM scales are set to be the same as displayed by the normal 

mixer meters - this can be changed in the Mixer page of the Setup Window. 

The toolbar (which can be viewed or hidden in the usual way - right mouse click, or the Toolbar 
I Mixer option of the View menu) offers some options as follows: 

Enlarges the PPM displays vertically so that they appear double height. 

Enlarges the PPM displays horizontally so that they appear double width. 

Views or hides the numeric Peak Level displays. 

Toggles the peak hold mode - when the button is pressed, the highest peaks are held 
until the Clear Peaks button is pressed. 

Clear Peaks - all held peaks are cleared down - both on the PPM meters and the numeric 
Peak Level displays. 

Clears the Clip LEOs at the top of each PPM strip. The Clip LEDs glow brighter red 
'N-hen an 'over' is detected, whether Peak Hold is enabled or not. 
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Note: 	 There is a setup option (View; Setup window; Mixer; Peak Displays; Clear on Play) 
that allows you to choose to clear all meters on going into playback or to hold them 
every time you play audio. This applies to the normal mixer meters and the Metering 
Window. 

For reasons of economy with screen space, the numeric Peak Level displays are displayed on the 
right side of each bank of inputs or outputs. The example above shows a Metering Window for a 
16 channel 24.96 system. Notice that the meters are grouped in banks of eight to represent the the 
inputs and outputs of each of the system's Audio Units. 
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LOG OVERLOADS WINDOW 

.23d8 at 00:00:13.36268 in HOSS.EDL (1) 

.95dB at 00:00:13.36268 in HOSS.EDL (2) 
3.50dB at 00:00:13.40076 in HOSS.EDL (1) 

.43dB at 00:00:13.40076 in HOSS.EDL (2) 

.16dB at 00:00:15.13316 in HOSS.EDL (2) 

.55dB at 0000:15.37892 in HOSS.EDt.. (1) 

.42dB at 00:00:16.40896 in HOSS.EDL (1) 
.19dB at 00:00:16.40896 in HOSS.EDL (2) 

.52dB at 00:00:19.43764 in HOSS.EDL (1) 

.52dB at 0000:20.05808 in HOSS.EDL (1) 
.44dB at 00:00:22.01672 in HOSS .EDL (1) 
.32dB at 00:00:22.01672 in HOSS.EDL (2) 

.35dB at 00:00:22 .24104 in HOSS .EDL (1) 

.35dB at 00:00:2224104 in HOSS.IillL 

The Log Overloads window is called up from the VIEW menu, or set to "pop up" as an error is 
detected. 

The Log Overloads Window can be set to capture Audio Overloads on all digital audio outputs, 
whilst a playust is playing. The accuracy of this is detemined by the "Mixer Output PPM type" 
setting as explained above. 

To enable, tick Log Overloads, and set a threshold above which you want the window to record 
the Overs. A list will appear below, recording the peak level, the EDL time that level occured, the 
name of the EDL in which it occured and the output which was peaking. Double clicking on an 
item in the list will locate the EDL to the correct time, so that you can review the problem. 

In order to produce a definitive, accurate list of peaks in an entire play Jist, SADiE effectively has 
to <listen' to the whole EDL, which involves playing the play list, through the mixer along with 
processing, and analysing the output signal. 

Errors can be logged as you play and edit the play list, but to speed up the process and produce a 
definitive Overs log, you can do a final play-through of the EDL with NON-R£AL·TIME 
checked in the Transpon Toolbar (at the bottom of the Record pane) 
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AUTOMATION 

OVERVIEW 

SADiE can record the positions and movements of the following controls:- fader level, mute, pan, 
and Mixer strip processes (i.e. aux. send level, EQ, but not dynamics) and then automatically 
replay them. You can update the automation data by making new adjustments as the old control 
movements are being replayed. This applies whether you are using a mouse or the hardware 
controllers. The advantage of the hardware controllers, of course, is that you can make more than 
one adjustment at a time. 

Each process section on the Mixer strip has a DISABLE AUTOMA nON button that will stop 
movements of its controls from being recorded or replayed. Individual EDL Entries can have D1SABI£ 

AUTOMATION their recorded automation data disabled in the Clip Details window so that it will not be replayed 
(see Chapter 4, A rranging an EDL). 

NOTE: 	 Process sections start with their controls disabled, so you have to enable them to record 
adjustments . For EDL Entries the default is automation enabled. When process 
automation is recorded, you have to put the whole process section into write, thus if 
you have any previous automation, the whole section will overwrite even if you only 
touch one knob. For that reason if you are recording for instance, an sweeping EQ, it is 
best to write stationary parameters first. This isn't a problem with a hardware 
controller because you can adjust more than one control simultaneously. 

Automation data is retained as part of the EDL, so that changes to mixes can be undone and 
redone using UNDO and REDO, and you can move between mixes by saving and loading different 
EDLs. The data is tied to the audio Entry that it affects and will move with it to different EDL 
times and even different Playlist Streams, so you can edit the Playlist after mixing. 

When you scrub the Playlist, the automation data will stiU be followed - just watch those faders 
fly! 

AUTOM...TION 

~ [l 
Automation is enabled for the whole Mixer from this button on the Mixer's configuration 

OFF ON toolbar. 

On the hardware controller the AUTO button will enable automation when the Mixer is the 
active window. 

When enabled, the Mixer automation toolbar will be displayed. 

This selects the modes that determine how automation data is recorded and replayed. On the 
hardware controller, they are selected with SHIFf + the buttons at the bottom left of the fader 
panel. 

Whenever the position of a control is being recorded, it will be outlined in red - by a red box 
around knobs and a red stem behind faders. Hardware controller faders will have their red, 
"write" LED lit. 

Whenever data from a control is being replayed, it will be outlined in green and hardware 
controller faders will have their green "replay· LEDs lit. 
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AUTOMATION MODES 

The following automation modes are sensitive to a control being "touched". With the mouse, this 
means clicking on it, hardware controller fader knobs are touch-sensitive. 

OVERWRITE mode - applies to all controls. Any previously written data is replayed until you 
touch a control. Its position will then be recorded and will continue overwriting any previous 

RED· 
OYERWRnt data until you stop or change modes . The control will be outlined red; hardware faders show 
MODE 

their red "write" LED. 

DISCONNECT mode - applies to all controls. Any previously written data is replayed until you 
touch a control. It then affects monitoring only and the previously recorded data will not be

GREY­
DISCONNECT changed. The control will be outlined gTey, and the hardware controller fader LEOs will be off. 
MODE 

After returning to another mode, each disconnected control will stay that way until it is touched. 

The AFFECT ALL buttons causes the above modes to immediately affect all controls. This is the 
equivalent of touching all the controls in the Mixer. So, if you press AFFECT ALL and then switch,

All 
say, to OVERWRITE mode, all control positions will be overwritten from that point. 

AUTO-RETURN mode - applies to fader and pan controls only. Any previously written data is 
replayed until you touch a control. It will then enter overwrite mode until it is released, when it 

GR££N· 
AUTO-R£TlJRN will return to replaying the previous mix. While the hardware controller's faders are being 
MODE moved, the "write" LED will flash, and while they are returning, both LEDs will flash. 

The time taken for the control to return can be adjusted with the adjacent knob and display . The 
knob brings up a pop-up fader which shows you a precise time in seconds; the display indicates 
the nearest whole second. 

TRIM mode applies to faders only- indicated by a blue fader stem and both hardware fader LEDs 
lit. Entering this mode causes all faders to immediately move to a middle position. The previously

BLUE· 
1lUM 	 recorded data will be replayed, but can be offset by the amount you move a fader. This is useful if 
MODE 	 you have a complicated mix where you got all the moves right, but the whole thing needs to be a 

bit quieter or louder. Note that you will not see the faders moving, but the automation data can 
be displayed on the Playlist Stream, as described below. 

TIP: 	 You can change modes during playback, depending on what you want each adjustment 
to do. For example, after making an overwrite adjustment for several minutes, you 
might want to switch to auto-return, touch the fader and have it return to the previous 
mix. You can also select a mode and reposition a control before starting playback, so 
that the adjustment takes effect immediately. 

Once data is recorded, when you next play the EDL, SADiE will automatically switch to AUTO­

RETURN mode. You can inhibit this automatic switching by pressing the KEEP button., which
KEEP 
CUllRENT 	 keeps you in the selected mode each time you stop and start playback. 
MODE 

The WRITE TO END button writes the current position of all controls that are outlined red 
(hardware faders "write" LED) to the end of the EDL

TO 
END 

SNAPSHOT mode buttons allow you to record a constant mixer setting throughout an Entry orIII~I groups of Entries. See Snapshot Automation below for a detailed description. 
SNAPSHOT 
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INOTES: 	If you have used fader grouping buttons, movements of linked faders are recorded as if 
they are all being moved individually. So, if the link is later removed, the automation 
will still replay the original movements. Linking faders after their movements are 
recorded has no effect on the way they are replayed. 

Automation data is tied to EDL Entries, so control movements where ·there is no 
Entry may be ignored. 

RECORDING AND REPLAYING A SIMPLE MIX 

1. 	 Get a rough mix together before you enable automation. That way you can experiment with 
different settings without all your twiddling being recorded and annoying the hell out of you 
when it is replayed. 

2. 	 Once you have your initial fader and processing settings, you can enable automation and they 
will become your starting point for recording. 

NOTE: 	 If you now position the current-time cursor at the start of the EDL, press the 
AFFECT ALL button followed by the WRITE TO END button, these positions will be 
written as a complete mix. This means that if you stop your first mix before the end 
of the EDL, the controls will return to these base positions at that point. 

3. 	 Play your EDL and move any control you want recorded. You will initialLy be in 
OVER WRITE mode. 

4. 	 Replay that part of the EDL and the positions and movements of the controls will be 
reproduced. Unless the KEEP button is down, you will see that OVERWRITE mode has 
automatically switched to AlITO-RETURN mode. 

5. 	 If there is any section of the mix that you want to correct, play over it and re-adjust the fader. 
Hold onto the fader until you want to return to the previous mix. If you want to re-write a 
long section, switch back to OVERWRITE mode and you won't have to hang on to the fader. 

NOTE: 	 Holding etr! and clicking on a mute button will start recording its status without 
actually operating the button. This can be used to overwrite a previously recorded 
button operation. 

SNAPSHOT AUTOMATION 

Whereas other automation modes are designed for recording dynamic changes to the mixer 
controls, the Snapshot Mode allows you to apply the same settings throughout an Entry or group 
of Entries. 

Thies feature has a number of uses - for instance 

• 	 you can quickly set a level on a group of Entries without having to play across them in real 
time. 

• 	 you may want to set a different pan on alternating Entries on the same stream. 

• 	 snapshot EQ's are perhaps more useful in many cases than dynamic changes. 
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Note: 	 Snapshot automation records ordinary automation data onto an EDL entry, in the 
same as you would if you held a fader or pot constant for the length of the clips. This is 
not a special type of automation, merely an automatic way of writing automation cLua 
if it's going to be constant. 
However, because you need to select EDL entries on which to apply the snapshot, 
streams that have no entries· like mixer only streams (bus faders, output faders etc.) 
cannot be 'snapped'. 

RECORDING SNAPSHOT AUTOMATION 

1. 	 Pressing the 'camera' icon on the Automation toolbar enables Snapshot Mode. You will notice 
the violet Snapshot Ready button will be pressed and all other Automation mode buttons are 
disabled except for the grey Disconnect. 

2. 	 Select the Entries in the Playlist that you want the automation to be applied to . You can 
change your mind about this whilst in Snapshot mode; the automation will only be applied to 
the Playlist Entries selected in red when Snapshot Mode is exited. 

3. 	 Set the mixer controls - faders, pans, mutes, EQ's etc., either in play or stop. Unlike other 
automation modes nothing is recorded as you go along. When you touch a mixer control it 
will be outlined in violet. If you want to change a control without putting it into Snapshot 
Ready mode, then click the grey Disconnect button before touching it. 

4. 	 Press the 'camera' icon again to exit Snapshot Mode. At this point the current position of 
every control outlined in violet will be set for every EDL Entry selected in red to which the 
control applies. For instance if you set a fader for stream 3 but only select entries on stream 1 
then nothing will happen. 

Note: 	 Before you snapshot, it 's advisable to have some automation recorded. When you first 
start automating none exists at alL If a snapshot is the first thing you do, you will find 
that the snapshot is applied across the WHOLE stream. Thus if you wanted to for 
example individually EQ or level change just one entry, then you should snapshot the 
'flat' settings for the EQ or the base level to the all entries in the stream first. 

DISPLA YING AUTOMATION DATA 

You can display fader, pan and mute automation data for each Mixer strip. Each parameter· fader 
changes, pans, mutes, process parameters etc, can be displayed as a white line on each Stream 
routed to that strip. Stereo and merged Streams will display the appropriate number of lines. The 
position of the line indicates the fader level or parameter value. 

The large button at the top left of the Playlist will display automation data on aU Streams. 

On the hardware controller this is duplicated by the AlTfO button when the Playlist is the actiw 
window. 

The small button by each Stream will display data for that Stream only . 
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The small fader button by each Stream allows you to choose which automation parameter to 
display. Selecting this button gives you a menu to choose from aU available processes, or fader, or 
pan, and the sub-menu lets you choose which parameter within that process to display. 

NOTE: 	 If there are Mixer strips controlling internal busses or inputs, Streams to show their 
data will be found in the Stream unit labelled "Mixer only Streams". Double-click on 
the unit name to display or reveal this unit in the Play list. 

These Streams cannot have Entries placed on them. 

EDITING AUTOMATION DATA 

As an alternative to re·recording control movements, you can edit (alter) the data by directly 
manipulating the line displayed on the Playlist Stream:· 

Use this button on the main Playlist toolbar to enable automation editing and display the Playlist 
automation tool bar. 

The Entries on the Stream will go into outline and the automation data line will turn red. 

This line, however curvy it looks, is made up of straight lines joining up a lot of" Automation 
Points" where the line changes direction. Each point is shown by a pink dot and a level indication 
when the mouse pointer is near it. 

You can use the mouse to move an existing Automation Point or draw a box around several 
Automation Points and move them together, either horizontally or vertically, depending on the 
first movement of the mouse. Hitting Delete on the keyboard will remove the Automation 
points within the box and replace them with a straight line. 

The three buttons· left to right - on the automation toolbar enable the following mouse functions 
to further manipulate the line. 
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1. 	 Add a new point to the line and set its level. 

2. 	 0) Draw a box around an area to create a "duck" or dip in level, the width and depth of which 
will be determined by the size of box you draw. 
(ii) Adjust the depth of an existing duck by dragging its bottom up or down. Wildlife 

enthusiasts should enjoy that one. 


3. 	 Draw a box around an area of complex data (as usually results from fader or pan movements) 
and when button is released smooth the data so that it consists of fewer Automation Points. 

HINT: You can remove ALL automation from an entry using an option available by right­
mouse~licking on the entry. 

NOTES: Editing is not applicable beyond the last Entry on the Stream. 

N.B. Stereo Entries must be on Stereo Streams if you want to edit the automation data 
of both left and right channels simultaneously (see under Playlist Streams in Chapter 4, 
A rranging an EDL). 

INTERNAL RE·RECORDING 

The Routing section explained how to set-up a bounce-down, which involves re-recording the 
audio internally. With a similar arrangement, you can re-record EDL Entries with processing and 
automation. Set up your routing like this:: 

REQUIRED PLAYLIST STREAMS ~ MIXER STRIPS(with processing) ~ NEW INTERNAL BUS ~ RECORD 
STREAMS 

You can then play the Playlist, with any automation you have done while recording the result on 
new Streams. 

You may choose re-record internally for a number of reasons: 

• 	 Convenience. You want the mixed or processed result to always appear as a single EDL Entry, 
or you don't want to bother with setting the Mixer or Automation to process the required 
Entries every time you play the EDL. 

• 	 To clear SCSI space. You want to re-record small parts of one or more much longer Tracks 
that you can then delete (as described under" Audio Disk Management", in Chapter 7, Fde 
Management). 

• 	 There is not enough DSP power available to carry out the processing you require in real time 
and/ or play the number of simultaneous Entries you require. Process and re-record the 
necessary Entries with "Non-real time" selected in the Transport Controls' record section . 
Then you can use the processed versions in the full EDL. See Chapter 2, Recording. 
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MIXER ROUTING TUTORIAL 


A mixer is a means of connecting many pieces of equipment and multiple channels of audio and 
mixing them together to produce a stereo (or multi-channel depending on configuration) master 
that you can listen to or record onto another piece of equipment. 

SADiE's mixing desk simulates a real mixing console, in the same way that the Playlist is 
simulating a multi-track tape recorder/player, and can be designed in a multitude of different 
ways. 

The vast majority of audio devices have Inputs and Outputs, and we are creating a continuous 
signal by passing the output of one device to the input of a second one. This next device processes 
the audio in some way (couM be just level or pans or it could be more complex processing like 
reverb for instance) and then we connect the output of the second device to the input of a third 
and so on. 

Let's first consider the most basic setup, for instance you have a 4 track Playlist and you want to 
'listen to all 4 tracks, mixed together into one stereo output. 

We have 4 streams in the Playlist that must be connected via virtual "cables" to Outputs 1&2 so 
that you can listen to them. The concept of "busses" is perhaps one of the more difficult, but this 
is crucial to any understanding of mixer routing. We will use these as intermediate links to help 
connect everything together, and to allow us to use devices like pan pots. 

In the real world a bus is a long strip of copper cable that runs along the desk. When you connect 
signals to a bus, they are added together, and then you can take that single signal and pass it onto 
something else - for instance a physical output, or perhaps ypage numbverou would send them to 
a reverb unit or similar. 

So in my simple stereo setup I have 4 Playlist streams, each of which we connect with wire to a 
fader strip. The reason we are connecting them to a fader strip is to allow us to change the level of 
that stream, and also a panpot on the strip allows us to feed some of each signal to the left side of 
our stereo image and some to the right. So each stream has now been converted, by the panpot, 
into a stereo signal. 

Mono fader.s 

withparu Bus 1&2 

.. 
STREAM 1 ... 

r ..
STREAM 2 ... --.... 

JO; ~ OUTPUT 1&2 .. ...STREAM 3 ... 
r 

...STREAM 4 ~ 

-
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We now connect all 4 stereo signals together by means of the Bus. So the left side of each pan pot 
is connected to this "copper cable" we're calling Bus 1 and the right side to Bus 2. We could have 
connected them directly to the physical outputs and we would be able to hear the mixdown in 
that way, but the reason we create a Bus is so that we can put another fader between this Bus and 
the physical outputs in order to give us a level control over the entire mix. 

In SADiE we can ignore the connecting cables, but we have to decide where the input and output 
of every device is coming from and going to respectively. 

So our basic mixer described above, with all the buttons showing, looks like this: 

Note: if you are changing the routing of your mixer, it's important to view the Output Bus 
buttons - these are revealed by pressing the button on the toolbar that's third from the top in the 
picture above - the one with OUT on it. If you can't see this the issue will be confused even 
further. 

The important buttons here are the two rows labelled: 

1 2 3 4 Bus 1&2 

Bus 1&2, Bus 1&2, Bus 1&2, Bus 1&2, o/p 1&2 

These two rows are respectively, the 'Input Bus Buttons' and the 'Output Bus Buttons' and are 
used to select input and output for each fader strip. Press the button and select from the drop 
down list to change the selection. 

From the left, we have 4 mono faders, each with a panpot. The inputs of these faders are named 
1,2,3,4 and these are names of the Playlist streams. The outputs of these first 4 faders are all going 
to Bus 1&2. 

The last fader on the mixer - the yellow one, is our master level control. This is gathering up 
everything that's appearing on Bus 1&2 and sending them, via the fader, to the outside world by 
using Output 1&2. So it takes its input from Bus 1&2, and its output is set to Outputs 1&2 
(labelled olp 1&2). 
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The next stage might involve introducing a plug-in into your mixer. For this example we'll put a 
Stereo Width process in the chain, although this routing method could easily apply to any stereo 
plug-in. 

We are going to break the chain in the first example, between Bus 1&2 and the master fader and 
slot the Plug-in in between. Thus Bus 1&2 are now going to be connected to the input of the 
Plug-in, and then to complete the chain again, we're going to connect the output of the Plug-in 
back onto the input of the master fader. 

So we open up the Process 'Rack' by clicking on the button that second from the bottom in the 
picture above. An empty 19 inch rack unit will appear, and we drag the appropriate icon (in this 

case ) from the toolbar onto the empty rack. 

It will look a little like this: 

When the Plug-in is first dragged onto the rack, the routing buttons on the left hand side of the 
Plug-in will say (for its input) 'Stereo Width 1 In' and (for its output) 'Stereo Width lOut'. These 
are names of the new busses that the Plug-in has created in order to connect it up. In this example 
we won't use 'Stereo Width 1 In', because we are going to connect Bus 1&2 directly to the Plug-in 
(and thus all 4 streams will be going through the Plug-in and being processed for width) . 

So, click on the top, input bus button for the Plug-in and select Bus 1&2, leave the bottom output 
button as it is. We now have to connect the output of the Plug-in back into the mixer. So we go 
back to the main mi..xer, and click on the top button on the yellow master fader, selecting 'Stereo 
Width lOut' as per the picture above. Done! 

Our routing diagram now looks like this: 
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Mcmo Fwn 

with pUIS Bw1&2 

STREAM 1 ~ 

STREAM 2 ~ 

=* =====1~t OUTPUT U 
STREAM 3 ~ 

STREAM 4 ~ 

As you can imagine this routing allows for many, many complex possibilities, and it does require 
some care if your mixer is going to include a number of different plug-ins operating on a number 
of different streams of audio. When you have built a mixer that you feel you'll want to use again, 
then you may want to save it as a Template (see Chapter 9). The whole purpose of a mixing desk 
is to provide these complex interconnections, but the fundamental concepts are: 

• 	 A device's output connects to another device's input. 

• 	 Busses provide a means of adding signals together and routing them onto another area of the 
mixer. 

• 	 In SADiE terms a fader or plug-in 's input can be from a Stream, Bus or Physical Input, its 
output can be a Bus or a physical Output. 

• 	 An audio signal must eventually make its way to a physical output - just follow the signal path 
through all its routes if you 're seeing error messages. 
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17 . FILE MANAGEMENT 


OVERVIEW 

Work in SADiE'" is held in a number of files. Firstly there are the Tracks - sound files of the 
audio as originally recorded into the system - these are stored on dedicated audio disks . Looking 

after these is covered in "Track management", below. 


Then there are the files that represent the work you have done to the raw material. These are: 


EDLs (how and when to play back which parts of the Tracks), 


Mixer setups (a record of the Mixer configuration needed to play the EDL) and 


Clipstores (a useful store of Clips for later use). 


There are also files called 

Projects, which group all the above files as components, together with a list of relevant 
Tracks. A Project file can then represent all the work for a particular job. 

Just like the documents of a word processor, these files need to be saved so that they can be 
opened later for further work or playback. They are stored on the DOS hard drive of the Pc. 

Creating, opening, saving and closing EDLs, Mixers and Clipstores can be done: 

1. 	 From the Project window. Files created this way will become components of a Project 

NOTE: 	 We strongly recommend that you always start work within a Project, as to later 
create a Project from non-Project-files requires importing all components 
individually. It also makes saving, reloading, archiving and keeping track of your 
work much easier. 

Working within Projects is described later in this chapter, following the basic 
explanation of the component EDLs, Clipstores and Mixer setups. 

2. From the File menu, with the New, Open, Save and Close commands. 


"New" creates a new EDL, Mixer or Clipstore outside the Project structure. 


"Open", "Save" and "Close" refer to the type of file shown by the currently active window 

(shown by a highlighted title bar). To make a window active, click on it anywhere or use the 
WINDOW button on your hardware controller. 

~Save" saves a file under its current name, thus overwriting the previously saved version. 

"Save As" allows you to rename the fLle, thus keeping the previous version. 

The dialogue boxes that appear following "Open" and "Save As" allow you to open different 
folders to find your file or to choose the folder that you want to save it in. , 2. EDL files can be opened and saved from these buttons on the Playlist toolbar. Note that this~ 
button is "Save" and not "Save As". 

OPEN SAVE 

EDL FILE 


3. 	 You can also, of course, close the file shown in any window by double-clicking on the icon to 

the left of its title bar, or - with Windows 95® - by clicking on the close button on the right of 
its title bar. 

EDLs 

EDL files are given the file extension ".EDL", so a typical name in full is "FRED.EDL". 
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Creating a new EDL opens an empty Playlist window for you to stan work in. 

Opening a previously saved EDL opens a new Playlist window containing that EDL. 

• 	 Any previously open Playlists will stay open and you can switch between PLaylists under the 
Window menu, from within the Project window or by using the WINDOW button on your 
hardware controller. 

Saving the EDL in the currently active Playlist window will save the file to the PC's DOS drive. 
The first time you use save a file, you will be asked to name it; after that, the "Save" command 
will save the file with the same name as before, overwriting the previous version. If you think 
you might want to keep the previous version, use the "Save As" command. This will let you give 
the new version a different name. Take care to open the folder that you want it saved in. The file 
extension" .EDL" will be automatically added to the name you type. 

Closing an EDL closes the Playlist window that is displaying it. You will be prompted to save the 
EDL if it has been changed since last saved. 

NOTE: 	 The EDL file that you save includes the layout and names of the Streams in the Playlist 
displaying it and any Automation data· i.e. fader and other control adjustments in the 
Mixer. However, you will need to save the Mixer setup that goes with the EDL 
separately, as described below. If you work within a Project, this will be done for you 
when you save the whole Project 

EDLs can be saved as a TEMPLATE using the FILE menu option Save current playlist as a 
template. EDL templates have the file extension 'EDT'. See Chapter 9 Playlist and Mixer 
Templates. 

CLIPSTORES 

A Clipstore is a useful holding place for Clips that you may later want to add to an EDL. These 
may be versions of Tracks with specific fade and level characteristics, or pans of Tracks. Clips 
created in the Playlist window or the Trim Editor can be saved to the active Clipstore, where 
they can be grouped in folders. 

A special folder labelled "Source Tracks Folder" will appear in the first Clipstore that is opened 
or created, so the Clipstore is also useful for accessing any audio on the system. 

• 	 If you are working within a Project, the Source Tracks folder will contain all the raw Tracks 
being used by this Project. 

• 	 If you work outside of Projects, it will contain all the raw Tracks the root directories of all 
your logged audio disks. If you are using a SADiE2 formatted drive this will in fact be the 
entire contents of the drive, whereas a SADiE3 formatted drive will only show you audio 
T racks that were created outside of a project. 

NOTE: 	 The Source Tracks folder is not saved as pan of the Clipstore ftle. It is added to it to 
enable you to access Tracks on the audio disks. Clips in the Source Tracks folder are 
not editable. See "'Track Management'" below for more details about the Source Tracks 
Folder. 

Clipstore files are given the file extension ".CLS", so a typical name in full is "FRED.CLS". 

Creating a new Clipstore opens a new Clipstore window with no Clips in it. 
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Opening a previously saved Clipstore opens a new Clipstore window containing the saved list of 
Clips. 

• 	 Any previously open Clipstore windows will stay open and you can switch between them 
under the Window menu, from within the Project window or by using the WINDOW button 
on your hardware controller. 

Saving the Clipstore shown in the currently active window will save the file to the PC's DOS 
drive. If you use the "Save As" command, or if the Clipstore has not been saved before, you will 
be prompted to give the file a name, and can select which folder it is saved to. The file extension 
".CLS" will be automatically added to the name you type. If you use the "Save" command, the 
file will be saved with the same name as before. 

NOTE: 	 You only need to save a Clipstore if you have deliberately stored specific Clips in it, as 
described below. In many cases, you may never want to do this and all your work will 
be contained in EDLs. However, it is often useful to save a list of Clips that have been 
"topped and tailed" or selected from much longer Tracks before you put them together 
in a specific order, in an EDL. It's a bit like having a shelf full of small insert reels for a 
particular programme, or can be used to make a library of Sound Effects . 

Closing a Clipstore closes the window displaying it. You will be prompted to save it if it has been 
changed since last saved. 

NOTE: If you close the Clipstore that contains your Source Tracks folder, you can get the 
folder back by opening a new Clipstore or closing and re-opening an existing one. 

USING 	THE CLIPSTORE WINDOW 

To select a Clip in the Clipstore with the hardware controller, use WINDOW to make the required 
Clipstore the active window, then the wheel will scroll through all the Clips. (Make sure it is not 
selected to jog or shuttle.) Alternatively, the PREVIOUS and NEXT buttons will step through the 
list. 

With the mouse, click on a clip to select it. As with most Windows® applications, multiple 
selection of items in the list can be made by selecting them while holding the Ctr! or Shift keys. 

The Root Node is the "top of the tree" for this Clipstore and Clips 
can sit at this level, or be grouped into folders. Double-clicking 
opens and closes the folders to view their contents. 

Mono Clips/Tracks are shown with single blue icons. 

Stereo Clips/ Tracks are shown with green, double clip icons. 
Double-clicking on these reveals the left and right channels for 
separate selection. 

Multi-channel Clips/Tracks are shown with red icons (as "voices" 
here) . Double-clicking on these will reveal their component stereo 
or mono parts for selection. 
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To open or close stereo and multi-channel Clip icons with the hardware controller, select the 
Clip and then press EDIT/SELECT. 

Clips can be listed alphabetically by name, or grouped by type (first stereo, then mono, then ~ multi-channeJ).l!:=I..:::!l 
NAME TYPE 

Allows you to create and name a NEW FOLDER. You flfst need to select the folder that you want [§J 
it to appear in - this may be the Root Node, or another folder. 

NEW FOWER 

The PREVlEW button will play the selected Clip from in point to out point, or until you release 
the button.

PIlE\I1EW 

The Transport controls apply to whichever is the active window and can be used for previewing 
selected Clips. 

[[J Allows you to RENAME a Clip or a folder. 
RENAME 

II 
 Allows you DELETE a Clip (or clips) or a folder from the Clipstore. 


DELETE 
NOTE: 	 Deleting a Clip will not delete any audio from the SCSI disk, but it will delete the 

reference you have created to a particular piece of audio, with particular level and fade 
characteristics. 

The SEARCH button lets you search for clip names with given text which can include the 
character * to represent any number of "wild" characters. The two buttons next to it review 
search results and return you to the full Clipstore listing. 

The details columns to the right of the tree of names can be customised, as in the Text EDL, by 
selecting options from the box that drops down when you click on any of the headings. 

NOTE: 	 When the Clipstore is the active Window, a Clipstore menu will appear on the main 
menu bar. This duplicates the above buttons for NEW FOLDER, SORT BY NAME/TYPE 

and SEARCH. 

COPY TO 
CUPSTORE 

STORING CLIPS IN A CLIPSTORE 

You may want to store the new Clip you have created by editing in the Playlist or the Trim 
Editor: 

Select the Entry in the Playlist or the Clip in the Trim Editor and press the COpy TO CLIPSTORE 

button on that window's too lbar. 

On the hardware controller, use WINDOW to make the required Playlist or Trim Editor the 
active window and CUT or COpy the Entry or Clip to the paste buffer. This is described in 
Chapter 4, Arranging an EDL, and the Trim Editor section of Chapter 5, Editing. Then select the 
required Clipstore as the active window and PASTE the Entry into the Clipstore. 
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= 

WAD TO 
PASTE BUFFER 

WAD TO 
1lUM EDITOR 

~ 

CUP DETAlLS 

MOVING CLIPS AROUND CLIPSTORES 

Clips can be copied and moved around between folders of the same Clipstore, or between 
different Clipstores by dragging with the mouse. Dragging ~ the Clip and holding the Ctr! 
key while dragging copies it . You will not be allowed to alter the contents of the "Source Tracks" 
folder, but you can ~ Tracks from it to other folders. 

On the hardware controller, use WINDOW to make the required Clipstore the active window, 
then the wheel will scroll through all the clips if it is not selected to jog or shuttle. You can CUT 

or COpy highlighted Clips to the paste buffer and PASTE them into the next Clipstore and folder 
you select. 

MOVING CLIPS TO OTHER WINDOWS 

The selected Clip can be loaded to the paste buffer for pasting into a Playlist, or dragged directly 
to the Playlist window. See Chapter 4, Arranging an EDL 

The selected Clip can be loaded to the Trim Editor to be altered and the new version saved back 
to the Clipstore. 

cm or COpy the selected Clip, then PASTE it into the next window you select. 

CLIP DETAILS 

You can bring up the Clip Details window for a selected Clip and make changes to it there, 
before "writing back" the new version and thereby re-saving it in the Clipstore. See the Clip 
Details Window section in Chapter 4. 

USING 	ONE CHANNEL OF STEREO/MULTI-CHANNEL CLIPS 

You may want to use just one channel of a stereo or multi-<:hannel Clip: 

• 	 Double-<:lick on the Clip or Track in the Clipstore to reveal the separate parts. On the 
hardware controller, select the Clip and then press EDIT/SELECT. Stereo components of multi­
channel Clips can be further opened to show separate mono channels. 

• 	 You can now select JUSt one channel and paste it into the Playlist. 

MIXER SET-UPS 

Mixer Set-ups are given the file extension" .MSU", so a typical name in full is "FRED.MSU". 

NOTE: 	 There can only be one Mixer connected to SADiE's outputs, so only one Mixer 
window may be open at a time. Creating a new Mixer or opening a saved Mixer set-up 
therefore closes the existing Mixer window. 

Creating a new Mixer replaces the existing one with the default set-up. This is specified in the 
Setup window displayed from the View menu. 

Opening a previously saved Mixer replaces the existing one with the saved set-up. 

Saving the current Mixer set-up will save it as a file to the PC's DOS drive. If you use the "Save 
As" command, or if the Mixer set-up has not been saved before, you will be prompted to give the 
file a name, and can select which folder it is saved to. The file extension" .MSU" will be 
automatically added to the name you type. If you use the "Save" command, the file will be saved 
with the same name as before. 
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[11 

SHOW 

MrxF.R 


Closing a Mixer closes the window displaying it. You will be prompted to save it if it has been 
changed since last saved. You can re-display the current Mixer set-up with the SHOW MIXER 

button on the Playlist tool bar. 

Mixers can be saved as a TEMPLATE using the Fll..E menu option Save current mixer as a 
template. Mixer templates have the file extension 'MST'. See Chapter 9 Play/ist and Mixer 
Templates. 
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PROJECTS 
To make handling the above files more convenient, they are grouped together as components of 
individual Projects. 

Every Project also has a list of audio Tracks associated with it. This is the list of Tracks that 
appears in the Source Tracks folder of its Clipstore. 

Each new Project that you name creates a folder of that name on your DOS drive under the path 
C: \ Projects. This contains the files for the individual components and the actual Project file itself, 
which has the file extension" .PR]". 

If you are using a version3-formatted audio disk, a folder is also created there, to group Tracks 
recorded under the Project. 

Once you are working within a Project, you can use the Project window to create, save, open and 
close all the individual components that make up your work. When you save the whole Project, 
all these are saved together. Next time you work on the Project, the Project window will only 
show the components that are relevant to that piece of work. The Source Tracks Folder that is 
created in the Clipstore only contains audio that is being used by the Project. 

Whole Projects can be deleted to delete all associated files in one go. 

You can only ever have one Project open at a time and so must close the currently open Project 
before opening or a saved one or creating a new one. 

Projects can be backed up to the SCSI disk which contains the audio Tracks, and this may be 
transferred to another machine or posted across a network. When you want to return to a Project 
that has been backed up in this way, you restore it (and its components) to the DOS drive in 
order to do funher work. 

A Project and its associated Tracks can also be backed up to other SCSI devices like Exabyte tape 
or MO disks for longer term storage. 

START-UP 

You are presented with the following box when you run SADiE: 

You can then either close the box and stan workSADiE3 Pfoject Staftup [3 
with an empty Playlist and a default Mixer and 
Clipstore (which would have to be saved and kept 
track of separately, or arranged into Projects later)­
or choose to: 

1. 	 Open the Project that was last worked on (the 
current Project). 

2. 	 Open an existing Project, that you have 
previously saved. 

3. 	 Create (and name) a new Project. 

4. 	 Restore a Project that has been backed up to a 
SCSI storage device. 

Note the underlined letters that act as keyboard 
shoncuts instead of using the mouse. 

Once SADiE is running, these facilities are provided from the full range of options in the Project 
menu described below. 
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MANAGING PROJECTS 

Projects are created, opened and closed from the Project menu on the main menu bar. 

Commands that are not currently available are "greyed out" in the list - for example you cannot 
open a Project until you close the current one. 

New Project 	 When you create a new Project, 

1. 	 If you have more than one SCSI audio disk you will first be asked which disk you want to use 
to record Tracks associated with it. You can also tell SADiE to use whichever disk has most 
space. 

2. 	 Then you will be asked to give the Project a name and the Project window wiU open. SADiE 
will have created a new EDLIPlaylist, Clipstore and Mixer named after the Project. These will 
start off in a default state and after use in the normal way will be saved, closed and re-<>pened 
as part of the Project. You can create additional components as well as one layer of "Sub­
Projects" within each Project - useful for episodes within a series, for example. 

NOTE: 	 A newly created Project will have no tracks associated, and hence the Source Tracks 
Folder of the Clipstore will be empty. However any or all of the Tracks on the SCSI 
audio disk(s) may be easily imported, as described below. 

Open Project 	 Lets you open an existing Project from those saved on the DOS drive. The Project window will 
appear (if minimised it will be reduced to a box at the bottom of the screen - press its maximise 
button, or select it from the "Windows" menu) . 

NOTE: The list of recently used files at the bottom of the File menu will always allow you to 

directly open your last used Project. 

Save Project Saves the current Project and all its components that have been changed since they were last 
saved . 

. NOTE: When the Project window is active, this is duplicated by the File I Save command and 
the hardware controller SAVE button. 

Close Project 	 Closes the current one so that you can open a different Project to work on. 

Delete Project 	 Closes the current Project and deletes its folder and all component files from the DOS disk. If 
you are using SADiE3-formatted audio disks, you will have the option of also deleting all audio 
Tracks associated with the Project. 

Cleanup Project Offers selections to enable you to automatically 'Tag' or mark audio tracks for backup or 
deletion. 

Backup Project Displays a box with two options: 
1. Backs up the current Project components by copying those files to the SCSI audio disk being 
used for the Project's Tracks. The disk can then be stored or transferred to another system, or its 
contents posted across a network. 
2. Backs up the Project and all the audio Tracks in its tracklist to another SCSI storage device, 
such as an Exabyte tape. 

Restore Project Displays a box with two options: 
1. Restores a Project that was backed up to an audio disk by copying its components to the DOS 
drive, then asks you if you also want to open the Project. 
2. Restores a Project's Tracks and components from another SCSI device, such as Exabyte tape. 
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MANAGING WORK WITHIN A PROJECT 

r"~«lQe<t:. is Helen's piece - when 

....aoCltc!ge'-' is the music .ontage ­
the ....ontage.. ",ixer to play itwe" bounce it down before 

;;;a 1~IlMting it in the main programme. 

Once you have opened or created a Project, the Project window will appear and you will be able 
to see all its associated components in a tree structure, as in Windows® File Manager or Explorer. 

Double-click on folders with + and - signs to reveal or hide their contents. 

Components of projects are EDLs, Clipstores, Mixers and Sub-Projects. Opening, saving and 
closing components from within the Project window has exactly the same function doing the 
same thing from SADiE's File menu - it is just a far more convenient way of doing it and keeping 
track of everything! 

An open yellow folder will appear against open components in the Project window. A red 
exclamation mark will appear next to the folder when you do anything to a component (e.g. edit 
an EDL) to remind you that it has been changed since you last saved it. The AUTO OPEN 

AUTO OPEN 
COMPONENT 	 COMPONENT tag means that the component will open automatically when the Project is first 

opened. 

NOTE: All buttons in the Project window are duplicated by right-clicking on the relevant areas 
of the name tree - you may find this more convenient than identifying the buttons. 

CREATE 

SUBP CU'ST EDL MXR 

Further components may be named and created with the CREATE SUB-PROJECT, 

CREATE CLIPSTORE, CREATE, EDL and CREATE MIXER buttons. If right-clicking, you 
will find them under "Create a new ... " 

The most useful way to save your work is to SAVE PROJECT, which will save !!Lthe components 
of a Project in one go.

SAVF. PROJECT 

NOTE: This is duplicated by the SAVE button on the hardware controller when the Project 
window is active, and by the Save Project command in the Project menu. 
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Existing individual components may be opened, saved and closed by selecting them and hitting 
~PEN;AVE ~LOSE the OPEN/SAVE/CLOSE COMPONENT(S) buttons. 
COMPONENTS 

NOTE: Double-clicking on a component will open it directly and is a useful way of bringing its 
window back in view. 

Ii) IMPORT COMPONENT allows you to bring a component into the current Project. For example, a 
IMPORT Mixer saved outside of any Project, or a Clipstore from another Project. You have two options: 
COMPONEl'<'T importing the original file into this Project, or importing a copy of it. 

NOTE: If you import the original file, it will not be moved from its current folder on the DOS 
drive, but the current Project will retain a link to it. 


If you import a copy, you can work on it and save new versions in the current Project 

while leaving the original where it was. 


REMOVE COMPONENT removes the selected component from the listing in this Project window. - NOTE: You will also be asked if you want to delete the component file from the DOS drive. If 
REMOVE 
COMPONEl'<'T you choose not to, it will remain in the folder where it was originally saved and can be 

imported into any Project or opened outside Projects. 

When you open a Project, if a component file has been moved on the DOS drive or had its name 
changed, SADiE will not be able to locate it. A warning message will be displayed and the missing 

lOCATE component will appear in red in the Project window. The LOCATE COMPONENT command will 
COMPONENT 

then let you browse through different folders, and when you find the missing file, will update the 
Project to keep note of its new location. 

DISPLA Y USERS and EDIT USER LIST let you to display or alter the list of users allowed to open 
the Project. The user that created the Project is its "Project Manager" - indicated by a tick in the 
"Manager" box - and only he/she can add or delete users from the list or promote other users to 
"Project Manager" status. Note, however, that System Administrators can open !!LProjects. The 
User Management software for multiple-user installations is described in Appendix E, and outlined 
in Chapter 1, Getting Started. 

SELECT AUDIO DISK allows you to specify which of your SCSI disks (if you have more than one) 
is used to record Tracks associated with the Project. Alternatively, you can tell SADiE to use 
whichever disk has most space. 

TAG SOURCE AUDIO TRACKS allows you to quickly mark which audio Tracks will be backed up 
when "Total Project Backup" is chosen. See Archiving below. The Tag marks can also be used for 
deleting audio that is no longer in use - see Cleanup Project below. 

LIST MISSING TRACKS is for removing links in the project to audio tracks that no longer exist. See 

~ Missing Tracks below. 
UST MlSSING 
TRACKS 
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SUB-PROJECTS 

Sub-Projects are a useful second level in the Project structure when different users are working on 
different parts of a Project. The Project that is open when you create Sub-Project(s), becomes the 
master Project. 

The master Project will show the Sub-project as a component, but will not show all the sub­
Project's own components unless they have been marked for global access to the master (with the 

T EXPORT COMPONENT button) . This is to mask possibly huge numbers of works-in-progress from 
COMPONENT the master and only make available the latest or best versions. 

To work on a sub-Project, once it has been created, select it from the list at the bottom of the 
Project menu. This effectively makes the sub-Project become the current Project. To return to the 
master Project, use the menu list again. 

CLOSING THE CURRENT PROJECT 


The only way to close the current Project is from the Project menu. 


You will be prompted to save any unsaved components, and the whole Project. 

DELETING THE CURRENT PROJECT 

The Delete Project command on the Project menu closes the current Project and deletes its 
folder and all component files from the DOS disk. If you are using SADiE3-formatted audio 
disks, you also have the option of also deleting all audio Tracks in the Project's folder on the 
audio disk - i.e. Tracks that were recorded under the Project . 

This will not delete audio imported into the Project, so a "Library" of sound effects is safe when 
deleting other Projects that use its Tracks. 

You cannot delete a Project that contains Sub-projects - these must be separately deleted first. 

BACKING UP A PROJECT TO THE AUDIO DISK 

To back-up the current Project to the audio disk, select Backup Project from the Project menu, 
thw select "Backup Project Components to the Audio drive" 

All the files for the Project will be copied to the audio disk, which can then be removed and 
stored, put into another system or posted across a network. 

To restore a Project from an audio disk, select Restore Project from the Project menu, then 
"Restore Project components from an audio drive". 

The Project files will be copied to your PC's DOS drive and a further box will let you open the 
Project for more work. 

FILE RECOVERY 

If you exit SADiE incorrectly, either:­

• 	 without shutting down properly (described at the end of the Tutorial in Chapter 1, Getting 
Starled) , 

• 	 because you suffer a power cut, or 

• 	 because your computer crashes (yes, lets admit it - it does happen!), 
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then SADiE will attempt to recover the Project, EDLs, etc. that were in use at the time of the 
problem. 

When you next run SADiE, you will be asked if you want to return to the recovered versions. 
This is your only chance to recover work done since the last "Save" command - so say yes! 

BACKUP FILES 

Whenever you save a file using an existing name (this happens with the ·Save" command), the 
previous version with that name will be overwritten. However. it is not immediately lost. SADiE 
keeps the last version as a backup me, with the file extension "_BKE" for EDLs. ".BKC" for 
Clipstores, ".BKM" for mixers, etc. 

To open a backup file, use the normal "Open" command. but in the dialogue box change the 
types of files listed to "All files". You will then see backup files included in the list and you can 
open the appropriate one. 

TRACK MANAGEMENT 

THE SOURCE TRACKS FOLDER 

During any SADiE session a Clipstore will contain a special folder which gives you access to the 
raw audio Tracks in use. Inside a project this is all the Tracks associated with the Project - this Jist 
is saved with the Project. Outside of Projects, it will be the entire root directory of your disks. 
Operation of the Source Tracks Folder inside a Project will be described below in detail, 
however, it is essentially the same when working outside Projects. 

The Source Tracks Folder provides a means of managing the audio Tracks that are being used in 
the current session and adding, removing and archiving audio belonging to your current work 
should be done here. For a more global view of the contents of your discs you should use Disk 
Management. 

There is only one Source Tracks folder and it appears in the first Clipstore opened. If no open 
clipstore contains the Source Tracks Folder. then opening another, or closing one and re-opening 
it will make this special folder re-appear. 

Tracks appear in the Source Tracks Folder if: 

1. They were recorded while the current Project was open, or 

2. They have been imported into the Project. 

Much the same functions are available in the Clipstore for clips from the Source Tracks Folder as 
for other clips. You can drag or cut and paste these as clips into EDLs or other folders in the 
Clipstore. You will notice however, that for these Source Tracks Clips aU the fields in the right­
hand table of the Clipstore are greyed-out and hence it is not possible to edit these parameters. 
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CLEANUP PROJECT 

The CLEANUP PROJECT functions, available under the Project menu, gives you extra tools to 

help manage your audio tracks within the project. 

You would use these functions for the following purposes: 

• 	 To remove or delete audio which is no longer used by the project· alternative or old takes; 
tracks that were imported by mistake or unnecessarily. 

• 	 To archive the project along with all or some of its audio tracks. 

Choosing the Tag Tracks option, allows you to automatically mark or 'Tag' tracks that either do 
or don't belong to some components of the project. 

Tag tracks gives us this window: 

Select tagging mode for Source AudIO Tracks ~ 

'Tag all of the audio tracks', changes the Tag mark on EVERY track in the Source tracks f Lder 
for the project. 

The 'Tag the used audio tracks' option operates on every EDL and clipstore that is current J.i 
OPEN. This includes minimised components. Note that clipstore does not include the Source 
tracks folder (which does not strictly belong to that clipstore, it belongs to the project itself). This 
function searches through all the open components and tags every track as YES that is in use, and 
tags everything else NO. 

'Tag the unused audio tracks' does the reverse - tagging unused tracks YES and used tracks NO. 
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Inside the Source tracks folder, the Tag mark for each track can be manualJy changed, to allow 
you to override the automatic selection. You may have to change the table display of t'he clipstore 
to show a 'Tagged' column. 

There is an extra Tag option - AL WAYS. This is a permanent mark - AL WAYS tracks are always 
copied, never deleted, and never c'hanged by the auto-tagging operations. Double-clicking on the 
Tagged field changes a NO to YES and vice-versa; right-mouse clicking toggles it between 
ALWAYS and NO/YES 

To DELETE the tracks you've tagged - from t'he Project menu, select Remove or Destroy - as 
usual, remove just disassociates the tracks from the project, whereas Destroy permananently 
deletes them (never to return I). Of course you're most likely to want to remove or destroy 
Unused tracks, so be careful that you've selected the right tagging option. 

To BACKUP the Tagged tracks, from the Project menu, select Backup Project. Then select 
'Total Project Backup to a storage device', and select the drive you v.-ish to archive the project to. 
The backup will procede as per the Project Backup procedure -see below. 

NOTE: 'Tolal Project Backup to a storage device' only ever archives tracks that are tagged YES. 
Choose 'Tag all of the audio tracks' in the Tag tracks window. 

MISSING TRACKS 

IJSADiE21ormaibleep802 

The SOURCE TRACKS FOLDER of the Clipstore displays all the audio tracks that belong to 
the project, but there are occasions when some tracks are not available - perhaps a disc drive 
containing associated tracks is no longer on line. 

SADiE will warn you of missing disc drives when it encounters them on loading a project, but 
still retains a record of these 'missing tracks'. When they return then the Source tracks folder will 
refresh. But there are times when perhaps these missing tracks are no longer needed for the 
project, and you may want to remove the link to them completely 
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LIST MISSING TRACKS gives you a list of these tracks and allows you to permanently remove 
them if you wish. ~ 

UST MISSING 
TRACKS 

THE SOURCE TRACKS TOOLBAR 

You will notice that clicking on a Source Track makes the bunons on this toolbar change colour 
from grey to show that these functions are now available. Also, right mouse clicking on a Track 
gives different options to those shown when clicking on normal clips. 

The Tracks are listed together with columns of details. The columns can be customised by 
selecting alternatives from the box that appears when you click on their headings buttons. 

As with most Windows® applications, multiple selection of items in the list can be done by 
selecting them while holding the Ctr! or Shift keys. 

NOTE: A newly created Project will have no tracks in the Source Tracks Folder, but any or all 
of the Tracks on the SCSI audio disk(s) may be easily imported:­

IMPORT TRACK opens a portion of the Disk Manager window so that you can select: 
• 	 Individual Tracks from any audio disks, 
• 	 A whole disk or folder. 
• 	 Groups of Tracks by either i) clicking on a Track while holding the CTRL key to add it the 

group selection or ii) clicking on the top Track in a range that want to select, then hold the 
SHIFT key and click on the Track at the bottom of the range. 

The tracks will then be added to the Source Tracks Folder for the current Project. 

NOTE: 	 An imported Track may still belong to a Project that it was originally created with. 
Deleting the original Project can delete such a Track. 


Tracks that you want to be available to many Projects should be held in a Project such 

as "Library" or "Effects" that you know you won't delete. 


REMOVE TRACK removes the Track from the Tracklist for the current Project without deleting it 
from the audio disk. 

DESTROY TRACK removes it from the Tracklist and deletes it from the audio disk entirely. It 
cannot be retrieved! 

RENAME TRACK allows you to change the name of the Track. 

NOTE: 	 What name gets changed by this function depends on the audio file format. 
With SADiE3 format files, the Track name is different from the file name on the audio 
disc, and so Rename Track will not change the file name, but will change the Track 
name in the Source Tracks Folder. You can see a Track's file name and location on the 
disc in the Source Tracks Folder, if you display the PATH field in the table. 
With a SADiE2 format file, changing the Track name will also change the file name, 
and thus any saved EDLs may not be able to find the Track. It's safest to not rename 
Tracks or Audio Files - change the name of the Clips or EDL entries instead. 
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Iii TRACK PROPERTIES shows the Properties box for that Track (see Chapter 2, Recording). 

AUDIO DISK AND FILE MANAGEMENT 


The Disk Management window is displayed from the File menu. It shows the SCSI devices on 
your system and the files that are on each of them in a tree structure like Windowsill File Manager 
or Explorer. Double-click on items in the tree to open or close them like folders . 

On a SADiE3-formatted disk, sub-directory folders will be shown for each Project. You can 
create further folders by right-clicking on the folder or disk name, or selecting it and using this CIlEATE 

SUBDIRECTORY button. 

The SCSI disk that we refer to as the audio disk actually also stores the waveform profiles of each 
Track. When Projects and their components have been backed up as described in the Projects 
section above, it will also contain packed Project files. 

These buttons on the Disk Management tool bar select whether only audio Tracks or all files are 
listed in the next column. On the far right, details for each file are given in columns which can be

TIlACKS I All 
customised: Click on their headings buttons and select alternatives from the box that appears. 
The dividers between column buttons can be dragged to change their width. 

If you have other SCSi devices attached - such as CD-R drives or tape backup devices - these will 
also appear in the Disc Management window. Within certain limits, the same basic rules apply for 
logging, file copying, formatting etc. There is a further discussion below - Other SCSi Drives. 

NOTE: As with most Windows® applications, multiple selection of files in the list can be done 
by selecting them while holding the Ctr! or Shift keys. 

CHECKING SPACE ON YOUR DISK OR SCSI DEVICE 

In the tree, select the storage device you '\I;ant to check and press STORAGE PROPERTIES. A 
display box will tell you how much space is used, how much is available, and details about the 

STORAGE 
PROPERTIES drive's SCSi ID. This command is also available by right-clicking on the device. 

You can also use this button to show you the storage properties for the SYSTEM, which will look 
similar to this: 
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Note that the Time Available is displayed in the format in which you are set to record. 

LOGGING AVDIO DISKS 

When you run SADiE, it will look at the SCSI devices on the system and log all the files on them. 

However, if you change disks, or connect to another drive via a network. you will want SADiE 
to recognise the new disk and log its files. To do this: 

1. 	 Select the directory which it is to appear under (e.g. "local" for disks on your machine, 
"remote" for those on a network) . 

2. 	 Press LOG DISK. - This command is also available by right-clicking on the directory. ~ 
lOG DISK 3. 	 In the box that appears, set the SCSI ID indicator to the ill number of the disk or drive unit 

you want to log. 

4. 	 Press the Log Disk button in the box. 

5. 	 You will be told when SADiE has logged the disk and its files, which will then be displayed in 
the Disk Management window. 

Advanced Logging 

The ADVANCED button on the Log Disk box, offers extra options for logging drives. 

LUN allows you to set a local unit number if the drive supports one. 

SCSi Bus - depending on your hardware you may have more than one SCSi Bus - for instance 
the Portia video card will use SCSi Bus 2. 

Disable WDTR, SDTR - some drives may not be logged by SADiE in the standard way because 
they don't support certain SCSi commands SADiE uses, and so these can be turned off. Consult 

UNLOG 
your dealer if you are having trouble logging a drive.You can UNLOG a selected disk ifyou don't 
want its contents to be accessible to SADiE. 

Scan Drives 

This function is found by right-mouse cliclcing on the LOCAL disk branch of the Disk 
Management window. Selecting this will automatically search every LUN on the system to see if 
there's a drive there. 

NAMING AVDIO DISKS 

To rename a disk, select it and press this button, or right-click on its current name. If you have 
removable disks, it is a good idea to give them all different names that can appear on labels to 

physically identify them when they are removed from your system. 
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It is inadvisable to rename a drive in the middle of a project. A project uses the disc name for 
logging audio tracks_ If you change the disc name, the tracks will not be found, although you are 
able to re-import the audio into the Source Tracks Folder. See the Projects section of this chapter. 

COPYING FILES 

You can copy files between disks or folders by simply dragging them across and releasing them 
over the destination symbol. The copy bin can be used as a temporary store when copying Files 
from more than one folder. So, drag some files into the copy bin, then click and drag the Copy 
Bin to where you want the files copied to. 

File copying is a background process, so you can do other work in the foreground. You will be 
informed when the copy is complete. The speed of copying will depend on the demand made on 
the system by your foreground activities - the copy may actually stop during periods of heavy 
playback! record, then continue as and when the processor power returns. 

During a Copy process, a new "copy process" branch appears on the left, and clicking on it 
displays the progress of the copy - which have completed and how far the others have got. 

Note that the Copy Bin has its own "Used Space" entry in the System Storage Properties 
window. This will help you check how much space you need for your copy operation. 
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RENAMING AND DELETING FILES 


Select the File and press these buttons to rename it or delete it from the audio disk entirely. These ~ 
RENAME 

[(I] 
DELETE 

commands are also available by right-clicking on the file name. 

WARNINGS: Renaming an audio file that is used by a saved EDL will mean that the EDL will 
not be able to find it when it is next opened. The safest way to rename a Track 
that is in use is inside the Source Tracks Folder - see above. 

You cannot retrieve a deleted file; all EDLs that refer to it will be affected. 

If you want to delete all the files on a disk, it is a good idea to format it, as 
described above .. 

OTHER SCSI DRIVES 

Tape Backup devices are treated as normal disc drives by Disc Manager. You can log, copy to 
abd from, and format tapes as you would an audio drive. Thus to make a backup to, say, an 
Exabyte tape, follow the normal copy procedure above - drag and drop files onto the Exabyte 
drive, or via the Copy Bin. For every drag and drop operation ooto the tape, you will have to 
create a new Directory on the tape - you will be asked to give it a name before the copy starts. 
Thus multiple sessions on a tape are possible. 

Copying/rom a tape is the same procedure - find the files you want in the directory displayed in 
Disc Manager, and drag it to the copy bin or directly to the destination drive . Because of the 
directory structure on the tape, the Tape drive will automatically seek and copy the selected files 
(like a hard disk !) 

You will notice that some tape drives are quite slow to react to rewind/fast forward commands, 
and so may take some time to reach the nth backup on a tape. For this reason, a tape drive (and 
likewise a CDR) will not be fully logged on initial start-up - the drive is recognised but its 
contents are unknown until it's formally logged. 

Tapes must be formatted before they can be used for backup. This is not the case with DDP 
tapes - it is a very different format, and backup and DDP cannot c<H!xist. A tape format or a DDP 
write will completely overwrite the previous contents of the tape. 

If you attempt a copy onto an unformatted tape, you will be asked if you wish to format the tape 
first. Formatting a tape can take a few minutes, depending on the drive type. Ask you dealer 
about supported tape drives. 

CD-R Drives again appear in Disc Manager as a "normal" drive, however, currently, the only 
function available for a CD-R is drive and disc logging. Currently CD-R drives can only be 
written to via SADiE's PQ editor. 

ARCHIVING 

The quickest and most effective method of archiving your audio is to a Tape Backup drive. 
Transfer time is usually quite a bit faster than real-time and tape costs are reasonable . Consult 
your dealer about supported drives . 

There are essentially two ways of backing up and restoring in SADiE: 
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1. 	 Use the Copy Process inside Disc Management. This gives you most flexibility - you can drag 
and drop exactly the files you wish onto the Tape dri\-e_ It's possible to copy your files from 
the PC disk - project components, EDLs etc. - so that they can be backed up alongside the 
audio - see Backing up a Project to the Audio disk under Projects above. 

2. 	 Using the Project Backup and Restore functions described below. These are much simpler to 
operate but hence .Iess flexible_ 

There is no reason why you can't "mix and match" the 2 methods - perhaps using Project backup 
to archive the project, but then the normal Copy process to partially restore it. 

PROJECT BACKUP 

One easy method of backing up to a Tape drive is by using Disc Management's copy process. 
However SADiE also provides a "one-shot" method of backing up a project, along with its 
associated audio files. 

1. 	 Select Backup Project from the Project menu, then select "Total Project Backup to a storage 
device". 

2. 	 The backup tape will be logged, and if necessary you will be offered the chance to format it. 
You will then be asked for a backup name. This is just the name of the directory on the tape, 
and so need not be the same as the project name, but it's wise to form a naming procedure for 
yourself. 

3. 	 The Project Backup Progress box will appear: 

JH.~nnJlhnl,clrmn1 [ADM] 
JH'IDrulhnl,clrm:n1 [PFM] 
l ....r'nnlhnl'irmlTJ [ADMI 

[PFM] 
[ADM] 
[PFM] 
[ADM] 
[PFM] 
[ADM] 
[PFM] 
[ADM] 
[PFM] 

IHptpMIOsIT18101 [ADM] 
l.HrJlPol!:lOslTl8I01 [PFM] 

ComPeted 
ComPeted 
Competed 
Completed 
Completed 
ComPeted 
Completed 
ComPeted 
Competed 
ComPeted 
ComPeted 
Completed 
ComPeted 
29% 
99% 
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4. 	 There will be a short pause while the Tape drive prepares itself, then the list of files will be 
worked through and copied to the tape. Do not be alarmed at the number of "duplicate file 
names n 

• each audio file is actually at least 2 separate files· you can see in the diagram the files 
marked [ADM] are the (larger) audio files, and the [PFM] files are used for displaying the 
waveform information. Those above are mono, but stereo audio requires 4 files. The first file 
above· IIHippo/Kevin [APJ] - is the project file - actually this is all the project components· 
EDLs. Mixers, Clipstores - that belong to the project.. Even so, in relation to the audio files 
this is trivially small. 

5. 	 Once the Abort I Close buttons are coloured in black and the backup is proceeding, you can 
hit CLOSE and allow the backup to carry on in the background, while you play EDLs in the 
foreground. As with the Copy process, (project Backup is nothing but a fancy copy process) 
foreground demand will reduce the speed of the backup. 

NOTE: 	 Only tracks tagged YES or AL WAYS will be backed up as part of the project. This 'It.·ill 
only not be the case if you have run the 'Cleanup project' or 'Tag Source 'Tracks' 
functions. See Cleanup Project above. 

This method can be used to backup the project to any suitable SCSI drive. However the project 
will have to be correctly restored before all the project component files match the new audio files. 

In brief, EDLs and Clipstores look for audio tracks by name and full path - for instance the EDL 
would see a track called 'KEVIN' in a directory called 'FRlNTON' on a drive named 'HIPPO' as : 

IIHippo/frinton/kevin 

If you move the audio track to a new disk or directory, the EDL cannot find it automatically. 
Thus if you use Project Backup to backup a project to a normal SCSI drive, the EDLs are still 
looking for files on the original drive, and if you open the project again, with the original disk 
missing, all entries will be ghosted, even though you know the audio is on the new drive. 

The correct way to deal with a Project Backup is to restore it to another drive. This function 
should not be used to move the audio tracks to another disk. 

Note: 	 the Exabyte drive may be busy for a long time after SADiE has apparently finished 
with it, and you'll find that you may not be able to start another backup or restore for 
a few minutes. 

PROJECT RESTORE 

Project Backup provides a "Snapshot n of the current state of a project when it's backed up. Thus 
Project Restore is designed to return the Project to exactly the same state as it was at the time of 
the backup. If there are any traces of the project, or a project of the same name, on the audio 
drive to which you are restoring or the path on the PC drive where the EDLs, c1ipstores, mixers 
etc. reside - they will be removed or over-written by the restore process. Thus if you have 
continued working on the project and wish only to restore a few tracks - this is not the function 
for you! Likewise if the backup is only a partial backup and you don't wish to disturb the 
existing project, then the only way to restore is by using the Disc Manager Copy function. 

To restore a Project that has been archived by Project Backup: 

1. 	 Close your current project - you must be outside projects to start a Project Restore. 

2.. 	Select Restore Project from the Project menu, then "Total Project restoration from a storage 
device" . 

.3 . 	 Then choose from the list of available backed-up Projects. 
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4. 	 The Proj'ect Restore Progress box appears. This is nearly identical to the Backup Progress box 
above, and reports on the progress of the restore. 

5. 	 As with backup, once the Tape drive has started, you can Close the Progress box and continue 
working in the foreground, pushing the restore to the background. 

6. 	 The Project files will be copied to your PC's DOS drive, the Tracks will be copied to your 
audio disk and you can then open the Project as usual. Note that project component files will 
returned to where they came from and if you have changed your working directory since the 
backup, then you will have to go hunting! 

Note: 	 Some Exabyte tapes can take quite some time to log, particularly if they have a number 
of backup sessions on them. 
You may find that V2 backup tapes will take even longer because there is no main tape 
directory. We have a tape containing many sessions of hundreds of tracks that takes 
about 1 hour to log! in this case it would be quicker to use V2 to restore this particular 
tape. 

SELECTIVE ARCHIVING 

If you are working inside a project, it is possible to mark files that you wish to be included in a 
Project Backup. If there is audio that you want to be backed up, whether or not the Track is used 
in open EDLs then right-mouse clicking on the backup field in the Clipstore will change the field 
to AL WAYS. Tracks marked ALWAYS are unaffected by the Mark Audio for backup function. 

You will notice that there is aTAGGED field in the table section of the Source Tracks Folder 
inside the Clipstore. When "Total Project Backup ... " is selected, it is actually only the Tracks 
marked YES for backup that are copied to the storage device. 

In the Source Tracks Folder you can manually change Tracks ' tag setting by double clicking on 
the field to toggle between YES and NO. 

TAG SOURCE AUDIO TRACKS on the Project Window toolbar brings up a dialogue box 
which allows you to: 

l. 	Tag all the used Tracks - this will look through all open EDLs and clipstores in the Project, 
and mark Tracks used with YES for backup. 

2. 	 Tag all of the Audio Tracks - marks every Source Track as YES for backup. 

3. 	 Tag all unused Audio Tracks - this is the reverse of Labove, and would be used for deleting 
unused audio. See Cleanup project above 

If there is audio that you want to be always backed up, whether or not the Track is used in open 
EDLs then right-mouse clicking on the backup field in the Clipstore will change the field to 
AL WAYS. Tracks marked ALWAYS are unaffected by the Mark Audio for backup function . 

ARCHIVING NON-PROJECT WORK 

If you have work to archive that was not kept in a Project, you can use the copying facilities in 
Disk Management to copy Tracks to another SCSI storage device_ You will then have to copy the 
EDL, Mixer and Clipstore files to Hoppy disk, using Windows® File Manager or Windows95 
Explorer. Files from the PC disk can also be transferred to a SCSi storage de...;ce via the DOS TO 

SCSI DRIVE FILE TRANSFER command under the FILE menu. 
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FORMATTING AUDIO DISKS 

You should format an audio disk: 

• 	 When first installing it on your system. 

• 	 As a quick way of deleting all the Tracks and other files on it. 

• 	 Every now and then , as good practice, since formatting checks and reallocates the sectors on 
the disk . 

Select the disk and press this button, or right-click on the disk name and select "Format" . You [IIJ will be given a warning that this will permanently erase everything on tlut disk. 
FORMAT 

This dialogue box will appear which allows you to choose from a number of different format 
types. 

a 64K minimum cluster size. 
lHn'Nf"Vf'r, there is no upper limit to the 

01 a partition which wi make the 
incompatible with Wndows 9SINT 

You'll notice that this window gives explanations as to why you would want to choose a 
particular format and a technical description. The majority of these are provided in order to 
enable you to interchange audio files with other equipment - if you have no need for this facility 
then you should choose SADiE 3 Format (and ignore the rest of this section.) 

The available formats (as of SADiE v3.7) are: 


SADiE 3 Format (Default) 


Use this if file interchange isn't needed 


Technical Description - The format is the normal FAT16 format with a 64K minimum cluster size. 

However, there is no upper limit to the size of a partition which will make the disk incompatible 

with Windows 9S/ NT 


The NA TIVE file format is SADiE3 . 


SADiE 2 Format 


Use this if you want to interchange audio with SADiE2 
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Technical Description· Proprietary format used by SADiE2. The duster size is fixed at 64k which 
limits the disk size to 4Gbytes. The SADiE2 software can only use this format and so if you are 
planning to use your disk with SADiE2 you must use this format. Certain facilities· long track 
names and project directories in particular - are not available in SADiE 3 with this disk format. 

The NA TIVE file format is SADiE2 . 

FAT 16 (2G max) 

Use this if you want to interchange audio with Windows 95 programs or Lightworks. 

Technical Description - DOS FAT 16 format. The cluster size is limited to 32kbytes which limits 
the partition size to 2Gbytes. Multiple partitions are created if the disk is larger than 2Gbytes 

The NA TIVE file format is W A V. 

FAT 16 (4G max) 

Use this if you want to interchange audio with Windows NT programs 

Technical Description - DOS FAT16 format. The cluster size is limited to 64kB which limits the 
partition size to 4GB. Multiple partitions are created if the disk is larger this. Any partition 
greater than 2GB in size cannot be accessed by Windows 95 

The NA TIVE file format is W A V. 

FAT 16 (MO format) 

Use this if you want to interchange audio with the AMS AudioFile using an MO disk 

Technical Description - DOS FAT16 format. The cluster size is limited to 32kbytes which limits 
the partition size to 2Gbytes. The disk contains no partition table which limits the disk size to 
2Gbytes. 

The NA TIVE file format is W A V. 

MAC HFS 

Use this if you want to interchange audio with MAC programs 

Technical Description - MAC HFS format. The cluster size is limited to 32kbytes which limits the 
partition size to 2Gbytes. Multiple partitions are created if the disk is larger than 2Gbytes 

The NA TIVE tile format is AIFF. 

You can also type a new name label for the disk. When you've chosen the format type, then press 
"Format" again. 

You may notice that some of the available formats have a limit on the partition size. If you are 
using one of these with a drive that is larger than the limit, the format process may create more 
than one partition and so in SADiE's disc manager you will see more than one disc with the same 
name (further partitions will be labelled Diskname·2, Diskname·3 etc.) and this will look like a 
number of different disc drives to SADiE. Beware that one of the partitions may be quite small­
for instance a 4.3GB drive formatted with FAT 16 (2GB) will produce three partitions - two sized 
2GB and a little one of only 250MB or so. When this disc is logged by Windows, again it will 
appear as three separate drive letters. 

There are a few restrictions as to which file format can be used on some of these disc formats. For 
instance you can only record with SADiE2 me format on a SADiE2 disk format (because 
SADiE2 is the only software program that will recognise this disc and the only file format it 
understands is SADiE2) . See the section on File Formats later in this chapter. 
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The Native file format mentioned is the default file format for the respective Disk Format. When 
you set the file format before recording, you can choose a Native option which will 
automatically make every recording in the appropriate file format for the disc. 

The disc format function is only available to system administrators. See Appendix E - User 
Management 

FILE FORMATS 

AUDIO 	DISK FORMATS AND FILE FORMATS 

I made a comment in the Formatting Audio Disks section above and the same applies here - if you 
are working totally inside SADiE 3 and have no need to interchange audio with other systems, 
then you should be working with the default settings of SADiE3 format audio files (or 'Native, 
on a SADiE3 formatted disk, and you will not need to read the rest of this section. 

But if are you are taking files from other systems and/or passing audio on to be worked on wld1 
another workstation (which is becoming more of a regular occurrence) the read on ... 

It's important to recognise the distinction between Disk Formats (covered earlier in this chapter 
under Formalling Audio Disks) and File Formats. A system may require a disk to configured to a 
particular format so that it can recognise its filing structure, whereas software programs will 
require the data files to be arranged in a certain way in order to read those files. So you may have 
the right disk format for a system, but unless the file formats are compatible for your software 
then they may not be readable - and vice versa. 

With SADiE we are mostly interested in Audio files, and usually the organisation of the peM 
audio data is similar from one file format to another, but the files headers (which will contain 
other information about the audio - sample rate, sometimes time-code stamps etc.)will differ from 
format to format. 

SADiE can work with a number of Disk Formats (as described above) and can play and record in 
a number of different types of File Format. 

Note: 	 SADiE can handle these different disk and file formats at the same time - so it's quite 
possible to be playing for instance SOU files from a Mac HFS disk, Lightworks and 
W A V files from a FAT 16 disk and SADiE3 native files from a SADiE3 disc in the 
same playlist. The Playlist makes no distinction between the different file types and 
you will have mostly the same facilities throughout. 
(The only differences being that a) certain disk and file types allow for less characters in 
the file name and b) some audio file formats treat stereo files differently - for instance 
with Lightworks a stereo file will always be two mono files, whereas a stereo W A V is 
one file - although the user will perhaps only notice these differences during file 
copying and maintenance.) 

You choose a file format every time you record, bounce, or use offline processing or PC audio 
import. To change the selection, pressing the Properties button on either the Transport Controls 
(record pane), Bounce Window, Offline Processing Window, or PC Audio import window, will 
show the Properties page for the file you are about to record, and you can change the details at 
this point. 
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The File format selection offered will depend on the format of the disc you are recording to. 
When you choose a file format. that will persist until you change to recording to a different disc 
drive that ha~ a different format, when SADiE will keep using that file format if it's allowed, but 
otherwise will flip to 'Native' . the chosen default format for that disc format. 

When you're recording to multiple disk drives of different disk formats simultaneously (!!) if you 
choose a format that's incompatible with one of the disk drives you may be told 'File is invalid'. 
In such a case SADiE software does not allow you to choose a specific file format for each drive· 
you choose one global file format or 'Native'. 

Some settings such as sample rate, will be fixed to the current system sample rate. Bit resolution 
will default to the system input setting (Audio Setup), but when you change it in the Properties 
window, this setting will persist until you change the system setting again. Take number is not 
editable· this is automatically created when you turn on the Auto-Take function and increments 
a number on the end of the file name. 

Some fields in Properties can be edited after the recording has been made - for instance reel name, 
reel track number, comments and references (if allowed by the specified format), and you can 
access the prri ies window by selecting the Track in the Source Hacks folder of the c1ipstore 

and pressing .. ,Soun:e Track details. 

Files can be recorded and played back in SADiE at a number of bit resolutions and sample rates ­
16 to 24 bit (32bit floating-point too in the case of SADiE3 format) and 32KHz up to 48KHz plus 
double (88.2KHz/96KHz) and quadruple (176.4KHz/192KHz) rates. 

Some files formats will restrict this, but if you intend to interchange this file you should make 
sure that the system waiting to accept it can handle these bit or sample rates. For instance you 
could make a 96KHz 20bit WAY but does the other sound card and/or software support> 16bit 
and >48KHz? 

The file formats supported, as of SADiE 3.7 are: 

SADiE3 SADiE3 's own proprietary format. 

WAY The standard Windows audio format. 

AIFF The standard Macintosh audio format. 

AIFC Another standard Macintosh audio format. 

BWF Broadcast Wave Format - an extensive to the WAV format to include timecode 
stamping and other references. 

FilmW A V Another extension to the W A V format for Film applications. 

Lightworks The Lightworks Video Editor's audio format. 

SDn A common format in Avid and ProTools systems 

IDS A proprietary format used by IDS systems. 

SADiE2 The Proprietary format used by an earlier SADiE version - you can only record in 
this format onto a SADiE2 format disc, although SADiE2 files can be copied to a 
SADiE3 disc. 
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TRACK NAMES 


The number of characters you can use for the name of the recording depends on the disk and file 

format. SADiE uses 8 characters for the file name (on the disc) for SADiE3, SADiE2 and FAT 16 

discs, and 28 for Mac HFS disks. 


However, if you are recording in SADiE3 file format, SADiE uses another layer of organisation 

that binds files together into Tracks and allows a longer name of up to 64 characters for the track. 

So for instance if you are recording 8 mono tracks simultaneously in SADiE3 file format to a 

SADiE3 format disk, under a track name of 'Eight men speaking bonngly about their lettuces', you 

will produce 1 track (seen in the Source Tracks folder of the Clipstore), but 8 audio files in [:isk 

Manager. You can see which file names relate to the Track, by displaying the Path column in the 

clipstore and double clicking on the red wiggly icon next to the Tracks' name. You will see that 

SADiE has automatically shortened the file names (remember - you're only allowed 8 characters 

for the file name) to: 


IIDISKNAME/ PRJNAME/eightmen 

I IDISKNAME/PRJNAMEI eightm - 0 

IIDISKNAME/PRJNAME/eightm -1 

IIDISKNAME/PRJNAME/eightm - 2 

etc.etc. 

Other file formats will not allow this and so essentially the Track is the same as the File. 


When you re-name a SADiE3 Track in the Source Tracks Folder - you are changing just the name 

of the Track and not the individual file names. 


RECREA TE PROFILES 


When tracks are recorded with SADiE, a 'profile' file is recorded at the same time, which is used 

to display the lower resolution waveform views in the Playlist. These appear in the file listing in 

Disk Management as *.pfl, *.pfr and *.pfm files, but only when you choose to SHOW ALL 

FILES. The first, ONLY SHOW TRACKS button (the default view) filters these out, and mostly 

you won't need to worry about these. 


However if files are recorded outside SADiE and have been copied up to SADiE's SCSI disk or 

have been brought in on a non-SADiE formatted disc, - for instance W A V , AIFF , Lightworks, 

SDn files etc., then they will not have profiles. (Files imported with PC Audio Import are reo 

recorded and will have profiles already.) 


However the first time you import any of these files into the project, SADiE will detect the lack 

of profile and automatically make a profile file for each track. This is often quite quick, however 

if you import long tracks or lots of smaller ones, then you may see the profile being drawn· if 

you drag a clip into the playlist, it may not immediately show its profile, but will draw it as you 

watch. 


If you exit SADiE before a profile has finished being created it will delete any partial profiles and 

start re-creating them the next time you open the project. 


It shouldn't be necessary, but if for any reason you wish to make the profile file, then there is a 

function to start this manually· the option will appear in the menu when you right mouse click 

on the track in the Source Tracks Folder of the c1ipstore. You can select a number of clips (using 

the SHIFT or CTRL modifiers) and 'Recreate Profile' will work on all of them. 


Note that profiles are created at the sample rate at which the track is stamped, and so if for any 

reason the track has picked up the wrong sample rate stamp, then 'Recreate Profile' is not able to 


change this . The quickest way to rectify an incorrect sample rate stamp is to bounce the whol 

track at the correct rate. 
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EDL FILES 

If you bring an EDL file into your PC that was created on a different system, when you open it 
SADiE will automatically detect any of seven different formats and ask you if you want to 
convert to SADiE version 3 format as you open it. 

iNOTE: 	 SADiE Version 2 EDLs differed from v3 ones in that they lacked automation data, 
Stream layout, etc. They can also be converted to v3 format, but you cannot use the old 
v2 mix files. 

Alternatively, the "Convert File" command in the File menu allows you to convert files between 
any of the recognised formats: 

• 	 Press the SELECT INPUT FILE button to locate and select the file to ;be converted and select its 
file type from the list below. 

• 	 Press the SELECT OUTPUT FILE button to give the converted file a new file name and locate 
the folder you want to save it in. 

• 	 You can select "From Playlist" to convert the EDL in the active Playlist to another format, 
and "To Playlist" when converting and importing an EDL to the current Playlist. 

COPYING FILES TO AND FROM THE PC 

There are two separare methods of transfering Audio between the PC and the SADiE system. 
You should be aware that SADiE uses a SCSi disk bus that is entirely separate from the PC disk 
bus, and so there is no possibility of a straightforward disk to disk copy using MS Windows tools. 

PC IMPORT AND EXPORT 

These functions offer more facilities and flexibility. It's possible to audition a file before 
importing and you can change the file format as part of the import process. These functions 
effectively re-record the audio as part of the transfer. 

FILE COPYING 

There are two functions available from the FILE menu, that enable you to copy files between the 
SCSI audio drive and the PC's hard drive (or floppy disc) 

These functions are not available for transfers to and from SADiE2 format drives. These are 
straight file copy operations, and a file retains its original format. 
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PC AUDIO IMPORT 


The PC Audio Import window is called up from the VIEW menu. 


This window allows you to transfer a W A V file from the PC disk, auditioning the file throught 

SADiE, and performing a file conversion in the process. Note that, because of the file conversion, 

this can be used with SADiE2 formatted disks too. 


Select the file in the top section. You can then select PREVIEW to listen to it. 


SOURCE PROPERTIES gives you details as to the bit rate, sample rate etc. of the PC file 


DESTINATION PROPERTIES allows you set the properties for the new file which will be 

recorded onto the SADiE SCSi drive. 


To transfer the file, enter a TRACK name, with all the usual autotake settings, choose non-real­

time (for the quickest and most reliable transfer) and press IMPORT. 


BOUNCE TO PC DISK 

There are some options inside the Bounce Window (See Chapter 4 Bounce-Down )to enable YOll to 
record files directly onto the PC disk. 

If you check PC disk as the destination, then the result of the bounce will be a W A V file on the 
PC disk, rather than on SADiE's own SCSi disk. 

Use this to transfer edits as complete W A V files, or simply to convert a SADiE format file to a 
W A V on the PC disk. 

This used in conjunction with MULTI·BOUNCE would enable vou to mixdown each entry of 
the play list as a separate W A V file on the PC disk. 
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See Special Bounce Functions in Chapter 4 for more details 

Will allow you copy any file except SADiE native audio files to the DOS drive. Selecting this 
option will give you a box to select the file to copy, and then you be asked where to put it on the 
DOS drive, and its new file name. 

NOTE: 	 If you need your final edited audio files to be in, for instance, W A V format on the 
DOS drive, then you must record them in W A V format onto the SADiE SCSi drive. 
This copy function does not provide a format conversion. 

DOS TO SCSI DRIVE FILE TRANSFER 

Similarly, this offers you a box to select a file on your PC drive, followed by another box asking 
you where you wish to save it on the SADiE audio drive. You might find this useful if you wish 
to copy related files· documents, CMX EDLs, etc. from the PC drive onto a removable drive to 

be used in a different location. At the other end, you will have to copy them back to a DOS drive 
in order to use them. 
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Is - SPECIFIC APPLICATIONS 

This section aims to do two things: 

l. 	To offer tips for using methods described in detail elsewhere in the manual, where they may 
be relevant to particular areas of work. 

2. 	 Give a detailed description of several SADiET>I facilities that are only relevant to cenain 
applications. 

As many techniques can be applied to different circumstances, it's a good i-ie to read the tips for 
areas of work other than your own. 

SYNCHRONISATION 

Whether you are working to picture, running in sync with a multitrack tape machine or 
recording from a timecode DAT, you will want to lock SADiE to other pieces of equipment. 

SADiE can generate timecode and run as a master. You may want to do this 0 drive a seql' ncer; 
running on MTC (Midi Timecode) or to stripe a videotape. 

However, most mechanical machines cannot chase timecode. SADiE will not only chase 
incoming timecode, but can also locate to any point in an EDL instantaneously, so you will 
usually run SADiE as a slave to the timecode generated by other equipment. 

With SADiE slaved to timecode, you can use the transpon controls of the master machine and 
SADiE will run in sync However, if you add 9-pin control of the master machine, you can also 
control that machine's transport and locating functions from SADiE. 

Timecode carries both current·time and clocking information. For a description of the different 
types, see Appendix G . Glossary. 

CONNECTING TIMECODE 

SADiE provides a number of different ways of reading timecode to suit the user's requirements. 

To synchronise to external equipment you will need to consider both clocking and current time 
information. 


SADiE's audio clock can be synchronised to : 


• 	 Digital Audio - via AES, SPDIF or Genlock!AES ref connector 

• 	 LTC (Longitudinal TimeCode) - via the LTC In connector 

• Video clock - via the Video In connector 


Current time can be read via: 


• 	 LTC 

• 	 9-pin timecode on the RS422/9-pin pon 

• 	 VITC - can only be read on Octavia systems. 
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Here are three suggestions for connecting up SADiE for synchronisation. There are many other 
combinations but these are the simplest. Explanations appear later in this chapter. 

t . LTC method 

Connect a cab!le from the external player's (VTRlDAT / etc.) LTC output to SADiE LTC In. Be 
careful with respect to feeding balanced connections into unbalanced inputs or vice·versa. Most 
LTC fau fts are due to bad cabling. 

In Sync Setup choose; 

• 	 Frame rate - to suit 

• 	 Timecode type· LTC 

• 	 Sync mode - Slave Mode 

• 	 Slave Mode - Trigger Lock for digital playback or recording, or Chase Lock for 
analog. 

• 	 Under Autostart & Offset set autostart to 2 seconds. 

• 	 Right-mouse click on the ONLINE button and select LTC sync 

• 	 No need for 9-pin connection or Video 

Pressing ONLINE and putting the external player into play will start SADiE's EDL playing, 
following the player's current-time. 

2. LTC with 9.pin control 


Connect as per the LTC method, and setup Sync Setup the same. Additionally; 


• 	 Connect a 9.pin lead between the external player and one of SADiE's 9-pin ports. 

• 	 In 9-pin Channels Setup, enable that 9-pin port for Sony 9-pin master. 

• 	 Right-mouse click on the ONLINE button and select that 9-pin port. The menu 
will show the machine's name if it recognises it. 

• 	 No need for Video cable. 

When you press ONLINE, the transport controls will now control the external player. Play puts 
it into play and SADiE will follow. If you double-click on the EDL's time line, the external 
player will locate to that position before playing, and SADiE will wait for it to locate before 
starting. SADiE's scrub controls will jog/shuttle the external player and SADiE in sync. 

3. 9-pin sync method 

This method requires no LTC lead or LTC setup. You will need a 9-pin lead between the external 
player and SADiE's 9-pin port. Additionally you must have connect a video signal to the SADiE 
hardware's Video In to provide clocking sync This could be from the external player (if it is a 
VTR) or could be a station video sync signal. 

In Sync Setup choose; 

• 	 Frame rate - to suit 

• 	 Timecode type - 9-pin 

• 	 Sync mode - Slave Mode 
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• 	 Slave Mode - is irrelevant - your audio clock is derived from the signal on the video 
input OR external digital audio if that's enabled. Note· if your audio clock is 
referenced to external digital audio, it must be in sync with the video reference 
signal. 

• 	 Under Autostart & Offset set autostart to 2 seconds. 

• 	 Right-mouse click on the ONLINE button and select select that 9·pin port . The 
menu will show the machine's name if it recognises it. 

Press ONLINE to control the external machine. Operation is identical to method 2 above. 

Note: 	 Video lock is like chase and so varies the audio clock to lock onto the video signal and 
increased jitter may be noticed. If you're recording or playing out digitally whilst 
locked to video you'll get more solid lock if you set the clock to AES/EBU. Video lock 
is fine for analogue recording and playback. 

SETTING UP SYNC DETAILS 

From the View command in the menu bar, display the Setup window and then select the Sync 
section. 

Frame Rate: 	 Select the frame rate you are working to in frames per second: 

24 Cine film 

25 EBU - European TV 

29.97 North American TV (Colour) 
29.97 drop North American TV (Frame accurate Colour) 
30 North American TV (Monochrome) 

Timecode Type: 	 Select the type you wish to generate, or slave to. 

No Timecode Sync: Incoming timecode is ignored and no timecode is generated. The online 
button in the Transport Controls, or on the hardware controller will only 
enable 9-pin control. 

Master Mode: 	 SADiE will generate timecode and output it from the relevant socket on the 
Breakout Panel or octavia's rear panel, in one of two ways: 

• 	 Sync to Video locks the generated timecode to the clock of a video signal connected to the 
"Video" BNC socket on the panel. N.B. If you set it like this and don't 
connect a clock source, you won't get ~ timecode! Used for striping a 
videotape, with a Station Clock connected to the BNC. 

• 	 Sync to Word Clock is the normal setting, where the generated timecode is locked to the 
digital audio clock currently generating SADiE's sample rate. The source of 
this clock is selected in the Audio section of the Setup window. 
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Slave Mode: 	 SADiE will follow the timecode arriving at the relevant timecode input 
socket, in one of two ways: 

• 	 Trigger Lock: After receiving timecode, SADiE starts at a synchronised point and then 
runs on its current digital audio clock, as described above. After several 
minutes it is possible that there will be a drift between SADiE and the 
timecode, unless you have a reliable station clock to which you can Genlock 
all equipment. 

• 	 Chase Lock: SADiE's audio clock follows the incoming timecode so that the sample rate 
is continuously varied to track it and therefore make slight variations in 
replay speed. 

NOTES: In either slave mode, timecode arriving at SADiE's LTC input is pennanently fed 
through to the LTC output (not regenerated). 

In Chase Lock, variations in the replay sample rate from chasing a VTR will mean that 
the digital audio output is unlikely to be acceptable to other equipment, such as the 
digital inputs of a DAT recorder. It is generally best to use Trigger Lock for digital 
transfers and Chase Lock when doing analogue transfers. 

Timecode Slave: 
• TimeSync Turns on SADiE's TimeSync function. At jumps in incoming timecode value 

. which result when a machine recording field timecode is stopped and 
restarted - SADiE creates a new Track and automatically relocates to the new 
value so that EDL Entries are automatically placed at the correct point in the 
EDL with respect to their timecode. Similarly in playback SADiE will 
follow the jumps in timecode. See Synching Rushes below. 

N.B. You need to have Autotake ON in the Transport Controls when 
using TimeSync. 

• 	 Don't stop after valid TC. If this is selected, if timecode disappears for longer than the 
tlywheel time, it will be ignored, and SADiE will continue playback 
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Double-click on the + sign next to the "Sync" label in the Setup window to display the sub­
section"Autostart & Offset" . 

Autostart Time sets the delay between SADiE detecting incoming timecode and starting 
playback in Slave mode, so that the current EDL can be compiled. The 
default value of 2 seconds is adequate for most situations. If you find that 
SADiE misses the trigger point in complicated EDLs, increase the delay. The 
display is adjustable in the same way as all other time displays. 

Timecode Offset sets a fIXed difference between SADiE's EDL time and the incoming 
timecode in Slave mode and the generated timecode in Master mode. 

Flywheel Length Frames sets the amount SADiE runs-on after incoming timecode stops. 
Record Stop Time Sets the time between timecode disappearing and SADiE stopping record 

while slave to timecode 
Record Timestamp Delay is the time between SADiE recognising a new timecode and 

timestamping the track it is recording. When SADiE is recording in sync it 
will wait until timecode is steady, and then it will timestamp the recording, 
back calculating the time to the start of the track. You may find that when 
Timesync is enabled, during timecode breaks SADiE may recognise a 
number of timecode breaks and perhaps record a number of very short 
tracks before the timecode stabilises and the real new slate begins. If this 
happens, try increasing the Record Timestamp Delay and SADiE will wait 
longer after a break before it starts timestamping and creating new tracks. 

Note: 	 in earlier versions of the SADiE v3 manual and helpfile, this function has been I 
incorrectly documented and it was suggested that this would add a timecode offset. This ; 
is not the case. 

ENABLING AND DISABLING SYNCHRONISATION 

The ONLINE button in the Transport controls or on the hardware controller enables and disables 
timecode synchronisation (and SONY 9-pin external machine control). Timecode 
synchronisation is enabled as follows : 

Timecode mode When ONLINE is pressed:­

Master SADiE will generate timecode when the current-time cursor is 
movlTIg. 

Slave SADiE will not start until incoming timecode is present, followed by 
the delay set under" Autostart Time". The Transport Controls are 
operating the 9-pin external machine if 9-pin is enabled (except record, 
which is still working in SADiE's play list). 

No Timecode Sync The online button has no effect on synchronisation. 

If 9-pin machines are enabled, right-mouse clicking on the ONLINE button shows a menu where 
you can choose which 9-pin machine to control. If you are using LTC for syncing, there will be 
an additional option: LTC sync which will stop transport commands being sent to a 9-pin device 
when ONLINE is pressed. 

NOTE: The Transport Controls have to be controlling a Playlist for the ONLINE button to be 
available, so a Playlist has to be the active window. 
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MONITORING 	TIMECODE SYNC 

The Sync Monitor window can be displayed from the View menu and gives you a visual 
indication of the quality of the incoming LTC, MTC or VITC timecode when sync is enabled. 

Both the incoming and SADiE's internal timecode values are displayed at the top. 

The graph continually redisplays itself and shows the sample rate variation that would have to be 
applied to chase the incoming timecode. Maximum and minimum variations on the graph in view 
are shown. 

In Trigger Lock, this will indicate potential drift. 

In Chase Lock, it will represent the amount SADiE has to chase to keep in sync. 

In Chase Lock, the Sample Rate display will show the sample rate being vaned, and the Sample 
Error will indicate by how much. 

The Timecode Reader Status indicates whether timecode is being received. 

SETTING UP 9-PIN CONTROL 

From the View command in the menu bar, display the Setup window and then select the 9-Pin 
Control. section. 

Nine-pin channels 	 There are four channels available on Studio Audio's CAT or Kitten RS 422 
interface cards, each represented by one of the four-way break-out leads 
connected to the card 

One channel may be used for a set of hardware controllers. Enable them by 
selecting that channel to "Hardware Controllers" after they are connected. 

The rest are available for control of external machines. For each machine 
that you connect to a 9-pin channel, select "Sony 9-pin Master". 

Double-click on the + sign next to the "9-Pin Contro'" label in the Setup window to display the 
sub-section "Machine Control Setup". 

Machines 	 Names each machine on a 9-pin channel. The name appears in the list 
displayed by right-clicking on the Transport Controls' ONLINE button, so 
that you can pre-select which machines SADiE will control when the button 
is pressed. 

Use 9-pin Locate Command & Use SADiE's Locate function. You have the choice between 
using the machine's own 9-pin locate command, or SADiE's own method 
which controls the fast forward and shuttling seperately. 9-pin locate 
command will be more accurate, but in achieving that accuracy, may well 
take longer to position the tape. Which method you use depends on the 9­
pin machine itself and the particular job you are working on. If for instance 
you are synching daily rushes with short timecode run-ups, it's Ilikely to be 
more efficient to go for the accuracy of the 9-pin locate, whereas if you are 
tracklaying and it doesn't really matter where the 9-pin machine starts 
within a few frames, then choose SADiE's locate function. 

Approx, machine FF / R W speed & Allowed locate error. These are the settings for SADiE's 
Locate function. FF/RW speed is the approximate maximum speed the 
machine reaches in fast forward - this is the speed ratio - 080 for instance 
means the 9-pin machine moves the tape 80 seconds during every real-time 
second. Locate error is measured in frames. 
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Machine Time 	 Selects the source of the timecode that SADiE reads from the external 
machine connected to the 9-pin socket. 

Machine Control Options. Allows you to disable or enable record options over 9-pin. SADiE's 
Machine Control windows (opened from the View menu) allow you to put 
a remote machine into record. , but you may wish, for instance, to disable 
video record options on a video machine. 

USING 9-PIN CONTROL IN SYNC 

The ONUNE button in the Transport controls or on the hardware controller enables and disables 
both timecode synchronisation and 9-pin machine control. Right-clicking over the button pre­
selects which (if any) machines will be brought online, or allows you to select LTC sync only. 

To control and lock to a machine, such as a VTR, you will have set up machine control and be 
running SADiE as a slave to the timecode from it. 

1. 	 Make the Playlist you want to play the active window. 

2. 	 Press the ONLINE button. 

3. 	 Use the transport Controls or hardware controller to play or scrub the audio and picture in 
sync. 

NOTE: SADiE will lock to the VTR's playback position. You can locate the VTR by: 

• 	 using SADiE's rewind/fwd buttons or scrubbing. 

• 	 going to a stored locator point 

• 	 double-clicking in the time bar 

• 	 repositioning the current-time cursor and pressing SHirr +PLAYon the hardware 
controller. 

The VTR will not re-Iocate if you position the current-time cursor and start playback 
normally. 

9-PIN MACHINE CONTROL 

You can remotely control a 9-pin machine with its own separate transport controls. This is 
independent of the playlist, although the two methods can be combined. 

Connect and setup the 9-pin channel (see Setting up 9-pin Control above). Although Sony 9-pin, or 
P2 protocol is a 'standard', different machines will implement it in subtly different ways - for 
instance some machines will have 2 audio channels, some 4, and others more. Some are video 
machines, but of course DATs have no video channel. 

SADiE implements a generic set of 9-pin commands, but it's possible that some machines may not 
implement these commands in exactly the standard way. 

Be sure to check the operation with your machine before working on master tapes - and in 
particular check that your machine doesn't interpret INSERT as ASSEMBLE !! 

If you have trouble with 9-pin control, consult your dealer with details of the machine; we may 
be able to provide a custom software driver better suited to your device. 

Under the View menu, select Machine Control and then choose the device you wish to control. 
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You will see this window: 

This gives you control of the Transport and Edit controls for the remote machine, allowing you 
to put it in and out of record, or play and jog it independantly from the playlist. 

The top section is for 9-pin Transport Controls: 

• 	 Time display for the machines current time_ This display will say TAPE if there's no tape in 
the machine_; MACHINE !!!! if there is nothing connected on the 9-pin channel. If there is a 
good time display but all buttons are grey, then the machine is probably set to local mode. 

• 	 Transport buttons, rewind, fast forward, stop, play, record_ The button above 'record' is for 
tape eject. 

• 	 The wheel and nudge buttons above are for scrub and operate in the same way as SADiE's 
normal transport controls - drag left/right for scrub and up/down for shuttle. 

• 	 Goto PreroU locates the machine to a pre-roll before the Edit In Point. 

• Setup opens up the 9-pin setup page. 

Next is the Edit section: 

• 	 Edit In point and Edit Out Point - set the edit points. These have fields for a time - you can 
double click and type in a new time. Or click on a digit and drag the mouse up or down to 
increase or decrease that value (as with SADiE's other green time displays). Grab copies the 9­
pin time from the 9-pin transport controls into the field . Reset sets it to nothing. After an edit 
has been performed, most 9-pin machines reset their edit points - Recall will call back the last 
edit time. 
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• 	 Preview locates the machine to its pre-roll time, into play, then between the edit points the 
machine will go E-E 

• 	 Auto-Edit actually performs the edit. It locates the machine to its pre-roll time, into play then 
punches into record on the enabled channels at the In point and out at the Out point. 

• 	 Review will locate to the pre-roll time and just play until it reaches the Edit Out point. You 
would use this after you've performed the edit, to check it. 

• 	 Edit and Edit off put the machine straight in (and out) of edit without using the In and Out 
pomts. 

Lastly the Record Enable section: 

• 	 Rec inhibit is a warning - the tape is protected. 

• 	 Insert and Assemble choose the record mode. Assemble mode can be disabled in 9-pin setup. 

• 	 at, a2, aJ, a4, V, tc enable the Audio 1,2,3,4, Video and Timecode channels for record. 

• 	 E-E - Full E-E puts all channels into 'Input Monitor'. Select E-E, puts only those channels 
enabled for record into 'input monitor'. 

NOTE: If you have ONLINE pressed, and the same machine selected for syncing the playlist, 
then both transport controls will operate the remote machine. 

WORKING WITH SYNC MATERIAL 

When working to picture, or other material where sync is important, you will want to: 

1. 	 Record audio material that is already in sync When SADiE is locked to the source machine, 
material you record in will be timestamped with its timecode and positioned correspondingly 
in the EDL. This also occurs when Autoconforming and when using SADiE's TimeSync 
feature, both detailed in sections below. 

2. 	 "Sync up" material that is not yet in sync - i.e. position it in the EDL so that it is correctly 
synchronised. This may take the form of syncing film rushes, or tracklaying sound effects etc. 

NOTE: 	 It is often most convenient to have two EDLs open for this. You can then have one 
as your source EDL - with the Entries in their original positions, and the second as 
your destination EDL into which you paste the Entries (either cut or copied from 
the first EDL) at their new, "sync-ed-up" positions. 

3. 	 Then keep it in sync while you trim, edit and mix it. 

MAINT AINING SYNC 

Once material is in SADiE, 

The LOCK ALL ENTRIES button on the Playlist toolbar and the LOCK button on the hardware 
controller stop any Entry from being moved in the EDL, and so stop accidental loss of sync. 

Changing an Entry's EDL times in the Text EDL will not alter sync when LOCK is on, but it will 
slip the Entry when LOCK is off. 

Editing follows all the instructions described in chapter 5. To maintain sync, use Playlist Editing 
in "EDL mode". When you want to slip an Entry against sync, switch to "SOURCE mode". 
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Individual Entries can be unlocked and slipped against sync when they are being adjusted in the 
Trim Editor, before being written back to the EDL 

SYNCING RUSHES 

If you are using timecode synchronisation and 9-pin control, the audio takes for film rushes 
(dai lies in the U. S.) can be put in sync in SADiE so that they can be laid back to a telecine 
videotape. 

NON-TIMECODE RUSHES (USING CLAPPERBOARDS) 

This is a recommended method; for an alternative, see the section below on Tracklaying, which is 
a very similar process. 

If the takes are loaded into SADiE in order, you can sync them up in the same EDL. If not, it is 
better to open a second, empty EDL, then one by one cut or copy the entries out of the first and 
paste them into the second in roughly the right place, and adjust them until they are in sync. 

1. 	 Record all the audio into SADiE, separate takes as separate Tracks. 

2. 	 Find the audio Entry for the first take and cut or copy it to the paste buffer. 

3. 	 With SADiE slaved to, and 9-pin controlling, the telecine VT, scrub the picture to the first 
clapperboard. SADiE's current-time cursor will now be at the sync point. 

4. 	 Paste the Clip for this take into the (second) EDL near the current time (hardware controllers 
will paste it ~ the current time). 

5. 	 Pre-select HOT and SOURCE mode and turn on Playlist Editing. 
- If you are using a mouse, have the automatic MOUSE EDIT SELECTION OFF - button up, 

select the Entry and press the PLA YLIST EDITING button. 
- On the hardware controllers, simply press EDIT/SELECT. 

6. 	 Adjust the audio, scrubbing it across the current-time cursor to line it up on the audio of the 
clap. 

7. 	 Turn off Playlist Editing. The take is in sync! Repeat for the others. 

Lay back the audio from SADiE to the VTR. Run SADiE in Chase Lock for analogue transfers. 

NOTE: 	 If you want to layoff an Autoconform DAT at the same time, you can also connect 
SADiE's digital outputs to a timecode DAT machine locked to the VTR timecode 
output.. In this case, run SADiE in Trigger Lock. 

RUSHES WITH TIMECODE BOARDS 

The audio takes will have field timecode with them - we are assuming that this matches the 
timecode on the boards. 

1. 	 Record the audio takes into SADiE, locked to the audio player, with TimeSync ON. - Use 
Trigger Lock for digital transfers; Chase Lock for analogue. Remember that you must also 
have Autotake ON in the Transport Controls. 

You will then have an EDL Entry for each take, positioned at its field timecode value in the 
EDL Each needs to be moved to a new EDL position representing the continuous timecode 
of the telecine VT. This is best done by opening a second EDL (the New IPlaylist command 
on the File menu) and pasting each Entry into that at the new time. 
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HINT: 	 If SADiE stops recording at the end of a single take and doesn't not go back into record 
again, it may be because you have RECORD STOP TIME in Sync setup set too low. This 
is time after timecode disappears before SADiE stops recording and thus if it is set to 
zero the TIMESYNC operation will stop on the first timecode break. 

2. 	 LOCK all Entries in both EDLs. Select Autoplace "Hotspot to Current-time" in the second 
EDL. 

3. 	 Check that the second EDL is active, and ... 

4. 	 With SADiE slaved to, and 9-pin controlling, the telecine VT, scrub the picture to the first 
timecode board. SADiE's current-time cursor in the second EDL will now be at the sync 
point. 

Mouse users: 5. 	 Make the first EDL active, pre-select HOT and SOURCE mode in the Transport 
Controls, and select the required Entry. Turn PLAYLIST EDITING ON, and for safety have 
the automatic MOUSE EDIT SELECTION OFF - button up. 

6. 	 Read the time on the board, and enter it into the edit point time display in the Transport 
Controls. This sets the Entry's Hotspot to the timecode value on the board. 

7. 	 CUT or COpy the Entry, make the second EDL active and paste the Entry into it. Its 
Hotspot will be positioned at the sync point, and the take is in sync. 

HWC users: 5. 	 Make the first EDL active with the WINDOW button. Pre-select HOT and EDL mode and 
select the required Entry (best to use PREVIOUS or NEXT). Press EDIT/SELECT to turn on 
Play list Editing. 

6. 	 Adjust the scrubwheel until the time in the SOURCE display on the controller matches 
that on the board. This sets the Entry's Hotspot to the timecode value on the board. Press 
EDIT/SELECT again to confirm the adjustment. 

7. 	 CUT or COpy the Entry. Press WINDOW to make the second EDL active and press PASTE. 

The Entry will be positioned with its hotspot at the sync point, and the take is in sync. 

Lay back the audio from SADiE to the VTR. Run SADiE in Chase Lock for analogue transfers. 

NOTE: 	 If you want to layoff an Autoconform OAT at the same time, you can also connect 
SADiE's digital outputs to a timecode OAT machine locked to the VTR timecode 
output.. In this case, run SADiE in Trigger Lock. 

AATON OR ARRIFLEX RUSHES 

The audio takes from these rushes will have field timecode with them. This timecode is also 
generated by the camera equipment and conventionally laid onto track 3 of the telecine VT. 
SADiE's TimeSync feature takes advantage of this to sync the rushes up totally automatically in 
just two passes of the EDL. 

1. 	 Record the audio takes into SADiE, locked to the audio player, with TimeSync ON. - Use 
Trigger Lock for digital transfers; Chase Lock for analogue. Remember that you must also 
have Autotake ON in the Transport Controls. 

You will then have an EDL Entry for each take, positioned at its field timecode value in the 
EDL. Because you can now lock SADiE to the field timecode on track 3, these can be 
positioned in sync as you lay them back to the telecine VT. 
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2. 	 Feed the output of the field timecode on the VTR (usually Track 3) to SADiE's LTC input. 
Run SADiE in Chase Lock and record SADiE's analogue audio outputs to the VTR. 

NOTE: 	 If you want to layoff an Autoconform OAT at the same time, you can also connect 
SADiE's digital outputs to a timecode OAT machine locked to the VTR timecode 
output.. In this case, run SADiE in Trigger Lock. 

TRACKLAYING 

This is only a suggested method - you will probably develop your own. Also read the section 
above on syncing non-timecode rushes, as that is a very similar process. 

The hotspot is a useful marker that you can set at a particular point within any Clip or EDL 
Entry and then use as the reference when placing it in an EDL For example, when you place a 
sound effect of a screech of car tyres followed by a crash, it's probably the crash that you want to 
position accurately. It is also useful for "back-timing", to get a certain bit of music to coincide 
with the end of speech, etc. 

For each audio Entry (or Clip in the Clipstore) use Playlist Editing or the Trim Editor to set the 
hotspot at the audible cue (see Chapter 5, Editing, and the Clip Details window section of 
Chapter 4, Arranging an EDL). 

Then, with 9-pin control of the VTR enabled, use SADiE's scrubwheel to find to the visual cue 
pomt. 

The current-time cursor is now at the sync point. 

If the Entry is already in the Playlist, use the Snap-Hotspot-to-Current-time function (by right­
clicking over the Entry in the Play list) to position the hotspot at the sync point, and so 
synchronise the Entry. 

If your Entry is not yet in the Playlist, paste it in using Autoplace set to "Hotspot to current 
time". 

AUTOCONFORMING 

OVERVIEW 

In the film and television industries, Autoconforming is the process of automatically assembling 
an audio soundtrack so that the audio edits conform (correspond) to the picture edits. 

A typical location shoot has the following basic elements: 

Generator 

Tinecode 
Irp..t Audiolnpoi 

Microphone 
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A film camera records the pictures and an audio recorder records the sound. Both also record 
timecode from a generator, normally supplying time-of-day code. When a roll of film and tape are 
used up, they are given the same name· usually a reel number· so that pictures and sound can be 
synchronised later. 

With video, both pictures and sound will be recorded together on one recorder, which will also 
record timecode. These tapes (e.g. Betacam) are labelled with reel numbers. 

The pictures are usually edited first. Editors will make edit decisions as they splice or dub 
together sections from the various source reels, making a final edit reel. These decisions can be 
given in the form of an Edit Decision List (EDL) file which details the source reel and timeco· 
reference that each section comes from, and the EDL time where it belongs in the final edit. The 
most common EDL file formats used in the industry are CMXn• type files. 

Picture editing systems often only use a low fidelity or mono soundtrack as a guide for the pier.ure 
editor, so to assemble the final soundtrack the audio is copied from the original source reels. 

Autoconforming on SADiE is a deceptively simple process to automatically record and place in 
sync the audio belonging to the EDL that was produced during picture editing. This EDL is 
imported into SADiE (usually from a floppy disk). The information is used to record all the 
required bits of audio from each source reel in turn and assemble a new SADiE EDL with audio 
Entries placed at their new timecode positions, conforming to the picture edits. The soundtrack 
in SADiE can then be run in sync with the edited pictures. 

SADiE can currently import and use CMXT>I 3200, CMX 3600, SonyTll 9000 and Lightworks'" 
EDLs. 

AUTOCONFORM SETUP 

To autoconform, SADiE must: 

A. 	have 9-pin control of the machines(s) you want to record from. See "Setting Up 9-Pin 
Control" in the Synchronisation section at the beginning of this chapter. You can set up 9-pin 
control of up to four machines. Note that there is a choice of methods for controlling the way 
the 9-pin control locates a machine - we suggest "use 9-pin locate" is more accurate for 
autconforming. 

B. 	 be synchronised in Slave mode to the machine you are currently recording from. If you are 
recording digitally, use Trigger Lock; if analogue, use Chase Lock. See the Synchronisation 
section. 

Consequently, SADiE should have both 9-pin (RS422) and LTC (timecode) connections to the 
source machine. 

For each Entry, SADiE can record a bit more audio than has been specified in the picture editor's 
EDL. This means that you have pre- and post-handles available so that you can increase 
crossfades, adjust edits and so on. You may want to change the settings for these in the 
Autoconform page of the Setup window: 

Lead Time Duration 	 Sets the "pre-handle" recorded at the beginning of each Entry. 

Overrun Duration 	 Sets the "post-handle" recorded at the end of each Entry. 

Minimum gap between takes 	 The gap between items on the source reel that will cause SADiE 
to record the next one in a new take. At gaps less than this, 
SADiE will continue recording the next item in the same take 
and as part of the same Track. A recomme ded setting is 15-20 
seconds. 
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NOTE: 	 These times are used to make the autoconform list as described in step 7 below, so 
there will be no effect if you change them in the Setup window after that stage (for 
example, before continuing with a partly recorded list). 

Setting the pre· and post· handles too long may result in SADiE trying to record before 
the beginning or after the end of the reel! 

Additional 9·pin pre·roll 	 The 9-pin locate functions already rolls the 9-pin machine back 
to a time before the actual locate time. This autoconform setting 
allows you to increase this pre-roll time to ensure that the whole 
of the take is recorded. You don't need to have timecode on the 
source tape in this pre-roll as SADiE rolls the machine 
backwards frame by frame. Note that this setting has no effect 
on the record list, and can be changed during the autoconform 
process. 

AUTOCONFORMING IN SADiE 

1. 	 Select "impon component" from the Project Window. In the next dialogue box, locate the file 
(a CMX-type EDL file is likely to have been given to you on a floppy disk, if so change the 
drive box to "a:") and click "OK". If the file has a .txt suffix, in the File Name box type *.txt 
then hit return to list files . 

2. 	 SADiE will detect that you are opening an EDL that is not in SADiE3 format, and the Auto­
Conven box will appear. Select the format of the file (if in doubt, try CMX 3600), click "OK" 
and SADiE will automatically conven it to SADiE3 format and save the new EDL in the 
project. Double click on the new EDL icon in the Project window to display it in a new 
P laylist. 

3. 	 In the Playlist, the Entries for which audio hasn't been recorded into SADiE yet will be 
drawn as "ghosts" . At this point, if you wish, you may select and delete any of the ghost 
Entries that you know you don't want to be included in the list to be recorded. You can even 
cut them with the scissors. In the Text EDL pane, the" Audio Present" column for 
unrecorded Entries will read "No", and you can edit any parameters shown in black (rather 
than grey) . 

4. 	 Display the autoconform list, which is one of the three text panes attached to the Playlist: 
press the TEX, PANE button on the Playlist toolbar and select the Autoconfonn tab at the III 

'ITXT PANE bottom left . If necessary, adjust the size of the pane by dragging the edges of the Playlist 
window or the border between the Playlist and the text pane. 

The Autoconform toolbar will appear: 

This can be floated or attached to the Play list by 
right-clicking on it. 

5. 	 Press MAKE LIST. SADiE will compile a list of all items that need to be recorded. The{I) 
name/number of each reel used in the EDL will appear in the column on the left. Selecting 

MAKEUST 
each reel with the mouse or the cursor (arrow) keys will display a list of items that need to be 
recorded from it, detailed in the table on the right. 

NOTE: 	 The autoconform list is compiled from all currently open EDLs, so don't 
accidentally have another EDL open that has any audio missing, or it will be 
included in the list. The list of items to be recorded will also remain unchanged 
until you MAKE LIST again, even if you close tE.e current EDL and open a new one. 
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MAKE 

11 
MONO / STEREO 

6. 	 You now have the option of editing the list before you record the Entries. Each parameter 
displayed in black (rather than grey) can be edited by double-clicking it with the mouse. 
Alternatively, select i( using the tab key to move between the reel list and the details (able and 
the cursor keys to move between parameters in the table, then press Enter/Return (.J). 

You can: 

• 	 Alter the start or end times that carne from the Picture Editor's EDL. 

• 	 Change whether an item is recorded in mono or stereo. The initial setting will have come 
from the imported EDL, but can be overridden by selecting the item and pressing the 
MAKE MONO/STEREO button, which changes the "Number of Channels" setting. This is 
often necessary if the picture editing system has used the audio in mono as a guide, but you 
want the stereo recording for your soundtrack_ 

• 	 Change the "First Channel" setting. This indicates which channel(s) of the picture editint 
system the audio was on, and will correspond to the channels of the source reel unless they 
were re-allocated during the edit. To relate these to SADiE's inputs, see the description of 
the Auroconform Recording box in step 7, below. 

• 	 Alter the "To Be Recorded" status so that individual items will not be recorded this time. 
This may be because you want to record certain items at a later date by doing another 
recording pass. Perhaps you need to take the audio from a different source - for example, 
using music from the original CD rather than the Betacam reel used during picture editing. 

• 	 Manually add or delete items from the list to be recorded. Note that deleting a record item 
is different from deleting an Entry in the EDL, as several EDL Entries may come from a 
single item. 
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7. 	 From the reel list, select the first reel that you want to record from and load it into the source 
machine. Press the autoconform RECORD button. The Autoconforrn Recording dialogue box 

RECOlJ) 
will appear: 

The input channels used for recording the items can be selected as follows: 

Use specified inputs 	 This setting uses the channel numbers in the autoconform list to 
determine which SADiE or octavia inputs each item is recorded 
from. octavia users will be able to record all channels 
simultaneously; SADiE XS/XACT users will have to make separate 
passes, recording two channels at a time and changing audio 
connections where necessary. 

Override inputs 	 Channel numbers in the autoconform list are ignored and all material 
is recorded from the inputs selected on the adjacent box. This will be 
necessary if the picture editing system has spread audio across several 
channels, but you are now recording it all from a stereo machine. 

Output selection 	 Determines the outputs used to monitor the recording. As 
autoconform recording is a background process, you can select 
different outputs from those used by your current foreground mixer 
and then do something else with another EDL whilst SADiE is busy 
autoconforming. 

Machine selection 	 Selects which 9-pin channel will be controlled. If you have more than 
one source machine, you can switch between them here, but 
remember to change the LTC connection so that SADiE is receiving 
timecode from the correct machine. 
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8. 	 Press the START button. SADiE will take control of the machine, locating it to the correct 
place, running in sync, dropping-in to record each Entry, then dropping-out and locating to 
the next. You will see the "ghost" entries become solid as they are recorded, and the "to be 
recorded" status of each item in the list will change. 

The CLOSE button closes the box so that you can do other work in the foreground while 
SADiE continues recording in the background. Press the RECORD button on the 
AutOconform toolbar to open the box again. 

The STOP button interrupts the process. 

NOTE: 	 As this is a background process, the Autoconform Record box takes the place of the 
Transport Controls' ONlINE button and Record section, although you will see the 
Track names appearing there. 

9. When all the items from the reel have been recorded, every "To Be Recorded" status will have 
changed to "No". Close the Record box and repeat from step 7 for each reel in turn. 

HINT: 	 If you wish to re-record the take for whatever reason, double click on the "To be 
Recorded" to change it from "No" to "Yes" and you will at that point be offered 
the chance to delete the previous recording. 

The Tracks that SADiE has recorded (and the EDL Entries) will be named after the reel that they 
carne from, with an autotake number added for each take. If you are recording to a version 3­
formatted audio disk, timecode values will be included in the name. 

NOTE: 	 If you get half way through the process and decide to call it a night, simply stop 
recording and close down in the normal way. When you open the EDL again 
tomorrow, you can continue from step 6 above. 

AUTOCONFORMING IN BRIEF 

The above list gave all possible options. In practice, most autoconform jobs can be done in the 
following steps: 

1. 	 Import the CMX-type EDL into your Project, converting it is it imports. 

2. 	 Press the TEXT PANE button and display the Autoconform pane. -Ir~ 3. 	 Press the MAKE LIST button. 
MAKEUST 

II 4. Select a reel in the list, put it in the source machine and press autoconform RECORD. 

RECOJU> S. Check the details in the Record box and press START. 

6. When all items are recorded, close the box and repeat from step 6 for the next reel. 
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HINTS AND TIPS 

Record Status 

SADiE) employs a new feature to avoid insufficient timecode run-ups causing problems when 
autoconforming. Recording is started as soon as the source machine starts playing at the required 
point, regardless of whether it is supplying good timecode. When timecode is stable, it is used to 
timestamp the recorded Track retrospectively and thus position Entries in sync. This is why the 
"internal time" display in the Autoconform Record box often briefly starts counting from zero 
at the beginning of each recording, and flips to the correct time when the timecode is stable, and 
also why the start times of the Tracks wiH often be slightly before start times in the autoconform 
list. 

If the 'internal time' never changes to be the same as the 'machine time', and SADiE continues 
recording without timestamping, then this suggests that SADiE has not been able to synchronise 
correctly. SADiE is not receiving timecode for some reason Perhaps there is no timecode on the 
tape, or bad code? Check that SADiE's sync settings are correct and that cables are good. Be 
particularly careful of balanced to unbalanced LTC cables - if the cold wire is shorted to ground, 
this is likely to make the timecode unreadable_ Bad cables are the single most common reason for 
this type of failure. 

Entries not filling in ? 

If you find that some Entries in the Playlist are not becoming solid when they should, or the "To 
Be Recorded" status of record items is not changing when t'he item appears to have recorded, 
check the start times of these Tracks in your Clipstore. If they are later than the start times in the 
autoconform list, SADiE is missing the very beginning of the item. Increasing the 9-pin Locate 
Pre-roll setting in the Setup window should cure this . We recommend at least) seconds for most 
machines. 

Find New Track 

Find New Track is a command available when right-clicking a "ghost" entry in the Playlist. 
Ghosts are drawn when there is not sufficient audio in SADiE to play the whole Entry. 
However, it may be possible to edit the ghost entry leaving one that could be played. Selecting 
Find New Track will then update the Playlist, to show the Entry with audio present in a solid 
colour. Find New Track checks for tracks to satisfy the Reel name and time code range required. 

This might be useful if a long record item was not quite recorded in full - perhaps because 
autoconforming was interrupted just before the end, or the 9-pin locate pre-roll was set so that the 
very beginning of the item was missed. Make a cut in the Entry, leaving two ghosts Entries, the 
larger of which actually has all the audio present. "Find New Track" for this and it will be drawn 
solid, recognising that the Track is present. Now, if you make a new autoconform list, you will 
only 'have to record enough audio to cover the smaller Entry. 

If you load a new CMX-type EDL that relates to audio that already exists - you will find that the 
Find New Track function acts automatically and so will "fill in" entries which are satisfied (reel 
name and timecode ranges) by existing audio. If the audio is not in the current project you will 
'have to import it before it can match to the EDL. 

Cross-referring Autoconform list entries and EDL entries 

The autoconforrn list and the EDL are displaying essentially the same information but ordered 
differently. There are times when you might want to view or manipulate EDL entries that belong 
to autoconform list items or perhaps even whole ree1. 
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The 'Add EDL entries for item/reel to the selection' buttons on the Autoconform toolbar, 
searches through the current EDL for entries that corne from the selected record item (or whole 
reel, depending on which button is pushed), and selects them in red. The next function· for 
instance copy/cut, or more complex operations like 1.10ve Selected Clips' (see below) will operate 
on all the red entries. 

NOTE: 	 these add to the selection· if you only want one item or reel selected in red, then you'll 
have to click in an empty pan of the EDL to clear the selection before you stan. 
Because these add to the selection, you can use the function again and again to select a 
group of items or a number of reels. 

Multi·track edit lists as multiple stereo lists 

As the CMX·type is the most commonly recognised format, you maybe presented with a mult i· 
track list that has been split into several stereo lists. Alternatively the channel information may be 
written in the reel name, as the channel information is restricted to 2 because of the CMX format. 
And so you may have a list with say, 4 reels referring to channels 1&2,3&4 etc. When you 
convert the EDL all entries will be on streams 1&2. 

If you use the 'Add EDL entries for reeL.' function above, a whole reels·worth of entries wili be 
selected in the EDL. You could then use the 1.1ove selected clips onto stream . .' option in the 
Playlist menu, to move those clips to a new pair of streams. 

Make Stereo / Make Mono 

The MAKE MONO/ STEREO buttons, on the autoconform toolbar change the EDL entries to be

fE mono or stereo as well as the record item. Note that there is a MA.KE STEREO option on the entry 
MONO/STEREO 	 menu that appears when you right·mouse click on an entry. This is only available if stereo audio 

material is actually available for that entry. 

Mono Recordings 

If your source material is mono and from a mono tape, the normal 'Override Input channel' 
setting will still try to record from one side of stereo, depending on which reel channel the record 
item is from· left for odd number channels, right for even. However in the Autoconform page in 
Setup, there is an option to Always record mono items on the left channel to further override 
this. 

The Autoconform list 

The Autoconform list in the table page of the EDL, is saved along with the EDL when you l-'ress 
SAVE EDL. 
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The MAKE LIST button always makes a completely fresh list, searching through the EDL for any 
MAIlEUST ghosted or missing items and creating a brand new record item list. 

However if you are have already started the autoconform, you may wish to retain an item in the 
list even if it has been recorded and it's marked NO in the 'To be recorded' field. Or perhaps 
you've made some edits to the list and not yet recorded these items - MAKE LIST will completely 
re-set this. 

But you need to add some extra entries from a new EDL ! For this situation there is the REFRESH 
REF1lESH 
UST LIST button, which keeps your old edited conform entries intact, but adds in new conform entries -

for the new clips. 

Or alternatively, you are given a completely new edit list that includes some extra entries. When 
you've convened this new EDL, you may want to continue using your old autoconform list. In 
this case select IMPORT CONFORM LIST from the File menu, and select the old EDL. This will 
pull in just the autoconform list from the old EDL; you can then REFRESH LIST and continue, 
with any new entries added to the record list. 

Note that IMPORT CONFORM LIST doesn't merge with any existing conform list, it overwrites it. 
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SADiE & LIGHTWORKSTM INTEGRATION 

The SADiE software can be used to do the audio post·production for a project that has been 
edited on a Lightworks video editor. There are several levels of integration that will help you 
complete the job. They are: 

Auto conforming from a Lightworks .EDG ftle. 


The ability to read Lightworks audio files. 


The ability to write Lightworks audio ftles. 


The ability to pass on your project to an AMS AudioFile.™ 


Note: 	 We've included AMS!Neve Audiofile in this section because some Audiofiles are able 
to read Lightworks projects. The procedure for taking SADiE projects into the 
Audiofile is very similar that for Lightworks, but be sure to read the specific sections 
later in this document. 

AUTO CONFORMING 

Auto conforming is covered in depth earlier in this chapter. There are, however, a few things that 
are specific to Lightworks .EDG files and Lightworks Multitrack EDLs. The .EDG file is the edit 
decision list that a Lightworks video editor produces. (The "G" stands for generic). It is more 
convenient if it was created omitting any video entries, otherwise the file could be too large to 
move on a floppy disk. 

A Lightworks Multitrack EDL is a variation on a CMX EDL with the ability to give you more 
than 4 specified tracks. 

Before you import the file there is one setting in the setup window that affects how it is 
imported. 
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Lightworks digitises stereo sound as 2 mono files. If you know that the audio is stereo then you 
can tell SADiE to "Merge entries on adjacent streams", making a link between the 2 sides. This 
will save time later, when editing the audio as the entries will a1Ti be stereo rather that 2 side 

by side mono entries. Of course, you can always group or ungroup the entries 
individually using the buttons on the playlist tool bar. 
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The Lightworks Multitrack EDL options also have the ability to use a comment field as an audio 
mapping facility. This is for import and export . So if you import the following MultiTrack EDL 
you will end up with the SADiE edl below (or vice versa) 
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TITLE: L"WKSI FORMAT: Multitrack Audio 
001 N/A A12 C 00:01:50:09 00:02:39:14 00:00:08:10 00:00:57:15 
002 N / A A34 C 00:02:39:14 00:03:12:21 00:00:57:15 00:01:30:22 
COMMENT: AUDIO MAPPING FROM CHI TO CH3 FROM CH2 TO CH4 
003 N/ A A56 C 00:03:12:21 00:03:42:07 00:01:30:22 00:02:00:<l8 
COMMENT: AUDIO MAPPING FROM CHI TO CH5 FROM CH2 TO CH6 
004 N/ A A78 C 00:03:42:07 00:04:02:03 00;02:00;08 00:02:20:04 
COMMENT: AUDIO MAPPING FROM CHI TO CID FROM CH2 TO CH8 
005 N/A A56 C 00:04:02:03 00:04:22:15 00:02:20:04 00:02:40: 16 
COMMENT: AlJDIO MAPPING FROM CHI TO CHS FROM CH2 TO CH6 
006 N/A A34 C 00;04:22: 15 00:04:59:02 00;02:40; 16 00:03: 17:03 
COMMENT: AUDIO MAPPING FROM CHI TO CH3 FROM CH2 TO CH4 
007 N/A A12 C 00:04:59:02 00:05:36:08 00:03:17:03 00:03:54:09 

To import the .EDG file it is probably best to copy the ftle from a floppy disk onto the PC's hard 
drive. Use Windows Explorer to do this, copying it to a directory such as C:\Projects. Once it is 
copied you should start or open a project. 

You need tOll0rt the .EDG file into the project. You can do this by pressing the Import 

component button on the Project window toolbar or by right mouse clicking on the 
Project window, choose miscellaneous! import component. Either of these 2 options will bring 
up a standard Windows dialogue box offering you a list of files to import. Navigate to the correct 
directory. You may need to select" All Files *.*" from the List Files of Type section, in order to 
see the .EDG file. Once you have selected the file press the OK button. You may be offered a File 
Conversion dialogue box. SADiE will offer you some default names and locations for the new 
.EDL file it is going to create. You can change these if you wish but there should be no need. 
Press OK and a new .EDL file wiU be created in the Project Window. Open this .EDL by double 
clicking on it and proceed as for a normal auto conform job. Once you start auto conforming 
from tape there is nothing Lightworks specific about the project. 

The file conversion process can be made automatic by selecting the "Don't show autoconvert 
EDL dialogue if SADiE has detected the type" in the EDL Conversion section of the setup 
window. 

READING LIGHTWORKS AUDIO FILES 

When the picture editor digitise picture into the Lightworks, she!he may also digitise the correct 
sound at a quality that is usable for audio post production. The audio must have a DOS extension 
of .524 and should have and associated .ED2 file with it. The .ED2 file is a "hidden" text file that 
Lightworks creates which contains vital naming information about the audio. Stereo or twin 
track audio has one .ED2 file for each pair of audio files. 

If you are happy with the audio that was digitised then you can save yourself an auto conform 
process and use the sound directly from the Lightworks disks. Alternatively, you may receive a 
disk that contains a Lightworks Archive or Consolidated project. In any case you will need the 
.EDG file that is associated with the audio. 

The differences between the 3 alternatives are as follows: 
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Lightworks Disk: This will be a very large disk with several partitions on it. It will contain a lot 
of video and audio and may not be the most convenient interchange medium, since the 
Lightworks editor might still have work in progress that requires the disk. The audio will be in a 
folder, commonly called "Material" (but we have seen examples called "Sound") in one of the 
partitions on the disk. 

Archived Project: This is a disk that contains all the audio that was recorded for a given project, 
exactly as it was digitised on the Lightworks. The disk can be any type, but is commonly an MO 
disk or Iomega Jaz disk. 

Consolidated Project: This is a disk that contains all the audio that is referred to in a given 
Lightworks EDL plus a pre and post handle. The pre and post handle length is determined wit bin 
the Lightworks system and must be set before the disk is made. Audio that has been digitised but 
is Dot in the Lightworks EDL will not be on the disk. The disk can be any type, but is commonly 
an MO disk or Iomega Jaz disk. 

Whichever disk is given to you, you will need to attach it, or the corresponding Jaz or MO drive, 
to your SADiE system and log it on in disk management. (See Chapter 7· File Management· 
Logging Audio Disks) If in doubt over which drives are currently supported or how to connect a 
drive to your SADiE, please contact your SADiE distributor. 

When connected and logged on you will see something similar to this in the SADiE Disk 
Management window. If the Lightworks disk has partitions on it you will see multiple disks all at 
the same SCSI ID. Do not worry about this. It is perfectly alright! 
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Ligh tworks audio has the lightbulb symbol next to it. If you press the 'Show aU Files' In 
button on the Disk Management toolbar you will also see all the .ED2 files that are on the disk. If 
everything looks OK you can shut The Disk Management window. 

You now need to import the .EDG file into the project in the same way as detailed in the above 
Auto Conform section. 

Once the file is imported, you need to import the audio into the current clipstore. Either press 

the Import Source Tracks button on the Clipstore toolbar or right mouse click in the 
clipstore window and select "Import Source Tracks". Navigate to the Lightworks disk and select 
all the fires . These are normally in a folder called "Material" on the disk. Pressing the "Shift" or 
"Ctr!" button on the keyboard enables you to make multiple selections. As soon as the audio is 
imported, the ghosted entries in the .EDL should fill in. You are effectively doing an 
autoconform from disk! 

NOTE 	 If some entries fail to fill in, it is either because the audio is not on the disk, or you 
failed to import all the audio into the clipstore, or you have the wrong Sample Rate of 
Frame Rate set. 

Again, once you have got this far, the job ceases to be Lightworks specific, and just becomes a 
normal SADiE trackJay or dub, which are covered in other sections of the manual. 

Any subsequent recordings you make into this project do not need to be in Lightworks file 
format, nor do they need to reside on the Lightworks disk that was originally supplied to you. 
SADiE software can read audio from multiple disks in multiple file formats (such as SADiE3, 
.W A Y, .BWF) all within the same EDL It should be completely transparent. 

However, if you need to give an amended .EDG file and!or extra audio back to the Lightworks 
or onto an AudioFile then you may need to read the following sections. 

RECORDING LIGHTWORKS FORMAT AUDIO 

SADiE can record audio to disk in Lightworks file format. This can reside on a SADiE3 or 
Lightworks (i.e. DOS) format disk., but in most instances you will want the disk formatted in the 
FAT16 (MO) format or FAT 16 (2Gb max) format. The MO option limits the disk to having 1 
partition and is what a Lightworks machine would use to Format drives. You cannot put 
Lightworks audio on a SADiE2 format disk. 
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FA T16 format . The cluster size is 

ed to 32kbytes which fimis the 


InA,rtilirm size to 2Gbytes. The disk 

Hr-'"'rt,.in... no partition table wtlch limits 


disk size to 2Gbytes. 


Before you make any recordings, select the disk you wish to record to by pressing the IliiJ Select 
Audio Disk button in the Project Window toolbar or with a right mouse click i.n the Project 
Window, Select Audio Disk. 

Next, select the file format you wish to record in. Click the properties button on the Transport 
Record Tab. Select " tworks" from the I down list. 

Now all recordings made into this project will be to a particular disk and in Lightworks file 
format. Just like on a Lightworks, you can give the recording a long name, up to 256 characters, 
but the name of the track in Disk Management will be only 8 characters long, based on the 
following structure: 

character 1 - file type (S-sound V-video) 
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characters 2 & 4 - machine id 

character 3 - channel id (differentiates more than one channel per recording) 

characters 5-8 - recording id 

Again, the file format you record in is dependant only on whether you need to take audio back to 
the Lightworks or forward to an AudioFile at some stage. If you are bouncing (see Chapter 4­
A rranging an EDL H - Bounce-Down) the final mix to a continuous stereo track to take back to 
the Lightworks then this must be in Lightworks format. But the sound fx and wildtracks that you 
digitised to make up the mix can be in any format you like. 

If you did not bounce this final mix to the Lightworks disk, then you can copy it in Disk 
Management. {See Chapter lJor Jurther details}. 

The files that you wish to take back to the Lightworks or forward to an AudioFile should be in 
the same "Material" directory as the original audio. 

Let us assume that you have created a track called "Mix" that you wish to take back to the 
Lightworks. Once the disk is safely re-attached to the Lightworks system, you need to unarchive 
the audio. It should appear as 2 files called SS13xxxx and SS23xxx within the archive (where 
"xxxx" is randomly generated alpha characters), but on some systems it will appear as one file 
linked by the .ED2 file that went with it. The audio will have a "timecode stamp" that was 
determined by where it was bounced in the SADiE playlist. Assuming you were tracklaying or 
dubbing to a picture source that had the correct programme timecode, it should synchronise 
straight to the picture on the Lightworks. 

WORKING WITH AMS/NEVE AUDIOFILE 

SADiE software can read and write a variety of audio file formats, within the same EDL if you 
want. One of the formats is Lightworks, which can also be read by the more recent AudioFiles. 
This means you can now tracklay and pre-mix on your SADiE and then pass it on to an 
AudioFile for tinal dubbing. Of course you could do the dub on the SADiE as well, so why not 
read the section on mixing and processing first! 

Before you start a Lightworks/ AudioFile project you must be careful to digitize your material in 
Lightworks format. This can be set from the "Properties" Button on the Transport Record Tab. 
Lightworks audio can be at either 44.1kHz or 48kHz sampling rates, but 48kHz seems to be the 
prevalent rate as far as Lightworks editors are concerned. It will almost certainly be 16bit. (See the 
section in the Helptile on Lightworks Integration for further details.) 

From SADiE version 3.70.00 onwards, you can interchange audio and EDL data from a SADiE to 
an AudioFile. If you wish to bring the data the other way we suggest you refer to AMS directly 
for advice. 

LIGHTWORKS MULTI-CHANNEL EDL IMPLEMENTATION 

First we need to outline the way the entries will be interpreted in a Lightworks Multi-Channel 
EDL when importing it into SADiE . The same criteria are used when exporting the SADiE 
EDL. An option has been given as to whether to use the dump reel or not. The use of the dump 
reel is explained in later sections. 
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THE ENTRIES 

A Lightworks Multi-Channel EDL consists of audio only. There are several different entries we 
are likely to find in a SADiE EDL, and this is how they are interpreted in the multi-channel 
EDL. 

Entry 
Number 

Reel 
Name 

Channel Edit 
Type 

Fade 
Length 

Source 
Start 

Source 
End 

Program 
Start 

Program 
Start 

NO FADES 

A H 
I I 

001 


FADE IN 

A B 

I 

C 

I 001 IRNM I Al ID I B-A I SS I SE IA IC 

FADE OUT 

A H C 

I 

001 
001 C- B 

1 
1= 1:: I~ 1 I: 1~: I: I~ 


FADE IN AND FADE OUT 

1 001 
002 1= I:: I~ I~ 
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003 RNM Al D 'ID.C ISS 1D
11 

CROSSFADE 

A B c D 

I~ 
A 

I~ I8 

DUMP REELS 

Lightworks systems are not able to export an EDL that contains overlapping entries using the 
same reel. To get around this problem it uses a dump reel. The dump reel entries are shown in 
the EDL file with a reel 1D of "900". The program times for these entries remain the same, 
however, the source times used reference a separate file. The extra file should have the same name 
as the EDL file, but with a '" .dmp" extension. 

The source times for each stream start at the EDL start time. They usually have a handle of 1 
second with entries on the same stream being adjacent. The source times in the EDL file should 
'fit' within the program times in the dump file, i.e. there should be enough audio for them to 
reference. The source times in the dump file are the actual source times of the audio. There 
should be no dissolve entries in the dump file as this implies that entries overlap and it would 
therefore require a further dump file to handle it. It is not known at this stage whether the use of 
a dump file is due to the restriction of the Lightworks exporting or the importing of another 
machine. 

FREQUENT PROBLEMS 

Can not find audio - If the audio is definitely on the drive this could be because the wrong frame 
rate or sample rate settings are being used in SADiE when the EDL is imported. Check that these 
are set correctly. Also, if the very start of a track is used, it is possib'le that there is a rounding 
problem. SADiE uses sample times, whereas the EDL uses frame times. It is possible that the 
frame time can push the start or end of an entry past the start or end of the available audio. 

"'900" reel names appear - This is because a dump reel was needed but not found when the EDL 
was loaded. If there was no warning about this, it is possible that a file match was made, but the 
dump file either does not contain the correct entries or is empty. 

The Audio is only found on streams 1 and 2 - The option for using the channel information for 
the 'stream index only' needs to be used. 

Tracknames ! AudioFile uses a slightly different track·naming structure than Lightworks or 
SADiE. A "stereo" Lightworks with a reel number of 23 will be seen in the AudioFile Disk Page 
(name ??) as the following: 

File SADiE/Lightworks AudioFile 

Left Channel SS13FRED 23 RED/1 
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Right Channel SS23FRED 23 RED /2 

.ED2 fue ES03FRED 23 RED/O 

HARDWARE 

Obviously, there are various versions of hardware and software in use so we need to define what 
has currently been tested. This does not constitute a full list of what will work, but merely what 
we have seen work, or what is reported to work by other users. Please refer to your SADiE 
Dealer for more up to date information or download the latest version of soft~ are from the 
SADiE Website (www.sadie.com) 

CLASSIC/GREEN SCREEN AUDIOFILE 

It is assumed that these machines are so old that nothing will work. If you know better then 
please tell us ! 

16 BIT SPECTRA 

running 11.27 software (or M Class when running with upgraded TranFIFO card, and 
possible the Prologic) 

These come in 8, 16, or 24 track varieties, with from 1 to 4 disc banks as your wallet will allow. 
Each disk bank supports 8 channels of audio, so by extension you can see that a 16 track system 
must have at least 2 banks. We have tested the 16 track variety using 11.27 software (released in 
1996?) 

There is more recent software (the }'1 series software) of which M2.04 is probably the latest 
(11198) . This will work on all 16 bit AudioFiles, but is required for the Prolog because that uses 
an updated disc card that can handle 24 tracks off one SCSI chain. 

Iomega Jaz (ADSG, 2Gb or 1Gb variants) or a variety of MO drives seem to be supported. You 
need to format the drive in SADiE using the FAT16 (MO) option, or use a drive that has been 
formatted by a Lightworks. There is a limit of 2Gb partition but it will generate multiple 
partitions on bigger drives. The audio must be present in a folder called "Material" and must be in 
Lightworks file format. 

You need to export the SADiE 3 EDL to a Lightworks Multitrack EDL. Go to the File menu, 
Convert File and choose the Lightworks Multitrack option in the right hand column, Playlist in 
the left hand column and choose a name. There are some options in the Setup window for this 
conversion. Make it on the SADiE C:\ drive then copy, using Windows Explorer to a floppy 
disk. This will almost certainly need to be a 720Kb low density floppy disk (normally blue in 
colour). The floppy also needs to be DOS format and the EDL file must end in the extension 
.EDL. 

You need the optional EDL software for your Audiofile 

The Lightworks disc needs to be configured as a 'removable' disc when you rebuild the system 
configurations for the extra disc. 

The disc is recognised as a Lightworks disc by the software, and the files present on the disc are 
displayed as usual in the cues and events page. This seems to include all files, whether they are 
audio or video (video files may be present if the disk started off in a Lightworks system), pro fi les 
and ED2 files (SADiE will generate profiles for the audio and the ED2 file is the textual 
information for each track) 
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On a 16-bit machine, the audio cues are only shown in Cues + Events if you have your machine 
running at the sample rate of the cues. This isn't the case with a 24-bit machine, which sees and 
plays the cues regardless. 

On a 16-bit machine, you need to bank copy the audio off the Lightworks disc to another 
AudioFile disc in the system. It doesn't support live playout from the Lightworks disc. The 24­
bit machines do. 

The audio is seen as mono or stereo audio within the AudioFile, as appropriate. The EDL takes 
with it Source start and stop times, Destination start and stop time and channel number. The 
timecodes are only frame accurate, whereas SADiE is sample accurate, so some edits may be 
slightly different. You may need to do some mapping work to get the channels right within the 
AudioFile. 

To deal with the EDL, you need to do the following: 

1. 	 Insert the tloppy disc in the AudioFile drive. 

2. 	 Go into the EDL page, and into Local Defaults. 

3. 	 Check your framerate, 

4. 	 Select MULTITRACK as the EDL type_ 

5. 	 Set your "Minimum Event Size" (probably to the default of 3 frames) 

6. 	 Set "Match input number" to "Yes" 

7. 	 Set mode of operation to mono or stereo as appropriate (you may have to go around the loop 
of stage 2-7 twice to set the mapping for mono then stereo, if the EDL you are importing 
demands it. 

8. 	 Exit local defaults, and press List EDL files. 

9. 	 Select and load the relevant EDL. 

10. Go back into local defaults, and set up the track mapping as appropriate, like you would do 
for a normal conform. This should look something like the diagram below for an 8 channel 
stereo EDL. 

Track Heading ?? Channel 

1 Al 1 
I 

12 A2 2 

1 A3 3 

2 A4 4 

1 AS 5 

2 A6 6 

11 A7 7 

2 A8 
I 

8 

II . Exit local defaults and hit' conform audio'_ 
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Fade iniormation and track names are passed on with the EDL and audio (the ED2 file contains 
the "long name" that you entered), but it would appear that the AudioFile cannot read the 
information at present. You might need to write a macro to put a fade up and fade down on each 
piece of audio. 

Level information and SADiE DSP processing and automated mixing are not passed on, nor 
could they be understood if they were passed on. 

24 BIT SPECTRA 

running S2.01 or S2.03 software (or S class machine) 

This is the current top of the range platform. Updated hardware means it is 24 bit capable, 
although some machines were supplied with 16 bit DACIADC cards. It also has the new disc 
card that can, on a single bank, handle 24 tracks of audio. Most recent software (11/98) is 52.06. 
We have used S2.01 (released a year ago) and briefly S2.03and S2.04 for our experiments. There 
are newer versions of S2.06 appearing. 

The first 24 bit machines ran software known as V12. This went up to V12.10, then became 
known as the S2/M2 series software. V12 software would not run on 16 bit machines, only on 24 
bit machines. 

IomegaJaz (ADSG, 2Gb or 1Gb variants) or a variety ofMO drives seem to be supported. You 
need to format the drive in SADiE using either the FA T16 (MO) option or the normal FAT16 
option, or use a drive that has been formatted by a Lightworks. There is a limit of 2Gb partition 
but it will generate multiple partitions on bigger drives. The audio must be present in a folder 
called "Material" and must be in Lightworks file format. 

You need to export the SADiE 3 EDL to a Lightworks Multitrack EDL. Go to the File menu, 
Convert File and choose the Lightworks Multitrack option in the right hand column, Playlist in 
the left hand column and choose a name. There are some options in the Setup window for this 
conversion. Make it on the SADiE C:\ drive then copy, using Windows Explorer to a floppy 
disk. The floppy needs to be DOS format and the EDL file must end in the extension .EDL. 

You need the optional EDL software for your AudioFile. 

The Lightworks disc needs to be configured as a 'removable' disc when you rebuild the system 
configurations for the extra disc. 

There is no audio import, like you do with OMF. The disc is recognised as a Lightworks disc by 
the software, and the files present on the disc are displayed as usual in the cues and events page. 
This seems to include all files, whether they are audio or video (video files may be present if the 
disk started off in a Lightworks system), profiles and ED2 files (SADiE will generate profiles for 
the audio and the ED2 file is the textual information for each track) 

On a 16-bit machine, the audio cues are only shown in Cues + Events if you have your machine 
running at the sample rate of the cues. This isn't the case with a 24-bit machine, which sees and 
plays the cues regardless. 

On a 24-bit system, live playout is supported (There might be an update to the TranFIFO card 
required, the same as was needed to support live OMF playout, but you should check this with 
AMS before proceeding). Even if "live playout" isn't supported by your hardware, you can still 
bank copy the audio as on a 16-bit system. 
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The audio is seen as mono audio only within the AudioFiJe. The EDL takes with it Source start 
and stop times, Destination start and stop time and channel number. The timecodes are only 
frame accurate, whereas SADiE is sample accurate, so some edits may be slightly different. You 
may need to do some mapping work to get the channels right within the Audiofile. 

To deal with the EDL, you need to do the following: 

I . Insert the floppy disc in the AudioFile drive. 

2. Go into the EDL page, and into Local Defaults. 

3. Check your framerate, 

4. SeJect MULTITRACK as the EDL type. 

5. Set your "Minimum Event Size" (probably to the default of 3 frames) 

6. Set "Match input number" to "Yes" 

7. Set mode of operation to mono or stereo as appropriate (you may have to go around the loop 
of stage 2-7 twice to set the mapping for mono then stereo, if the EDL you are importing 
demands it. 

8. Exit local defaults, and press List EDL files. 

9. Select and load the relevant EDL. 

10. Go back into local defaults, and set up the track mapping as appropriate, like you would do 
for a normal conform. This should look something like the diagram below for an 8 channel stereo 
EDt. 

Track Heading ?? 
I 

Channel 

I Al I 

2 A2 2 

1 A3 3 

2 A4 4 

1 AS S 

2 A6 6 

1 A7 7 

2 . A8 8 
, 

II. Exit local defaults and hit 'confonn audio'. 

Fade information and track names are passed on with the EDL and audio (the ED2 file contains 
the "long name" that you entered), but it would appear that the AudioFile cannot read the 
infonnation at present. You might need to write a macro to put a fade up and fade down on each 
piece of audio. 

Level information and SADiE DSP processing and automated mixing are not passed on, nor 
could they be understood if they were passed on. 
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CD PRE-MASTERING 

NOTE: 	 CD players work to a resolution of CD frames . There are 75 CD frames to a second. 
Earlier PQ editors worked to an NTSC resolution of 30 frames to a second, which W;lS 

less accurate than the players themselves. SADiE3 works to the full 75 frame 
resolution. 

We recommend you change SADiE's time display format to CD frames in the Gener..i 
section of the Setup window before doing any PQ work. If you don't, you will find 
that times will jump in steps equivalent to CD frames. 

PQ LISTS· OVERVIEW 


All CDs have Index points which the player can locate and display timing information about. 

This lets the user playa particular item, or program the machine to play items in a certain order. 

PQ flags marking each index are embedded in a CD by the manufacturer. 


PQ flags are described by a track number, followed by an index number. 


Track 2 Index 1 (written 02.01) is the start of CD track 2. 


Further Index points (02 .02, 02.03, 02 .04 ... etc.), are occasionally found within tracks. 

They may be used on Sound Effects discs where several variants of the same effect are 

given, or on classical disks for movements within a work. 


The CD player also needs a PQ flag for the end of each track. 

The flag for the end of track 1 is 02.00 ... and so on for other tracks. 

The flag for the end of the last track is labelled" AA .O 1" and is the End of CD marker. 

There is a special Start of CD flag, labelled 01.00. The "Red book" standard specifies 
that this should be between 2 and 3 second before 01.01 (the start of track 1). 

On any CD there can be a maximum of 99 tracks, each with 99 Indexes. 

So a CD with only three tracks, where track 2 has an internal Index point, would have the 
following PQ flags : 

Start of CD 	 End of CD 
01.00 01.01 02.00 02.01 02.02 03 00 03.01 AA.01 

,~ ~ ~ ~, 	 , ~ 

'-v-' 	 '-v-' 
countdown countdo'Ml 

The gap between the end of one track and the start of the next is called the countdown (or paus.; i. 
This will be silence on many CDs, but may be applause or atmosphere on a live recording. 

If the countdown has a length of zero (i.e. the 00 index would be coincident with the next 01 
index), the 00 index is not written to the CD. 

When playing a whole CD in order, a player will start at 01.01 and then play continuously to 
AA.Ol. 

When playing just track 2 (on its own or as part of a program), a player will play from 02.01 
through to 03.00 
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PQ OFFSETS 

You will probably determine the EDL times at which PQ flags are placed with reference to the 
audio. These times are called Start Times, or User Times. 

CD players vary in their speed and accuracy in locating an index, starting to play, and then fading 
up the volume. To avoid the possibility of clipping the start or end of tracks and to separate 
mechanical noise from the music, the start/user times of PQ !lags are offset to obtain the 
PQ Times, as follows: 

• 	 The Start of CD flag (01.00) and the first track start (01.01) are advanced by the Start of CD 
Advance, typically one second. 

• 	 Subsequent track start flags (02.01,03.01, etc.) and all index flags within tracks are advanced 
by the Start of Music Advance, typically 12 CD frames. 

• 	 Track end flags (02.00,03.00, etc.) are delayed by the End of Music Delay, typically 5 CD 
frames. 

• 	 The End of CD flag (AA.01) is delayed by the End of CD Delay, typically two seconds. 

NOTE: 	 After applying offsets, an 00 index is not allowed to be after the next 01 index, so it is 
set coincident with it. In this case there will be no countdown and the 00 index is not 
actually written to the CD. Very short countdowns left after offsets also are commonly 
removed. I 

Traditionally, the start of the first audio on a CD master tape is positioned at 00:02:00 (two 
minutes) with respect to timecode, and therefore at 00:02:00 in SADiE's EDL. The CD doesn't 
need to have two minute's silence on the front, so the actual CD Times are the PQ times with 
respect to the Start of CD flag (01.00). 

SADiE'S PQ EDITOR 

You can create a PQ list 

• 	 by manually inserting each fl ag, or 

• 	 by letting SADiE automatically generate an entire list based on the in and out points of 
Entries in the EDL. The flags can then be adjusted manually . 

SADiE will display the positions of the flags alongside the EDL Entries and apply all the above 
offsets for you at the time the PQ list is first created. 

To make an EDL with a PQ list you must: 

First enable PQ Editing features . This is done with the check button in the "PQ SETTINGS" 
section of the Setup window. 

Then create a new EDL, which will have an extra Stream for PQ nags, displayed above Stream 1. 

NOTE: 	 If you already have an EDL that was created before you enabled PQ features, and you 
want to add a PQ list to it : enable PQ, "Select All" Entries under the Edit menu, then 
cut and paste them into a new EDL. 

II The PQ list is displayed as one of the three text panes attached to the Playlist . Use the TEXT PANE 

button on the Playlist toolbar and then select PQ from the tabs at the bottom left. If necessary 
TEXT PANE drag the edges of the Playlist window or the border between the Playlist and the text pane. 
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The PQ toolbar and the Stream displaying PQ flags in the Play list will also be displayed. This is 
in a separate unit from the Streams for EDL Entries; double-click on the unit name above the 
Stream control buttons to open/close it. 

Stream (Tj name 

This button on the PQ toolbar directly opens the PQ section of the Setup window. There are 
several setup sub-sections referred to below in capital letters. 

GENERATING A PQ LIST AUTOMA TIC ALLY 

If your audio material is not already divided into EDL Entries, you can either put razor-cuts at all 
the track start points first, or choose to insert all flags manually. Manual insertion is covered by 
the section on editing an automatically generated list. 

1. 	 Set the offsets (described above) that will be used in the list. These are in the PQ OFFSET 
setup. 

NOTE: 	 The offsets set here are applied to a PQ list from the moment 

(a) 	 a list is automatically created by using the GENERATE PQ LIST bunon, or 

(b) the first flag is manually inserted. 


From then on, they are held in the EDL and changing offset settings will not 

change the current PQ list, unless you destroy it and create a new one. Therefore be 

sure that you set them as you want before you do lots of intricate PQ editing! 


This is different from SADiE version 2. 


The "Normalise" function is described below. 

2. 	 Set the parameters for calculating PQ flag positions based on your EDL. A 01.01 flag for the 
start of track 1 will be put at the in-point of the first EDL Entry. After that, SADiE will put 
track end flags at Entry out-points, and track start flags at Entry in-points subject to the 
following options in the PQ FLAGS setup: 

New tracks will only be flagged 
when the previous track has exceeded the minimum track length, and 
after a gap between EDL Entries longer than the minimum gap length. 

The first index 0 length determines how much before the start of track 1 the Start of CD 
flag, 01.00, is positioned. Red Book recommendations are between 2 and 3 seconds. 

3. 	 In the PQ FLAGS setup, you also can set the default emphasis and copy-permit settings for 
each track that is flagged. 

4. 	 Press the GENERATE PQ LIST button on the PQ toolbar. 

GENERATE 
PQUST NOTE: 	 A minimum gap length setting of zero will find all edits - even overlaps. The GROUP 

CLIPS function in the Play list may be very useful for preventing certain edits from 
affecting the PQ list creation. 
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Fu.G 
DlSPUY 

MODE 


start times ~ 

pqtimes ~ 

GENERA'IT 

lSRC. 
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THE PQ LIST DISPLA Y 

The PQ Stream in the Play list should now display the PQ flags. 

The FLAG DISPLAY MODE button to the left of the PQ Stream selects whether flags are displayed 
at 
the Start times, which will line up with edit points after auto-generating (button down), or 
the PQ times, which are the positions after the offsets are applied (button up). 

".fr!~~)"J' ,j, :--)"') 	 ; .. ~#, ~l~,~;.iiIIL, 
~ .J.i,' 1".... I , _ _______ ___ ~t.~ ~,.. JiIb '4!~:. ' 	 __ • 

_"G_........ ·oIt..,'''<lL9 ... 	 ~~ ~ ,~,,~ 


. . .-- -- • . - ~ _. -. 	 I .--~ ----~ -r~_ 

:SCI : 

, ' sc ' 

I 
I ,,-ec-, 

sc = start 01 cd advance 	 sm = start 01 music advance ec = end 01 cd delay 
em = end 01 music delay 

The text pane shows the details of the PQ entry at each flag: 


On the left hand side, the list is shown in a tree structure, with the whole CD at the top, tracks 

within it, and flags within tracks. Double-click to open!close items. 


On the right-hand side, the details of each PQ entry are shown in columns. The columns can be 

customised by clicking on their heading buttons, and the width of columns can be changed by 

dragging the dividers between the heading buttons. 


You can click on the flag names in the tree, and the track or Index numbers in the columns to 

select a PQ entry and locate the current-time cursor in the EDL. The entry's details and the flag 

in the Playlist will be highlighted in red. 


Other columns are: 


Track name and Index name. These allow you to enter your own names for display purposes, 

and for printouts. Double-click on the names. 


Start time shows the start time (or ~user time") of each PQ entry. 


Duration shows the length of time between this PQ entry's start time and the next. 


PQ time - the time of each PQ entry after offsets are applied to the start time. 


PQ duration shows the length of time between this PQ entry's PQ time and the next. 


CD time is the PQ time of each PQ entry with respect to the Start of CD flag (01.00). 


Emphasis shows the setting of the emphasis flag for the following CD track: ., = emphasis on. 

Double-click to change the setting. 


Copy shows the setting of the copy permission flag for the following CD track: ., = copy 

allowed. Double-click to change the setting. 


ISRC is the unique code that you can allocate to each CD track for P.R.S. logging purposes, etc. 

Double-click to enter the code. You can generate sequential codes for the whole CD by pressing 

the GENERATE ISRCs button on the toolbar. Enter the number for track 1, and the codes for all 

other tracks will be allocated. The country and owner parts of the code are entered in the PQ 

FACILITY setup. 
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PREVIEWING THE PQ ENTRY POINTS 

To audibly check the positioning of your PQ entries, the following preview buttons will play the 

relevant partS of the EDL, with pre-roll and post-roll times set in the Setup window. 


The FLAG DlSPLA Y MODE setting will affect which EDL times the previews apply to. 


Plays up to the selected PQ entry. 

Plays through the selected PQ entry. 

Plays from the selected PQ entry. 

Plays through the countdown for the selected PQ entry. 

Plays from all the track starts for the CD. 

Plays through all the countdowns for the CD, so checking all track starts and ends. 

EDITING/ MANUALLY CREATING A PQ LIST 

NOTE: 	 If you are creating an entire PQ list manually, use the Setup window to set the PQ 
offsets to be applied to the list before you insert the first flag. From then on, they are 
held in the EDL and changing the settings will not change the current PQ list 

The PQ DISPLAY setup has a button to enable the use of a mouse for PQ Editing in 
the Playlist. Some users may prefer to disable this to avoid accidentally moving flags 
with the mouse. 

Inserting PQ entries using the mouse in the Playlist 
PQ fNSERT 
MODE The PQ INSERT MODE button pre-selects whether the PQ entry you insert will be 

(button up) : an index within the current track or 

(button down): a track start. 

Position the mouse at the desired EDL time in the PQ Stream. The mouse pointer will turn to a 
flag and the mouse time display will show the time you are pointing to. Click to insert the PQ 
entry. Subsequent entries will be renumbered. 

NOTE: If you are inserting a track start, a track end flag will also be inserted before it. The 
default countdown duration between these two is set in the PQ FLAGS setup. 

The default emphasis and copy permit settings for new track flags are also set here. 

Inserting and Removing PQ entries in the PQ Text List 


Use the following buttons in the PQ toolbar to: 


Add a track start (with track end and default countdown) at the current-time. This is for 

accurately positioning flags at a point found by audible scrubbing of the Play list. 


Add an index flag at the current-time. 


Delete the selected PQ entry. 
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Moving PQ entries using the mouse in the Playlist 

Position the mouse pointer over the flag you want to move. The flag symbol will change to a 
hand. You can then either: 
• Drag the flag to a new location, or 
• Right-click and Snap the PQ flag to current-time. (Useful after scrubbing the audio.) 

The SLIP INDEXES button will cause all PQ entries to the right of the one you move or delete to 
move with it. 

SUP 
INDEXES 

'NOTE: 	 Take note of whether you are viewing Start time or PQ time, as selected by the FLAG 

DISPLA Y MODE button. 

Editing PQ entry details in the PQ text list 

You can double-click on any of the time values in the PQ list, and edit them like other time 
displays in SADiE. The PQ entry will move accordingly and the SLIP INDEXES button will 
determine whether all following PQ entries move. 

Double-clicking also allows you to change each track's emphasis and copy permit settings and 
ISRC code. 

The NORMALISE button will reduce to zero all countdowns less than the value set as the ~ minimum index 0 length in PQ OFFSETS.
NORMAUSE 

NOTE: 	 This is done by moving the track end (index 0) flag up to the following track start flag. 
The PQ and CD times for the track end flag will not be displayed as it is not actually 
written to the CD when it has zero duration. 

The EDIT HEADINGS button lets you enter CD details for the printout and manufacturer. 'lia 
EDIT 
HLWlNGS 

The MODE 2 DATA text box above the PQ list tree represents the CD's bar code. Double click to 
enter the code. 

TIPS: 	 If the audio for your CD is all one EDL Entry, and you don't want to remove noise or 
atmosphere between tracks, either: 

1. Put single razor-cuts at each track start point and auto-generate the PQ list with 
minimum gap length set to zero. Or: 

2. Manually insert each track start flag after scrubbing the Play,list to locate the point; 
use the ADD TRACK button, or paste the flag in with the mouse; then snap it to the 
cursor. 

You can then move the track end flags back, if you want to create countdowns. 

PRINTING OUT THE PQ LIST 

PRINT PQ uses the Windows® application Notepad to print the PQ list directly to your printer. 
Offsets used, CD details entered in the "Edit Headings" box and Facility details entered in the PQ

PRrNTPQ 
F ACILlTY setup are included in the printout. 

PRINT PQ TO FILE saves the PQ list as a text file which you can later open and edit in any text 
editor or word processor. 

PQ 
TO FILE 
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MAKING A MASTER TAPE/CDR 

SADiE will write your finished PQ list and the audio to the following equipment:­

• 	 SCSI Exabyte tape drives, using the DDP format 

• 	 SCSI CDRs 

• 	 Any timecode-synchronised recorder, using a PQ burst (commonly SONY 1630/U-matic). 
Synchronisation is covered earlier in this chapter. 

NOTE: Consult Studio Audio to check on currently supported SCSI devices 

See the Audio Disk section in chapter 7 if you need to log-on a SCSI device. 


See the notes at the end of this CD Pre-Mastering section for a further discussion on writing discs 
or tapes at speed, or in real-time. 

Press the READIWRITE PQ DATA button. 

READIWRIT In the box that appears, select your pre-mastering device:­
EPQDATA 

DDP to tape 	 Press the WRITE button to create a DDP master. The SCSI Exabyte tape drive 
will locate itself and the PQ data and audio will be written to it. 

If you select NON-REAL TIME, this will be done as fast as possible, but you will 
not hear the audio. 

A message will tell you when the operation has been completed . 

A Clip named "CD Audio Imagen will appear in the Source Audio Tracks folder 
of your Clipstore. 

NOTE: 	 There are some choices with regard to the format of the DDP tape_ : 
1) You can choose DDP version 1.00 or 2.00 - this is chosen in the Setup window, 
under PQ Settings; DDP Details 
2) with either version of DDP, you can choose to put the DDP files before or after the 
audio file - there is a tick box in the Read/Write PQ data - 'DDP at end of tape' for this. 
The advantage of putting the DDP files at the edn of the tape is that they can be 
replaced at a later date - perhaps you need to add ISRC codes - and this can be done by 
pressing 'Overwrite DDP at tape end' (but only if the DDP files ARE at the tape end). 
It is recommended that you check with your manufacturing plant that they will accept 
DDP v2.00 and/or DDP at the end of tape, as these are non-standard. 
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CDR 	 Press the WRITE button to create a Red book CD, complete with Table of 
Contents. 

Set the CDR Speed. The speed that SADiE can write to the CDR will depend 
on the complexity of your EDL. Experience will teach you how fast you can go. 
lf you're not sure, try ... 

CDR Test Mode. This writes the CD with the laser on low power, so that the 
disc is not actually burnt. It effectively checks whether the whole EDL can be 
written to your CDR machine at the selected speed, without spoiling the disc. 

You will not hear the audio while the CDR is being written unless you deselect 
NON-REAL TIME which uses a different method to write the CD - see Notes on 
Real-Time and Non-Real-Time Mastering below. 

A message will tell you when the operation has been completed_ 

A Clip named "CD Audio Image" will appear in the Source Audio Tracks folder 
of your Clipstore. 

PQ Burst 	 Press the WRITE button at the moment you want to send the PQ burst to the 
tape, then run the machine with SADiE in sync and record the audio. The 
outputs used and level of the burst can be set in the PQ BURST setup. -14dB is 
normal. 

NOTE: 	 It is advisable to lock SADiE's digital audio clock to that of the 1630: Connect 
the 1630's digital output to SADiE's digital input and select that input as the 
clock source in the "Further Audio settings" of the Setup window. Then run 
SADiE as the slave, in trigger lock, synchronised to timecode from the U-matic. 

EPQDATA 

VERIFYING 	A MASTER 

Press the READ/WRITE PQ DATA button and select your pre-mastering device. 

DDP tape 	 Press VERIFY and the PQ data on the DDP tape will be checked against the 
current PQ list in SADiE. You then have an option to VERIFY AUDIO 

INTEGRITY. This will produce a text file detailing the audio error correction rate 
on the master. In "PQ Settings" in the Setup Window, you can choose how 
detailed this text file will be. 

NOTE: 	 Exabyte is a fully error-correcting data medium. It checks all data as it writes, 
and re-writes if necessary. Unlike the error correction on a CD, a high error 
count will not affect audio quality, but at worst could slow the transfer rate to a 
point where data transfer cannot be done in real time. 

CDR CDR's cannot be verified. 

PQ Burst Press VERIFY, then play the PQ burst from the tape. Set the input you are 
sending the burst to in the PQ BURST setup. The PQ data will be checked 
against the current PQ list in SADiE. 

READING PQ DATA AND AUDIO FROM A MASTER 

If you have been given a master that needs further editing, you will want to load both the audio 
and PQ data into SADiE: 
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N.B. First create a new EDL, because the PQ data you are about to read will be attached to 
whatever is the current EDL. 

Press the READIWRITE PQ DATA button and select your pre-mastering device. 

READIWRlT 
E PQ DATA 

DDP/CDR 	 Press READ. The PQ data from the tape or CD will be read into the current 
EDL and appear in the PQ list. A CD Audio Image clip will appear in the 
clipstore, which can be dragged to the play list for playback or bouncing to audio 
drive. 

PQ Burst 	 Press READ. Then play the PQ burst from the tape to the input you have 
selected in the PQ BURST setup. The PQ data from the tape will be loaded into 
the current EDL's PQ list. Record audio from the 1630 in the usual way. 

NOTE: 	 You will be loading PQ times into from the master the PQ list. SADiE will apply the 
currently set offset values in reverse to derive start times. If these are different from the 
offsets used to generate the PQ list originally, you will find that the start times do not 
line up exactly with the audio. 

You will probably just work on the PQ times directly, but if this bothers you, either: 

1. 	 Adjust all flags' start times, and let SADiE produce PQ times according to your offsets. 

2. 	 Work out what the original offsets must have been, set them in the PQ OFFSETS 
setup, then read the PQ data again. 

When you read a PQ list in off DDP tape or CD, the times on the medium are calculated from 
00:00:00, whereas it's possible that when it was originally edited, you may have had an offset in 
the EDL and the CD started for instance at 00:02:00. It is usually more convenient to not start at 
zero_ This would be where the PQ print-out was timed from also. 

The EDL PQ UST OFFSET setup option allows you to choose the position in the EDL of Track 1 
ID 0 when PQ data is read from a CD-R or DDP tape. 

REPLAYING 	CDRs OR DDP TAPES 

A Clip named "CD Audio Image" will appear in the Source Audio Tracks folder of your 
Clipstore. after writing a CDR or DDP master, or reading the PQ list from one. As the Exabyte 
or CDR is a SCSI device, its audio can be treated just like a SADiE Track on an audio disk - the 
only limitation is the speed of the device. 

Paste this Clip into a Playlist, and it will automatically place itself at the correct PQ time, with 
PQ flags displayed. You can then play the Playlist, and preview or locate to the PQ flags. SADiE 
will play the audio directly from the DDP or CDR. With Exabyte, it is even possible to scrub the 
audio forwards, to a certain degree! 

NOTE: You can copy individual tracks from the master to your audio disk using the Bounce 
function. 

SA VING DDP PQ DA T A 

The current PQ list in DDP format (without the audio) can be saved like any file and read back 
into SADiE's PQ editor for later modification. The new version can then be saved to floppy disk 
and sent to the factory separately from the master tape. This is sometimes done when a detail 
such as the ISRC codes gets added at a later date. 
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Press the READ/WRITE PQ DATA button and select DDP to Hard Disk.:· 

R£ADIWRIT • WRITE will save the file (to the DOS drive or the floppy drive), 
EPQDATA 

• VERIFY will compare the saved file with the current PQ list, 
• READ will re·load a saved file to the PQ editor. 

NOTES ON REAL-TIME AND NON-REAL-TIME MASTERING 

NON-REAL·TIME CD MASTERING 

UsuaUy you will probably want to write the CD-Master to either DDP or to CO-R as quickly as 
possible, and SADiE is able to make the master quicker than single playback speed. How fast it 
will go depends on the complexity of your EDL and the hardware you are using. This is called 
'non-real-time', which you may be familiar with from other areas of the program. The master will 
proceed at a speed regulated by the hardware (which in practise may stop and start and perhaps 
change speed to accommodate different levels of complexity throughout the EDL) but you will 
not be able to hear the audio as it transfers to the master. Because there is no audio playback, you 
will not be able to use any external processing during the write, however of course you can get 
round this by re-recording to include the processing before the final writing process. 

The speed of writing will vary for different hardware platforms and CD/DDP writers, but here 
are some rules of thumb: 

Non-real·time DOP to Exabyte 

The Exabyte drive works at a number of different speeds and is able to stop and start and charlge 
the speed while it's writing a master. You don't have to consider speed - the drive will run as iast 
as it can , and SADiE will slow it down if necessary. 

Non-real-time CD·R 

This is much more complex for the user to work out. CD writers have fixed speeds - IX, 2X 4X 
and 8X are relatively common, however this speed setting is fixed when you press WRlTE, and if 
SADiE is not able to feed the audio data to the CD-R drive at this speed, then the CD·R will run 
out of data and the write process will stop. CD-R's are usual write-once and so you will have 
spoiled a disc. SADiE will recommend a conservative write speed before you start the burn, 
however, if you're feeling confident, you can over·ride this. The speed that SADiE can deliver 
data at can be worked out approximately, based on the number of streams playing back (don 't 
forget to allow for the two tracks you're recording to the CO·R and bear in mind that 4 tracks 
playing at 2X speed is the same as 8 tracks playing at normal real-time speed), however if you are 
using plug-in processing within SADiE, these figures will be changed radically. Note also that bit ­
rate will seriously effect possible write speed because more data is being transferred. 

In practise, you will get a feel for what's possible with your hardware. You can perform Test 
Writes by clicking on the 'CD-R Test Mode' button in the READ and WRITE PQ OATA 
window, before pressing Write. This sets the CD-R to a special low power laser mode and the 
CD-R will go through all the motions of writing the disc without actually burning anything onto 
the disc. And so if the test write completes you will know that a real write is possible. 

Note: after running a CD-R in test mode, you should re-power the CD-R device to set the 
laser back to its correct level. 

You should be aware that IX CO-R speed is NOT real-time - if you are set to write non-real-time 
and I X you will not hear audio being played back. 

REAL-TIME CD MASTERING 
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IVERGENCE 


Divergence is an important aspect of panning, and control of it becomes a significant issue when working with 
pan controls that operate on 3 (or more) channels. Consider the following example that illustrates the most basic 
panning characteristics of a 3 way panner used to control LCR stereo: 

OdB 

-3dB 

c 

L R 

Panner 
characteristics 
when divergence 
Is set to 100%. 
(The default) 

As you can see from the diagram, when the panner is hard left, dead centre or hard right, only the corresponding 
channel carries any signaL This movement of the signal from channel to channel is known as divergence. In this 
particular case the panner is said to have full divergence, because at no point during the complete pan does the 
signal ever appear on more than two channels at once. 

In SADiE all surround strips are created withfull (maximum) divergence by default, and in many cases the 
resulting behaviour of the pan control may be perfectly acceptable. However, consider the following situation. 
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Imagine you're mixing to picture and there is a particular sequence where a car drives from left to right across the 
entire scene. Obviously, a left to right pan of the sound of the car's engine is required to provide a convincing 
effect. But will a complete left to right pan with a fully divergent panner produce a convincing result, and perha 
more importantly, will it produce an effect that is acceptable to most (if not aU) of the audience? 

In reality, the pan will fail on both counts. Due to the fact that the sound moves completely in and out of each 
speaker in turn, the pan will appear to 'jump' from speaker to speaker. This effect becomes more noticeable as the 
speed of the pan is increased. It will also iail to produce a consistent effect across the entire auditorium. People 
sitting in the centre (where the limited 'sweet spot' will be situated) will get the best results, whilst those sitting at 
the far left and right extremes are going to receive disproportionate amounts of the left or right channels even 
though they can clearly see the entire picture. 

To remedy this situation, you can decrease the divergence of the pan control, altering its characteristics so that a 
proportion of each signal is automatically 'bled' into the adjacent channels, 'spreading' the sound over a wider 
proportion of the stereo image. This will not only produce more coherent results for those seated at the left and 
right extremes of the auditorium, but will also make pans appear to glide more smoothly. 

Panner 
characteristics 
when divergence 
is set to 50%. 

c 

L R L R L R 

OdB 

·3dB 

I 
I 
I-------1-----­

c 
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Again, it is imponant to remember that the behaviour of this control is dependent on the current position of the 
divergence control and also the state of the divergence mode toggle switch. 

Joystick control 
This is not actually a true control in its own right, but a convenient interface that allows simultaneous control of 
the Left-Right and Front-Back pan controls. The control will appear on strips that feature an LCRS or LCRSS 
output, and only be enabled on those that feature a mono or LR stereo input. 

The control has two modes of operation: 

The first is invoked by a single downward click and hold of the left mouse button on the joystick control bunan_ 
This will launch the joystick window with the left-right and front-back pan positions represented by a 'knob' at 

the appropriate position in the window_ This window represents the complete surround sound field and the 
position can be adjusted by moving the mouse. Releasing the mouse cancels the window. 

The second mode is activated by double clicking on the joystick control button. As with the first mode, this 
launches the joystick window and positions the 'knob' at the relevant position in the window. It will, however, 
remain open until you subsequently click the mouse outside the limits of the control window. While the window 
is open you can adjust the position of the knob by clicking on the knob and dragging it to its new position whilst 
holding the mouse button down . 

Quick centring of the joystick is possible by double clicking in either the centre of the window (on the cross 
hairs), or in the top centre of the window (beneath the centre speaker icon). 

The Joystick control window 

Divergence control 
This normally controls the amount of left-right and front-back divergence_ If the 'Divergence mode toggle' bunon 
is down, it will only control the amount of left-right divergence. By default the control is set to maximum (fuji 
divergence) when a strip is created. The control is only enabled on surround strips than have a mono or LR stereo 
input. 

For more information about divergence, see the following section entitled Divergence. 
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Divergence mode toggle 
Normally, the divergence control applies the same divergence to both the left-right and front-back pan controls 
simultaneously. In certain situations, however, it can be desirable to detach the divergence control from the fron 
back pan control and restrict its inHuence to just the left-right pan control instead_ This 'detached' mode is 
activated by pressing the divergence mode toggle bunon into the 'down' position. When in this mode the front­
back pan control is always fully divergent allowing it complete front-back movement. 

This switch will only exist on strips that have an LCRS or LCRSS format output, and only enabled on strips with 
a mono or LR stereo input. It is also not automated, but its current setting is saved with the mixer. 

Width control 
This control will only be enabled on surround strips with a mono or LR stereo input. You will probably only find 
yourself needing to use it if you have some non-directional LR stereo source material that needs panning to a 
picture. 

Reducing the width of a LR stereo input to the absolute minimum effectively collapses it into a mono signal. 

By default, the width control is set to its minimum for mono input strips and maximum for LR stereo inputs 
strips. 

Front-Rear PPM display toggle 
Although this button appears on all mixer strips it wili only be enabled on strips that have an LCRS or LCRSS 
format input. When enabled, clicking on the button will toggle the PPM area between displaying the front three 
channels (LCR) and the rear channels (of which there will be either 1 or 2 depending on the input format). 

Strip input / output format indicator 
Due to the fact that all of the surround strips look very similar at a glance, this display forms a handy reminder of 
the input and output format of the strip. It uses the same familiar icons that appear in the Routing Toolbar - the 
wp icon, above the downward arrow, indicates the input format, the bottom icon, the output format. 

Because this area of the strip allows no user interaction, it also makes a handy place to click on if you want to drag 
a strip to another place in the mixer, or you want 10 minimise a mixer strip by double clicking on it. 
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nowhere to route to - yet. To remedy this situation select the New Bus option. This will automatically create a 

new LCRS bus called LCRS 1 (LCRS A 1 in multiple card systems) and assign it to the output of the strip. 


Repeat this process for the next seven strips, but on each occasion select an input bus 'one greater' than the 

previous strip. For example select '2' as the input bus for strip 2 and '3' as the input bus for strip 3. Always, 

however, select LCRS 1 as the output bus for each strip. 


Finally, set the input routing of strip 9 to LCRS 1 (the bus that carries the combined outputs of strips 1 to 8) and 

the output routing to o/pl&2&3&4. 

You have now completed setting up the input and output routing for your mixer and it should match the example 

below: 


.....~.. _ f" __ 

~~ 

~~ 


Y 
~ "~'-.-, 

o 
ur mixer is now ready for use and should be saved before proceeding any further. 

FLEXIBLE INPUT AND OUTPUT ROUTING 

The previous example described one of the most simple mixer configurations possible. In reality, more 
complexity and hence flexibility are required to achieve particular results. SADiE addresses this requirement by 
allowing a great degree of flexibility when it comes to routing internal mixer busses to mixer strips. 

For example, just because a strip has an LR stereo input doesn't mean that you have to route a conventional LR 
stereo bus to it. You could for example route the two rear channels of an LCRSS bus to such a strip - useful if you 
want to do some processing on just the surround component of you mix. Strips with mono inputs or outputs ofter 
total freedom - any individual sub-bus can be routed to them. 

One particularly useful aspect of this flexibility is the potential to conserve DSP power. Imagine, for example, that 
you're producing an LCRS mix for a film. Much of your material may just be dialog and you have decided that 
you want to keep all of the dialog in the front three speakers. Rather than create full LCRS output strips for each 
channel of dialog, you could just create strips with LCR outputs which you route to the LCR sub-bus of your final 
surround mix bus. This is obviously 'cheaper' in terms of DSP power as it saves the extra (and unnecessary in this 
case) calculations required to derive the rear channel component. 

Perhaps the best part of all this is that SADiE does the hard work for you. Whenever you want to set up the input 
or output bus of a strip, SADiE works out all the possible valid routings for you and presents them ;n (he drop 
down list box. All you have to do is browse the list and pick the appropriate one. 

PPM MONITORING ON SURROUND MIXER STRIPS 

In most circumstances the PPMs meter PRE-fader. The ONLY exception to this rule is if a strip is routed to a 
physical output AND the output format of the strip matches the input format, in which case the metering will be 
POST·fader. 
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UNDERST ANDING THE CONTROLS ON THE NEW SURROUND STRIPS 

Although each of the surround strips has its own distinct characteristics, they all share a common interface and Sl 

of controls. Certain strips may disable some of the controls because they have no function due to the input formal 
of the strip. Other strips may omit certain controls altogether because they have no relevance with respect to the 
output format of the strip. For example a strip with an LCR output does not require the front-back pan control to 

be present. 

Below is an example of a mono to LCRSS strip (1 in / 5 out): 

Joystick 

Divergence 
 control 

control 


Divergence 

Left-Right 
 mode toggle 

pan control 


~	Front-Back 
pan control 

Front-Rear ~ Width controlPPM display 

toggle 


Strip input I 
output fonnat 
indicator 

Each of the new controls labelled in the above example will now be explained in turn, along with specific details 
about which of the new strips feature each control and which do not. 

Left-Right pan control 
This particular control needs little introduction and will already be familiar to most users. It pans the front (and 
LR stereo rear channels if present) between the corresponding left and right channels. This control is disabled on 
strips that feature the same input and output format (i.e. LCR to LCR, LCRS to LCRS and LCRSS to LCRSS). 

It is important to remember that the exact behaviour of the pan control is dependent on the current position of 
the divergence control. For example, if the divergence control is set to its minimum value, then the pan control 
will have no effect. 

Front-Back pan control 
This control only appears on strips that have an LCRS or LCRSS output and performs a similar function to the 
Left-Right pan control except it operates between the front and rear channels. The control will be disabled on 
strips that feature the same input and output format (i.e. LCRS to LCRS and LCRSS to LCRSS). 
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"HE SURROUND FORMAT MIXER STRIPS 

Of course, all of the surround busses would be of little use without some different mixer strips to generate and 
manipulate them . To offer maximum flexibility SADiE offers nine new types of mixer strip in addition to the 
original mono/ LR stereo strips. 

The new strips fall into three categories; those with an LCR output, those with an LCRS output and finally those 
with an LCRSS output. Each of these three categories contain a further three strip types; one with a mono input, 
one with an LR stereo input and one with an input that matches the format of the output. 

The following table summarises the input and output formats of the nine new strip types: 

~~~~1Im, t.cl~;-.. II~":. _. 
Mono LCR 

LR Stereo LCR 

LCR LCR 

MonoI LeRS 

LR Stereo LCRS ' 

LCRS L9RS 
I Mono LCRSS 

LR Stereo LCRSS 

LCRSS LCRSS 

To avoid cluttering up the mixer process toolbar with nine new strip buttons we have opted to add just three 

buttons instead. These three buttons are labelled LCR, LCRS and LCRSS and refer to the output format of the 

strips that they will create. The input format must be specified by the user at the moment of dropping the strip 

into the mixer. 


Depending on the surround format that you work with, a typical simple surround mixer might consist of 8, mono 

in / LCRS out strips (one for each playlist stream) and a final LCRS in / LCRS out strip for global processing and 

level control. 


To help familiarise you with process of creating a surround mixer from scratch, the following section is designed 

to walk you through the entire process from the creation of a new project right up to the moment where you're 

ready to do some real work. 


CREATING A SURROUND MIXER 


In this example we 'll assume that you are going to work with an 8 stream EDL, mixing mono material to LCRS. 


The first step is to create a new project. Next, you need to remove all the default strips from the mixer in 

preparation for dropping the new surround strips in. This is certainly the most tedious pan of the whole process, 

although it needn't be a process that you repeat every time you create a new surround project (see section headed 

'Making use 0/Mixer Templates' for more details) . Mixer strips can be deleted by selecting the Delete Strip option 
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from the right mouse popup menu that appears when clicking on a strip. Alternatively strips can be deleted by 
dragging them off the mixer window (you will need to pick them up by clicking on an area of the strip that has n 
other function when clicked on, for example the PPMs or strip number). 

Once you have emptied your mixer, you are ready to add the new surround strips. Double click on the LCRS 
button on the mixer process toolbar. This will put SADiE into 'strip insert mode'. A small dialog box will then 
appear asking you to specify the input format for your strips. Just click OK to select the default mono option. 

You are now free to insert as many strips as you like. All you have to do is point and click wherever you want a 
strip to be inserted. If the position you're pointing at is not valid, the mouse pointer will change from a mixer 
strip to a 'no go' pointer. For our example, insert eight strips - if you insert too many, don't worry, you can easily 
delete them again afterwards. When you have finished inserting strips, click the right mouse button to exit insert 
mode. 

If a horizontal scrollbar appeared on the mixer window whilst you were inserting your strips, make sure it is 
moved to its far right extreme, in order to fully reveal strip number 8. 

To insert the final strip just drag and drop from the LCRS button on the process toolbar. Click on the button and 
drag it all the way to the right hand half of strip number 8 (or further right if your mixer window is wider than 
your mixer). When you release the mouse button, the dialog box asking you to specify the input format will 
appear again. On this occasion select LCRS and press OK. (!fthe dialog does not appear, then you are dropping the 
strip in an invalid position. Try repeating the process, making sure that the mouse pointer resembles a minzfader be/ore 
releasing the button.) 

At this point you should have a mixer that resembles the example below: 

T 
he 
ne 
xt 

ste 

P 
is 
to 
set 
up 
th 
e 
in 
pu 

t and output routing for each strip. Currently, you will notice that all of the routing buttons are 'Unset'. (Ifyou 
can only see one row 0/ 'Unset' buttons, enable the Output Bus buttons by clicking on the 'Output bus buttons' button on 
the mixer configuration toolbar - the button resembles a bus emerging from a tunnel). Before we start, make sure that 
your plaYlist, rather than the clipstore, is linked to the mixer. Do this by clicking on the playlist window and then 
clicking back on the mixer window. 

Click on the 'Input selection' button on strip 1 (the top 'Unset' button), scroll down the list and select '1' (this will 
be 'A l' if you have a multiple card system). This sets the input routing of the first strip to stream 1 of the play list. 
Next set the output routing for the strip by clicking on the 'Output selection' button (the remaining 'Unset' 
button) . This time your options will be more restricted. This is because apart from the physical outputs, there is 
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In most situations, you probably won't find yourself creating busses from the Routing Toolbar. Instead you'll 
probably create them from the familiar and more convenient New Bus option in a mixer strip's Input / Output 
routing drop down list boxes. It is, however, handy to know that all bus housekeeping can now be performed in 
this one place. 

THE LCRS BUS 

Now that we have established that SADiE has mono, LR stereo, and LCR busses at its disposal, we can take the 
next logical step. 

LCRS stands for 'Left, Centre, Right, Surround' and represents the configuration used by DolbyTM Stereo (also 
known as DolbyTM Surround). This is the most common surround format in use today and consists of fol'· 
channels in the following configuration. 

Front 

lCRS 
configuration 

Rear 

The 'froot' consist of three channels which can be represented by an LCR 
bus, and the 'rear', a single mono channel which can be represented by a 
mono bus. To confirm this, create an LCRS bus from the Routing 
Toolbar by right mouse clicking on the New Bus entry in the bus tree 
and selecting LCRS from the Create a new bus sub-menu. The resulting 
LCRS bus should match the example to the right. 

Once again, each sub-bus within the overall LCRS 1 bus has an 
automatically generated suffix that uniquely identifies not only the sub­
bus itself, but also its type. 

All LCRS busses will be placed in the bus tree immediately after any 
LCR busses. 
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THE LCRSS BUS 

The final surround bus to describe is the LCRSS bus which is the same as the previously described LCRS bus, 
except for the fact that it features individual left and right surround channels. This five channel configuration is 
particularly significant because it forms the '5' of the increasingly popular '5.}' format used by Dolby Digital (SR· 
D), DTS Digital (DTS) and perhap~ mo~t importantly of all, Digital Versatile Disk (DVD). 

Front 

LCRSS 

configuration 


Rear 

As with the LCRS bus, the front three channels can be represented by an LCR 
bus. The two rear surround channels can be considered a stereo pair (for bus 
purposes) and therefore represented by a conventional LR stereo bus. A fully 
expanded LCRSS bus therefore matches the structure of the example to the 
right. 

We briefly mentioned '5.1' above when listing formats that could make use of 
LCRSS busses. Some users may be wondering why we haven't taken the final 
'logical' step and implemented a 5.1 iormat bus that consists of an integral 
LCRSS and mono bus . 

There are several reasons why we decided not to take this approach, most of 
which will become apparent when you ~tart working with mixer strips that 
handle surround busses . However, the reasons mainly concern the vastly 
difiering control and processing requirements of the two busses. 

This absence of an integral 5.1 style bus does not mean that you cannot produce a 5.1 mi." using SADiE. It simply 
means that you have to consider your total 5.1 output as consisting of an LCRSS bus (to provide the main 5 
channels) and a separate mono bus (to provide the .1 or LFE channel). The LCRSS bus would typically be routed 
to 0/pl-5 and the mono bus to 0/p6. 

The advantage with this approach is that it enables you to process your .1 (LFE) channel independently of the 
other 5 channels. This is essential considering the limited frequency range requirement of the resulting channel. It 
also gives you total freedom when deciding what components of your overall mix to add to the channel 

11:6 



SADiE Usn Manuall7J .7 Chapter II - Surround Sollnd 

-"'HE VISIBLE DIFFERENCES WHEN SURROUND SOUND FEATURES ARE 
NABLED 

You can tell at a glance if surround sound is enabled by checking if the pan pots on the 
mixer strips have a small left-right arrow legend above them (as in the example strip to the 
right). There is also a new button beneath the PPM display area that is used to switch the 
PPM display between front and rear channel metering. This button will always be disabled 
00 conventional mono and LR stereo strips. 

The Process Toolbar will also have three extra strip type buttons labelled LCR, LCR . 
and LCRSS appended to the end. Note that you may have to resize the mixer to brio!, 
these extra buttons into view. 
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SURROUND FORMAT BUSSES 

The key to successfully working with surround sound on SADiE is to understand surround format busses and 
how they have been implemented in SADiE. Once you have mastered this fundamental aspect, everything else 
will fall into place relatively easily. 

With Surround disabled SADiE features just two types of busses - mono and conventional LR stereo. In actual 
fact, SADiE only really features mono busses. Stereo busses are little more than a convenient pairing up of two 
adjacent mono busses. 

Surround sound in SADiE builds on this foundation. All busses are still ultimately derived from an arrangement 
of mono busses. We have simply provided new 'building blocks' in addition to the familiar LR stereo pair. 

THE LCR BUS 

The most important new bus type is the LCR bus (Left, Centre, Right). In order to understand exactly what this 
new bus consists of, open the Routing Toolbar (from the Mixer Configuration Toolbar on the mixer) 

Open up the Mixer Internal 
Busses folder and right mouse click 
on the New Bus entry. You will 
notice that the Create a new bus 
submenu offers four options. (If 
you do not see this submenu then 
you have not yet enabled the 
Surround Sound features AND re­
opened the mixer. See section above 
entitled Getting SADiE into 
Surround Sound mode for more 
details). The first option is Mono 
pair which will create the standard 
LR stereo bus with which you are 
all familiar. On this occasion, select 
the second option, LCR. 

This creates a new LCR bus called LCR l. You will notice that it is placed 
immediately beneath Bus 1 &2 in the bus tree. Double click on LCR1 and you 
will find that it is constructed from three mono busses. Each of the mono sub­
busses have an automatically generated sufftx ( L, C or R) to uniquely identify 
them. You can rename a bus by right mouse clicking on it and selecting the 
Rename bus option. The one restriction with surround busses is that you can 
only rename the root bus (LCRI in this case). All of the sub-busses will be 
renamed automatically when the root is renamed. Try renaming LCRl to, say, 
Demo. The resulting bus tree should then match the example to the right. 

Finally, to return to the starting point, delete the LCR bus by right mouse 
clicking on it and selecting the Delete bus option. 
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(,1 - SURROUND SOUND 

INTRODUCTION 

The v3.6 release of SADiE is the first to incorporate support for mixing to the most popular surround sound 
fonnats . We have attempted, wherever possible, to integrate the new surround sound features into SADiE as 
seamlesslyas possible. Hopefully, this will make your step into the world of surround sound as intuitive and 
straightforward as possible. 

As with any major new feature, there will inevitably be many questions that can't be answered by 
experimentation alone. We therefore recommend that you spend a little time browsing this document before 
attempting to undertake anything too ambitious. Once armed with the knowledge contained in this manual, 
working with surround sound will be as straightforward and logical as working with conventionalleft·right 
stereo. 

If, whilst familiarising yourself with the new features, you encounter a problem that seems to defy explanation, 
your first port of call should be the last section of this chapter, where we have listed solutions to a number of the 
most commonly encountered problems. 

TERMINOLOG Y 

For many people, stereophonic implies twO channels - left and right. This perception has been created by the 
dominance of the 2 channel, left-right format used by the music recording industry since the 1960s. There are 
however many 'stereo' formats. Each surround format is a stereo format. DolbyTM Stereo (also known as 
DolbyTM Surround) for example, is a 4 channel stereo system. It is therefore important to try and break any 
association that you may have held in the past between the word 'stereo ' and the number '2'! 

To avoid confusion, this manual will refer to conventional 2 channel stereo as 'LR stereo' where there is any 
possibility of ambiguity. 
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GETTING SADiE INTO SURROUND SOUND MODE 

Not everyone will need to work in surround (yet!), so SADiE can hide everything related to surround sound from 
the user. This is the default operating mode. You will therefore need to first enable the Surround Sound features 
by opening the Setup window and selecting the 'Surround Sound' topic from the left pane. This will display the 
check box that allows the Surround Sound features to be activated. 

Once activated, the features will not actually take effect until the next time a mixer is created or opened. It is 
therefore important to remember that if you switch modes whilst a project is open, you will need to close and 
then re-open the currently open mixer. This should be done from the mixer component in the project window 
rather than the mixer window itself. Better still, only change the mode whilst you don't actually have a project 
open. Most users will probably just enable the surround sound features once and then leave them enabled 
indefinitely. Having the features enabled does not restrict your ability to continue creating and working on non­
surround sound projects. 

If your system currently has the Surround Sound features turned off, and you attempt to load a mixer containing 
surround sound format strips then SADiE will automatically offer to turn the Surround Sound features on, so that 
it can successfully complete the load. If you decline the offer then SADiE will abort the loading of the mixer. 

The state of the 'Surround Sound enabled' check box is stored in the user's INl file and can therefore be set 
depending on each user's needs or preferences. 
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Record Properties - in the usual way, we'll name the recording (the video and audio files will have the same name 

if you record them together) in the Transport Controls Record pane - click and type into the empty Track.: box. 

(press return when you're finished) 


You may want to choose your file format at this point - click on Properties on the Transport Controls, and select 

from Native, SADiE3, WA V, BWF, Lightworks, etc. If in doubt, select Native, but if the material is likely to be 

passed on somewhere else, it's worth consulting with whoever you are passing it to - a different, more generic 

format may be more appropriate. 


There's no choice of format for video tracks, only quality, which is selected in the Portia Record Setup window 

as explained above. 


Select the source for audio recording - we're coming off the Betacam (and my one is analog, but of course you can 

choose to record digitally from a Digi-Beta) so I'm selecting Analog for the Input source in Audio Setup - click on 

Setup on the Transport Controls. Select the sample rate and input resolution to suit. 


Now, click on the playlist, press the II record enable buttons on the video stream and the audio streams you are 

wanting to record to. You select which audio input is routed to the stream with a drop-down list on the left hand 

side of the stream display, but mostly it's easiest to record track 1 to stream 1 etc. 


Put the Betacam into play. If you've set up 9-pin control, you can do this by opening the Machine Control 

window for the Betacam - under the View menu; Machine Control, and if you've set the Betacam to remote, it 

will identify itself in the list - for instance Betacam UVW-1800 (PAL); select that and the window with transport 

and other controls for the Betacam will open. 


Upon record enabling the streams, when you put the Betacam into play you should be able to see the video, E-E 

through Portia, and hear the audio E-E through SADiE. 


If you can't hear any audio and there is no movement on the mixer meters, first check the E-E settings - View 

menu; Settings; Mixer; E-E mode; check that 'E-E on record enabled streams' is ticked. If there's still no audio, 

then check you have the correct audio setup, check your leads, check your audio monitoring. 


If you see no video through Portia, check your leads, check the sync setup again. If the video looks odd, then 

check your YUV leads are the right way round. If the horizontal position looks odd, then consult the Portia 

hardware documentation for details of how to set that up. 


If all is well, then right-mouse click on the Online button in the Transport controls window - this is the button to 


the left of the large time display. It may currently have the legend :- 9-pin ch.2 or Betacam etc. or 7030 DAT - it 

will display the name of the device attached to your lowest numbered 9-pin channel. On right-mouse clicking on 

this button you will be able to choose the Betacam from the list. 


Now push the Online button, the Play list will now have control of the Betacam, and also will be following its 

timecode. If you have not setup 9-pin control and are using LTC, then you will need to manually play the 

Betacam and the Playlist will follow the LTC. 


If you'd left the Betacam in play, the Playlist will start playing at the correct timecode, video E-E will continue, 

but audio E·E will stop. Pressing the STOP button at this point will stop both the Playlist and the Betacam. 


So, cue up the Betacam, using its Machine Control window and put it into play. Alternatively you can do this by 

using the standard transport controls - you'll notice that if you double click anywhere in the Play\ist time bar (this 

is of course the normal 'locate and play' command in SADiE) the Betacam will locate to that position, and when 

it's in play, normal playback will continue. If you're using the Hardware controllers, pressing SHIFT before 

pressing PLAY will do the same thing. 


Hit RECORD at the point you want to drop into record, and then magenta video clips and green / cyan audio 

clips will start to draw in the Play list, and full E-E will return. 


Hit STOP when you've finished. 


Done. Now get on with some editing. Or go and have a nice cool beer - that's where I'm off to. 
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This is another 'deviation' from the first example really, but coming from a very basic angle, so if you're worrying 

about Master SPG's etc.etc- then check this first - you may be able to customise this setup easier than the first 

example. 


In this particular example I'll describe a situation with a SADiE system, with Portia, and a Betacam to load the 

video and analog audio material. 


This time we will be using Portia itself as the source of video clocks for the setup. 


CABLE CONNECTIONS 


On Portia 


1. 	 For Portia inputs - connect YU & V video cables from the Betacam outputs to Portia's YUV inputs. 75 ohm 
terminate on the Portia break-out box. 

2. 	 To view the Portia picture - connect YU & V cables from Portia's YUV to the monitor YUV. Terminate at 
the monitor. 

On the Betacam 

1. 	 To genlock the Betacam - connect a video cable from Portia's mixed sync output to the Betacam video input. 
Terminate_ 

2. 	 To sync the monitor, - a video cable from the Betacam's Video Out, to the monitor's Mixed sync input. This 
could also be used to view the Betacam's composite output alone if the monitor has the facility to switch 
between viewing composite and component inputs. 

3. 	 For 9-pin machine control of the Betacam - connect a 9-pin lead from the Remote connector on the Betacam, 
to one SADiE's CAT (or Kitten) card's 9-pin connectors_ 

On the SADiE audio unit (I shall describe connections for a 24.96_ Octavia and XS/XACT are very similar) 

1. 	 To provide a video reference to SADiE - connect a video cable from the Betacam's video input loop-through 
BNC connector, to the lower of the two BNC connectors on the CAT card.{the CAT's video BNC's may 
have been connected to the Portia breakout box in which case connect to VITC IN) >I­

2. 	 To record audio from the Betacam - connect 1 to 4 audio cables from the Betacam audio outputs to SADiE's 
analog inputs - connectors will depend on which break-out box or audio unit you have_ 

NOTES TO COVER DEVIATIONS FROM THIS SETUP 

1. 	 >I- For the video reference for Octavia - connect the Betacam's video input loop-through to the VIDEO BNC 
on the rear of the Octavia unit. 
>I- For the video reference for the XS/XACT - connect the Betacam's video input loop-through to the 
XS/XACT breakout box's Video In BNC. 

SOFTWARE SETUP 


Set Portia Sync Setup to Free Run and Sync on Y as explained above. Portia does need a video sync on its input, 

even though it is the Master video clock in this example. In this example we'l! use the sync on the Y signal from 

the Betacam. 


Set Audio syncs, by opening the Setup page, double-click on Audio to reveal Further Audio Settings, and click 

on that. 
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Set Clock Source to be Automatic. The SADiE audio unit is only going to be recording analog and so the audio 
clock will be 'internal'. BUT, when a Portia is installed, internal audio clocks are always generated from the audio 
unit's video reference input. The setting for 'Internal Clock' - Free Run or Lock to Video is irrelevant in this 
situation. 

You are likely to want to setup 9-pin machine control for the Betacam and DAT, so that audio and video 
recordings are time-stamped correctly. 


In Setup double-click on 9-pin Channels and select 9-pin Master for the channel you are using by clicking on the 

drop down box. 


Also in Setup double click on Sync to set the timecode settings: 

Set the Frame Rate ( although SADiE will warn you if it detects you have it set incorrectly), and Timecode Type 

- my example is using timecode via the 9-pin, but you could use VITC if it's available or LTC if you connect the 

appropriate leads. 


RECORDING AUDIO AND VIDEO IN SYNC 


If this is sounding familiar and you've read the first example too, then you'll know all this by now. But otherwise, 

read on. 


We'll record off the Betacam to get some synchronised pictures and audio in. We're now in familiar SADiE 

territory (you did read the rest of the manual didn't you? If not have a look at Chapter 2· Recording) 


Start a new project. 
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box and so I select Genlock. I could be using any otherwise unused AES input and so would select that one from 

the drop-down list. 


The setting for 'Internal Clock' - Free Run or Lock to Video is irrelevant, because, when a Portia is installed, 

frame syncs are always taken from the audio unit's video reference input. 


You are likely to want to setup 9-pin machine control for the Betacam and DAT, so that audio and video 
recordings are time-stamped correctly. 


In Setup double-dick on 9-pin Channels and select 9-pin Master for the each of the channels you are sing by 

c1icklng on the drop down box. 


Also in Setup double click on Sync to set the timecode settings: 

Set the Frame Rate (although SADiE will warn you if it detects you have it set incorrectly), and Timecode Type 
- my example is using timecode via the 9-pin, but you could use VITC if it's available or LTC if you connect the 
appropriate leads. 

You're now ready to go (phew) - have you double checked those leads ??? 

RECORDING AUDIO AND VIDEO IN SYNC 


We'll record off the Betacam to get some synchronised pictures and audio in. We're now in familiar SADiE 

territory (you did read the rest of the manual didn't you? If not have a look at Chapter 2 - Recording) 


Start a new project . 


Record Properties - in the usual way, we'll name the recording (the video and audio files will have the s<' me name 

if you record them together) in the Transport Controls Record pane - click and type into the empty T;·ack: box. 

(press return when you're finished) 


You may want to choose your file format at this point - click on Properties on the Transport Controls, and select 

from Native, SAOiEJ, WAV, BWF, Lightworks, etc. If in doubt, select Native, but if the material is likely to be 

passed on somewhere else, it's worth consulting with whoever you are passing it to - a different, more generic 

format may be more appropriate. 


There's no choice of format for video tracks, only quality, which is selected in the Portia Record Setup window 

as explained above. 
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Select the source for audio recording - we're coming off the Betacam (and my one is analog, but of course you can 
choose to record digitally from a Digi-Beta) so I'm selecting Analog for the Input source in Audio Setup - click o! 
Setup on the Transport Controls. Select the sample rate and input resolution to suit. 

Now, dick on the playlist, press the II record enable buttons on the video stream and the audio streams you are 
wanting to record to. You select which audio input is routed to the stream with a drop-down list on the left hand 
side of the stream display, but mostly it's easiest to record track 1 to stream 1 etc. 

Put the Betacam into play. If you've set up 9-pin control, you can do this by opening the Machine Control 
window for the Betacam - under the View menu; Machine Control, and if you've set the Betacam to remote, it 
will identify itself in the list - for instance Betacam UVW-1800 (PAL); select that and the window with transport 
and other controls for the Betacam will open. 

Upon record enabling the streams, when you put the Betacam into play you should be able to see the video, E-E 
through Portia, and hear the audio E-E through SADiE_ 

If you can't hear any audio and there is no movement on the mixer meters, first check the E.E settings - View 
menu; Settings; Mixer; E-E mode; check that 'E-E on record enabled streams' is ticked. If there's still no audio, 
then check you have the correct audio setup, check your leads, check your audio monitoring. 

If you see no video through Portia, check your leads, check the sync setup again. If the video looks odd, then 
check your YUV leads are the right way round. If the horizontal position looks odd, then consult the Portia 
hardware documentation for details of how to set that up. 

If all is well, then right-mouse click on the Online button in the Transport controls window - this is the button to 
the left of the large time display. It may currently have the legend :- 9-pin ch.2 or Betacam etc. or 7030 OAT - it 
will display the name of the device attached to your lowest numbered 9-pin channel. On right-mouse clicking on 
this button you will be able to choose the Betacam from the list. 

Now push the Online button, the Playlist will now have control of the Betacam, and also will be following its 
timecode. If you have not setup 9-pin control and are using LTC, then you will need to manually play the 
Betacam and the Play list will follow the LTC. 

If you'd left the Betacam in play, the Playlist will start playing at the correct timecode, video E-E wiH continue, 
but audio E-E will stop. Pressing the STOP button at this point will stop both the PlayList and the Betacam. 

So, cue up the Betacam, using its Machine Control window and put it into play. Alternatively you can do this by 
using the standard transport controls - you'll notice that if you double click anywhere in the Playlist time bar (this 
is of course the normal 'locate and play' command in SADiE) the Betacam will locate to that position, and when 
it 's in play, normal playback will continue. If you're using the Hardware controllers, pressing SHIFT before 
pressing PLAY will do the same thing. 

Hit RECORD at the point you want to drop into record, and then magenta video clips and green / cyan audio 
clips will start to draw in the Playlist. and full E-E will return. 


Hit STOP when you've finished . 


Done. 


The same basic procedure can be followed for recording audio from the OAT player - you may want to switch to 
AES input in audio setup. You can select the DAT player by right-mouse clicking the Online button. and now 
SADiE will switch its control and timecode reference to be from the OAT. 

If you have no 9-pin control, you'll need to connect an LTC cable from the device you're recording from_ Set 
SADiE's Sync Setup timecode setting to LTC. Putting the Betacam or OAT into play will have much the same 
effect on the playlist when you push the Online button, and the recording procedure is the same. 

EXAMPLE SETUPS - 2. Synchronising with a stand-alone SADiE & Portia 
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I'm assuming in this (all singing, all dancing !) example that we are using a Betacam VTR to load video (and analog 
audio) onto SADiE, and additionally we'll have a synchronisable DA T player with 9-pin control to allow digital 
audio recordings. We have a component monitor to view the Portia output. If your monitor has a composite 
input only, you will need a YUV to composite encoder between Portia's outputs and the monitor. 

CABLE CONNECTIONS 

On Portia 

1. 	 To genlock Portia - connect a video cable from the master SPG's Mixed video Sync output (or 'Black and Burst' 
or 'Composite sync' or 'Video Reference,) to Portia's Mixed Sync input. 75 ohm terminate on the Portia break­
out box. 

2. 	 For Portia inputs - connect YU & V video cables from the Betacarn outputs to Portia's YUV inputs. 75 ohm 
terminate on the Portia break-out box. 

3. 	 To view the Portia picture - connect YU & V and sync video cables from Portia's YUV and Mixed Sync 
output to the monitor YUV and Mixed sync inputs. Terminate at the monitor. 

On the Betacarn 

1. 	 To genlock the Betacarn - connect another video cable from the master SPG's Mixed video sync output to the 
Betacam's Video Input. Terminate. If the Master SPG has too few video outputs, you may need to 'loop 
through' instead. - So unterminating the Portia Mixed Sync input and connecting from the loop-through 
output to the Betacarn Video Input instead is perfectly acceptable. 

2. 	 For 9-pin machine control of the Betacam - connect a 9-pin lead from the Remote connector on the Betacam, 
to one of SADiE's CAT (or Kitten) card's 9-pin connectors. 

On the DA T player 

1. 	 To genlock the DATto AES reference - connect an AES cable between the Master SPG and the DA T's AES 
in. Set the DA T to EXT sync and digital in. Alternatively, depending on the number of AES out connectors 
on the SPG, you could connect an AES lead from a spare SADiE output to the DAT's AES in 

2. 	 For 9-pin machine control of the DA T - connect a 9-pin lead from the Remote connector on the DA T, to one 
SADiE's of CAT (or Kitten) card's 9-pin connectors. 

On the SADiE audio unit (I shall describe connections for a 24.96. Octavia and XS/XACT are very similar) 

1. 	 To genlock SADiE - connect an AES cable between the Master SPG and SADiE's AES reference input. .. 

2. 	 To provide a video reference to SADiE - connect a video cable from the master SPG's Mixed video sync output 
to the CAT cards lower BNC connector. Alternatively use the 'VITC IP' connector on the Portia BOB if this 
BNC connector is looped to the Portia BOB. Again, if there's a shortage of BNe outputs on the Master SPG, 
you can take a loop-through signal from the Betacarn or Portia. On Octavia - you will have to connect to the 
VIDEO input on the rear panel of the unit, which has no loop-through >I­

3. 	 To record audio from the DAT - connect an AES lead from the DAT's AES output to a SADiE audio input­
AES 1-2 should be fine. 

4. 	 To record audio from the Betacarn - connect 1 to 4 audio cables from the Betacam audio outputs to SADiE's 
analog inputs - connectors will depend on which break-out box or audio unit you have. 

NOTES TO COVER DEVIATIONS FROM THIS SETUP 


If you have the Master SPG and 24 .96 or Octavia, don't read the next section, it will only confuse you more! 
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1. 	 ... for XS/XACT users. XS has only one digital input, and no separate AES Ref. In connection. If you're not 
recording digitally, then that's fine, you can use the AES input for AES Ref. However, with this setup you're 
most likely to want to record digitally or you wouldn't have bothered with the Master AES SPG. In this case, 
set the Clock Source to Genlock and this time choose lip 1&2. You will be syncing by using the same AES 
cable from the digital machine you are recording from - in this case the OAT, and therefore you must ensure 
that the OAT is taking its clock source from the Master SPG. So in simple terms in this example, with an XS, 
there is only one cable to cover SADiE lead 1 and lead 3 in the above example. 
For the video reference for the XS/XACT . connect from one of the Master SPG's video outputs to the 
XS/XACT breakout box's Video In BNC. 

2. 	 If your Master SPG has no AES Reference out, only video syncs. If your digital player - the OAT in this 
example, can be set to clock to the video reference, then, run another video cable to the OAT from the SPG, 
set it to External clock! video, and then the AES cable from the DAT's AES out to SADiE's AES in can be 
used as the genlock source for the audio. In this case, set SADiE's Audio Setup; Clock Source; Genlock; to be 
liP 1&2 (or whatever SADiE AES input the DAT is connected to.) 

3. 	 If you have NO Master SPG. If you're working with digital audio this is possible but, in this setup, you will 
most likely have to use the Betacam as a source of master syncs, which is not real1y advisable. It's likely that 
the syncs will not be stable enough and the end result could be excessive jitter on SADiE's AES outputs. 
In the above main example,S connections will be unavailable. You could replace these, respectively, with: 
i) 'Portia 1 . video ref.' a video cable from the Betacam video out to Portia Mixed syncs in 
ii) 'Betacam 1 - video ref.' - nothing - the Betacam is the master 
iii) 'DAT 1 - AES ref.' - a video cable, either from the Betacam's second composite video out, or the loop­
through sync output from the video monitor. Then set the DATto be clocked to video, as in the 'deviation' 
number 2 just above. 
iv) 'SADiE 1· AES ref.' - would be replaced by the AES cable from the DAT output to SADiE's input, and 
then SADiE's clock source / genlock option changed to be that input - again, as per the 'deviation ' number 2 
just above. 
v) 'SADiE 2 . video ref.' - remember the SADiE audio unit must have a video sync at its video input when 
working with Portia. This cou'ld now be supplied by a video cable looped-through from either the DAT, or 
straight from the video monitor. Whatever you do, check that these sync cables don't having a missing loop 
somewhere and that everything is set to genlock to the video input (except the SADiE audio unit which is 
automatically set that way when you install Portia, and will be genlocked to it's AES input). 

SOFTWARE SETUP 

Set Portia Sync Setup to Genlock and Mixed Syncs as explained above. 

Set Audio syncs, by opening the Setup page, double-click on Audio to reveal Further Audio Settings, and click 
on that. 

Set Clock Source to be Genlock, and then select, (from the drop down box shown) the connection on which the 
AES reference signal is appearing - in this example I'm using the" AES Ref. in" on the SADiE 24.96 '800' breakout 
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Scrubbing the EDL works in the same way, and most imponantly of course, the video clips scrub in sync with the 
audio clips. As an example of how powerful working with Ponia can be try the following brief exercise. 

To synchronise an audio clip with a video clip 

1. Place the video . and audio cl' into the EDL. Drag and drop them from the Clipstore if necessary 

2. 	 Jog/shuttle the EDL and find a sync point in the video entry - a clapper or any obvious sync point. Mark this 
with a locator for safety. 

3. 	 Now with the hardware controller or with the mouse, put the audio clip into playlist edit mode and select 
HOT, SOURCE /¢¢>\ mode, with scrub on. You can now drag the audio across the stationary 'play head' at 
which the Ponia is still, and listening to the audio clip you should be able to scrub to find the same audio sync 
pOint. 

4. 	 Drop the audio clip at the correct point and the audio and video will now be in sync. 

It's possible to make edits in the video stream, using the razor and scissors tools. There a few basic areas where 
Ponia editing differs from normal audio editing. 

• 	 Ponia has a single channel of video, and so there are no fades . 

• 	 All edits are made at frame boundaries. 

• 	 Dragging and dropping a video entry to a new position in the EDL will replace any existing video entries in 
the new area, shonening them to make room for the new clip. 

• 	 There are three additional editing tools, that are made available by right-mouse clicking on a video entry, as 
shown in the picture above: 

1. 	 Extend entry start to fill gap 

2. 	 Extend entry end to fill gap - these two options keep the video entry locked in time, and if more video 
is available in the video track that this entry is cut from, these will lengthen it forwards or backwards to 
meet a preceding or following entry. In other words fill the holes in the EDL. 

3. 	 Move nearest cut to current time - you would use this if you have an edit between two video entries, 
that are in sync, but the edit point is not at the right position. Move the current time to a new position, 
and once again, only if the excess video exists in the recorded video tracks, this option will move the edit 
point to be at the new position. 

These three options are greyed out if SADiE detects that it's not possible to do that action - i.e. there is not 
enough spare video to move the entry start or end. 

EXAMPLE 	SETUPS 
There are as many different ways of connecting as there are leads in the examples I am about to propose and the 
setup will entirely depend on the equipment that is available. But the basic rules are the same: 
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• 	 Every piece of equipment must be genlocked to the same signal. 

• 	 The more devices you have re-generating syncs (as opposed to looping-through) the more likely it is that the 
sync will break down somewhere. 

• 	 Video equipment must be genlocked to one master video reference signal. 

• 	 Digital audio equipment must be genlocked to a the same master reference signal, however as digital audio runs 
at higher frequency than video field syncs, then relying on only a video signal to genlock a digital audio unit to 
is likely to increase jitter in the system . It's better to have one unit generating a digital audio clock from a video 
signal, and then lock other digital audio devices in the setup to that digital audio clock, than to have all devices 
resolving separately to the same video signal. Best is to have a Master SPG (Sync Pulse Generator) generating 
synchronous video and digital audio clocks from the same source. However, if all your audio recordings are to 
be in the analog domain, then digital audio clocks are less crucial. 

Example 1 below is a full-blown synchronised setup that we would recommend if recording from digital audio 
sources. Example 2 is a much simpler stand alone setup, recording analog, and with everything synchronised to the 
Portia. 

ERROR MESSAGES 


Most sync errors are preceded by a 'Peggy Freeze field error' message 


• 	 Portia failed to enter playback: there is no video input at the audio unit' then you'll need to connect a 

video sync signal to the SADiE audio unit. This is the lower of the two BNC connectors on the CAT, or 

VITC IP connector on the Portia BOB if it's connected on to the CAT card. On an Octavia this is VIDEO. 

On an XS/XACT system, this is VIDEO IN on the BOB. 


• 	 'Error - no video reference is present at the audio unit...' on entering SADiE is the same problem. 

• 	 'PORTIA failed to enter playback: the video reference at the audio unit is not locked to PORTIA' - this 
is similar, except the SADiE audio unit is detecting that its video ref. signal is not locked to that on the Portia 
unit (or to the Portia itself if that is in Free Run). Sometimes the problem could be exactly the same as above­
NO video ref., and its just picking up some noise, but most likely is that there is a break in the video genlock 
chain somewhere - SADiE is receiving a genuine video sync signal but its different to Portia's genlock signal. 
You'll have to chase leads again to rectify this. 

• 	 Magenta screen on video record enable. Portia has no video sync on its input - check the Genlock Source in 
Portia sync setup is correct, and there ARE syncs at the specified input. 

• 	 Rolling picture on video record enable. Portia is not in sync with the video player - perhaps Portia is Free 

Run and the Betacam is too ? 


• 	 Portia is unlikely to be able to sync to a VHS signal even if it's decoded to YUV - you will need a Time Base 

Corrector. 


There are more Notes and possible faults in the Portia Installation guide. 

The connections and sync setup are sometimes the most time consuming part of getting Portia running. Once you 
have your equipment 'linked together it's wise to draw a diagram of the cabling, so that you can more easily 
incorporate different equipment, or set it all up again if things change. Sorry - grandmothers and egg-sucking 

. etc.etc. 

EXAMPLE SETUPS· 1. Synchronising with an external sync source 
The most ideal way to setup the Portia/SADiE system, is to use a separate Master Sync Pulse Generator (SPG) to 
provide both a video reference signal and an AES clock source. 
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AES reference signal must be synchronous with the video signal that is providing Genlock for the rest of the 
system. The need for a separate AES reference is less if you are working with analog audio recordings only. 

PORTIA RECORD SETUP 
is accessed in the normal Setup Page (View menu, Settings) under Portia. Double click on 'Portia' to reveal the 
'Portia Record Setup' branch, and then click on that branch to show the page as below. 

Here you can choose which disk the video files will be recorded to from the drop-down list· you either choose a 

single disk by name, or 'Disk with most space', which, in the normal way will record to the disk that has the most 

free space on it at the moment of going into record. 


You can also choose the Record Quality. 


Portia uses a ]PEG compression scheme. With this system, the amount of data stored is not fIXed to a compression 

ratio, as different images will produce different size files . With the slider in the Record setup page, you can choose 

a quality level. In practise, record times on a 9GB disk drive will be approximately: 


To record video into SADiE now, the procedure is exactly the same as with audio. 

Record enable the video stream using its II record enable button. Portia will go into E-E - the video on Portia's 
inputs will be echoed to the video outputs. This way you are able to see the incoming video in preparation for 
recording. 

You go into record in the usual way - on the Transport Controls, press RECORD to go into record directly . 
Alternatively you can press PLAY and then push RECORD at the moment you want to drop in, and press 
RECORD again at the moment you want to drop out . Or using the Left/Right locators you can set the video 
recording to automatically punch in and out at preset times. See Chapter 2 Recording· Dropping in and out 0/ 
record 
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In the usual way the Video Entries will be drawn in the EDL as magenta blocks. Video entries always appear as 

blocks· there is no waveform view for video clips. 


Recording can be done with or without timecode in the usual way. 


OTHER SETUP OPTIONS 

Freeze Mode chooses whether Portia displays the current field or both fields of the current frame when the 
playlist is stopped. Freeze on frame may sometimes look a little jittery if there is a lot of movement in the picture. 
Freeze on field will give a more steady picture. Portia will always output a picture when there is an active EDL . 
when in stop it will display the current field or frame 

Stop Mode determines what happens when there is no active EDL. Portia will either show Black, E·E (echo the 
input video signal) or display a Freeze Frame. The Even and Odd Stop Field boxes allow you to select a suitable 
file to display for the freeze frame. These files need to be baseline JPEG compressed, separate odd and even 
(interlaced) fields and the correct size for PAL (720 x 576· so each fJe would be 720 x 288 ) or NTSC (720 x480). 

Disable video streams· this allows you to turn off Portia. You will still see the video entries in the EDL, but no 
video will be displayed. 

PORTIA EDITING 

Portia entries in the EDL are treated in much the same way as audio entries. Cut, Copy, Paste, Razor, Scissors, 
Glue, Remove Gap, Copy to Clipstore, lock, ALL autoplace and Slip functions, undo/redo - all these functions are 
exactly the same. 

You cannot use the Playlist Editing mode, they can't be loaded into Trim windows, Group/ungroup does not 
work, and you can't bounce video clips. 


Portia entries are saved as pan of the EDL . they are just another EDL entry, and can be viewed as entries in the 

Text Edl of course. 
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U -PORTIA 

OVERVIEW 
Portia is an optional PC plug·in card which adds video recording and playback to a SADiE system. When a Porti2 
is installed, the software adds a video stream at the top of EDLs, which will contain video entries. The video 
entries are fully integrated into SADiE· these can be manipulated in similar ways to ordinary audio entries - drag 
and drop, razor, copy/cut and paste, autoplace, slip etc. and some editing functions operate exactly the same. The 
video entries are coloured magenta to distinguish them from audio entries, and you'll notice that video clips 

appear in the Clips tore and Disk Management with a new 'film'. icon. 

There is a separate document that explains the installation and connections for Portia. The Portia card has 
standard component YUV inputs and outputs, but you may have other equipment that converts to and from 
other video formats - for instance composite NTSC/PAL decoder! encoders. 

Note that video connected into Portia should be 7S ohm terminated. 

SYNC SETUP 
As with all video equipment, synchronisation has to be set up correctly, but it's important to note that Portia 
must be synchronised to your audio hardware for the two to work together correctly. There are various ways of 
doing this and I shall describe a couple, but the golden rule is that there must be a video signal with syncs present 

at the video input of your audio hardware, and it must be in sync with Portia, for video and audio to play 

together correctly. 

The position of the video input to the audio card depends on which audio hardware you have: 
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an )(ACT card, and there must be a connection inside the PC 

I 
between the XS and the Portia - see installation guide for 
details. 

Octavia "Video' - BNC connector on the rear panel of the Octavia unit. 

SADiE 24.96 The un-named BNC connector on the CAT card on the rea,r of 
the PC - there are two - the lower is the video input, and the 
top one is a loop through. You must use the lower one. 

OA : you may have your CAT card's BNCs connected to the 
Portia BOB for convenience. In this case the lower BNC on the 
CAT is connected to CAT IN, and the upper one to CAT OUT. 
In this case the video input is marked VITC IN on the Portia 
BOB. 

Note: 	 The CAT card's upper 'CAT OUT' BNC connector, is a video output and not a loop-through. When 
there is a video signal on the lower 'CAT IN' connector, this is passed through to the 'CAT OUT'. So 
this is like a loop-through but it's not a hard-wired connection. The CAT IN connector is always 75 
ohm terminated. 

PORTIA SYNC SETTINGS 

are in the normal Setup Page (View menu; Settings) under Portia. Double click on 'Portia' to reveal the 'Portia 
Sync Setup' branch, and then click on that branch to show the page as below. 

The P AUNTSC choice should be a sim pie one. 

Genlock or Free Run is described below. 

Mixed Sync or Sync on Y sets the input connector for Genlock and where input syncs are appearing - Mixed 
syncs if you have a separate mixed syncs signal on Portia's 'mixed sync' input, or you can sync to a Y signal if 
syncs are included on that signal. 

AUDIO 	SYNC SETTINGS 

are determined by how you are syncing the audio hardware to Portia. If a Portia is installed, you don't need to 
change anything and the audio will automatically take its synchronisation from the video input. However you can 
separately set the audio hardware to sync to an AES reference signal, which will give you the advantage of lower 
jitter, as the AES reference is a much higher frequency sync signal than a video sync reference. However - this 
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I. 	 First find the command line: 

• 	 Windows 9S 

If your system is set to run SADiE automatically when you switch on, the relevant icon 
can be found under the Start button I Settings I Taskbar I Start Menu Programs. Click 
"Advanced" and, in the Explorer box that appears, open the Programs folder and then the 
StartUp folder. The SADiE shortcut icon will be in the list on the right. 

If you run SADiE manually from the Start button, follow the above instructions, but 
instead of finding the icon in the StartU p folder, it will be in the SADiE Disk Editor one. 

Alternatively, you may have an icon on your Windows 95 desktop. 

Right-click on the relevant icon, select Properties and the Shortcut tab of the box that 
appears. The command-line is in the box labelled "Target". 

• 	 Windows 3. t and 3. t 1 

If SADiE starts automatically, the relevant icon will be in the "Start Up" group in 
Program Manager, otherwise it will be in the SADiE Disk Editor group. 

Single-click on the icon to select it, select the File menu at the top of Program Manager. 
and choose Properties. The command line is in the box labelled "Command Line" 
( ... honestly!). 

A typical command line is: 

C:\SADIE3\BIN\SADIE3.EXE_/dc:\SADIE3\desktops\800def.dsk 

The first part of the command line, C:\SADIE3\BIN\SADIE3.EXE is the instruction to run 
the program file "Sadie3.exe" which runs SADiE. It gives the full location (or "path"), of the 
file - it's in the "Bin" folder, which in turn is in the "SADIE3" folder, which is on the C drive. 

The second part starts with a space (shown above as_) and then /d, which is the instruction 
to load the following file as the desktop, in this case "800deLdsk", which is in the "Desktops" 
folder, in the "SADIE3" folder, on the C drive. 

2. 	 Now edit the command line by clicking within it to change the text. The line may be longer 
than the box displaying it, but you can use the keyboard arrow keys to move it. 

• 	 To automatically load a desktop file, carefully change the current desktop file name to the 
one you want to use. You probably won't have to change the folder parts of the path, 
unless you have been storing desktops in strange places. 

Remember to keep the space shown as_ after" Sadie3.exe". 

NOTE: On Windows95 systems, any paths that use filenames with spaces in them must be 
enclosed in quote marks. 

• To log-in automatically, carefully add the following to the end of the command line, aher 
any quotation marks: 

where "NNNNN" and "WWWWW" are your user name and password respectively. 

Note the spaces shown as _ before the first oblique and between your user name and the P. 
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Generally, 800 x 600 (often called SVGA) is a good default. You may prefer 640 x 480 (often 
called VGA) if you have a smaIJ monitor or a SADiE portable, and 1024 x 768 if you've got a 21" 
monitor. The method of changing resolution may be different for different PCs and different 
display cards, but the following are most common: 

1. 	 WINDOWS 95 

From the Start button, select Settings I Control Panel, double-click on the Display icon and 
select the Settings tab of the box that appears . There is a sliding control to change resolution, and 
a selection box for the number of colours. Most changes can be done without closing down and 
restarting Windows 95, but if that is necessary, the screen instructions will warn yo u and you can 
close SADiE and save your work accordingly. 

2. WINDOWS 3.1 and 3.11 

• 	 Your display card may have been supplied with it's own program for changing resolution . 
Th is may appear: 

(i) 	 as an icon in Program Manager - many UK turnkey PCs use a program called SETRES. 

(ii) 	as an icon inside "Control Panel". Double-click on the Control Panel icon in Program 
Manager's "Main" group - the program may be called" Kelvin 64" . 

Open the program by double clicking on its icon. There is usually one section to set 
resolution, another for number of colours, and another for font size. Large fonts are not 
recommended as they can cause problems with SADiE's time displays. Having made your 
selection here, press OK, and the program will usually tell you that Windows will have to be 
restarted for the changes to take effect 

• 	 If you do not have a specific display program, in the Main group of Program Manager there is 
a Windows Setup icon. Double-clicking on this will show the system settings for the Mouse, 
Keyboard, Network, and Display. Before you change the Display settings it's worth hunting 
for the disks that came with your PC - you may be asked for the Windows® disks or the disks 
that came with your display card. To change the display driver, select "Change System 
Settings.. . " from the Options menu, and select the appropriate driver from the display list. If 
you cannot see one that looks correct, don't select them at random - if you try the wrong 
driver you may get a blank or "wild" screen and it's not so easy to reset things if you can't see 
what you're doing. (You need to run Setup from the Windows directory in DOS.) 

If in doubt, speak to the supplier of the Pc. Usually, the standard VGA driver - called just 
VGA - will work at 640 x 480, and "Super VGA" or "SVGA" will run at 800 x 600. However, 
sometimes you'll get better performance with the drivers that are supplied with the display 

card . 

MESSAGE BOX PLACEMENT 

In the Setup window, on the General page there are settings to allow you change the position 011 

the desktop at which messages, warnings and errors appear. 

You can choose 

% from left of desktop 

% from top of desktop 

and you're able to Test the settings to see where you've placed the messages. 

This is particularly useful if you are running SADiE on a machine with more tl.an one monitor. 
With the default setting, messages appear in the middle of the screen, which Cal be spread across 
two monitors on a twin screen system. 
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CHANGING HOW SADiE STARTS UP 

STARTING SADiE AUTOMATICAllY 


Windows 95 


To make SADiE start automatically when Windows95 starts: 


1. 	 Click on the Start button and point to Settings 

2. 	 Click Taskbar, then the Start Menu Programs tab . 

3. 	 Click"Add" followed by "Browse". 

4. 	 Open fo lders to locate the icon that you use to run SADiE. It should be under Win95\Start 
menu \Programs \SADiE 

5. 	 Click Next, then double-click on the.Start Up folder. 

6. Type a display name for the new icon, then press Finish. 

To stop SADiE starting automatically: 

1. 	 Click on the Start button and point to Settings 

2. 	 Click Taskbar, then the Start Menu Prograrnstab. 

3. 	 Click "Remove". 

4. 	 Open the folders Programs and Start Up. 

5. 	 Select the SADiE icon and press Remove. 

Windows 3.1 and 3. t 1 

Ii your system is set to run SADiE automatically when you switch on, there will be a SADiE icon 
in the Program Manager group called "Startup". If not, there will just be the one in the "Sadie 
Disk Editor" group. 

To make SADiE run automatically, copy the icon in the Sadie Disk Editor group to the Startup 
group by holding the Ctr! key while dragging it across. 

If you don't want SADiE to start automatically, delete the icon in the Startup group: Select it 
with a single-click and press the Delete key on the keyboard. Deleting this icon does not erase the 
program; the icons in Program Manager are just the "front door" to it. 

AUTOMATIC lOGGING-IN AND lOADING DESKTOPS 

You may want SADiE to start with a particular desktop file that you have previously saved, 
particularly if you have changed screen resolution. You can also set the log-in process to be done 
automatically when SADiE boots up. 

The icon that you select to run SADiE contains instructions to run the program. These take the 
form of a command line, to which you can add the desktop to be used, and your user name and 
password. 

To modify these instructions: 
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DESKTOPS 

The arrangement of windows and tool bars (groups of buttons) on your screen is called a desktop. 
As described below, this can be saved as a file, just like an EDL. You can save several different 
desktops for different tasks and then reload them to quickly rearrange the screen whenever you 
want. Note that a desktop will not look the same when viewed with a different screen resolution. 
Several desktops files are provided with the software. 

ARRANGING WINDOWS 

Moving and Resizing windows with the mouse is covered in Appendix A - Windows Basics. 

The Window menu has the following commands which are standard for Windows® applications: 

• 	 Tile will attempt to fit all open windows onto the desktop - not especially useful in SADiE 

• 	 Cascade will arrange all open windows on top of each other, with all the title bars visible. 

• 	 Arrange icons will align the symbols for minimised windows along the bottom of the 
desktop. Again, not especially useful unless you have lots of minimised windows. 

• 	 The list at the bottom of the menu shows all open windows and is useful for quickly restoring 
to size a minimised one, or making active (and so bringing to the top) an obscured one. 

SPLIT AND DUPLICATE WINDOWS 

The Window menu's New Window command creates a duplicate of the active window so that 
you can effectively split it and place different pans in different places on your desktop. 

For example, you may have a very large Mixer of, say 24 channels (especially if you are an 
octavia user). You could put the first 12 channels in the top half of the screen and the rest below. 
Or, if you are using a dual graphics card to spread the desktop across two monitors, channels 1-12 
on one screen and 13-24 on the other. 

You might want to have two Playlist windows, one looking at one pan of the EDL, and the 
second at a different pan. You can also create a quite separate Text EDL window like this. 

• 	 Make the window you want to duplicate the active one. 

• 	 Select New Window_ An exact duplicate will be displayed. 
If duplicating the PlayJist, you have the option of a new Playlist or Text EDL. 
If duplicating the Mixer, you have the option of a new Mixer or Process window. 

• 	 You can now resize the two duplicates and use their separate scroll and zoom functions so that 
they display the bits that interest you. 

• 	 Move the new windows where you want them on your desktop, which can then be saved as 
described below. 

TOOLBAR DISPLAY 


The various toolbars used in SADiE can be attached to different pans of their windows or floated 

and moved around the screen. 


Right-dick over any toolbar to see the list of options: 


• 	 Each toolbar can be docked to either of the four sides of its window. 
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• 	 The toolbar can be floated, in which case it becomes a separate, "always-on-top" box that can 
be positioned anywhere on the desktop. A floating toolbar can also be re-shaped by dragging 
its sides in or out. 

• 	 Each tool bar can also be hidden, so that it doesn't appear on the desktop at all. To redisplay a 
hidden toolbar, look under the View menu, where the "Toolbars" command will let you 
select which toolbars are displayed. 

NOTE: The Transpon Controls are a special toolbar that cannot be reshaped or docked. They 
can, however, be displayed or hidden under the View menu. 

SA VING AND LOADING DESKTOPS 

To save the current arrangement of your desktop (which includes the size and position of all 
windows, even if they are not currently on view), select "Save Desktop" from the Desktop menu. 
The save box that appears allows you to give the new desktop file a name and open the folder that 
you want it saved in. There is a folder for Desktops within the main SADIE3 folder. 

To load a previously saved desktop select "Load Desktop" from the Desktop menu and find it in 
the relevant folder. Alternatively, select it from the list of recently used desktops at the bottom of 
the Desktop menu. 

TIP: 	 When editing the Playlist, you may want to quickly switch between two different 
venical and horizontal zoom settings. Save them in two different Desktops. Then 
switch between them by using the keyboard shoncuts to the Desktop menu:- Simply 
press Alt + D, followed by the number of the desktop file in the list. 

You can load any of the five suggested desktops, which are provided in the Desktops folder, for 
each of the following screen resolutions: 

800(x600), 1024(x768), and 1280(xl024). 

The resolution forms the first part of the filename. Desktops with a "0" after the 
resolution are for octavia users. 

There is a general "Default" desktop, which will be the one loaded when you start SADiE, two 

editing desktops, one for mixing and one for -rQ editing. 


There is also a single "Defawt" desktop for 64Qx480 resolution. 


CHANGING SCREEN RESOLUTION 

OR - WHY DOES MY SADiE LOOK DIFFERENT? 


A PC's display is a grid of coloured squares each called a pixel. Most PCs can display at different 

screen resolutions - in other words, a different number of pixels across the same size screen. A 

high screen resolution of 1024 pixels horizontally by 768 pixels venically will use smaller pixels 

than a resolution of 640 x 480. This means the elements of any display will appear smaller, yet 

you can fit more onto the screen. 


The choice is down to your personal preference for the size of monitor you are using. SADiE can 

work equally well at either 640x480, 800x600, 1024x768 or even 128Oxl024. It's wonh bearing in 

mind that the PC will be working harder if you increase the resolution, so the display may be 

slower to refresh. Another factor that can change the speed of operation is the number of colours. 

SADiE only uses 16 colours, and so if you set the display driver to use 256 or more colours, it is 

processing numbers unnecessarily and could work slower. Some display cards, however, are 

optimised to run at a cenain resolution and number of colours, so there is no hard and fast rule. 
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HOTKEY SETUP 

Here you can set a wide range of computer keyboard key-presses and hardware 
controller buttons to duplicate on-screen commands, so avoiding the use oj a mouse. 

Categories First select the window in which the Hotkey will operate. Remember that Hotkeys set 
for the Transport Controls will affect other windows. 

Commands Select the command you want to check or assign to a new Hotkey. 

Hotkeys assigned This box will list what Hotkeys are currently assigned to the selected command. 

New Hotkey Select a key by scrolling down the box and tick the Ctrl, Shift or Alt key(s) to be 
pressed in combination with it. The keyboard function keys Fl-F12 can also be used 
without Ctrl, Shift or Alt. 

For hardware controller bunons, select HWC Fl-F12 and tick HWC Shift and/or 
HWC Assign if they are to be used in combination. 

Assign Adds the selected New Hotkey to the list of those assigned to the command. 

Remove Removes the selected item in the Hotkeys assigned box from the list assigned to the 
command. 

Reset All Resets all Hotkeys in SADiE to the standard factory defaults. 

Dump Keys Allows you to save the current Hotkey settings to a text file so that you can print it 
out. Note ­ these dumps cannot be reloaded - this is a job for SADiE Settings files. 

CLIP DETAILS SETTINGS 

Write back Clip on exit 	 Automatically writes back the changes you make in a Clip Details window when you 
close it. 
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PLAYLIST AND MIXER TEMPLATES 

The TEMPLATES feature allows you to further customise your working environment, by 
allowing you to easily save custom Playlists and Mixer Setups for future use. 

In normal use you will save Playlists and Mixers but these will contain other information - EDL 
entries, Fader levels and pan and EQ settings for instance, which are of no further use. Once you 
have customised a Playlist or Mixer, if you save it as a TEMPLATE you can use it again and 
agaIn. 

For instance you may always require a playlist with 2 mono streams and 1 stereo, with a mi.xer 
that has perhaps 2 mono and 1 stereo strips with an EQ and maybe a reverb. If, having 
constructed this blank playlist and mixer, you save them as template files, you can set SADiE to 
use these for the defaults. 

To save a Playlist or Mixer as a template select the option under the FILE menu: Save current 
playlist (or mixer) as a template. 

The files will be saved with a EDT or MST extension. 

If (and only it) you are working in a Project, you can enable Templates in the Templates Setup 
Page (which is a sub-section of Project Management Setup). 

The three options for using templates are: 

1. 	 Do not use templates· this is the default choice. Templates are disabled, and the type of 
EDL/mixer that is created when you make a new EDL/mixer is determined by the Setup page 
options. See Playlist Setup and Mixer Setup above 

2. 	 Use the specified templates below - In this setup page you can choose a single EDT Playlist 
template, and MST Mixer template, which will automatically be used as the basis for your 
Playlist and Mixer EVERY time you create a new Playlist and Mixer - either using the FILE 
menu/ NEW function or the CREATE EDL and CREATE MIXER buttons in the Project 
window. 

3. 	 Choose a template at playlist or mixer creation time - when you create the new 
EDLIMixer, SADiE will ask you to name the file in the usual way, and then offer you a list of 
all the available templates files that appear in your own template directory. 

NOTES: 	Templates are saved and reloaded on a user basis - i.e. the user 'Joe' will find his 
templates in c:\sadie3\templates\joe (assuming c:\sadie3 is the normal working 
directory for SADiE). 
You will notice that if you press CANCEL (or press the ESC key) you will bypass the 
template and the new EDLImixer will be based on the Setup page setting. You will also 
notice that you will be first offered the template that was chosen last, and so you onfy 
need to press RETURN to use that same template again. 
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Auto write back 
to Playlist 

Dou ble click opens 
Clip details 

Stop automatically when 
cutting with the razor 

Entries currently in the Trim Editor are automatically written back when the RAZOR­


cm, the LOAD NEXT EDIT or LOAD PREVIOUS EDIT buttons are used. 


Double-dicking on the relevant profile does just that! 


applies when razor-cutting during normal playback. 


TRIM/TRIM EDIT NUDGE 

Nudge amount 

Alt+Nudge amount 

MIXER SETUP 

Select PPM scale 

Default Mixer 

E to E mode 

UNDO SETUP 

Enable undo 

Sets the amount by which edit points are nudged either in Playlist editing, or the T ..im 
Editor. 

applies to the on-screen nudge buttons (in the transpon controls or Trim Editor), and 
the Transpon Control Hotkeys. 

applies to the on-screen nudge buttons (in the transpon controls or Trim Editor), when 
holding down the Alt. key. 

Zoom dependent settings mean that the higher magnification you use, the finer the 
nudge adjustment 

Selects the scaling of the PPM level meters in the Mixer. Scales 1-3 emphasise different 
areas of the dynamic range and are calibrated in dBFS (decibels with respect to OdE, 
which is maximum coding level) . The BBC scale is numbered 1-7, with green segments 
up to PPM4, then yellow segments up to PPM6 and red above PPM6. 

Tick the box and set the indicator numbers if you want to specify the layout of mono 
or stereo strips when new Mixers are created. Otherwise, SADiE will generate Mixers 
with 8 mono Streams strips and 2 mono output strips (16 Streams strips for octavia 
systems). See also Playlist and Mixer Templates below. 

When selected, E to E mode gives you input monitoring on record-enabled Streams 
before you press the record button. E to E is cancelled when record is disabled on the 
EDLstream. 

Strongly recommendedl In fact, there is really no reason not to use it. You can set any 
number of undo levels up to 50. More levels use slightly more disc space in the Pc. 

DEFAULT CROSS FADE SETUP 

Sets the fade curves and lengths that are created at the beginning and end of Clips after 
recording and when using the razor-cut function. The normal default is around 40 
subframes (20 milliseconds). 

9-PIN CONTROL 

These settings are described in full in the section on 9-pin control in Chapter 8, SpecifIC 
Applications. 
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TRANSPORT CONTROLS SETUP 

Loop pre/post-roll Sets the amount played either side of the Left and Right locator points when the LOOP 

button is used. 

TRANSPORT CONTROLS/SCRUB SETUP 

Mouse Jog ratio Sets how much the audio is scrubbed for a given horizontal mouse movement. Default 
setting 040. 

Mouse Jog Damping Sets how quickly the audio comes to a halt when jogging. Default setting 80. 

Mouse Shuttle sensitivity Sets the speed of shuttle for a given vertical mouse movement. 


Fixed s<:rub Speeds Set three flXed shuttle speeds used by the Hotkeys for forward and reverse scrubbing. 


AUTOCONFORMSETUP 

See the Autoconforming section in chapter 8, Specifu: Applications. 

PQ SETTINGS 	 For a full description, see the CD Pre-mastering section of Chapter 8, Specifu: 
Applications. 

PQ DISPLAY 


Enable PQ editing 

in the Play list Allows PQ !lags to be inserted or moved with the mouse. 


Auto-show the 
PQ Playlist Stream The Play!ist will automatically open the PQ Stream displaying PQ flags, when the 

EDL is loaded. 

PQ FACILITY: 	 The country code and owner code entered here will form part of the ISRC number 
that can be generated for each CD track. Production details can also be entered for the 
printout of the PQ list. 

PQ BURST: 	 Sets SADiE's input channel for reading a PQ burst, and the output channel and level 
used when writing a PQ burst. 

PQ OFFSETS: 	 Sets the length below which all countdowns win be removed when using the 
NORMALISE button. 

Sets the parameters for applying offsets to the PQ Entries. 

NOTE: 	 The offsets set here are applied to a PQ ,list from the moment you start 
creating it. From then on, they are held in the EDL and changing these 
settings will not change the current PQ list. Be sure that you set them as you 
want before you do lots of intricate PQ editing! - This is different from 
SADiE version 2. 

PQ FLAGS: 	 Sets the parameters used when automatically generating a PQ list, and when adding 
new track flags. 
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AUDIO / FURTHER 	AUDIO SETTINGS 

Clock Source 	 Sets what digital audio clock is used as the reference for generating SADiE's sample 
rate: 

Automatic 	 When a digital input is in use (either for recording or routing to a Mixer input strip), 
the clock is derived from that. When no digital input is in use, SADiE's own internal 
clock is the reference. This is the usual setting, unless you are recording from a digital 
device that needs to take its clock reference from SADiE (e.g. bouncing through an 
external digital processor or mixer), in which case they would each be trying to fa 110\1,' 

the other, so you must use SADiE's Internal setting: 
Internal 	 Internal clock used at all times. 
Genlock 	 External clock reference used at all times (except with XS/XACT systems when using 

an analogue input, as the digital signal cannot then reach the XS card). This setting is 
for those who use a station clock to reference all their digital equipment . 

XS/XACT 
clock source 

WITH DIGITAL 
IIP IN USE 

WITH 
AN ALOGUE liP 

IN USE 

WITH NO INPUT 
IN USE 

Automatic selected di.zital input internal internal 
Internal internal internal internal 
Genlock selected digital input internal selected digital input 

octavia 
clock source 

WITH DIGITAL 
UP IN USE 

WITH 
ANALOGUE l i P 

IN USE 

WITH NO INPUT 
IN USE 

Automatic lowest nwnbered 
digital input in use 

internal internal 

Internal internal internal internal 
Genlock AES reference input AES reference input AES reference input 

Output Format 	 Selects whether SADiE produces digital output signal to the SPDIF or AES/EBU 
protocol. The selected format is actualJy supplied to both the phono connectors on the 
XACT card and the XLR connectors on the Breakout Panel. 

SYNC. SETUP 

These settings are described in full in the section on Synchronisation in Chapter 8, 
Specific Applications. 

PRE/POST ROLL SETUP 

Here you can set how much SADiE plays before (pre-roll) and after (post.roU) an edit 
when you use the preview buttons in the Transport Controls or Trim Editor. These 
times also apply to the preview buttons in the PQ editor. 

Three alternative times are available: using the preview buttons alone, with the Sh.ift 
key and with the Ctrl. Key. 
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PLA YLIST SETUP 

No. of Playlist Streams 

Cut Mode 
Splice 
V cut 

Stop automatically when 
cutting with the razor 

Autolocate on cut 

Double click opens 
Clip details 

Auto load new EDL into 
current Play list if empty 

Autoplace options 

Use Fades 

Tick the box and set the indicator number if you want to specify how many Streams 

new Playlists are generated with. Otherwise, SADiE will generate Playlists with 8 

Streams for XS/XACT systems and 16 Streams for octavia systems. See also Playlist 

and Mixer Templates below. 


Determines the joins created between Entries when the Razor-cut is used: 

Fade-out of first Entry overlaps fade-in of next (a crossfade). 

Fade-out ends where iade-in starts. 


applies when razor-cutting during normal playback. 


means that when SLIP is on, cutting an Entry from the Playlist will reposition the 

current time cursor so as to take account of the slip. To be used in conjunction with 

the above. 


when double-clicking on the Playlist Entry. 


If your current Playlist is empty, opening an EDL file wilIload it into the empty 

Playlist instead of creating another one. 


The time display is used to set the gap between Entries when using the" Autoplace 

with Separation" option. 


When selected, the gap length includes the fade-out of the earlier Entry. 


PLAYLIST SETUP /PLA YLIST DISPLAY 

Stream comment space Choose between displaying the "comments" or "dialogue" that can be written in the 
Clip Details window. 

Fade display mode Entries drawn with fades as splices: ~ 

Entries drawn with fades as cuts: ~ 
PPMs in Play list Turns on or off the miniature meters on the left of each Stream. 

PLAYLIST SETUP /PLA YLIST NUDGE 

Nudge amount 

Alt+Nudge amount 

Sets the amount by which Playlist Entries are nudged with the button on the 
Autoplace tool bar, or the Hotkeys. 

Sets the amount by which Entries are nudged when holding the Alt key and using the 
Autoplace buttons. 

Zoom dependent settings mean that the higher magnification you use, the finer the 
nudge adjustment 

TRIM EDITOR SETUP 

Playlist Auto Follow 	 When selected, the current-time cursor in the Playlist will move to keep up with the 
latest edit point in the Trim Editor. 
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19 - CUSTOMISING SADiE 


SETUP WINDOW 

The Setup window can be displayed under the View menu and allows you to change many settings that affect the 
way SADiETlI is working. These are stored in a file called SADIE3.INI which is used by Windows® to recall them 
whenever you run SADiE. 

The settings are grouped under topics that can be selected from the list in the left-hand pan of The wir w. 
Double-click on topics with a + next to them to reveal sub-topics for selection. 

The window is fully interactive - so you can leave it open and make changes while using SADiE. Options that are 
currently not available Oike changing sample rate while recording} will be greyed out. 

GENERAL SETUP 

Time Format 	 Selects the format for all time displays. 

Timecode Hours: Minutes: Seconds: SMPTE frames: SMPTE subframes 

Milliseconds Hours: Minutes: Seconds: Milliseconds 

Samples Hours: Minutes: Seconds : Samples 

CD Hours: Minutes: Seconds: CD Frames 

Bars and beats Bars: beats: ppqn (pans per quaner note) 


Time Format Settings 	 Allows you to set the Tempo, Time signature, and ppqn for the Bars and beats display. 

Popup Help 	 Enables the yellow pop-up captions when resting the mouse pointer over a button . 

Warning Messages 	 Allows a choice of four different settings. Display all messages until you are familiar 
with using SADiE 

Message Box Placement 	 Allows you change the position on the desktop at which messages, warnings and errors 
appear. 

GENERAL / STATUS DISPLAYS SETUP 

Status displays 1-5 	 Let you choose which displays of important settings are shown in any of five positions 
on the Status bar at the bottom of the screen. You can display any of the following: 

Sample Rate Double-clicking on the display will take you to the relevant pan of the Setup window 
to change the setting. 

Frame Rate: As above 
Transport Ctrls: Simple Play and Stop buttons and current-time display. Use as you would 

the main Transport Controls which you can close to save screen space. Double click_.1g 
in the time display allows you to change the current time in the playlist. Also, clicking 
and dragging any digit up or down, increments or decrements that digit and hence 
moves the current time. 

Autoplace: R.ight-click on the display to change Autoplace settings. 

Slip: R.ight-click to change Slip settings. 

Input Source Double-clicking on the display will take you to the Audio Setup page, to allow you to 


change this. 
Clock Source Double-clicking on the display will take you to the Audio Setup / Further Audio 

Settings page, to allow you to change this. 
Input Res (input resolution) Double-clicking on the display will take you to the Audio Setup page 
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Output Res (output resolution) Double-clicking on the display will take you to the Audio Setup 
page 

Tempo Double·clicking on the display will allow you to alter the tempo directly without 
having to go to the General Setup page. 

Varispeed Double-clicking on the display will take you to the Audio Setup page 
Output Format Double-clicking on the display will take you to the Audio Setup / Further Audio 

Settings page. 
Record Format Double clicking on this has no effect - this is display only. 

Display Titles 	 When selected, each display shows its description in full. 

AUDIO SETUP 

Input Source 	 Select which physical inputs are active for routing and recording. 

Input Resolution 	 Select the sample resolution (how many bits per sample) of the input. For analogue 
input, XS/XACT converters are limited to producing a 16-bit signal, octavia system 
converters can convert at 20-bit resolution. For digital input, set to match the input 
data, unless you want to reduce the resolution. 

Sample Rate 	 Sets SADiE's working sample rate, for recording and playback. Obviously, SADiE can 
only replay audio at one sample rate at any time, so if you mix Tracks recorded at 
different sample rates in the same EDL, one of them will be replayed at the wrong rate 
and sound speeded up or slowed down . Selecting Varispeed allows you to vary the 
sample rate for special effects. 

Output resolution 	 Sets the output resolution at the digital outputs, or supplied to the digital-analogue 
converters, which on XS/XACT systems are limited to 16-bit, on octavia systems to 

20·bit. No point in setting this higher than the material you are replaying. 

Default record disk 	 Only applies to recording outside any PrQject. When recording within a Project, there 
is a separate disk selection in the Project window's Tracklist. 
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Cue Points 

SADiE will recognise any cue points that were recorded by the GX8000. These can be displayed 
by right mouse clicking on the entry in the EDL There is an option to SHOW CUE POINTS, which 
will change the height of the stream a little. The cue points will be shown underneath the EDL 
entry. To locate to cue points, there are two self explanatory hotkeys - LOCATE TO NEXT CUE POINT 

& LOCATE TO PREVlOUS CUE POINT . These are setup in the Playlist section of Hotkey Setup. 

Note that the cue points are embedded in the audio track and thus mark source times unlike 
Locators which mark EDL times. 

Saving Projects to the GX8000 

It's possible to reserve a small area of the GX8000 MO disk for SADiE to write to by setting a 
SADiE partition. This can be used by SADiE for saving project components (EDLs, Mixers. 
Clipstores etc.) to. This way the audio material and SADiE's edit information can be kept for 
archive purposes on the same disk. 

To backup you project to the GX8000: 

1. 	 Make sure that the GX8000's Internal MO disk is logged in SADiE's Disk Management ­
instead of reponing' unrecognised format' as when the MO disk has no SADiE partition, 
SADiE will see the partition - calling it 'SADiE on Ge' 

2. s backs up the project components to the disk which is set for recording to ­

press the Select Audio Disk button in the Project Window, and now select the 'SADiE 
on Ge' disk. 

3. 	 Now, from the Project menu, select Backup Project. Select the first option: Backup project 
components to the audio drive and press OK. The components will be saved to the project 
directory on the GX8000 MO's partition. 

To restore the project, as long as the 'SADiE on Ge' disk is logged, then selecting Restore Project 
from the Project menu, and choosing Restore project components from the audio drive, will 
offer you the project. 

Important notes on operation of Genex GX8000 

The GX8000 does not behave exactly like a normal disk drive, and so some things you may take 
for granted with disk drives are not possible. 

It's panicularly imponant not to power down the GX8000 while it is attached to SADiE and the 
SADiE software is running. This will fatally crash SADiE's SCSI bus. The only way to reset it is 
to power everything down and start again. 

Similarly it's inadvisable to eject the MO cartridge, or to switch the GX8000 out of or back into 
DAW LINK mode while the SADiE software is running. 

If you want to power down the Genex, remove or replace the MO disk, switch the Genex out of 
DAW link mode or back into link mode, then you must exit SADiE beforehand. If you follow 
this rule then you will be able to re-enter SADiE when you have put the GX8000 back into 
DAW Link mode, without having to power down the Pc. 

8:57 





SADiE User Manual vJ.7 	 Chapter 8 . Spmfic App/icarrons 

• 	 Record-enable the presenter Stream, and play the first insert. Drop into record (by pressing 
the record button) just before it ends, and the presenter can pick up straight away with their 
link. 

• 	 While they are reading the link, pull the next insert out of the Clipstore, (if using a mouse, 
have it hovering over the correct Stream, with your finger still on the button) and paste it in 
on cue. Autoplace will position it for you. As SADiE is playing an EDL that doesn't know the 
Clip is there yet and you won't hear it immediately, so 

• 	 Stop playback, and re-start from just before the new insert (with the mouse you can do this in 
one go, by double-clicking in the time bar) . 

• 	 You are now ready to drop into record at the next link, and repeat the above. 

• 	 After recording, the whole programme is in order, with the joins between links and insertS 
very likely to need no more attention. You can go through checking them and editing any 
presenter fluffs. 

The great advantage of this is that the Presenter can hear and respond to each insert, and you get 
the flow of the programme. The slight delay (four or five seconds, tops) that everyone hears 
between each link and the following insert should not be much of a problem. 

ROCK-AND-ROLL RETAKES 

It's easy to record this way with SADiE: 

If the artist fluffs, stop recording but keep the voice-over Stream(s) record-enabled. You can play 
back their last few words and drop in by hitting the record button on the fly. 

If the drop-in doesn't sound too good, don't worry - you haven't lost any of the previous take! 
The join between the two Playlist entries at the drop-in point is an edit that can be adjusted like 
any other. The previous take is there for bits of it to be pulled back in. 

MUSIC EDITING 

MULTIPLE TAKES 

If the material is recorded to sync or keeps a steady tempo, you can place multiple takes on 
different Streams and use the solo buttons to switch between them. 

Then make your razor-cuts at the edit points, delete the out-takes and swap sections from other 
takes using Autoplace Butt. If you used synchronisation when recording into SADiE, different 
takes will share a timecode reference and you can use Autoplace by Track time. 

Tidy up the edits with Playlist Editing, or the Trim Editor. 
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GENEX GX8000 


------~ . ---	 .
-. 
~'~'-. - - - - - ......... 

.~:-=~ . .; .. '.. ­

. 	 ::.--- ~: .... -- ~ --=. ~- - . 

SADiE includes support for the Genex GX8000 magneto-optical disc recorder. This unit records 
up to 8 tracks of 44.1 or 48KHz audio at up to 24bit resolution, or 4 tracks of 96KHz /24 bit 
onto MO cartridges. The GX8000 has a SCSI interface which can be connected to SADiE's SCSI 
bus so that SADiE can read the audio tracks directly for editing and so you don't have to copy the 
tracks into SADiE in real-time via AES/EBU. 

1. 	 Connect the GX8000 to SADiE's SCSI bus. Take care over termination and make sure that 
there is no SCSI ID conflict. The GX8000 takes TWO SCSI Ids - one for its MO drive and 
one for the GX8000 itself. You can find out which are in use by looking through the 
GX8000's setup - Int SCSI ID is the ID the MO is set to; DAW SCSI ID is the In of the 
GX8000 and is the lD that SADiE will 'see' the GX8000 at. 

2. 	 Set the GXSCCO to DAW LINK - SADiE. This disables all the front panel controls on the 
GX8000 and allows the disc to be logged in SADiE 

3. 	 Start up SADiE and log the GX8000 on the ID set for DAW SCSI ID. You will not be able 
to log the MO drive itself - SADiE will report 'Unrecognised drive'. 

4. 	 In Disc manager you will see a SADiE track for each GX8000 track up to a maximum of 8 ­
depending on how many tracks the MO is set up for. Note that the GX8000 only has one file 
per channel, and when you stop and start recordings, you are appending the 8 files, rather 
than creating extra ones. 

5. 	 The GX800C tracks can then be imported into a clipstore in the usual way, and dragged into 
an EDL and played as any clip. 

The MO drive [' the GX8000 is of lower performance than a standard hard disk, and depending 
on your SADiE hardware platform, you may find that during playback, SADiE will report 'Disk 
too slow'. It is usually possible for SADiE to playback up to 8 simultaneous, continuous tracks 
from the GX8000, but edits may make the EDL unplayable in some cases. 

Depending on the complexity of your work with the GX8000, you may find it's better to copy 
the tracks onto a normal hard disk. This will give you the normal performance and make edits 
play correctly. 

To copy the GX8000 tracks to a SADiE hard drive - use the usual 'drag and drop' in Disc 
Manager. The speed will be a little slower than a normal hard disk to disk copy, but faster than a 
real·time AES/EBU transfer. 

Profiles 

GX8000 tracks can only be viewed in Profile view in SADiE if the GX8000 has been set to record 
profiles - ProfIles ON in the GX8000 setup. Otherwise, they win appear empty. 
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4. 	 You can use the PQ editors preview buttons to check your list if you wish . 

5. 	 Once you have marked the track starts, you are now ready to play the EDL to DAT (or CD). 
Make sure that SADiE's output format is set to SPDIF. 

Now press e READ/WRlTE PQ DATA ' 

Against SELECT CD PREMASTER DEVICE select AUDIO DAT (or SPDIF CD-R). 
Pressing the WRlTE button will start the playout. You will first get a message telling you put 
the DAT or CD-R into record, and on pressing OK, the playout will start. The EDL will be 
played until you stop it with the transport controls or until it reaches the point 10 seconds 
after the END OF CD flag. 

Notes on SPDIF CD-R recorders 
In SPDIF CD-R mode, before you press OK to start the playout, SADiE is in a 'paused' 
condition and is not clocking the SPDIF output. When the playout starts, the clock 
sets, and the CD player subcode is started. Some CD-R recorders can take this as a 
signal to start recording, in which case the track start flag for Track 1 will be in the 
correct place. 
Other recorders will make the first track at the point you press record, and will start to 
record immediately. If you start SADiE playing out within 5 seconds of starting the 
CD-R recorder, then no new track flag will be made; if you wait until after 5 seconds, 
then the EDL's track 1 will be track 2 on the CD - timings will however be accurate. 
Similarly, at the END OF CD flag, SADiE does send the correct flag, but some CD-R 
recorders will not recognise the flag. Others will see this flag and stop the recording 
automatically. 
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RADIO PROGRAMMES 

EDL START TIME 

If you are not synchronising to timecode, it might seem logical to start the first Entry in your 
EDL at 00:00. However, this makes it more difficult to start playback from the beginning by 
using the mouse in the time bar, and it also prohibits the SLIP function from moving any Entries 
to the left. If you start the EDL at 00:01:00 or 01:00:00, you will leave plenty of room to the left 
and can easily subtract one minute or one hour from the current-time display to get an idea of 
your running-time_ You can do this at any time by moving all the Entries along, with SLIP on. 

USING CLIPSTORES AS YOU RECORD 

If you are using SADiE to assemble a programme from lots of material that is on another 
medium, and not in the correct order, it may be most convenient to dedicate a Clipstore to the 
programme, and work from that. 

Say you have a W' tape or DAT with many inserts. You can record them into your Playlist in 
one go, but use the razor-cut between each to create separate EDL Entries. Whilst recording 
continues, you can rename each with a name relevant to the material (right-click over the EntryIII 

SAVE TO 

CllPSTORF. 
 in the Playlist), then select it and save it to the Clipstore. 

Then, rather than re-ordering the Entries in the EDL that has just been created, open a new 
Playlist, pull Clips out of the Clipstore and paste them into it in the required order. Have 
Autoplace (butt) on and they will butt up together as you drop them in, and you can use PIaylist 
Editing to fix each join later. 

PICKING THE GOOD BITS 

You didn't mean to, but it happened again .... you came back to the office with tv,-o hours' worth 
of material on tape and the interview needs to be six minutes maximum! 

Record it all into SADiE, whilst having a listen and getting an idea of where the good bits are. 
Then, with the whole interview on Stream 1 (or 1&2, or whatever), you can scrub-and-cut to 
identify the rough bits you want to use. Rather than remove the rest, drag out the bits you like 
and paste them onto the next empty Stream(s). Have Autoplace (butt) on and they win join up 
together. 

You can now keep referring backwards and forwards between what you are picking and what 
you're leaving behind. Use the solo buttons on the Streams to choose which you are listening to. 

LIVE COMPILING 

You can make a very good approximation to the old way of recording a programme of pre­
recorded inserts linked by a live presenter: 

• 	 Have aU your inserts ready topped and tai.led in a Clipstore. If you put a number in front of 
their name, they will be listed in the correct order for the programme. Enable Autoplace-at­
current time and have Autotake on in the Transport Controls. 

• 	 Decide which Stream(s) you are going to use for inserts, and which for the presenter{s). 

• 	 If the programme starts with an insert, paste it into the Playlist. 
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DAT & CD IDs 

DA T & CD IDS ON AN INPUT 


SADiE can be set to recognise subcode on an SPDIF digital audio signal . When a OAT ID or CD 

Track 10 is read while recording to an EDL, SADiE will automatically perform a razor cut on 

the entry so as to mark it and divide the recording into separate entries for separate tracks on the 

OAT orCD. 


To enable this feature, press the button marked ID on the Transport Controls to choose between: 


NONE turns the function off. 


CD subcode reading will only be turned on for CD subcodes. 


DAT subcode reading will only be turned on for OAT IDs. 


AUTO subcode reading will be turned on automatically when either a OAT or CD is 

recognised. 


Note: 	 CD and OAT IDs are only output on an SPDIF signal and there is no standard place 
for them in the AES/EBU subcode. SADiE's format setting is unimportant· SADiE 
will recognise SPDIF or AES/EBU audio whatever SADiE's output format is set to, 
and whatever (digital) connector it is input into. View the Input Monitor Window for 
more information about the signal on a digital input. 

CD Monitor Window 

On recognising CD subcode, SADiE performs a razor cut at a track start, but additionally, , the 
CD Monitor Window will pop up. This can also be shown by selecting it under the ~IEW menu. 
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This gives details about the CD - the track number currently playing, how long it has played for 
and time remaining. Also there is a display for the track's ISRC code and the CD's mode 2 bar 
code. 

OAT & CD IDS ON AN OUTPUT 

SADiE can output DAT IDs or CD track starts on the SPDIF digital output. The OUfPUT 

FORMAT (in Setup; Audio; Further Audio Settings) must be set to SPDIF for this to work, but 
the signal will appear on both phonoloptical and XLR connectors for outputs 1 & 2. 

There is no provision in the AES/EBU stream for either DAT IDs or CD track starts. 

The use for DAT IDs is obvious; CD track starts less so perhaps - this is for use with audio CD 
recorders - when these devices see a CD on their digital input that is changing track number, it 
causes them to put a new track start on the CD-R. Therefore SADiE will emulate a CD player 
and output tracks starts at the appropriate time. 

The positioning of the DAT or CD IDs is set in the PQ editor. It will help to have an 
understanding of the PQ editor, but the following gives you a brief description of how to prepare 
your EDL for DAT IDs. The procedure for CD tracks starts is identical. 

1. 	 Open the PQ editor b~; pressing the III SHOW TEXT PANE button on the EDL, and select the 
PQ tab. This will also reveal the PQ stream above the playlist. If there is no PQ stream, this is 
because you have PQ disabled for this EDL - you will have to turn it on in the PQ setup page, 
and then create a new EDL. 

2. 	 The next step will depend on your EDL. The simplest way to make a PQ list is by using the 

GENERATE PQ button, which will place a flag on the beginning and end of every entry in 
the :list. There are some settings under 'PQ flags' to make this generate a more suitable list, but 
if, for instance you have several edits in each track, one way of making the EDL match the 

way you want the DAT IDs to happen, is to use the grouping function to group entries 
together into one entry per track. Then pressing the GENERATE PQ button puts flags on the 
beginning and end of every track. 

Note: Only track start flags - marked as T rack n ID 1 - are used for DA T and CD IDs - all 
others, including the end flags - IDO - are ignored. 

3. 	 Alternatively you can hand-place PQ flags. Make sure the. INSERT TRACK is pressed in on 
the top left side of the EDL. Then when you click in the PQ stream a PQ track start nag (and 
its associated 'previous track end' flag) will be placed at the position you clicked. These flags 
can be adjusted by hand - if you hover over a flag with your mouse, the mouse cursor changes 
to a 'hand' and then you can click and drag the flag to a new position. Additionally, position 
the current time cursor where you want a flag to be moved to, and then right mouse clicking 
over the flag gives you the option to SNAP PQ INDEX TO CURRENT TIME. 

The only important flag other than the Track n ID 1 is the END OF CD flag. This will be 
placed at the end of your last entry when you use GENERATE PQ or 1 hour after the first flag 
you manually drop into the PQ list. This flag is used to stop the playout and so if you have 
any entries after the END OF CD, they will not be played 

I Note: 	 The first track's flags cannot be dragged by more than a 1 second. The reason is only 
relevant for full red book PQ lists. If you want to move the first track flags, then you 
have to use the SNAP PQ INDEX TO CURRENT TIME method. 
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This section shows information about the CD recorder and the disc, ands allows to change some 
settings for the track you are about to record: 

CD-R TEST MODE - this sets the laser to low power and so SADiE will go through the motions of 
recording the track, without actually burning it to the disc_ This is useful in case you want to 
check to see if the system is fast enough to write at the chosen speed. After using Test mode, some 
CD-recorders need to be powered down and up again to reset the laser to full power again. 

CD-R (1) in the diagram above shows you which SCSI device (1 in this case) you are using. 

CD-R SPEED sets the speed for the recording. It's advisable to calculate whether your system is 
capable of the speed you've set before recording_ CD-Rs have to be recorded in a constant stream 
and so if SADiE cannot deliver the audio continuously at the set speed, the CD-R recording will 
stop and the disc will be wasted. If for instance your SADiE hardware is a capable of playing 
approximately 8 tracks in real-time, then it's unlikely to be able to achieve more than 2 tracks at 
4X speed. Processing and cross fades will have an affect too. If in doubt, try Test mode first. 

FIX UP CD - pressing this button will fix up the CD. You will not be able to add any more tracks 
to the CD after fLxlng it up, but you will be able to play it in a normal CD player. There are 
other places in SADiE to do this - in the 'Read / Write PQ Data' window, available from the PQ 
toolbar, and also in Disc Manager. 

When you are ready to record the track, press START and the recording will proceed. Note that 
with SOURCE set to anything other MUlTI will write just one track to the CD-R, but the MULTI 

option will create a separate track for each entry in the EDL. 
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Playing Orange Book CDs 

Note: 	 You cannot log tracks off an orange book disc in a Yamaha CDR-l 00 and therefore 
you will not be able to play the disc with SADiE, until it is fIXed up. This is possible 
with a Yamaha CDR-400 drive. You may not be able to log tracks created with another 
recorder. 

If the CD-R drive allows it, Orange book CDs can be logged in the usual way in either Disc 
Manager or from the PQ data window - available from the PQ toolbar. 

Logging the disc in Disc manager will show each track separately, and these can be imported into 
the project via the clipstore, and then dragged into an EDL like a normal clip_ 

If you are able to log the disc in the PQ data window (press READ) then the track start flags for 
each existing track on the disc will appear in the current EDL. 

MULTISESSION CDs 

It is possible to create a CD-R disc with two sessions - one a normal red book CD Audio session, 
the other might contain data of another sort. A CD player only recognises the first session on a 
disc, and so will see this disk as an ordinary red book CD. A CD-ROM drive will see the data 
session, which could contain graphics, video or other data. 

If you tick the MULTI-SESSION button in the 'ReadIWrite PQ data' window before writing a CD­
R, SADiE will write the red book session as normal using the PQ list, but on finishing this 
session, will leave the disc open for another session. 

Currently the second session will have to be written outside SADiE, but this does allow you to 
use the powerful PQ editing tools in SADiE for the CD Audio session, and then take the disc 
onto a different CD authoring system to write the data session. 

Multi-session support is an optional feature - contact your dealer for details of how to obtain it. 
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Now the routing is like this: 

Streams 1 to 4 ? Bus 1 &2 ? Output 3&4 ? External Equipment? 

Input 1 &2 ? DigiLim 1 In ? Mastering Limiter? Output 1 &2 ? CD-R 

You will also have to consider Audio Settings. If you feeding the external analog, then normal 
Auto clock settings with Input source set to Analog is fine. If you are feeding digitally to the 
external equipment then you will have to set up the clock source in a way that avoids a feedback 
loop. There are a number of ways of doing this - if you already have SADiE locked via a separate 
AES genlock clock, then I assume you will also have the external equipment locked to the same 
AES clock, however if this is stand·a1one, theD it is best to set: 

Audio input: (in Setup Window; Audio) AES 

Clock Source: (in Setup Window; Audio; Further Audio Settings) Internal 

This way, SADiE is the master clock, and the external equipment should be set to clock to its 
input. If it's possible to set one of the external units to be Master clock, then you will need to 

change SADiE's clock source to be Genlock to Input 1&2. 

Hint: If you're using the same kind of processing and mixer setups for most jobs - save the 
mixer as a template (see Chapter 9 . Customising SADiE,. Playlist and Mixer Templates) 
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ORANGE BOOK CDs 

In addition to Red·book, disk·at-once CDs, SADiE can create Orange book, track·at-once CDs . 

Red book CDs include the full PQ data· multiple IDs per track, ISRC codes, Mode 2 bar codes 
etc., and these have to be written to the CD-R media in one go. Once the disc is burnt it is 
complete and no more tracks can be added. 

Orange book CDs have reduced features - each track has essentially only a Track Start flag, but an 
advantage is that tracks can be added at different times. However, the disadvantage of Orange 
book discs is that a normal CD player will not play them, unless they have 'been 'fixed up'. When 
an Orange book disc is 'fixed up', no more tracks can be added to it and it effectively becomes a 
finished Red book disc. 

Before they are fixed up, there are some devices that will play them back - for instance you can 
buy Orange book players and recorders. SADiE will play orange book discs with some CD-R 
drives. 

Recording Orange Book Tracks 


To add a track to an Orange book disc is very simple - this is 


procedure. Select an entry or group of entries and press the I Bounce button. 

In the DESTINATION section of the Bounce window, there is an option for CD-R. Ticking this box 
will first log the disk in the CD-R drive to check if it can be used for Orange book tracks, and 
then it shows a new section on the bottom of the Bounce window, as in the diagram. 
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There is a special mode which enables you to make a CD Master to DDP or CD-R while listening 
in real-time, which will also allow you to use real-time inputs and outputs so that you can use 
external processing. 

Real-time DDP 

Most Exabyte drives are able to play and record audio at real-time, however, please note that one 
of the most popular drives - the 8505 model - performs a re-calibration every nine minutes or so, 
which stops the process for too long to continue a real-time playback. If you are unsure, test your 
drive first . 

Real-time CD-R 

Under normal circumstances, there some difficulties with real-time CD-R - in particular the fact 
that when a CD-R is written, there is a long halt near the beginning while the PQ data is beingREADt'WRfTE 

PQ DATA written. However, SADiE can accommodate this by delaying the writing process (but still 
playing back continuously) until the CD writer is ready for more data. To initiate Real-time CD­
R writing, edit the PQ as normal, and when it comes to writing the CD-R, open the Read and 
Write PQ data Window, and press the button next to Non-Real-Time so that it is NOT ticked 
(i.e. NOT non-real-time). 

When you press Write the playlist will start to playback as normal. The CD-R will start soon, 
but there will be a significant delay between play finishing and the CD-R write process finishing. 
Therefore DON'T eject the disc until you're sure the CD-R write is complete. SADiE will 
continue playing for about twenty seconds after the end of the PQ list, but when SADiE 
automatically stops there will be up to about 4 minutes before the CD-R itself is completed. 
During this period you can, it's not recommended to use SADiE to play/ edit etc., if for instance, 
by playing back or scrubbing too many tracks you were to cause a DSP overload, the CD-R write 
would be spoiled_ 

Wait for the CD-R write to finish - at the end of writing, a message will pop-up 'Winding Up 
Audio i/o - writing lead out' and then SADiE will report 'PQ audio image file written 
successfully'. 

Note: 	 when you first enter the Read/Write PQ data window, a write speed will be 
recommended in the usual way . When you de-select non-real-time (i.e. select real-time 
) this setting is over-ridden. Of course, a real-time CD write will have to be at IX, but 
the user doesn't have to change that setting - it will happen automatically. 

DSP Issues - it's worth noting that writing a CD-R like this involves the use of a fair bit more 
processing than a non-real-time write - if a CD-R will write at IX in non-real-time, that doesn't 
mean that it will do so at real-time_ You've may have added another mixer strip to handle the 
input from the outside world, and the extra buffering required to see the write process through 

Routing hints for Real-time CD Writing 

As suggested above, one of the reasons you will want to use Real-Time CD-Writing is to allow 
you to use your eX1:ernal processors in-line during the write and hence avoid a time-consuming re ­
record process. 

I'd advise that you look at Chapter 6 which describes the mixer and particularly its routing 
methods (but you've read that already haven't you ?), however here's a brief discuss ion on how to 
patch external equipment into the mixer. 

Because of the flexibility of SADiE's mixer routing, there are a number oi different ways of 
setting the mixer for this purpose. This is just one example. 

Example 

8:45 



SADiE Usn- Mamull vJ.7Chapter 8 . Specific Applications 

This simple example uses 4 outputs and 2 inputs. We're using output 1&2 for monitoring (plus, it 
should be noted, the CD master is AL WAYS made from Outputs 1&2). Outputs 3&4 will be 
used to send audio to the external equipment (for example an EQ unit and a compressor - in this 
example I'm putting the whole signal through the external equipment). Inputs 1&2 are used to 
patch the outputs of the external equipment back into SADiE. 

To produce a mixer like this, I've deleted some strips I didn't need, changed the master output 
(the right hand yellow fader) to be sent to Output 3&4, and dragged a new stereo fader onto the 
mixer. As it happens the default routing for a new stereo fader is from Input 1&2 to Output 1&2 
so I don't have to change that at all. 

So you can see that the routing here is : 

Streams 1 to 4 ~ Bus 1 &2 ~ Output 3&4 ~ External Equipment ~ 

Input 1 &2 ~ Output 1 &2 ~ CO-R 

A variation on this might involve using a SADiE plug-in somewhere in the chain - for instance a 
Digital Limiter or perhaps UV22 or Dither. These particular processes would normalily be placed 

ri~ht at the end of the c~~n. T ~ a~d litallimite~ to t~e mixer above, open the Process 

WIndow drag a Digital Limiter ~ onto the rack. We want to route the return from the 
external equipment to the Limiter and then on to Output 1&2 so that the result can be recorded 
to the CD-R. 

So, starting with the first mixer, now change the routing as per the picture below - the Input fader 
has its output routed to DigiLim 1 In, the Limiter has its input set to this same DigiLim 1 In bus, 
and you should change its output to go direct to Output 1&2 
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fTING SURROUND BUSSES TO PHYSICAL OUTPUTS 

The two main points that need addressing, with regard to routing surround strips to physical outputs, are: 

1. Of the available physical outputs, which ones can surround strips actually be routed to? 

2. In what order will the individual mono sub busses actually appear on these outputs? 

WHICH OUTPUTS CAN I ROUTE MY SURROUND STRIPS TO? 

SADiE uses a simple rule to decide where you can actually route to: 

If the number of channels, n, is 1 or even 

You can route the bus to every nth physical output starting from o/pl. 

Other~.-ise 

You can route the bus to every n + ph. physical output starting from 01pl. 

The second half of the rule is necessary to ensure that busses with odd numbers of channels (excluding mono 
busses) are treated as though they had an even number of channels. This guarantees that all busses (with the 
exception of mono busses) are aligned with an odd numbered output. Don't worry if you currently find all this a 
little confusing and meaningless - once you start using SADiE you'll soon understand and appreciate the need for 
this rule. The most important thing to remember at this stage is that SADiE won't let you do anything that isn't 
allowed. 

To save you having to work out the full implications of the above rule we have produced the table below. It 
clearly illustrates all the possible valid output routings for each type of bus in a system with 8 outputs. The 'grey 
holes' do not necessarily indicate unusable outputs, only that they are unusable by a bus of the same type as the 
column in which they appear. For example, if you were creating a 5.1 format mix it would be perfectly legal to 
route your main LCRSS bus to olp 1·5 and to then route your mono bus (representing the .1 channel) to olp 6. 

f---'------I o/p 3-4 

~...c...;:"""""_--I o/p 5-6 

f---'------I o/p 7-8 
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As you continue to decrease the divergence, the variation in the level of each channel during a pan continues to 

decrease, until you reach the minimum setting (no divergence at all) where no change occurs, and the pan cont 
therefore has no effect. 

You may have gathered by now that using the divergence control is something of a compromise - too little and 
you create unnatural results that don't work across an entire auditorium, too much and you start to lose the 
benefits of stereo sound. 

The ability to control divergence is especially important when mixing to picture, and will rarely be left set at its 
maximum value. Of course, in the case of music production there are no such constraints, so you should just 
consider divergence as another creative tool. It is important to remember though, that you will not be able to 
produce truly 'natural' effects whilst the divergence control is at its maximum setting. 
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\KING USE OF MIXER TEMPLATES 

You may have noticed that creating a basic mixer for surround sound work can be a rather involved and tedious 
process. First you had to start with a standard LR stereo mixer and then remove all (or some) of the strips before 
adding the required surround sound strips. Finally, you then had to set up all the routing, creating the necessary 
surround busses as you went. 

Fonunately there is a solution to this inconvenience and it involves a feature that some users may already have 
experimented with in the past - 'Mixer Templates'. 

SADiE features both playlist and mixer templates, but we'll just concentrate on mixer templates, although all of 
the concepts involved apply equally to both types. 

] ust think of a mixer tern plate as an ordinary mixer which you have created and saved in a special location. 
Actually, the only real difference between a mixer template and an ordinary mixer is its filename extension (.MST 
rather than .MSU). Once you have created one or more templates you can then tell SADiE to create any 
subsequent new mixers from a specific template. Alternatively you can ask SADiE to allow you to choose which 
template to use at the actual moment that a new mixer is to be created. 

CREA TING A MIXER TEMPLA TE 

Creating a mixer template is very simple indeed. The easiest way is to just create a new mixer using the New 
option on the main File menu (don't bother adding it to the currently open project when asked). You can then 
edit this mixer into the mixer of your choice. 

Once you are happy with the mixer you have created you will need to save it as a template. To de this select Save 
current mixer as template... from the main File menu (this option will only appear on the menl. if the mixer is 
the currently selected window). A suitable directory will automatically be selected, so all you need to do is give it a 
name and press OK. 

Your template has now been saved and is ready for use . 

USING A MIXER TEMPLATE 

To set SADiE up to use a template, you need to open the Setup window and go to the Temphte:: topic, which is 
a subtopic of Project Management. (To reveal the Templates subtopic, double click on the Project Management 
topic entry). This will reveal the template set up options. 

By default, templates are not used. To use specific playlist and mixer templates click on the 'Use the specified 
templates' option. This will enable the two 'Change' buttons in the section below. Click on the one next to the 
edit box labelled 'Mixer'. You should now see your previously created template(s) listed. Make your selection and 
press OK. 

From now on, all new mixers will be created from the mixer template that you have specified. Playlists will 
continue to be created in the normal non template way, because no template has been specified. 
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If you find yourself unable to route your strip to where you believe you should be able to, check that one or more 
the outputs in question are not already being used by a different type of bus in another mixer strip. The most 
common cause of not being able to route your LCRS strip to o/pl-4 is an LR stereo output strip routed to 0lp1 
somewhere else in your mixer. Failing this, check that you don't have any Aux Send processes using the desired 
outputs. 

IN WHAT ORDER WILL THE MONO SUB-BUSSES APPEAR ON THE OUTPUTS? 

You might be forgiven for thinking that if you routed an LCR output strip to olp 1&2&3 that the left channel 
would appear on 01p1, the centre on 0/p2 and the right on 0/p3. 

What actually happens in this particular situation is that the centre and right channels are 'swapped over'. This 
ensures that the left and right channels always occupy the first two outputs, maintaining compatibility with 
conventional LR stereo routing. Additionally, when combined with the 'odd' bus alignment rule mentioned in the 
previous point, it also ensures that the related left and right channels will be sent to the same AES output. 

The following diagrams summarise the exact routing used for each of the supported surround formats: 

LCR LCRS LCRSS 

[IJ II< OlPn [0 ~ OlPn .. OIP nCD 
0 OIP n+l OIP n+l OIP n+lCD X 
 0 
0 X 
 OIP n+2 
 IT] OIP n+2 
 OlPn+2
0 

[TI ~ OlPn+3 OIP n+3 

§] OIP n+4 

@] 

For consistency, a similar re-arrangement of the surround channels occurs if you route a surround format input 
back into SADiE through three or more physical inputs. In order to work out which channel to apply to each 
input, use the above diagrams in reverse, following each input back to the appropriate channel. 
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My output channels seem to be jumbled up - channels don't seem to be appearing on the expected outputs. 

Surround busses get re-ordered slightly when they emerge into the real world. There are several reasons for this, but the main 
two are: 

1. 	 To ensure that the first two outputs are always L and R (to prevent you having to re-route your output wiring when 
switching between LR stereo and surround projects) 

2. 	 To keep related stereo pairs on the same AES output wherever possible. 

For more information about the exact channel routing used by each of the surround formats, see the section entitled 'Routing 
surround busses to physical outputs' 
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If you ever \I.·ant to change your choice of template or mode of working (as you inevitably will sooner or later) 
then just return to the Templates setup page and make your changes. All of the settings in this window are also 
user specific, so each user can have their own preferred template configuration. 

FAQs, TIPS AND TROUBLESHOOTING 

If I create a project whilst the surround sound features are disab'led, will I be able to incorporate surround sound strips into 
the mixer at a later date? 

Yes. The state of the Surround Sound features option when the project is created is of no consequence. If you subsequently 
require the surround features then just enable the option in the Setup window and reopen your project. 

Inserting multiple strips into a mixer is a real 'drag', especially when they are surround strips, because I have to keep 
responding to the 'Input Format' dialog when I drop a strip. Is there a short cut? 

Yes. Instead of dragging the strip button from the toolbar, double click on it instead. If it is a surround strip button sele 
the input format that you require. Then simply click wherever you wish to insert a strip into the mixer. When you have 
finished adding strips, click the right mouse button to exit insert mode. This handy feature also works for inline processes. 

I've enabled the surround sound features checkbox on the Setup window and dosed and reopened my mixer, but I still 
don't get the surround format strip buttons. 

You probably just haven't 'really' closed the mixer. You need to do this from the project window by right mouse clicking 
on the mixer component and selecting Close Component from the popup menu. Once closed, double click on it to 
reopen it again . Alternatively (or if you are not working in project mode), close the mixer from the File menu and then 
reopen It. 

I've got 4 (or more) physical outputs on my system but I don't seem to be able to route my final LCRS output strip to 
0/pl&2&3&4. 

You've probably already got 0/pl&2 assigned to an LR stereo output strip somewhere else in your mixer. Reassign the 
output of the offending stereo strip to a different output or bus (or delete the strip if it isn't required). If this isn't the 
problem check all Aux Send processes to see if any of them are using 0/ pl&2. This problem can also occur with inputs and 
the remedy is exactly the same - except check strip inputs, rather than strip outputs. 
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When you change the routing on the mixer (or change the record input selection at the left side of 
the Playlist) you will notice that you are only offered streams/inputs/outputs and busses 
belonging that unit. Also when you use the process window for plug-ins, when you drop a new 
plug-in into the 'rack ' you will be asked which unit this plug-in will be operating on. 

Playlist and Mixer Jor a twin-card, 16 track, 24.96 system 
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112 - MULTIPLE AUDIO UNITS 


It is possible to run a SADiE system that utilises more than one audio card or unit, to give you 
more processing power and audio inputs and outputs. Each card or block of I/O is called a unit. 
There are a few special rules and concepts that you should be aware of. 

• 	 It is only possible to add extra 24.96 units. This is not possible with the SADiE XS/XACT 
(a.k.a. 'Classic') system. 

• 	 The multiple audio units are synchronised internally to sample accuracy. 

• 	 Extra cards are added as discrete units of audio 110 and playback tracks. It is not possible to 
pass audio from one unit to another other than by routing it via physical audio I/O in real­
time. It's therefore not possible, for instance, to play tracks on one unit and process them on 
another, unless you connect the outputs from the first unit into the inputs of the second using 
physical cables. 

• 	 It is possible to mo'(,'e clips from one unit to another in order to change the playback unit. And 
it is possible to make recordings that span units, creating multi-channel clips that can be edited 
as one clip. 

• 	 Non-real-time operations can only be performed on one unit at a time - the units are 
synchronised for real-time playback but not for non-real-time operations. Thus you must 
choose a unit for each bounce operation, and CD masters can (usually) only be produced from 
one unit. 

• 	 The maximum number of units that can be linked together is four. 

THE PLAYLIST AND MIXER 

The Playlist and mixer displays have divider bars (horizontally in the Playlist, vertically in the 
mixer) with 'Audio U nit A' (or B, C, D) on them to show you which areas of the Playlist and 
Mixer are devoted to which audio unit. The divider bar is at the top of the Playlist streams and to 
the left of the mixer strips that it is referring to. The units are labelled A, B, C, and D (for up to 
four units ), and stream numbers and busses, inputs and outputs on the mixer are prefixed with 
A,B,C, and D. Playlist streams and Mixer strips belonging to a particular unit must be kept 
together - you cannot move a stream or strip from, for instance, unit C to be next to one from 
unit A. 

You can double-click on the divider bars to hide the unit's streams or mixer strips, and double 
clicking again will reveal it 

Playlist streams from one unit can only route through their own mixer unit. Clips can span across 
units, and can be dragged to different units, so if you do want to move audio that originated on 
one unit to be processed by another unit, or to be played out of a specific output, then you can 
just pick up the clip in the usual way and drag it to a different stream on the other unit. 

A common use for such a large multi-track system is as a multi-track player and editor only, and 
it's quite possible that you'll be using a separate mixing console, and so may have no use for 
SADiE's onboard mixer. In which case you may want to configure the streams and mixer as in 
the picture below - you can see that every stream in the playlist is routed directly to a different 
physical output. However in another configuration you may want to use SADiE's own routing­
SADiE's mixer still works exactly as usual. See Chapter 6 Mixer and Processing; Routing for details 
on how to change the mixer routing. Also see Chapter 9 Customising SADiE; Playlist and Mixer 
Templates which explains how to set SADiE to start up with your own design of mixer and 
play list. 
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Record enabling streams 

This can be very tedious with multi-track recordings if you have to push each and every 1m 
record enable button. The good oews is that there are menu options that help speed this up: 

This menu will only be on the top menu bar of SADiE if the playlist is selected - click once 
anywhere on the play List to focus it. 

Enable the streams you wish to put into record by pressing the Stream Name button I '2 1­
a stream is enabled when the bunon is pushed in. You can enable multiple streams by holding the 
SI-UFT key when pressing this button - all the streams at the same state above the one pressed 
change state. Holding the CTRL key while pressing this button enables ONLY the one selected 
and disables all others. 

Then you can record enable all the enabled streams using the Playlist menu option. Also there is 
an option to disarm all record enabled streams for when you've finished recording. 

BOUNCING AND NON-REAL TIME OPERATIONS 

You are only allowed to Bounce on one unit at a time, either in real-time or non-real-time. 

The Bounce window has a Unit Selection box which allows you to choose which unit is doing 
the bounce, and this is normally automatically selected for you on the basis of the source you 
have selected before going into the bounce window. However you should be careful when 
selecting the source clips not to select clips on the wrong unit (or across units). If you do, these 
will be included in the bounce - oot their audio, but their length will have an affect 00 what gets 
bounced. For instance if you are bouncing some clips on unit A, but also select a clip on unit B 
which finishes ten minutes later than the clips you really wanted to bounce, then the bounce 
process will continue for that e:>'1:ra ten minutes, but the clip produced will be empty for that 
period. This is not a serious problem, and you will see warnings if your selection spans more than 
one unit, but it can be a time and disc space waster. 

Otherwise the bounce window works exactly as explained for single unit systems in Chapter 4 ; 
Bounce-Down. 

Here are two examples of situations where you may want to bounce dowo a multi-unit EDL into 
a stereo pair - 1) wheo you're making a stereo master, or 2) when you're making a CD master 
from a multi-track EDL. To perform this you will have to route the mixer in such a way that you 
can record every unit's master outputs back onto disk. 
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SCSI DISKS AND RECORDING 

To allow the flexibility of moving clips across different units, all hardware units will share a 
common SCSI bus and each card will occupy its own SCSI ID . One unit (A) will be considered 
the 'Master' unit and will be at ID 7, other units will reside at 6, 5, and 4 (for a 4 card system). 
Thus there is room for at least another 4 SCSI drives, which will be shared by the audio units. 

When recording, it's possible to record to one specified disk drive, or to choose a different drive 
for each unit. It depends largely on the scale of the system and recordings, but you may find that 
a single disk drive is not fast enough to record 32 tracks simultaneously, and so you may to 
choose to record to multiple disks to spread the load across 2 or more disks. 

When you start a project, with a multi-unit system (which has more than one disk drive), you 
will be offered the Audio Disk Selection Window: 

Audio Disk Selection IOf PlOject RecOfdmg r.­

This lists the recordable drives attached to your system. 

This window will open up showing the Unit A selection, defaulting to Use specified disk(s) and 
if you select a drive and press OK, then that will be chosen for every unit. However by clicking 

on, I.e. _=-_.... you can select a different drive for some or all units. 

Use least full local disk allows you to record to whichever drive has the most space remaining 
(but only one drive for all units). 

Use each local disk in tum will choose a different drive for every track when SADiE goes into 
record. This is irrespective of how many units you have. The number of tracks depends on how 
many streams are involved, how they are grouped (a stereo track is one track not two) and what 
file format you are recording to. So if for instance you are recording 8 tracks across 3 units and 
you have 4 disks connected, then each disk will record 2 tracks, and thus the load on the disks is 
evenly spread. If your disks start to become full, for multi-track recordings, your maximum 
record time is the time remaining on the most full disk drive. 

Tracks that are recorded at the same time are grouped together in the playlist and can be 
mani pulated and edited as if they are one single, many-channel clip. You can separate these clips 
out and regroup them, as long as they are still in the same time relationship to each other. This 
applies to multi-unit and multi-disk recordings as well as those on single unit systems. 

12;] 



Chapin 12 Multiple Audio Units 	 SADiE User Manual tlJ. 7 

Note that the record input for the new 'Mixdown' stream is 'Output A 1&A2' - we're recording 
the signal that appears at outputs Al&A2. 

Note also that the mixer strip that corresponds to the "mixdown" stream is routed to 
OutputA3&A4 . this is an otherwise unused output pair and routing it this way avoids a feedback 
loop. 

Audio clock settings 
If you're looping one unit back into another like this you may have to consider your audio clock 
settings. If the connection is via analog connections then there's flO problem, Auto or internal 
clock will be fine, but if the connection is digital you'U have to think a little harder about it. If the 
system is completely stand-alone, the 'Auto' will not do - you should set the Clock Source to 
Internal (in View; Setup window; Audio; double click for Further Audio Settings; Clock Source). 
If you're running locked to an external AES/EBU clock then you'll be set to 'Genlock' to 
'Genlock' - physically this is the 'AES Ref In' connector on the master audio unit (A). 

SO it's all ready to go - your slave units are connected and mixed back into the master unit, and 
you're set to record the master outputs - OutputAl&A2. 

A simple way to make the recording now is : 

Press the Home key on the keyboard. 


Press SHIFT-Fll - this sets the Left locator at the start of the EDL. 


Press the End key on the keyboard. 


Press SHIFT-FI2 - this sets the Right locator at the end of the EDL. 


Then open the L&R pane of the transport controls as in the picture, and press the 
'Punch' button. 

Record enable the 'Mixdown' stream and locate the EDL to a few seconds just before 
the Left locator. 

Press play - the EDL will start playing and automatically drop into record at the Left 
locator, and out again at the right locator, leaving the master stereo mixdown on the 
'Mixdown' stream of the EDL. 

CD MASTERING WITH MULTI-UNITS 

CD masters can be created to CD-R, DDP or 1630 in the usual way with Multi-unit systems, 
however with Non-real-time masters the same rules apply as with bouncing· the master can only 
be made from one audio unit. 

• 	 Non-real-time CD masters can only use one unit (this should be Unit A) 

• 	 CD Masters involving multiple units can only be made in Real time, and any slave unit's 
outputs must be connected back into Unit A. Outputs Al&A2 are the stereo master mix (a 
little like the example above) 
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Example 1 - creating a stereo mixdown 

Here's an example setup that does this. Each unit is mixed down a stereo pair, and then I've 
connected each of these pairs into Unit A using physical cables in order to produce a single master 
stereo output form Unit A; i.e. 

Outputs B 1 &B2 connect to Input AJ&A4 
Outputs C1&C2 Input A5&A6 
Outputs 01&02 Input A7&A8 

I've created three new stereo faders on unit A that route Inputs A3&A4,A5&A6,A7&A8 onto 
BusA 1 &A2 so that they feed into what is now my main output - Output A 1 &A2. 

This method provides a way of monitoring multi-units on one pair of stereo outputs without 
using an external mixing console. 

To record this back into SADiE, I have created a new stereo stream on unit A - right mouse click 
on the left side of the playlist on the last stream of unit A and select 'Insert Stereo stream after', 
and I've renamed this stream 'Mixdown'. For the sake of conserving page space I've stereo merged 
some of the mixer strips and am only displaying two units but the principle is the same with any 
number of units. 
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Example 1 - creating a CD master 

If your material spans several units, you may choose to make a CD master directly to the CD-R 
instead oi a stereo master on disc. The set-up is very similar to last example - you connect the 
slave units' outputs back into Unit A's inputs to create the stereo mix, but instead of re-recording 
the result back to disc as above, you record straight to a CD-R. 

This prIXess has to be performed in real-time because there is no non-real-time audio connection 
between the units. 

The setup is identical to Example 1 above, however you don't need the 'Mixdown' stream. You 
will need to consider your clock settings as with the first example. Once you're happy with your 
master mixdown, you should then follow the instructions for making a CD-R but be sure to 
untick 'Non-real-time' before starting the write to CD . (See Chapter 8 - Specific Applications; NOleS 
on Rea/·time and Non·rea/·time mastering for more details) 

It's important to be aware that a CD master can only be created from Outputs 1&1. 
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Application windows have a number of standard features; a title bar showing the name of the 
window; a menu bar giving access to various common commands, and a general work area below 
them. If the window is not large enough to display all of the work area's contents, there will also 
be scrollbars. These let you move the contents of the window to see partS that are not currently 
In view. 

Further windows for specific tasks can often be opened within the work area. 

WINDOWS 3.1 & 3.11 

bar 

Main window 
title bar 

Scrollbars 

Desktop 

application 

II 
MS-DOS 
PI""", 

Iu-I<lEt 1"_1dEt lUll4Et 
Network Gomes StartUp 

Icon for a minmised for minimised windows 
within Prog. Manager 

Windows 3.1 and 3.11 have an application called Program Manager permanently running on the 
desktop for looking after programs. It has the same overall format as any other Windows 
application, with a main window containing other windows and icons and will therefore be used 
as our example. The icons represent applications on your system which can be run by double­
clicking on them. They are arranged in groups, each of which has its own window. One 
application you will find is File Manager which lets you organise, copy and change the names of 
all the files on your computer. 
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IAPPENDIX A . WINDOWS BASICS 


The Microsoft® Windows'~ operating system provides a standard graphical user interface for mM 
compatible personal computers (PCs). This means that you don't have to adopt a different way of 
working every time you load a new program. 

USING 	A MOUSE 

Most of the techniques you need to learn to use Windows revolve around the use of a pointing 
device, usually a mouse. Microsoft provide interactive tutorial programs to develop your mouse 
skills and show you how to use the basic elements of Windows. In Windows 3.1 or 3.11 Program 
Manager, use the mouse to point at the word "Help" in the menu bar along the top of the screen 
and click the left-hand mouse button once. Then point and click on "Windows Tutoria1".In 
Windows 95, click on the Start button, then "Help" and then "Ten minutes to using Windows". 
If these are not available on your system, refer to the Windows manual. 

NOTE: 	 If you are using SADiETX with hardware controllers, you will be able to do most 
things without using a mouse (or similar pointing device). However, certain setting up 
procedures and arrangements of the display screen do require mousework so it is a 
good idea to get used to it. You may find that combining the use of the hardware 
controllers and mouse gives you optimum speed and flexibility. 

The mouse is used by pointing at an item on the screen and using the left or right mouse buttons 
in one of four ways (if you have a third, middle button, ignore it):­

Click Press and release the left mouse button once. - Generally used for pressing on­
screen buttons and selecting an object, or item in a list, that you want to work 
with. For instance, if you click on an icon in Program Manager or on your 
Desktop, you will notice that the label is highlighted. This means that the 
program is now selected. Hitting the return key will then cause it to be 
activated. 

Double·click Quickly press and release the left mouse button twice. - Usually the equivalent 
of selecting an item Mld pressing return, i.e. it will make things happen! 

Right-click Press and release the right mouse button. - Rare in Windows 3.1 and 3.11, but 
used in Windows 95 and SADiE version 3 for getting a menu of alternative 
options for an item or part of the screen. 

Drag Click and hold the left mouse button over the chosen item, move the mouse to a 
new position, then release the button. - Used to move things around the screen 
and to select more than one object or text character. 

WINDOWS FEATURES 

The Windows operating system mimics the way you work at a desk. Files (of data or work) and 
programs (tools which you use - also called "applications") appear as objects that you can move 
with the mouse or perform an action on, such as editing a file, running a program, etc. 

All work takes place on the desktop. This is the basic screen area onto which you bring 
applications which appear in the rectangular areas we call windows. Icons are small pictures 
representing files or applications that are not currently running or showing in a window. 

A:l 
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The menu bar drops down menus of options or commands that the application can perform. 
Select a menu by clicking on the required word in the menu bar, or by holding down the Alt key 
and then pressing the letter that is underlined in the word. For example, you can select the ~ile 
menu by pressing AIt+F. 


You will then see the menu of commands which can be selected with the mouse or the keyboard 

letter that is underlined. To select items from further lists, use the i..j, keys 


If the command appears dimmed it is not currently available. 


If it is followed by dots ( ... ) a "dialogue box" will appear to allow you to enter more 

information before the command is carried out. 

If it has a ..-' next to it this option is active, selecting it again will deactivate it. 

If it has a key combination (e.g. Ait +F4), this is a keyboard shortcut for selecting the 
command at any time, without going through the menu bar. 

If it has • next to it this option displays another sub-menu. 

WORK AREA 

This is where the action happens. The type of application will determine the type of display and 
the available operations. For instance, you use the work area for drawing in a paint program and 
typing in a word processor. 

Windows in the work area can be moved around the screen by dragging their title bar with the 
mouse. 

You can change their size by dragging their borders or corners (the mouse pointer will change to 

a double headed arrow). You can't do this if a window is maximised. 

If the window is too small to show you all of its contents, then scroUbars will appear allowing 
you to scroll the contents past the window. You can do this: 

in small steps by pressing or holding down the little arrow buttons. 

2 in steps of a whole window width/height by clicking either side of the moving box. 

3 by dragging the box itself. 

Play around with the Program Manager or Windows Explorer to see what happens. 

DIALOGUE 	BOXES 

Many tasks, such as opening and saving files, cause a box to appear in which you make selections 
and choose between various buttons. The buttons can be directly pressed with the mouse, or you 
can hit the keyboard return key (.J) to press the button that is shown with a heavier outline. This 
will be the most likely, or the safest button to press! Using only the keyboard, you can use the 
Tab key ( )to move between items _ buttons for selection, before pressing Return. 

SELECTING 	ITEMS FROM A LIST 

Run File Manager or Windows Explorer, which list files on your PC in lists. 

You can select items in this list in the following ways: 

1. Clicking on an item selects it, deselecting any others. 
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WINDOWS 95 

laB 
21K11 
4SKB 

v___ 

..... bn lBK11 BINn. 
~bn 00l BINn. 
OdMJ l86 lJI:B 
Odb .. IT.J(8 

Odopbn 13(8 BINn. 
o.,..bn lOOl 

nKII 
29JI:B 

lSKB 
22JI:B 

ScroUbar3 

Button fora 
mlntnlsed applicationStart button 

Windows 95 lets you get at everything directly from the desktop via icons or from the start 
button on the taskbar. Press the start button, or press Ctr! + Esc. on the keyboard. Then click 
on "Programs" and, in the next box that pops up, on "Windows Explorer" Alternatively, if there 
is an icon for Exp'iorer on your desktop, you can double-click on that. Explorer, like File 
Manager, is for organising all the files on your system and will serve as our example. 

TITLE BAR 

As well as showing you the name of the application, the title bar has a number of buttons that 
control the window. 

WIN). I WlN95 

Minimise button 	 Reduces the window to an icon on the desktop, or a button on the 
taskbar. This lets you make space on the desktop for other work. 

[j) Maximise button 	 Increases the size of the window to fill the whole screen. Duplicated, 
rather annoyingly, by double-clicking in the tide area. 

Restore Button 	 Restores a maximised window to its original, intermediate size. III 
Close Button 	 (Win. 95 only) Closes the window. In a main application window, ~ 

closes down the application. 

Control menu 	 On the left of the bar. A single click gives all the above options, iJ 
showing their keyboard shortcut keys . Double-clicking is Close. 
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2. 	 Sdecting one item, then holding the Shift key while clicking on a second item selects all those 
in between as a block. 

3. 	 Holding the Ctr! key while se lecting lets you select multiple items from the list. 

NOTE: The above convention applies to lists you will find in SADiE - so remember it! 

SWITCHING BETWEEN APPLICATIONS 

H you have more than one application running, you can switch between them by holding the All 
key and repeatedly pressing the Tab key-tl ). 

A box will appear, indicating each of the running applications with each press of the Tab key. 
Releasing the keys will now switch the computer to the indicated one. 

RESTARTING THE COMPUTER 

If the computer stops responding 0t has been known!), rather than simply turning off the power, 
do a soft re-start by pressing Ctr! +All +Delete. In Windows 3.1 this will re-start the whole 
system. In Windows 9S you will have the opportunity of shutting down only the application 
with the problem. 
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You will be presented with the Run dialogue box. Type a:\setup.exe in the Command 

Line box. This starts the SADiE set-up program. 


The setup software ask you to wait while it configures itself, displaying the following box: 


This is followed by a Welcome screen, which gives you the opportunity of continuing 
with the installation or cancelling it, in case you started it by mistake. 

NOTE: Each setup screen has the following buttons: 

Next - move onto the next screen 

Back - go back to the previous screen 

Cancel - abandon the installation 

The buttons can also be selected using the letter in its title that is underlined. 

3. 	 The next screen contains the licensing information for the SADiE system. Please read the 
information carefully and - if you agree to the conditions - use the YES button to continue 
the installation. A copy of the licence agreement can be found in the Introduction of this 
manual . 

4. 	 The Choose Destination Location screen determines where the SADiE files will reside on 
your PC's hard drive. The drive needs to have at least 8 megabytes of free space. 

You can leave this selected to the default folder SADIE3, which will be created if it doesn't 
already exist on your drive. Any older version of SADiE software that exists in this folder 
will be overwritten. If you want to keep older versions, use the BROWSE button to select 
a different folder for this new one. 
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IAPPENDIX AB - SOFTWARE INSTALLATION 	 I ) 
~------------------------~------------~-------------------------;\ ~ 

NOTE: 	 If you have purchased a pre-coniigured or "Turnkey" SADiE'" system, the software 
~ 

will already be loaded. The system will normally be configured to run SADiE when 
you iirst turn the machine on. See the instructions in Chapter 1, Getting Started. 

The SADiE soitware set-up program is a Windows® application that wi ll automatical.ly copy the 
program files onto your hard disk and configure the Windows environment. You will need to 
run the set-up program when: 
• 	 You need to install an updated version of the SADiE software. 
• 	 If you ever replace your PC's hard disk. 
• 	 You want to install SADiE into a new Pc. 

NOTE: 	 Installing new SADiE software on an existing system will not destroy any of your 
work - Existing Project, EDL, Clipstore, Mixer files, etc. are not destroyed. The 
settings in your INl file (as shown by the Setup window) will also be retained. 

PREPARATION 

Before you can install SADiE software for the first time you first need to have installed DOS and 
Windows 3.1 or Windows 95 onto your PC's hard disk. Please refer to the DOS and Windows 
documentation for information on how to do this. 

Once you have a fully working Windows 3.1 or 95 system you can now install the SADiE 
software. Although SADiE stores all its digital audio files on an independent SCSI disk, you need 
about 8 megabytes of space on your PC's hard disk to install the SADiE program and data files . 

If you are unsure of how much space you have on your hard disk, you can use Windows File 
Manager or Explorer to find out. Please refer to your Windows User Guide for information. 

NOTE: 	 SADiE operates quite happily at most screen resolutions - such as a Super VGA in 
80Ox600 mode - the installation program should ideally be run in the resolution that 
you intend to use. See Chapter 9, Customising SADiE to change screen resolution. 

INSTALLATION 

The floppy disks marked SADiEJ Software and Utilities contain the executable programs and 
data files that make up the system software in a compressed format. The setup program de­
compresses and loads these files onto your hard disk so that you can use SADiE. 

Setup takes you through the installation procedure via a series of screens allowing you to choose 
various options. 

NOTE: We have assumed that your PC's 3.5" floppy drive is drive A:. If this is not the case, 
simply substitute the correct drive letter (e.g. B:) throughout thjs chapter. 

1. Run Windows and put SADiE3 Software and Utilities DISK 1 in the floppy disk drive. 

2. 	 • From Windows 3.1 Program Manager: 

Click on the File menu and select "Run" (or type' Ait + F and then R). 

• 	 From Windows 95's desktop: 


Press the Start button and select "Run" (or type Ctr! +Esc and then R) . 
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We recommend that you choose to view the release notes at this point. Then click Finish. 

11. 	 As the new SADiE installation has changed certain Windows initialisation settings, you 
must restart Windows before you run the new software. The final box gives you three 
options of when to do this. 

Resld.1 Windows f7 
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5. 	 The next screen allows you to choose in what folder the icon that you select to run SADiE 
will be located. This folder represents the Program Group, either in Program Manager 
(Windows 3.11) or on the Start Menu (Windows 95). 

You can select an existing folder, or create a new one by typing in a name in the box at the 
top. 

6. 	 The setup program then needs to know what SADiE hardware you are using. Check the 
appropriate buttons for hardware platform and hardware controllers. 

7. 	 A new screen will appear summarising the settings you have made so far. Click Next to 
continue. 

8. 	 This box will appear showing the progress of the setup installation as it copies the files to 

your hard disk: 

You will be prompted to insert the remaining SADiE installation disks at the appropriate 
time. 

9. 	 When copying is completed the following box appears: 

Take your pick. You can change this option at any time. See "Starting SADiE 
Automatical~y" in Chapter 9, Customising SADiE. 

10. 	 The installation is now complete and the final screen appears. 
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~DIT/SELECT 

RAZOR 

CUT/COPY/PASTE 

IN/HOT/OUT 

GRABTIME 

LOCATE + Fl·Ft2 

SHIFf + LOCATE + Fl·FI2 

PREVIEW 

SAVE 

FI·Ft2 

Ft F2 F3 

SCRUB 

UNDO 

SHIFf + UNDO 
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1. Selects Streams (as above). 
2. Selects EDL Entries: With no IN/OUT/HOT point selected will select the Entry 
under the cursor on the first enabled Stream. (SHIFf + SELECT is multiple selection as 
described above) 
3. Turns on Playlist Editing mode: With an IN/OUT/HOT point lit it will put the Entry 
under the cursor into editing mode working on the selected IN/HOT/OUT point. 
PREVIOUSINEXT will then select another Entry for editing. 

Razor cut on enabled Streams. 

clips and EDL Entries to/from all windows. Pasting into an EDL pastes in-point at the 

current cursor position on the lowest numbered, enabled Stream. 


In the Trim editor, and in the Playlist with Playlist Editing mode on, select the point 

for adjustment and jump the cursor to that point. 


Enters a new mode where the wheel selects time displays in turn. The value in the 

display may then be copied and pasted to another display 


Set or Locate to numbered locator. FII and FI2 work as the Left and Right locators. 


Overwrites existing locator point. 


Previews an edit in Playlist Editing mode or the Trim Editor. 


Duplicates File I Save on menu bar, so saves the current EDL, Clipstore, Mixer, etc. 

The exception is with the Project window active, when the button will save the Project 

and all components. 


Programmable function keys, which can be assigned in the Setup window. 

There are four banks in all: Ft·FI2 SHIFf + FI·F12 


ASSIGN/ Ft·Ft2 ASSIGN/ SHIFf+Ft·Ft2 

giving 48 possible Hotkey actions. 

Nudge selected EDL Entry up, left, down, right as per buttons in Autoplace toolbar. 

Default Hotkey to turn waveform display on/off for ALL Streams 

Toggles scrubwheel action through Jog / Shuttle / Move cursor. 

Undo. 

Redo. 
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IAPPENDIX ABC - HARDWARE CONTROLLER FUNCTIONS 

When you first connect your hardware controllers, you will need to initialise them by selecting them to a 9-pin 
channel. This is done in the 9-Pin Control section of the Setup window. Use the View menu to display it. 

The controls on the hardware controllers apply to whichever is the active window on the screen. Therefore in 
many cases you will need to use the WINDOW button to select the required window before using other controls. 

The SHIFf button on the hardware controllers doesn't need to be held down unless you are following it with more 
than one further button push. 

The ASSIGN key is latching and affects other button actions until it is released. 

EDIT CONTROLLER 

THE SCRUBWHEEl is used for audio jog/shuttle and, in other modes, selection. The mode is selected by the 
SCRUB button and will apply to the active window, as selected by the WINDOW button. 

ONLINE Puts the selected external machine on line for control by SADiE and puts SADiE on 
line for timecode synchronisation. 

SLIP Slip on/off (the cross/tick button in Autoplace toolbar). Turning Slip on will enable 
left or right slipping as pre-selected on the Autoplace toolbar or status bar display_ 

AUTO If Play list active, turns automation display on/off for ALL Streams 

If Mixer active, enables automation. 

LOCK Lock all Entries to EDL time. 

STREAM Allows Stream selection: Both wheel and PREVlOUSINEXT buttons select Stream by 
moving red highlight around Stream enable button on screen. Then EDIT/SElECT 

enables/ disables that Stream. 
Using SHIFT + EDIT/SELECT changes the status of a group of Streams: Select one, SHIFf 

+ SELECT another, and all in between get toggled. (Like File Manager) . 

CLIP Wheel selects EDL Entries on enabled Streams in order. Used with IN/OUT/HOT, will 
jump cursor to appropriate point . 

ZOOM Wheel gives horizontal zoom. 

SHIFf + ZOOM Wheel gives vertical zoom. 

PREVIOUS/NEXT If Playlist active, selects previous/next EDL Entry and jumps cursor to selected 
IN/HOT/OUT point. If STREAM button on, selects previous/next Playlist Stream. If 
Trim Editor active, selects previous/next Entry in it. If Clipstore active, selects 
previous/next Clip in it. 

WINDOW Toggles through which window is active. 

END Moves cursor to end of last Entry of EDL. 

SHIFf + END Moves cursor to start of first Entry of EDL. 

PLAY/STOP/REC/PAUSE Produce toast from floppy disc slot. What do you think ??? 

CROSSFADE In Playlist Editing mode selects the inside fade point - i.e. the end of the fade-in if IN is 
selected, the start of the fade-out if OUT selected. 

SHIFf + CROSSFADE selects the outside point. 

EDL/SOURCE Switches between edit modes - EDL no light, Source with light on. 

C:I 
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FAD ER PAN EL (and the single fader on the edit controller) 

MUTE 

SHIFT + MUTE 

ASSIGN + <c-I--'> 

ASSIGN + fit 

SELECT 

EQ 

CMP 

ASSIGN + MUTE 

SHIFT + SELECT 

OVERWRITE/TRIM/ 

AUTORETURN 

M utes selected strip. 

Solos selected strip. 

Bank select - will select the next eight Mixer strips. 

Changes faders from Level control (Fd in top left LED) to Pan (Pn in LED) 

Selects this strip's processing for adjustment. Strip number appears in top left LED and 
processing strip is displayed. 

Toggles through selected strip's processes for adjustment by rotary knobs. Knobs A-F 

control the section parameters from the top down. 

Direct selection of EQ sections. 

Direct selection of compressor sections. 

Bypass all processing on the strip. 

Reassigns fader to new on-screen Mixer strip - move the fader, the new strip number is 
shown by the LED. Let go of fader - it selects. 

Change automation mode. 

C:J 
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IAPPENDIX ABCD - EQUALISATION CURVES 


AUO .t c:· F-1P£,;:S[.oN OAF AHP l t dBFSI '/ t! FE E';;: H;! ) 

- 21) 0 0 

- )0.00 

-J5.00 

-40.00 

-4.'5.00 

-50.00 

-55.00 

-60. 0 0 

-65. 00 

-70. 00 

- 7 5. 00 

Ap 

r- ­ r-..... 

~" 
r-r--..r--, 

~b-. 

~V 

L.....-VI--" 

V ...... 

V V 

1 00 10 K. 201c. 

LOW SHELF @ 200Hz; Gain +20, + 10,0, -10, -20 dB. 

AUD I O ?REC I SION DAF .:u-lP<: Id BF S \ ''; $ !'"F EQ( H=: ) ':' 1 SLP 1 3 :-a : ) 0-:0 2 

- ; '5 OIJ 

- JO . OQ 

-35.00 

- 4 0 .00 

- 45. 'JO 

-50 . 00 

-55. 00 

- flO . GO 

- 65 . 00 

- 70 . ']-[ 

-IS. JO 

--
Ap 

............. ~ ........ .... --........ ........ 
~ ' ...... -.............. ' ...... 

'" "'­ I 

'" ,I 
I I ............ - '"""'­ ....:- ~ 
I ./ 

....­ .,,­ ,I 

/ "' I 
I /' 

/ ,// 
I 

/ // 

-'I--"~ l..--'"
',,/" 

1--1--" VI".... 
,I 

, 

, 

7 1 


LOW SHELF + 1-20dB @ 60Hz, 200Hz, 600Hz, 2KHz. 

D:I 

100 Ii, ~Ok: 20k I 

http:F-1P�,;:S[.oN


Ap~ndix D - UJU4lisation Curves SADiE User Manual vJ.7 

;"~_': Z ::: PREC I S ION OAF AMPl (d8F$ i "/ 5 FR EQrHz l 21 S EP 9) 15:20: 4 5 

-;~ . 00 

Ap 
- : ::' . 00 

V V~ 1/-.a e .00 '" "'" ~ V~ -I"-.1""/ ~ ""-..a 5 . 00 

' ­ r- .... 1­~ 
-SlJ.OO ~ : ­ ~t:::~ -55.00 - -............ 
 V~V ~ '"~ ....... 
 ~ -6 0.00 

" ,\"'" ../t/-65 . 00 

/-70 . 00 

- 15. 00 

20 lOO lk lOk 20k 

BAND-PASS@ 1kHz, Q=I, Gain = +20,+15, +10, +5,0, -5, -10, -15,­
20dB. 

ALrOI O PR£C I SION OAF AMP 1 (dBFS) 'IS FREQtH'l l 2 1 SEP 9] 14 : 30:02 

·~ 5 . 00 

Ap 
- 30 . 00 

\- 35 . 'JO 

\\- "'-J ) 

~ -.as.OO 

~~k:::~ 
-50 00 

-5 5,00 "'~~ A ~ 
11/- 0 ) . J () 

1/
-6~ .0 0 

V
. ;0 .) , )0 

-75.00 

'0 lOO lk lO k 20k 

BAND-PASS @ 1kHz, Q=5, Gain +20,+15, +10, +5,0, -5, -10, -15,­
20dB. 

D:4 



SADiE User Manllal QJ.7 Appendix D - biwausation Curves 

_. ;;;; EF­ 11 14 :) 0 :0 2 

- :25. 00 
Ap 

-JG GO 

· 35 GO 

-4 0.00 

-45 . 00 

- SO .Ou 

~ .IV 
..... -...., r... 

I / I \ 
V V V \ " \I 

/ / \ \ 1 
J / \ 1 

-ss,OO 

- 60 . 00 

- 65 .00 

-70,(10 

-75 00 

20 100 lit 10k 20 k 

HIGH-PASS and LOW·PASS FILTERS: 12dB/octave 
HPF @ 10, 20, 60, 200,600 Hz LPF @ 600Hz, 2kHz, 6kHz, 20kHz 

ACD IO l-'REC I S I CN CA.f" AMPt 1d.8 F'S J 'I S PRE: H: ' 2 1 5 Er n 15: 20 : 4 6 

- 25. O~ 

Ap 

"'IX ...... ./ ........... ...... ./ ........... 

~ 
,/ /'X 

- 0 O~ 

/ ...... , ~V ...... , ~ / 'I>< \ 
.....- ...... ~ "",x ...... <­ >.....­ \" 

- 40 . 01l 

,,/' ~K' ~ v>< --­
I' ~- -- 50 00 --... 2 K- Ix--­- -;/.......... I I 

", ~ / ~ ~ ) K / 

" " / '" 11/" / " 
>< r­ ,1/

/ / 

./
X, ~ ./X}. ~ ./~, I "-. 1 

Ii, ,I I iii 

-55. 00 

- 60.00 

- 65, 00 

-7 0 .0 0 

- 15 , ()O 

20 100 1 'Jk 20k 

BAND·PASS; Q = 1, + / ·20dB @ 20, 60, 200, 600Hz, 2kHz, 6kHz, 20kHz 

D:J 



Appendix D - Equalisation Curoes SADiE User Manual QJ.7 

AUCI O ? R.Et;:! S IOtl l S7J.l 29 S'EP 93 16:54 : 16 

- 40 . !)O 

-so. oo 

-6 0.00 

-' 0 . 00 

-80.00 

-90 . 00 

- 100.0 

-110. 0 

1) Ok 14.. Ok is . Ole. 16. Ok. 11 .0k 18. Ok 19 . Ok 

Ap 

---.. 
~ V 

\/ 

DETAIL OF NOTCH @ IS.734kHz 

D:6 



SADiE User Manual vJ.7 Appendix D . Equalisation Curoes 

AUDIO PRECIS I 

- 25 0 0 

-lO.OO 

OAf' AM P l [dSf'S I 'IS FR EQ I H:r: ' 21 SIP ~ J 1. : ) 0:02 

Ap 

-.1. 5 Of} 

-4 0 . 00 

. ~o 00 

-60. 00 

-65.00 

-7 0 . 0 0 

- 75.00 

20 100 lk 10k 2 0k 

TYPICAL NOTCHES, Gain = -60dB 

AUD IO PREC I SIGr' l:s n .a AKP l ldEFSl 'f S P'REQiI't :;:: ) 29 52P )l ~ o : 5 2: JE 

-4 0.00 

-50 00 

Ap 

- 00. 00 

-10 . QO 

- M .OO 

- 90. 00 

- 1: 0- . -0 

,0 1 0e lk 101< la k 

NOTCH @ 15.734 kHz 

NOTE: Each curve comprises 60 sample points only, with straight line interpolation_ 

D:5 



Appfflfiix E - User Manag~ent SADiE User Manual QJ.7 

System Administrators 

These users can run the User Management Application and alter the User Database by adding and 
removing (and altering the details oQ ordinary users. They also have access to all SADiE projects. 
This is to prevent a lowly pip-squeak of a user creating a project that cannot be accessed by 
anyone, however powerful. 

There is no restriction on the number of System Administrators that there can be in a User 
Database, but for security reasons it is advisable to keep it to a minimum. 

System Administrators can only be created by the Super System Administrator. 

Super System Administrator 

This is the most powerful user of all. Each User Database contains only one Super System 
Administrator, who is appointed when the database is created. 

Super System Administrators can run the User Management Application and alter the User 
Database by adding and removing (and altering the details oQ System Administrators and 
ordinary users. They also have access to all SADiE Projects. 

SADiE SETTINGS FILES 

User ini files 

Every user in the User database will have their own settings file. A user ini file has a filename of 
< username > .INI, where < username > is the first eight characters of the user's username. The 
files are derived initially from SADIE3.INI (situated in the c:\windows directory) 

These 1NI' files contain information on every setting in the SADiE program - fundamental things 
such as sample rate, record input, as well as more obscure functions hidden away inside the Setup 
pages. These settings are carried from session to session, so that if you change a setting, it will stay 
that way until you change it again. NOTE that HOTKEYS are stored here. 

If an anonymous user logs on (presses SKIP in the login dialog) then they will be considered to 

have a username of DEFAULT, and therefore will use the DEFAULT.INI user ini file. It is 
therefore important to bear in mind that all anonymous users will share one ini file. 

You can find out which user INI file is being used at any given time by opening the settings view 
and looking at the filename that appears in the title bar of the window. 

User ini file directory 

The user 'INl' files are kept in a separate directory on a pc drive. This will be created 
automatically when you run the new version of SADiE (or the User Management application) . 
By default it will be created in the same directory that contains the current User Database and 
wilJ always be called 'settings'. Initially the directory will be empty, but as users log onto the 
system, user ini files will be created in this directory. 

E:2 
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IAPPENDIX ABC DE - USER MANAGEMENT 


INTRODUCTION 

User Management allows full access to SADiE3 to be restricted to a list of specified users, held in 
a User Database. The SADiE3 Project system further restricts access to individual Projects to a 
list of specified Project users (a subset of the User Database) . 

The 'SADiE3 User Management' application is a separate Windows-based utility for creating and 
altering a User Database. 

All installations require a User Database even if it only contains one user. In a one-user 
installation the User Management Application is not strictly required, as SADiE3 will construct a 
default User Database the first time it is run if one is not found. 

You will need to run the Application if: 

• you are setting up a multi·user system, 

• additional users need to be added to a system, 

• an existing user wants to change their username, 

• you want to point SADiE3 at a different User Database (perhaps on a networked drive). 

Each user has their own username, password (optional), management privilege level, and SADiE 
settings file. 

USERNAMES 

A 'username' is a unique name given to each user and can be up to 16 characters long. Valid 
characters are the lowercase letters of the alphabet, a - z, the digits 0 - 9 and the underscore 
character _. The application will validate all input, so there is no possibility of entering an illegal 
character accidentally. 

PASSWORDS 

Passwords are optional, although recommended in any system that has more than one user. The 
same rules for usernames also apply to passwords. 

MANAGEMENT PRIVILEGE LEVEL 

This determines whether a user can run the User Management application, and what they can do 
within it. It also allows certain users access to all SADiE Projects. 

There are three levels of privilege: 

Ordinary Users 

Most users will be created as ordinary users. They can run SADiE3 and gain access to projects 
that they are signed on to. They cannot run this application and therefore have no power to alter 
the User Database. 

E:l 
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Answering 'Yes' will launch the 'Create or Select a different SADiE3 User Database' dialogue box: 

Iii c:\ 
~ sadie3 

audcnt 
I!ZJ docs 
Iii graphic 

This is a standard Windows browser window and allows you to open the folder where you would 
like the User Database created, or locate one that already exists (perhaps on a network drive). If a 
User Database exists in a selected folder, it will appear in the left hand list box. 

A User Database always has the filename SADIE3. UDB. 

Once you have chosen your folder, press OK. If a User Database already exists, the Log In 
dialogue will be displayed and you should log in using the identity of one of the users in the 
database. 

Alternatively, if no User Database exists, the application will automatically offer to create one for 
you, displaying the following message: 

Replying 'No' will terminate the application while 'Yes' will create a default User Database and 
display the following message: 

Note that the one user added to the User Database at creation time is given the username 'admin' 
and no password. As mentioned previously, this user will be a Super System Administrator. The 
user will also be granted the highest possible SADiE3 privilege level. 
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SADiE Settings Files 

Just as you can save your desktops to DSK files you can save your current environment (i,e. yo 
user ini file) to SST files. This is an advanced feature that most users will probably never venture 
into, but it can be found under the Environment menu on the main application menu system. 
Settings files can be saved anywhere and are accessible to all users (\\'ho have access to where you 
save them). 

Loading a setting file will instantly reconfigure your settings and screen to the way it was when 
you saved the settings. 

USING THE APPLICATION 

CREATING A USER DATABASE AND LOGGING IN 

What happens when you run the User Management application for the first time depends on 
whether you have already run SADiE3 on the machine in question. 

• 	 If you have already run SADiE3, the application will automatically select the User Database that 
SADiE created, and display the Log In dialogue box. 

The path of the User Database currently being used by SADiE3 will be displayed at the bottom 
of the box, as a reminder for administrators who may be maintaining several User Databases. 

You should enter the Username (and password if there is one) of the user that was specified when 
SADiE3 was run for the first time. This user will be a Super System Administrator, who is always 
the first user to be inserted into a User Database when it is created. 

• 	 If you have not yet run SADiE3, the following message box will be displayed: 

If you answer 'No' at this point, the application will shut down since a User Database is required 
for it to run successfully. 

E;J 
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From here you can enter a new user's username, password (optional), and their SADiE privilege 
level. 

If you enter a password you must enter it in both the 'Password' and 'Confirm Password' boxes. 

If you are the Super System Administrator, you can also use the check box to make the new user 
a System Administrator. 

When you have finished, press 'OK' to add the new user to the system. 

EDITING AN EXISTING USER'S DETAILS 

To edit an existing user's details, select the user in the main window and press the 'Edit... 'button 
(or just double click on the user). This will launch the 'Edit User' dialogue box, which is identical 
to the 'Add New User' dialogue box described above. 

If you are the Super System Administrator, you can use the check box to grant or revoke System 
Administrator status_ 

When you have entered all of the new details, press 'OK' to confirm, or 'Cancel' to abort. 

REMOVING A USER 

To remove an existing user from the system, select the user in the main window and press the 
'Remove' button (or press Alt-R) . You will be asked for confirmation before the user is removed. 

Remember that only the Super System Administrator can remove System Administrators from 
the system. If you do not have the privilege level to remove a particular user the 'Remove' button 
will automatically be disabled. 

SA VING YOUR CHANGES TO THE USER DA T ABASE 

As you add, edit and remove users from the current User Database, your changes are not actually 
being saved to the real database file. This will only happen when you: 

select 'Save changes to User Database' from the File menu, or 

exit the application (from the File menu). 
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Once the message box has been closed, the User Management Log In dialogue box will be 
displayed. You should now enter 'admin' as a username and no password. 

THE MAIN WINDOW 

Having successfully logged on to a User Database, the main window of the application will be 
displayed. It is from here that all the user management tasks can be performed. 

(SysAdmin] 

(SysAdmin] 

The main part of the window is occupied by a list displaying all the usernames in the selected 
User Database. The list is ordered alphabetically with a total user count at the top right. Initiali~' 
you will only see one user - the default "admin" user that was automatically inserted when the 
database was created. 

The user's Management privilege level is shown against each username (in the case of ordinary 
users, nothing is displayed). 

ADDING A USER 

To add a new user to the system, select the user in the user list and press the 'Add' button (or 
press Alt-A). This will launch the 'Add New User' dialogue box 

A U sername of either SADIE3 or DEFAULT is not allowed. 
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·PORTANT POINTS 

• 	 Whilst User Management and SADiE) are separate applications, they both reference the same 
User Database (on any given PC). 

• 	 The Start-up of SADiE) will not be affected by any User Management changes until the 
database is saved. This happens when the User Management application is exited (or when 
File I Save Changes ... is selected). 

• 	 When a new User Database is created, one Super System Administrator is added to the 
database automatically, with the usemame 'admin' and no password. You are advised to give 
this user a password as soon as possible. 

• 	 The User Database is heavily encrypted on disk and is effectively unhackable. Any tampering 
with a User Database file is likely to result in it failing to be read correctly. The usual 
symptom is lost users. 
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SELECTING A DIFFERENT USER DATABASE 

Occasionally it might be necessary to point the User Management application and SADiE3 at a 
different User Database. This is likely to occur if you want a previously isolated machine to refe 
to a User Database on a network drive. To change the currently selected User Database press the 
'Change ... ' button under 'Current User Database in the main window. 

This will launch the User Database browser dialogue box: 

c:\ 
~ sadie3 
G::J audcnt 
I2J docs 
r.::J graphic 
I2l resource 

A User Database always has the filename SADIE3. UDB. 

Locate the new User Database and press OK. The application will confirm that it has selected th 
newly chosen database and advise you that it will now shutdown: 

This is done for security reasons. Should you wish to make changes to the newly selected User 
Database you will have to re·run the application and log in accordingly. 

SELECTING THE SETTINGS DIRECTORY 

You can alter the location of the settings directory, where User Settings files are saved to. It will 
probably not be required in many situations (provided the User Database location has been 
configured to a sensible location). However, this is the place to alter it should the need arise. The 
procedure is similar to changing the current User Database above. 
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FEEDBACK 

We are always interesting in hearing what our customers think about us and our products. Many 
of the features in SADiE have appeared as a result of customer requests, so if there's a particular 
way that you would Like SADiE to work for you, tell us! If you have any ideas for cool new 
features or products, either hardware or software, send an email to: 

feedback@sadie.com 

If you're lucky, your ideas may even appear in the next software release! 
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IA P PEN 

0 II~YO~~,~t~h~i~ru a:v~'~~d~:~~'~~Di: ~::~,::rt lin" ar, lliuruly availabi<U 
from 9 a.m. until 11 p.m. every day. Please remember to allow for daylight saving when working 
out time differences. 

Outside office hours the support will be covered by a mobile telephone. In order for us to 
maintain this as a free service, we ask you to restrict out-of-hours calls to real emergencies, and to 

please check in the manual or help-file before you call. For local public holidays and surrounding 
weekends, custOmer support hours will be reduced - the times and the mobile number will be 
announced on the office answer-phone message. 

UNITED KINGDOM 

Phone: +44 (0) 1353648888 
Fax : +44 (0) 1353648867 

REST OF EUROPE 

Phone: +49 (0)711 396 9380 
Fax: + 49 (0)711 396 9385 

NORTH AMERICA 

Phone: + 16153271140 
Fax: +16153271699 

WEB SITE 

There is a SADiE home page on the world wide web. The address is: http://www.sadie.com 

SADiE FORUM 

There is an independently maintained users' group on the Internet. This is run as a forum for 
users of SADiE and related products to share advice, tips and news. 

To subscribe to the forum, send an e-mail to the following address: 

majordomo@lists .uoregon.edu 

Type the following command as the body of your e-mail message: 

subscribe sadie 

end 


You will then shortly receive a welcome message with details on how to post messages to the 
entire group, remove yourself from the list, etc. All messages posted to the group will now be 
automatically sent to your e-mail address . 

Studio Audio customer support will monitor the correspondence and reply when necessary to 
advise on any subject. 

F:I 
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~'")L 	 An Edit Decision List. A term that has been used in video editing for some time. In 
SADiE, the EDL is the list of instructions that the system uses to play back the required 
Clips at the required times. It is a computer file that will need to be saved and can be later 
loaded and modified, just like a document on a word processor. You can think of the 
EDL as your script, cue sheet or running order, and the Tracks as the raw material. An 
EDL is graphically displayed in SADiE by the Playlist, where it is created by placing Clips 
in the required order. 

EDL Entry 	 When Clips are placed in the Play list they become EDL Entries as they then have a 
particular EDL replay time. Any changes made to an EDL Entry (such as level changes or 
adjustments to the in and out points) then only apply to that particular occurrence of the 
Clip and will not affect Clips in the Clipstore, or other EDL Entries of the same Clip. 

Frame Rate 	 The number of video or film frames per second. 

Hotspot 	 The hotspot is a useful marker that you can set at a particular point within a Clip or 
Entry and then use as the reference when placing it in an EDL. For example. when you 
place a sound effect of a screech of car tyres followed by a crash. it's probably the crash 
that you want to position accurately. The hotspot may actually be outside the in and out 
points of the Entry you are placing - you wouldn't include the sound of the clapperboard 
recorded at the start of a dialogue Track. but you can still use it as the hotspot in order to 
place Entries from that track in sync. Also useful for "back-timing", to get a cenain bit of 
music to coincide with the end of speech. etc. To set or adjust the hotspot, see Chapter 5, 
Editing, and the Clip Details window section of Chapter 4, Arranging an EDL. To use the 
hotspot when placing EDL Entries, see the"Autoplace" section of Chapter 4. 

Input 	 In SADiE. one of the physical input connections to the system. 

See Scrub. 

See Tirnecode. 

MIDI 	 Musical Instrument Digital Interface . A signal sent between electronic musical 
instruments containing information determining what notes to play, when and how. 

MTC 	 See Timecode. 

Output 	 In SADiE, one of the physical output connections to the system. 

Playlist 	 The window on the screen which shows you graphically the work you are creating (i.e. 

G:2 
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IL-~-X-:-I~-a-~-~-ns-~-f-~'-:-. -'~-h-~w-C-n-~-iE-tal-~-,~-ar-e-s--pe-~-if-i~-~-S~_~_A_iE_~_._Y_O_F_T_E_R_M_s_______-;0 
A-D or ADC 

AES/EBU 

Clip 

Clipstore 

Current-time 
cursor 

D-A or DAC 

Discontiguous 

DSP 

EBU 

Analogue-to-Digital (Conveners). 


The Audio Engineering Society I European Broadcasting Union. Often refers to the 

professional digital audio interface standard which uses XLR connectors . 


A Clip is any part of (which may be all oQ a Track and can have its own name. It is not 

actually a separate recording, but a set of instructions of how to Play audio: 

between what in and out points within a Track, 

at what level and 

with what kinds of fade-in and fade-out. 


The Clipstore is simply a list of Clips. You will always find whole Tracks here, and may 

choose to use it to store clips which you have topped and tailed for later use. This is like 

keeping a load of small reels of leadered tape insens on the shelf before you put them into 

a piece of work. Different Clipstores can be saved for different projects. 


NOTE: 	 Deleting a Clip from a Clipstore does not mean you have deleted any audio, as 
the Track will still be on the SCSI disk. You will have simply dd eted one 
particular version (in and out points, fades and overall level) of how to replay 
the audio. 

The venical dotted line in the Playlist which passes over the EDL Entries like a playback 
head. 

Digital-to-Analogue (Conveners) . 

Usually referring to timecode and meaning having jumps in the recorded value. These will 
result, for example, when a location machine recording time-of-day timecode is stopped 
for a break. 

Digital Signal Processing, or Processor. The digital circuitry which can manipulate digital 
audio to achieve fades, EQ, Dynamic processing, etc. 

The European Broadcasting Union. Often used to refer to the European timecode 
standard, with a frame rate of 25 f.p.s. 

G:l 
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Streams 

SVGA 

Time bar 

Timecode 

Track 

VGA 

VITe 

G:4 
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them, and other settings displayed by selecting them in the Setup window. (Menu bar 
View I Setup window. Double-click on "General", then select "Status Displays"). The 
status bar also shows a description of any button that the mouse pointer is resting over. 

EDL Entries in the Play list are placed on Streams, each of which is routed to a channel 
strip of the Mixer to control the playback of the audio. A stereo Entry sits across any two 
adjacent Streams, a mono Entry only needs one. The Streams are therefore similar to the 
tracks of a multitrack tape machine but allow editing and overlapping within individual 
Streams and moving audio Entries around in time. There is no limit to the number of 
Streams you can add to the Playlist, only to the number of Entries the hardware of your 
system can play at once. The Streams are independent of the physical outputs of your 
hardware system and are routed to them by SADiE's Mixer. 

See VGA. 

The white calibrated "ruler" at the top of the PlayJjst which indicates the position of the 
current-time cursor in terms of EDL time. 

A digital timing signal which, when recorded alongside sound or picture information, can 
be used to synchronise recordings made on separate media. 

LTC Longitudinal Time-Code. Any Timecode stored or sent linearly, in the same way 
as audio. When the tape stops, so does the timecode. 

VITC 	Vertical Interval Timecode. Timecode embedded in a video signal so that it is sent 
continuallv and can be read from video recorders on a still frame. 

MTC 	 MIDI Time-Code. A way of sending timecode via MIDI interfaces. 

A Track is a whole, original audio recording, held on a SCSI disk as a sound file, and 
running from when you started recording to when you stopped. It is identified by a name 
and will remain on the disk until deliberately deleted. It has properties set when it is 
recorded, such as whether stereo or mono, what sample rate, etc. Don't confuse it with 
the term "track" as applied to multitrack tape machines (see Streams) - it's closer to the 
"track" on an LP or CD and recalls SADiE's origins as a simple stereo music editor! 

Video Graphics Array (or Adapter) . A standard interface between PCs and video display 
monitors. SVGA (Super VGA) is a higher resolution version. 

See Timecode. 
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Project 

SADiE 

Sample Rate/ 
Sampling 
Frequency 

Scrub 

SCSI 

Shuttle 

SMPTE 

SPDIF 

Status Bar 

the EDL). It acts as your tape machine. EDL Entries are shown as coloured blocks like 
bits of tape, or as profiles showing the level of the audio. They are positioned to be 
replayed when the current-time cursor passes over them like a playback head. Fade-ins 
and tade-outs are shown as slopes to the front and rear of the blocks. Editing is done by 
making "cutS~ which divide Entries into two, so that one or the other can be removed, or 
the in and out points can be adjusted to fine edit the audio. 

A Project is a useful way of looking after your work on a job-by-job basis. EDLs, the 
layout of the internal Mixer to play them and Clipstores are all stored as components of a 
SADiE Project. A list of relevant Tracks is also kept for each Project. 

The Studio Audio Disk Editor. 

The rate at which: 1. Analogue audio signals are sampled and converted to digital audio. 
2. Digital audio is replayed and so may be converted to analogue. Audio recorded at one 
sample rate but played back at another will sound speeded up or slowed down. 

To move audio at a variable speed whilst hearing it, usually while adjusting or locating an 
edit point . There are two modes of scrubbing in SADiE:­

Jog mode is the equivalent of rocking the reels of a tape recorder back and forth : The 
more you move the mouse left-right, or the hardware controller wheel, the more audio 
you hear. 

Shuttle mode is the equivalent of spooling the tape across the heads: The more you move 
the mouse up-down, or the wheel, the faster the audio goes forward or backwards. This is 
useful for losing large amounts of material at an edit point, just like dumping tape onto 
the 1I00r. 

SmJ.11 Computer Systems Interface. A standard interface for disk drives and other storage 
de\'i.:es. 

See Scrub. 

The Society of Motion Picture and Television Engineers. They set professional timecode 
standards. 

Sony/ Philips Digital Interface - the consumer digital audio standard. 

A bar along the bottom of SADiE's main display showing important current settings, 
such as Sample Rate and Frame Rate. The settings can be changed by right-clicking on 

G:J 
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XACT Studio Audio's Analogue Convener and Timecode card. 

XLR A professional audio connector, usually a three-pin plug/socket carrying balanced audio 
signals. 

XS Studio Audio's floating point digital audio processing card . The XS and XACT cards are 
usually fitted in the Pc. 

G:5 
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CHECK DISK 

This option checks the File Allocation table (F.A.T .) for errors. The F.A.T. is like a table of 
contents for the disc. If the F.A.T. is incorrect, then software will not be able to iind the files 
it is searching for. 

On pres.sing the Check Disk option, you can choose NO to merely check for inconsistencies 
in the F.A.T . and report on them if they exist. This will not change the contents of the disc at 
all, and is the only Disk Checker option that is safe. If you choose YES any errors found wiiJ 
be repaired, and reported to the screen - you will be warned of the possible effect of any 
changes. 

DISK RECOVERY 

When audio files are recorded in the SADiE3 software, each file can contain special 
information in its file header. Disk Recovery will search the disc for these special headers, and 
reconstruct the disc's F.A.T. to use the new files it has found. NOT ALL FILES have the 
special header. This header is unique to SADiE's own native file formats and hence is only 
available for the following files: 

• 	 SADiE3 format disc - SADiE3 format (native) files 

• 	 SADiE2 format disc - SADiE2 format (native) files THAT HAVE BEEN RECORDED 
USING SADiE3 software. 

The fim thing Disk Recovery does before attempting the header search is a disc format. Any 
fJes without this header will be lost. Files that do not have the header and WILL BE LOST 
include: 

• 	 SADi.E2 format files recorded in SADiE2 software; W A V files; Lightworks format files; 
any DOS file that has been copied onto the drive via DOS to SCSI transfer; every file on a 
DOS, FAT16 format drive. 

However if all your recordings are in SADiE3 in a native format, then it may be possible to 
retrieve files that have been deleted. When files are deleted, they still exist on the disc, and it's 
only their entry in the F.A.T. which is removed. However if more audio has been recorded 
or copied to the drive since the file was deleted, the chances of recovering it are slim, because 
either the special header, or some of the data itself, may have been over-written. 

You must back up any audio that you wish to retain, before performing the Disk recovery. 
Because the process formats the disc before starting, it's safer to assume that your audio could 
be wiped. This should only be used in extreme circumstances. 

FORMAT 

The format button provides the same options for disk formatting as are available within the 
SADiE application itself - Format to SADiE2 or SADiE3 format . 

SURFACE SCAN 

When disk drives are manufactured, they generally have some medium errors - areas of the 
disk that cannot be written to or read from due to a fault. This is quite normal, and disks 
mask these faults from any software, by keeping their own table of medium errors, and not 
allowing software to use these bad areas. 

H:2 
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IAPPENDIX ABCDEFGH - SADiE DISK CHECKER 


The SADiE Disk Checker is a separate software application that provides some tools for 
checking your SCSI audio disc drives. To run the Disk checker, FIRST EXIT SADiE, press 
the Windows START button, select frograms; SADiE, then "SADiE Disk Checker - use 
with care." 

Disk problems, loss of data and related warning messages can be very disturbing, but the 
SADiE software can help you fix some problems if they do occur. As its icon suggests, this 
program should be used with great caution. Almost every option can change the contents of 
your disc drives. If you have any doubts at all about the use of this - seek advise first. 

WHAT'S IT FOR? 

Disk checker provides an expert user diagnostic and repair tools to help deal with disc drive 
problems. Disk Checker can help deal with three different types of problems: 

1. 	 Undelete, or even unformat, if a user has deleted one or more files by mistake. 

2. 	 Filing structure problems. Much as with a DOS drive, it's possible for a drive's File 
Allocation Table to become mis-aligned with the actual files 

3. 	 Medium errors. Disk checker can perform a surface scan and low level format on a drive. 

DISK CHECKER OPTIONS 

Note that some options, particularly on larger discs, or discs with many files, may take some 
time to complete. You will be warned when you choose a particularly time-consuming 
function. The screen may appear idle at times - watch the Messages .. . word in the top left of 
the window. The dots will update to show that there is some activity. 

You can use these utilities only on one disk at a time - select the ID of the disk you wish to 

operate on. 

H:J 
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Again, if the disc is continually deteriorating, and medium errors keep appearing, even after 
you've low level formatted or run Surface Scan, then this will become very inconvenient, and 
you should really replace the drive. After a time you may notice the capacity of the drive 
decreasing slightly as the bad areas get larger. 

Low level format will irretrievably empty the disc, and so, again, make sure you have a safe 
backup of anything you want to keep. 

H:4 
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However, it is not unusual for medium errors to appear on a disk drive during operation. 
Reasons are many - mishandling, moving a drive while it's in operation, deterioration or 
physical wear are some. Small numbers of these medium errors are generally considered 
acceptable, however if a drive continually gains medium errors it ought to be replaced. 
Software will not be able to read from areas of the disk with medium errors, and thus, from a 
SADiE point of view, the audio would be corrupt. 

The Surface Scan function performs a scan of the surfaces of the disk drive, searching for 
medium errors. When one is found, it is reported to the screen, and then Surface Scan 
"repairs" the medium error. This involves retrieving any data that can be read in the bad area, 
and moving this to a different, uncorrupted part of the disc. Any data that cannot be 
retrieved will be replaced with silence (and hence the audio file may drop out) The F.A.T. is 
then updated to link the file to the new location on the disk. Note that only the affected area 
is moved, not the whole audio file, and hence this will fragment the file a little - although this 
is preferable to corrupt or un-playable audio. Also the F.A.T. is updated so that the bad area 
is not used again by SADiE. 

Areas marked as medium errors in the F.A.T. by Surface Scan will not be blanked down by 
the SADiE disk format function - it is aware of these and retains these for future use. 

Because Surface Scan can alter the contents of your drive, you should backup any material 
you need before running this routine. 

Additionally, SADiE itself will automatical.ly offer to repair medium errors if it finds them. 
If, during playback, SADiE detects a medium error, the following warning will appear 

You have the choice to ignore this and continue, or SADiE will fix the error there and then, 
in the same way that the Surface Scan option of Disk Checker handIes medium errors. This 
should be a relatively quick operation, and should allow you to continue working if you are 
in a hurry. However exiting SADiE and running Disk Checker and Surface Scan may give 
you a more permanent solution. 

LOW LEVEL FORMAT 

Disk Checker's Low level format option runs the drive's own Low level format routine, 
which, in a similar way to Surface Scan, searches for medium errors on the drive, and then 
updates the drive's internal table of bad clusters. This is more permanent even than Surface 
Scan, because the drive will then hide the bad areas from the software. 

H:J 
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The entries 

A general entry: 

001 01 I Al I C I 00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

This would give the foll o w ing entry in the SADiE play list on stream 1: 

10:00:00:00 10: 10:00:00 

01 

1 1 

A fade in is recognised as one of the follo w ing: 

001 01 Al D 20 00:00: 10:00 00: 1 0: 1 0:00 10:00:00:00 10: 1 0 :00:00 

Or 

001 

001 

BLK 

01 

Al 

Al 

C 

0 20 

00:00:00:00 

00:00:10:00 

00:00:00:00 

00:10: 10:00 

10:00:00:00 

10:00:00:00 

10:00:00:00 

10: 1 0:00:00 

This would give the following entry in the SADiE playlist on stream 1: 

10:00:00:00 10: 10:00:00 

~=f---es--01-------11 

A fade out is recognised as the following: 

001 01 Al C 00:00: 1 0:00 00: 10: 10:00 10:00:00:00 10: 10:00:00 

002 01 Al C 00:10:10:00 00: 10: 10:00 10: 10:00:00 10:10:00:00 

002 BLK Al 0 20 00:00:00:00 00:10:10:20 10:10:00:00 10:10:00:20 

1:2 
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APPENDIX ABCDEFGHI - EDL FORMATS 
SUPPORTED BY SADIE 

This document outlines the text based EDL files that are supported by SADiE. 
Confusion arises when variations on a specific format are loaded into SADiE. 
There does not appear to be any strict rules as to the content of these files, which 
may cause problems when the file is being read and loaded into SADiE. To avoid 
these problems we have listed the types of entries that we handle. If a file contains 
lines other than these it is possible it will fail to load completely. 

CMX 

A line for an entry in a CMX file contains the following information: 

Fade length 


(if edit type is '0') 


These are 3 digits and are in the range of 001 to 999. 

The known maximum lengths for different formats are as follows: 

CMX 340 - 3 characters, 0-9, that allow reel numbers from 1 to 253. 

of reels is allowed with a 'B' on the end. 


CMX 3400 - 3 characters, 0-9, that allow reel numbers from 1 to 999. 

of reels can also have a 'B' on the end. 


CMX 3400A and CMX3600 - allow 8 characters, A-Z and 0-9. 


Entry number 

Reel name 

Channel 

Edit type 

This same set 


This same set 


Files have been seen with longer reel names than those specified and so there is a 
limit of 10 characters in SADiE when importing a CMX file . A reel name of 'BLK' 
or 'BL' is used to define a silent entry or a fade to/ from silence. 

The channel information for CMX files is given in Table A. Additional channel 
information is placed on the next line, see the comment section below for more 
details. 

SADiE will only use edit types of 'C' for a cut and '0' for a dissolve. All other edit 
types are ignored. The dissolve time for an entry is to be given in frames. 

Source and program times 
These times are given in frames. See the comment section below for how the frame 
rate is handled when reading the file . It is possible the EDL will not be loaded 
correctly if the correct frame rate is not selected in SADiE. 

1:1 
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Channels 

A udio mapping 

Sony 

This will set the frame rate to be 29.97 drop frame. 

The table in Table A shows the channel infonnation that is used in a CMX EDL 
file. 

The following line is used to determine the audio mapping of the entry in the file: 

0072800 A2e 00:00:00:00 00:00:02:20 \0:02:02:23 \0:02:05: 18 

COMMENT: AUDIO MAPP[NG FROM CHI TO CH2 

This indicates that the entry on stream 2 uses audio from track 1. 

Any other lines containing information regarding, for example, the speed of the 
video playback, the freeze frames and other channel mapping formats, will be 
ignored. 

The format of the lines for fade information will be the same as those for the CMX 
format EDLs. 

It can be seen that additional information is placed at the end of the line for 
channels 3 and 4. The channel information is described in the table in Table A. 

Grass Valley (GVG) 

Entry number 

Channels 

1:4 

The format of the entries in these EDLs is similar to that of the CMX files. Only 
files containing cut entries have been tested. EDLs have been found where the 
entries are not in program time order. This has not posed any problems when 
importing to SADiE. 

This has been found to be either 3 or 4 digits in length. 

The channel information for this type of EDL is given in Table A. 
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This would give the following entry in the SADiE play list on stream 1: 

10:00:00:00 10: 10:00:00 

11---------IEYe,
01 

This gives the following lines for a cross fade: 

001 01 Al C 00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

002 
I 

01 Al C 00:10:10:00 00:10:10:00 10:10:00:00 10: 10:00:00 

002 02 Al D 20 03:00:30:00 03:01:00:20 10:10:00:00 10: 10:30:20 

10:00:00:00 

I 


Comment lines 

This would give the following entries in the SADiE playlist on stream 1: 

10: 10:00:00 10: 10:00:20 10: 10:30:20 

~~' 
01 01 I 

The iollowing comment lines are handled in the CMX conversion. 

Frame rates: 

If the setting is used ior multiple frame rates it is possible to alter the frame rate for 
each reel before the EDL is loaded into the play list. When a frame rate change line 
is encountered, all subsequent entries will use the new frame rate. The user is asked 
whether the system frame rate in SADiE is to be altered, if a frame rate is detected 
that is different to the current setting. 

FCM: NON-DROP FRAME 

This will set the irame rate to be 29.97 

FCM: DROP FRAME 

/ :3 
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TABLE A 
EOL channels 

GVG 6.0 CM.}( 340 CMX 3400 & 3600 Sony 9000 LW Multi· 
channel 

Maximum channels supported: Audio-4 Audio·2 Audio· 4 Audio - 4 Audio·B 

Video· I Video· I Video - I Video - I Video- 0 

V AI A2 A3 A4 In edit line Chan 3 & 4 In edit line in edit In edit line 
(note following edit extension 

line) 

* Al A A Al Al 

* A2 A2 A2 A2 A2 

• A3 NONE AUO 3 A A3 A3 

* M NONE AUD 4 A A4 M 

• • AI2 AA AA AIA2 AI2 

• * A23 A2 AUD 3 A2 A3 A23 

• • A34 NONE AUD 3 4 A A3M A34 

• * A!3 A AUD 3 A A3 A!3 

* • A24 A2 AUO 4 A2 M A24 

• * AI4 A AUO 4 AI M A14 

• • * A 123 AA AUO 3 AIA2 A3 AI23 

* • * AI24 AA AUO 4 AIA2 M A124 

• * * A!34 A AUO 3 4 AI A3A4 AI34 

• * * A134 A2 AUD 3 4 A2 A3A4 A234 

* • * * AI234 AA AUO 3 4 AIA2 A3M AI234 

* V V V 

• · AIV B B VAl AI 
• * A2V A21Y A2/ V VA2 A2 
• * A3V V AUO 3 V A3 A3 

* * MV V AUO 4 V M M 

* * • AI2V AAiV AAIY VAIA2 AI2 

* * * A23V A21Y AUO 3 VA2 A3 A23 

* · · A34V V AUO 3 4 V A3M A34 

* • * AI3V B AUO 3 VAl A3 AI3 

* · • A24V A21Y AUO 4 VA2 M A24 

· * * AI4V B AUO 4 VAl A4 AI4 
• * * * A123V AAIY AUO 3 VAIA2 A3 A 123 
• * • * AI24V AAiV AUO 4 VAIA2 M AI24 
• * • * A!34V B AUO 3 4 VAl A3M A134 
• • • • A234V A21Y AUO 3 4 VA2 A3M A234 
• * • • • AI234V ,---AA~y____ AUO 3 4 VAIA2 A3M A 1234 

- - --­ --------­
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Lightworks Multi-channel 

The Entries 

Dump reels 

NOTE: 

It has been found, after discussions with people at Lightworks, that there will be no 
video entries as part of a multi-channel EDL. Therefore, we do not need to put in 
the dummy video entry that spans the length of the EDL. From this we are 
assuming that there is no need to insert black entries for the silence between the 
audio entries in the EDL. This can be added at a later stage if needed. 

The format of the entries within the rue is similar to that of the CMX files. 

The Lightworks machine that was used for the test material was not able to export 
an EDL that contained overlapping entries using the same reel. To get around this 
problem it uses a dump reel. The dump reel entries are shown in the EDL file with 
a reel ID of "900". The program times for these entries remain the same, however, 
the source times used reference a separate file. The extra file should have the same 
name as the EDL file, but with a ".drnp" extension. 

The source times for each stream, start at the EDL start time. They usually have a 
handle of 1 second with entries on the same stream being adjacent. The source 
times in the EDL file should 'fit' within the program times in the dump file, i.e. 
there should be enough audio for them to reference. The source times in the dump 
Ii Ie are the actual source times of the audio. There should be no dissolve entries in 
the dump file as this implies that entries overlap and it would therefore require a 
further dump tile to handle it. 

The text based EDLs that have been described only contain one piece of channel 
information. The user is given the option as to whether to use this information for, 
the stream the entry is to be placed on, or the track of audio to use, or both. 
SADiE handles additional lines in the EDL for channel mapping, as described in the 
comment section. This allows both the stream and track information to be read 
from the file. This information can also be exported as part of the file if required. 

1:5 



Index 

f".opying files from the PC ...... ... ... .. ... ........... ... ...... .. ... .... 7:29 

pying files to and from the PC ................................... 7:28 

pying Tracks ............................................................... 7: 13 


C rossfades ......................................................... See also Fades 

default lengths ............................................................ 5: 1 


Currem·time cursor ............................... ....... .... .... ............. 3:6 


D 
Dailies, syncing ... .. ....... .. .. .. .. .... .. ......................... ........ .. .. . 8: 10 

DAT & CD IDs .. .......... ... .. ........ ..... ........... ........ ..... ..... .... 8:51 

DAT IDs .................................................................... ...... 8:51 


outputting .. ...................... ... ........... ......... .. .. ........ ..... 8:52 

DATIDS 

inputting...... .... ..... .. ...... .... .... .. .... ........... ..... .. ... .... .... . 8:51 

DDP tapes .................................................................... .... 8:41 

De-click 

Manual...... .......... ..................................... ........ .... .. ... 6:36 

De·Click ......................................................................... .. 6:33 


Auto ..................... ............. .. ....... ... .. ................ .. ... .... 6:33 

De·esser ..................................................... ..... .. .. .............. 6:21 

Deleting Tracks................................................................ 7: 13 

De·Noise ................................................. .... ..... ..... ........... 6:32 

Desktop menu 

Load and Save .......... .. .. .. .......................................... 9: 10 
Desktops 

arranging, saving and loading ........................ .. .......... 9:9 

loading autouuticalJy when you run SADiE .......... 9:12 


Digital Limiter ................... ... .. .... ... ........... .... .... ............. .. 6: 19 

Digital Varispeed ................................................ .... .... ..... 6:46 


'ectx ......... ... ...... .. ................... .. .... ............... .. .... ........... 6:38 

K Checker ....................................................................H: 1 


15k Management ............................................................ 7: 16 
Disk Recovery ...... .. .. ................ ........ .. ..... ... ... .. .... .... ......... H:2 
Disk too Slow ....... ........ .............................. ........ .. .. ... .. .... 4:20 
Disks 

checking space on SCSI devices ........ ... ........... .. ...... . 7: 16 
Disks, audio 

changing and logging new disks .............................. 7: 17 

formatting ................. ... .... .. ..... ... .... ... .... ......... .... .. .... 7:23 

naming .................. .. ... .... ...... .................... .. .. ............. 7: 17 

Display Profile Mode 
Playlist 

Display Profue Mode .... .. ..................... ............ .. 3:3 

Dither ...................... .. .. ..................................................... 6: 17 

Dither ........ .................................................. .. ................... 6:23 

Divergence .............................. .. .... ........ .. ............. 11: 11, 11: 13 

Draw Clip button .. .................................... .. .. ............ ... ... 5: 15 

Drop-ins ... ..... ... .. ..... ..... .... ........ ....... ............. ...... ... ............. 2:5 

DSP Power ....................................................................... 4:20 

Dynamics processing .......................... ...... .... .. ................... 6:7 


E 
Edit menu 

Cut, Copy and Paste .................................................. 4:6 

Select All .................................................................... 4:5 

Undo and Redo ......................................... .. ............. 4: 14 


Editing 

in the Playlist with a mouse....................................... 5:2 

in the Playlist with the hardware controller ............. 5:7 

overview ..................................................................... 5: 1 


Index: ii 

SADiE User Manual tlJ.l 

using the Trim Editor. ............................................. 5:10 
EDL entries 

moving ........ ... ..... ... ...... .... .............. ............................ 4:7 
EDL Entries 

adding from Clipstore ............ .... ............................... 4:8 
dunging replay levels ...... ... ........ ................. ............ 4:15 
C.opying or repeating ................................................. 4:9 
cutting, copying and pasting ..................................... 4:6 
groupinglungrouping ....................... .. ............ ......... 4: 11 
locking all to maintain sync .................................... 4:14 
moving 

with Text EDL ................................................ 4:19 

removing from the EDL. .. .... ...... ...... ................... .. .... 4:6 

reIU.ID.iog ..... ............... ............. .... ................... ... ... ..... . 4:6 

selectingl deselecting .................................................. 4:5 

selecting/deselecting with the Text EDL.. ......... .... . 4:19 


EDL Formats supported.. .... .. .............................................. l: 1 
EDL PQ list offset ........................................................... 8:43 
EDUSOURCE modes when editing .. ............................. 5:8 
EDLs 

creating, opening and closing .................. .......... ........ 7: 1 
pasting ............. .... ....................................................... 4:7 

Effects 
'sends and returns .............................. ...... .. .. ............. 6:13 


Emphasis ............. .. ......................................... .. .... ..... ...... ... 2:4 

Enable Subcode reading .......... .............. .. ..... .................... 8:51 

EQ . Equalisation .......... ........ ............ .... .. .......................... 6:8 

Error Message Position .......... .... .. ............................. .. .... . 9: 11 

Exabyte DDP tapes ......................................................... 8:41 

Exabyte drives ................................ .......... .. ...... ........ .... ... 7: 19 

Expander ........... ................ ... ..... ............. ... .. ................. .. .... 6:7 

Extend entry end to fill gap ............................................. 10:5 

Extend entry start to fill gap ........................................... 10:5 


F 
Faders 

deleting ....... .... ................................. ...... ... ... ...... .. ..... 6: 15 
drag and drop ........................................................... 6: 15 
l.inking / grouping ..................................................... 6:3 

Fades 

adjusting EDL Entry fade lengths and types........... 4:16 

adjusting in Text EDL .................. : .......................... 4:19 

adjusting with hardware controller in Playlist ......... 5:9 

adjusting with mouse in Playlist ........... .................... 5:6 

how displayed in Playlist ........................................... 3:3 


Fades and crossfades 
adjusting in Trim Editor... ........ .......... ........... .... .. .... 5:15 
setting default ...... .. .. .... ........ .......... .... ............ .. ......... .. 9:5 

File Allocation table .................... ... .. .................. ...... ........ H:2 
File Management .................................................... .... ....... 7: 1 
File menu 

Disk Management ..... .. .......... ..... .............................. 7:16 

Load to Paste .............................................................. 4:7 

New, Open, Close, Save, Save As .......................... ... 7: 1 


File Transfer .............. .. ............ ...... .................. ...... .......... 7:28 

OOS to SCSI drive .................... ......... ............ .. .. .... . 7:30 


Film Rushes (Dailies), syncing ..... ............................ .... ... 8:10 

Find New Track command........ .............. .... ................... 8: 18 

Fix up CD .............................................. .... ........ .............. 8:49 




IndccSADiE User Manual tlJ. 7 

]INDEX 


.1 .. ... .. ...... ... ........ ..... ...... ..... ....... ....... ........ ........ ................. 11:6 


5 
5.1 ...... ...... ....... ..... ..... ..... .. .. ........ .......... ... .... ........ ............ .. 11:6 


9 
9·pin 

Machine Control ..... .. ........ ................... ...................... 8:7 
Remote control ........ ............. .. .. ... ...... ........................ 8:7 

9·pin control 
setting up ............ ..................................... ................... 8:6 
sync .... ..... ........ ..... ..... ... ... ......... ..... ..... ... .... ....... .. ...... ... 8:7 

A 
Active Streanls .. ... ........ .... .. ..... ...... ......... .. ... ... ...... ..... .. ..... 4:22 

Add EDL entries .... .. ........................... .... ...... ... ... .. ...... .. ... 8: 19 

AIFC ... ...... ........ ......... ... .. ........... .. ........... ... ... .. .. ...... ......... 7:26 

AIFF ........ ..... ... ........... ...... ................... .. .. .... ....... ... ..... ... ... 7:26 

Apogee UV22 .. ........ .............. ... ............ ... ...... ......... . 6:18,8:52 

Archiving ...... .......... .... .... ... .......... ..... ... ...... ..... ................. 7:19 

Audio Disc Selection ......... ......... .. ... .... .... .. ................ .... .. 12:3 

Audio input and output settings ........... ..... .................. ... ... 9:2 

Auto De·Click ... ......... .. ..... .......... .. ....... ... ..... .................... 6:33 

Autoconform 


Impon conform list .... ............... .. ...... .... ... .... .... ....... 8: 19 

Make List ........... ....................................... ..... ... ......... 8: 19 

mono recordings ................................. ...... .. ..... ........ 8: 19 

Record Status ..... .... .. .. ............................ .................. 8: 18 

Refresh List ............ ..................... .. .. ... ......... ........ ....... 8: 19 


AUlOconforming ........ ...... .. .. ....... ......... ... ... .. .......... ... ... ... . 8: 12 

hims and tips ... ................... .............. .. ... ............... .. .. 8:18 

in brief ......... ....... .... ... .. ................ ............... .............. 8: 17 

overview ............. ... .... ... ............... ..... .. .... ........... .. ..... 8: 12 

setup ......... ........ ... .... .. .. .. ............... ... .. ..... .. ....... .. .. ..... 8: 13 

step 'by step .......... ........ .. ........ .............. .............. .. .. ... 8: 14 


Automation 

displaying data .... .. ....... .. ............................ .. .. .. .... ..... 6:55 

editing data ......... .......................................... ........ .... 6:56 

keep button .... .. .. .... ................................ .. ................ 6:53 

modes ....... .......... .. .... .......... .. ......... ....... ......... .. ....... .. 6:53 

overview .. ....... ........ ... ....... ............... ....... .................. 6:52 

recording and replaying a mi"e ................................. 6:54 

Snapshot ... ..... .......... .. ... ..... ...... ........ .. .... ................... 6:54 


Autoplace .... ......... ...... ... .. .................... ... ..... ...... ... ........... ... 4:9 

Autotake ....... .... .......... ..................................... .... .. ............ 2:2 

Auxiliary sends ......... ....... .. ....................... .. .. ..................... 6:8 


B 
Backing up and Restoring work .......... .. .... .. .... ......... ....... 7: 19 
Backing·up and restoring work .................... .... .. .......... .. . 7: 11 
Backup 

Tape Drives ................................. ............................. 7: 19 

Backup files ........ ...... ...................................................... .. 7:12 

Backwards ................. ....... .. ....... .... ....... .. .......................... 4: 14 


Balance, stereo 
adjusting individual EDL Emries ...... .. .. ............ .. .... 4: 16 


Bars and beats display .............................. .... ......... ..... .. .... .. 9: 1 

Bounce·dow n .. ..... .... .... ...... ... ... ..... .... .. ....................... .. .. .. 6: 12 


with processing ........... .. .......... ........ .. .. .. .... .... .. ......... 6:57 

Bounce.Down .... .. .. ............................... ........................... 4: 12 

BWF ....... ... .... ............................. ...... .......... .. ... ... ... ... ........ 7:26 

Bypass processing ............................. .. ..... ... .. ..... .. ... ............ 6:6 


C 
CD 

multi·session ......... ....... ... .... ........... ........ .. ...... .. ... ... ... 8:50 

orange book ......................... ....... ......................... .... 8:48 

track at once .... .. ............. ............. .. .. .......... ...... .. .. .. ... 8:48 

CD rDs .. ..... .... .. .... ..... ....................... ........... .... .. ..... .. ..... .. . 8:51 
outputting .... ........... ......... ... ....... ........ .... ............. ..... 8:52 

CDlDS 
inputting ..... ............................ ... ....... ....................... 8:51 

CD Monitor Window ........................ .......... ................... 8:51 
CD writing 

Flow·through ........ .. ... .. ....... .... ... ........ ............ .. ........ 8:44 
Real·tinle ... .... ... ....... ....... .......... ..... ....... ... .... .. ...... ..... 8:44 

CDR 
Logging ... ... .... ................................... ... .............. ... .. . 7: 19 

CD·R 
Fix up ..... .............. ....................... ........ .. .... ............... 8:49 

using SPDIF ............................. ................ .......... ...... 8:52 


CDR, SCSI .. .... .......... .. ...... ................. .... ...... .................... 8:41 

Cedar De·Click ................................... .. .. ...... ................... 6:33 

Cedar De·Noise .... .. .............................. .... ..... .. .... .. ... ....... 6:32 

Cedar Manual De·C'lick.. ...... .. ..... ................... ........ .. ....... 5:24 

Check Disk .. .. .. .. ...... ...... .. .............................. ..... .. .. .. .. .... .. H:2 

Cleanup Project ...... .. .................................. ..................... 7: 13 

Clip Details window .. .... .. .. .. ................. .... ................ .4: 14,7:5 


using from Trim Editor ..... ...... ... ......... .. .... .. ...... ...... 5:16 
Clip-based Automation ..................... ........ .. ........ .... .. ...... 6:54 
Clips 

using only one channel ............. .... ............................. 7:5 
Clipstore 

altering details of Clips in .... .. ..... ................ ... .......... 4: 14 

Source Tracks Folder ...... .... .... .. ........ ..... .... .. ............ 7:12 

Clipstore menu .... .... ..... .. .... ...... .. ....... ............ .. .... .. ........ .. .. 7:4 
Clipstore window .... .......... .......... ..... ........ .. ........ .. .... .. .. .. .. . 7:3 
Clipstores 

Creating, opening and closing .. ......... ..... ............... .... 7:2 
overvie'\l.' ....... .. ................. .. ..... ... ............. .. ....... .......... . 7:2 

Clock 
Digital audio clock source ............ ....... ...................... 9:3 

CMX'" ftles ... .. .. ....................... .......... ....... .. .......... .......... 8:13 
Comments 

displaying alongside each EDL Entry ...... .... ............. 3:3 

writing comments in EDL Entries .......................... 4: 18 


Compressor......... .................. .... .. .. ... .. ................ ..... .......... . 6:7 

COIUlecting Timecode ..................................................... .. 8: 1 


Indcc: i 



Index 

basic techniques ...... .... ... ..... .. ........ ... ......... .. .... ........... A: 1 

setting sensitivity to scrubbing ..... ................ ..... .. ...... 9:6 


ITe nearest cut to current time ... ....... ... .. ... ... ...... ..... .... 10:5 

Move selected clips onto stream .. .... .... .... ... .. .. .... .... ........... 4:8 

MS Decoder .. ...... .... .. ...... .... ... .. ......... ......... .... .. .. .. .. .. .. .. .... 6:10 

Multi·Card Systems .. .... .. ... .... .. ......... .. .. ....... .... .. .. .... .. ...... 12:1 

Multiple Audio Units .. ........ .. .... .............. .. .. .. .... ........... ... 12: 1 


Bounce ..... .... ..... ........ .. .. ..... .. .... .. .......... ........... ... ..... .. 12:4 

CD Mastering .. .............. .. .... ............. .... .. ................. . 12:6 

Mixer ...... ............... .... .. .. .......................... .... .......... ... 12:1 

Non·Rea1·Time ..... ... .... .. .. .. ............. ..... .. ........ .... .. .. .. 12:4 

Playlist .. .. ... .. ... ... ..... .. ....... .... .... ... ... ...... ..... ...... ..... ..... 12:1 

Recording ... ....... .. .. ......... ..... ........ ... .. ..... .. .... .. .......... . 12:3 

SCSI Disks .. ........ ..... .. ... ............. ........ ...... ... ....... ...... . 12:3 


Multi·session CD ..... ...... .. ....... .... .. ... .... ... ... .................. .... 8:50 

Multi·T asking .... ....... ............ ..... ....... .. ...... ..... ...... .... ......... 4:23 

Multi·track edit lists .......... .. ........ .......... ...... .. ...... ............. 8: 19 

Mute and solo ....... .. ...... .. ............ ...... .. ................ ...... ......... 3:4 


N 
Names 

changing EDL Entry names 
in the Clip Details window ...... .... .................... 4: 18 


changing EDL Entry names in the Text EDL .. .. .. .. 4:19 

Networking ............ ...... .. .... ............. .. ...... See separate booklet 

Noise shaped dither ...... ......... .... ............. .. ........ .. .. .. .. .. .... . 6:23 

Non 1 ·1 processes .. .. .. .. .... .. .... ....... .. .... .... ............... ...... ... 6:40 

Non-Real·Time 


CD Mastering ....... .. ..... ...... .. .. .. .. ........ ............ ...8:44, 12:7 


ne Processing Windo w .... ..... .. ...... .. .. .. .......... ........ ... 6:38 
Offset, ste reo 

adjusting individual EDL Entries ...... .. .......... .. .... .... 4:16 

Online button .. ... ............. .. .. .. .......... .. ... .... .. ................ 3:4, 8:5 

Orange book CDs .. .. .. ......... .. .................................. .. ....... 8:48 

Out of DSP .... .. .. .... .. .. ......... .... .. .. .. ..... ......... .... ................. 4:20 

Outputs .......... ...... .. .... ........ .... ...... .. .. ...................... .. .... .. 11: 16 

Overdubbing ........ .... ... .. .......... .... .... ..... .... .. ............ .. .... ...... 2:5 

Log Overloads Window ................ ..... ........ ..................... 6:50 


p 
Passwords ...... ... .. .......... .. .... ..... .. .... .... .... ... .. ....... ...... .. ....... .. E: 1 

Paste Buffer .... ....... ..... .... ....... .... ... ..... ..... ... .. ... .... ....... ....... .. 4:6 


pasting whole EDLs ................. .... ... ...... .. .... .... .. ..... .... 4:7 
Pause.. ...... .. .... ........ ........ ... ..... .. ...... ..... .......... ... .. ........ ....... .. 3:4 
PC Audio Import..... .... .. ... ... ... .. ..... .. .. .. .... ... ...... ........ ..... .. 7:29 
Bounce to PC disk; W A V 

Copy ............ ... ........... ..... .. .... .. .. ..... .... ... .. .... .. ............ 7:29 

Peak Displays ... ... ....... ... .... .. ....... ... .. ......... ... ........ ... ......... . 6:49 

Phase Reverse Controls ...... .. .. .. ................ .............. .. ...... ... 6:3 

Play Edit without region .. ..... .. .. ............. ........... .. .. .... ...... 5:23 

Playback .... ... ..... ..... .. ............. ... ... ..... .... ........ ..... ........ .. .. .... . 3:3 

Playlist 


Lim.itations ... .... ..... .. ....... ..... ........... ....... .. ... ..... ......... 4:20 
Playlist 

default stream layout .. .......... ...... .... .... .. ....... .. ............ 9:4 

setup options .. .... ... .. ... .... ...... ... .. ..... .. ...... .. ... ..... ... .. ... .. 9:4 


llitting the window view .............. .... .. ..... .............. .. 3:3 

emplates ...... .... ...... ....... ..... .. .. ...... ... ... .. .. ... ...... .. ....... . 4:4 


Index: if) 

SADiE Usn- Manllal f)J.7 

viewing .... .... .. .. ..... .... ......... .... .. .. ... ........... .. ..... .... ........ 3: 1 
Play list Streams 

comments display .. ...... ..... ... ..... ........ .. .. .. .... .... .... ... .... 9:4 
Playlist Editing mode 

using a mouse .... ........ .... ...... ....... ... ........ .. ... .. .. .. ...... .... 5:3 
using with the hardware controller ...... .. ................ .. . 5:7 

Playlist menu 
ProfJe Display Mode .. .. .. ...... ....... .... ............ .. ........ .. . 3:2 


Plug·ins ........ ........ .. .... .. ....... .. ....... ............ .. ..... ... .. ... ...... .. . 6: 17 

bypass in scrub ............. .... .. .... ............ ................... ... 4:23 


Portia .. .... .. .............. .. ..... .. .... ... ... .. ........ ... ..... ................ .. .. 10:1 

disable video streams .. .......... .. .. .... ...... ........ ...... ....... 10:4 

disk to record to .. ..... .. .... ....... ...................... .... .. .... .. 10:3 

does not play video ......... .... .... .... .. .. .. .............. .... .... . 10:4 

Editing ....... ... ..... .. .. .... ... .. ... .. ... ... ............. ........ .......... 10:4 

Error Messages .... ....... .................... ............ ... ... .. .... .. 10:6 

example setups .. ..... ... .. .... .. .... ..... .. .. ...... ....... .. . 10:6, 10:10 

Genlock ... .. .. .. .. .... ... ..... .. ... .. .. ....... ..... .. .. .. .......... .. .. ... . 10:2 

Other Setup options .. ...... ...... .... ..... ..... .. .... .. .... ...... .. 10:4 

Record Quality ........ .... .. .. .. ........ .. ............ .. .... .... .... .. 10:3 

Setup .. ... ..... ... .. .... .... .. ... .. .... .. ..... ..... ................ ... ... ... . 10:4 

sync settings .... .. .. .. ............ .. .. .......... .... .. ................ .. . 10:2 


Portia Overview .... .. .......... ........ ........... ...... .. .......... ........ . 10:1 
Portia Record Setup ... .. ..... ........... .......... .......... ............ ... 10:3 
Portia Sync Setup .. ........ .. ... .. .... .. .... ... .... .... .... .... .... .... ...... 10: 1 
PQ Editing 

setup options .. ......... .. .. .. ..... .. .. ........ .. ...... .. ....... .. .... ..... 9:6 
PQ list offset .. ...... .. ................ ..... ..... .. ...... .. .. .... .... .... .. ...... 8:43 
Pre-roll and post-roll times ...... .. .... .. .. .. ...... .. ........ .. ........ .. .. 9:3 
Preview 

buttons on hardware controller .. ...... .... .... ...... .. ........ 5:9 
Preview buttons 

in Transport Controls .... .... ...... .. ....... .. .... .. ...... .. .. ...... 5:5 
Printing 

PQ lists .. ...... .. ... ... .. .... .... ............ ....... .. ........ .. .... ... .. ... 8:40 

Printing The Text EDL. .. .. ................ ......... ........... .. .. .. .... 4:19 

Privileges ........ .. ............ ..... ... .. .. .... .. .... .. .. ... ....... ... .... ... ... .. ... E: 1 

Process window .......... .. ... ... .... .. .. ...... ...... .... .... .......... ..... .. 6: 17 

Processes ........... ... .. .... ..... .... .. .... .. ....... .. .. .. .. .. ............ ...... .. 6: 17 

Processing 


adjustment in Mixer.. .... .... ............. .... ........................ 6:6 

inseningl deleting processes in Mixer strips .. ....... .... . 6:5 

on recording.... ........ .... ................... ............ .. ............ 6: 12 

re·recording with .. .. ...... ..... ........ .. ......... .... ......... .. .... 6:57 

stereo linking in Mixer .. ........ .. ........ ... .............. .. .. .. . 6: 10 


Profiles 
displaying in Playlist .. ........ .. .. .. .... .... ...... .. ........ .. ........ 3: 1 
Recreate ProfJes .... ............................ ........ .... .......... 7:27 

Project menu.. ....... .. ......... ................. .... ............. .. .. .. ......... . 7:8 

Save Project .. .... .... .. ........ .. ........... .... ......... .. ... .. .. .... ..... 7:9 


Project window .. ........... .. .... ..... ....... .. ...... .... ...... .. .... .... ...... 7:9 

Projects ..... .. ............ .. ..... ...... .. .... .. .... ....... .................. .. ...... . 7:1 


closing .. .... .. .... .... .. ........... .... .. .. .. .............. ....... .......... 7: 11 

creating, opening, and closing .. ...... .... .. .. .... .. .... ......... 7:8 

deleting ... .. .. .. ... ... .... ...... ...... ... ... .. .. .... ...... .... .... ...... .. .. 7:11 

overview ....... .. ...... .... .. .. ....... ... ...... ... ............... ........ .... 7:7 


Properties · Tracks .. .. .... ...... .... .. ...... ..... .. ....................... ..... 2:3 

Punch·in ......... ... .. ............... .. ..... .... .. ... .... .... .......... ... .... .. .. ... 2:5 




IndexSADiE User Manual vJ.7 

Fixed Speed Scrubbing ..... ......................... ..... ................. ... 3:8 

Format ...... ........ ........... .................. ............... ... ..... ....... .. .... H :2 

Format disk 


FAT 16 (2GB max) ....... .. .. .................................... ... 7:24 

FAT 16 (4GB max) .................................................. 7:24 

FAT 16 (MO format) ..... .. ................ .......... .............. 7:24 

MAC I-IFS ................................................................ 7:2 4 

SADiE 2 format .. ...... ..................... ...... .... ................ 7:23 

SADiE 3 iormat ...... ........................ .. ............. .......... 7:23 


Front.Backpan ................ .............. ................................ 11 :10 


G 
Gaps in the EDL 


removing ..... .. ...... .. .. .. .................. .......... ..................... 4:9 

Gate .................. ......... .... ...................... .... ...... ..................... 6:7 

Genex GX8000 ............................. .... .... .......... ... ........... .... 8:56 

Glue - repairing razor cuts ........... .... ... .................... ..... ...... 4:5 

Graphical EQ ................ ......... ........... ................ .... .. ...... ... 6:20 

Grouping EDL Entries ...... .......... ........................ ........ .... 4: 11 

GX8000 ............... .......... ........................ .............. ............. 8:56 


H 
Hardware controllers 


assigning faders ...................... ................................... .. 6:2 

button sununary .. ....................... ............. ............... .. C:l 

references in this manual ...................... ............ .. ...... .... . i 


Hardware Controllers 

setup .............. ....... .............................. ....... ................. 8:6 


l-iide strip ............ ............................... ............ ................ .. 6: 16 

HiDither 96 ... .. ................ .. .............. .... ............. ...... .......... 6:23 

Hotkeys....... ....................... ......... .......................... ....... .... ...... i 


setting and checking .......... .... .......................... ........... 9:7 

Hotspot ........ .. ....... .. ................. ...... .......... ... .......... .......... . 4: 10 


adjusting in Trim Editor. .......... .. ................. ............ 5: 15 

movlllg 


with Clip Details window ................... .... ........ 4: 17 

with Text EDL.. ................. ............... ........ ....... 4: 19 


moving with Playlist Editing 

hardware controller ........................................... 5:8 

mouse ........ ......................................................... 5:4 


I 
Import conform list .... ..... ................................................ 8: 19 

Inactive Streams ............................... ............ .............. ... . 4:22 

Input Monitor Window .................. ..................... .............. 2:8 

Installation 


hardware ........................................... See separate booklet 

Internal busses .................................................................. 6:12 


J 
Jog .... ............. ............... ......... ......................... ............. ....... 3:7 

joystick .......... ................... ................ .................... .......... 11:11 


L 
LCR ................. .................. ... ...... ... .......... .... ... ................. . 11:4 
LCRS .................................................................... ............ 11 :5 
LCRSS .. ... .................. ...... .. .. ........ ........... ... ... .................... 11:6 
Left/Right swap .................... ....... ... ................ .. .... ............. 6:3 
Left-Right Pan ................................ ................................ 11:10 
Levels 

changing EDL Entry replay levels 

in Clip Details window ............................ .. ..... 4: 15 

in Text EDL ........................... .. ........................ 4:19 


controlling stream playback levels .............. ........ .. .... 6: 1 

LFE .... ..... ................... .. .................................................... 11:6 

Lightworks 


and SADiE Integration ........ .................................... 8:21 

Autoconforming ...................................................... 8:21 

Reading Lighrworks Audio Files .......................... .. 8:24 

Recording format. .................................................... 8:26 


Limiter ..................................... ........................................ 6: 19 

Missing Tracks ........................ .................................... ..... 7: 14 

List Unplayable Points .................................................... 4:21 

Locating ....... ................................ ... .... .. .............. ...... .. ....... 3:6 


with hardware controllers ....................................... 3: 10 

Locator points 


storing and recalling .................................................. 3:8 

Locking Clips and Entries in sync 


when using Trim Editor .......................................... 5:18 

Loopable edit .............. ...... ............................................... 5: 16 

Looping ....... .................. .......... ................... .................. 2:6, 3:9 


setup ......... .... ... ............ ....... ............. ........................... 9:6 

Low Level Format ... ......................... ................................ H :3 


M 
Machine Control .................... .............................. ............. 8:7 

~1ake Stereo ......................................... ............ .. .. ........ .... 4:11 

Management privilege level ..... ................................. ........ . E: 1 

~Ianual De-click .... ................... ...... .... .............................. 6:36 

Mastering Limiter ............................................................ 6: 19 

Maximise Strip ......... ............... .... ............... .. .............. ...... 6:16 

medium errors .......... .... ...... ............................ .......... H:2, H:3 

Menu bar ........................................................................... A:4 

Message Box Placement ................................................... 9: 11 

Peak Metering ........... .................. ................. ................. .. . 6:48 

Metering Window .................... .................................. .... . 6:49 

Microsoft® Windows~ 


review oi basics ...... ........ ....... ............. ...... .... ...... ....... A: 1 

~Iinirnise Strip .......... .............. ..................................... .... 6: 16 

Mixer .... ................ ................ .. .... ....... .. ... .......... .................. 6:1 


adding and deleting strips ..................... ......... ........ .. 6: 12 

customisation ................... .. ...................................... 6:14 

input and output selection buttons ..................... .... 6: 11 

inserting new channel strips ...................................... 6:6 

my mixer's disappeared ........................................... 6: 16 

saving and loading settings ........................................ 6:8 

set-up fJes ............. ............. ............. ............. ............... 7:5 

setup options ................. ..... ....... .............. ... ... .. ........... 9:5 

stereo strips ........................ .............. ............... ... ... ... 6: 10 

Templates .... ............................... ........................ ........ 6:9 


Mixer Routing tutorial ........... ......................................... 6:58 

Mixer Strips 


changing order ......................................................... 6:15 

Mi."er Templates ........................... .. ....... ............ ...... ....... ll:18 

mono 


using one channel of Clips.. ............ ........................... 7:5 

Mono 


ungrouping stereo EDL Entries to mono ............... 4: 11 

Mono to Stereo ....................................... .... .... ................. 4: 11 

Mouse 


Index : iii 



Index 

FAQs .. ... .............. ... .............. .... ..... .... .......... ... .. ...... 11 :19 

Front·Back pan ............................... .. ... .......... ...... .. . 11: 10 

joystick ......................... .... ...................................... 11: II 

LCR bus .............................. .. ................. ......... ......... 11:4 

LCRS bus .......................... ............. ...... .................... 11:5 

LCRSS bus .......... .. ....................... ....... ................... .. 11:6 

Left·RightPan ........................................................ ll:10 

mixer strips ....................................................... ....... . 11:7 

outputs .......... ...... ....... .... .................. .......... ... ... .. .. .. 11:16 

ppms ............................................................... 11:9, 11: 12 

routing ...... .... .. ..................................... .. ......... 1 1:9, II: 16 

strip controls .......................................................... 11 :10 

width ...................................................................... 11:12 


Surround Sound ............ .... .. ....... .......................... ............ 11:1 

Sync Monitor window .................... .. .. ...... .......... .. ............. 8:6 

Sync working ..................................................................... 8:9 


maintaining sync ........ .... .. ...................... .. .................. 8:9 
Sync. 

when using Trim Editor ............................. .. ........... 5: 18 
Synchronisation 


COWlections ..................... .. .. .......... .. .................. .. ...... 8: I 

maintaining when placing EDL Entries .................. 4: 10 

Quick start ........ .. ....................................................... 8: I 

Setting up ........................ ... ... ....... ........... ... ................ 8: I 

time-stamp applied when recording ............. ........ .... . 2:8 


Synchronisation .......... ... ................................. .... .... ...... ..... 8: I 


T 
T'II?; Tracks .......................... .. ............ ........ .. ..................... 7:13 


! Drives 
Backup.. ......................................... .. ............ .. ...... ..... 7:19 
Logging, Copy, Format ............ .. ............................. 7:19 

Play list and Mixer Templates ............................................ 9:8 

Terminology .... ....................... .. ............ .... .. ...................... G:I 

Text EDL ...... ......................... ... .... ....... ....... .. ..... .. .... ........ 4: 18 


customising display layout .................... .... .............. 4: 19 

Time bar 

Play list .. ............... ................................ ...... ... ..... ......... 3:6 
use for playback and locating .. .......... .. .... ........ .......... 3:6 

Time displays 
adjusting .. ........ .. .. ..................... ........ .. ....... 3:6, 3:10, 4: 16 
format ......................................................................... 9: 1 
mouse ..... ............................... ........................ ... .... ...... 3:6 

Time Displays 
use for moving EDL Entries ................... ................. 4:17 

Time Scrunch .......... .. ..................................... ... ............... 6:47 
Time stretch .. ................ .............. ...................... ... ............ 6:47 
Timecode 

Connections ............... .... .. ................. ........... .... .......... 8: 1 

Timemod...... ... ........ .... .... ... .. .. ... .. ... ....... ... ... ..................... 6:47 

Timestamping .................................................................... 2:8 

TimeSync ...... ................................. ...... .... .. ....... 8:4, 8: 10, 8: 11 

Title bar ................ .. ........................................................... A:3 

Toolbars ............... ....... .................. .... .... ...... ......... .............. 9:9 

Track at once CD ............................................. .. ............. 8:48 

Track Management .......................................................... 7:12 

T~'ck names ................................ .. ................................... 7:27 


Jaying ................... ... .... .... ................. ....................... 8:12 

,s 

Index: vi 

SADiE User Manlllli 'IlJ.7 

associating with Projects ....... ............. .... .................. 7: 12 

copying berv.-een audio disks ................. .................. 7: 18 

deleting .................................... .. ... .. ......... 7:11,7:15.7:19 

deleting all 0 0 a disk ......................................... ....... 7:23 

management of audio disks ..... ......... ...... ............. .... 7: 16 

numbers of channels ......... ............... .. ... .... ...... ...... ... .. 2: 1 

propenies .............................. ....... .. .. .. .. ...... ...... .... ...... 2: 3 

reoarrliog ......................................... ............. .. .. 7: 15.7: 19 

start time ........................................... ... ..................... . 2:8 


Transmission Mode .... ........................................... .. .......... 3:5 
Trim editor 

defining new clips .... ........ .. ........ .. ... ......................... 5: 15 
Trim Editor .......... .. ............ .... ........ ......... .......................... 5: 1 


adjusting edits ......................... .......... ................ ... .... 5: 12 

display features ........................................................ 5: 10 

Make a Loopable edit .............................................. 5: 16 

opening .................................................................... 5: 10 

preview burtons ....................................................... 5:14 

razor·cut ................................................ .. ................. 5: 18 

reloading .................. ......................... ........ .............. . 5: 17 

setup options .. .................... .. .................... ........ .......... 9:4 

writing back .... ............. ............. ...... .... .... ......... 5: 17, 5: 18 


Trim Editor ..................................................................... 5: 10 

Trim Editor menu .... ............ .................... ....................... 5: 11 

Trim slips ......................................................................... 5:18 


U 
Undo and redo ................................................................... 9:5 

Undo and Redo .... .... .................................... .. ........ .. ....... 4:14 

Uogroup button ............................ .... .......... .. .. .. ...... .. ...... 4: 11 

Use each local disk in turn ............ ..... ....................... 2:9. 12:3 

Use least full local disk ................ .... .......................... 2:9. 12:3 

Use speci.fied disk(s) .. .... ................... .. ........................ 2:9, 12:3 

User ini fJe directory ................... .. ................................... E:2 

User ini fJes ...................... .................... ... .... ................... .. . E:2 

Use r Management. .. ................................. ...................... ... . E: 1 

User z.oom in Trim Editor ................. .. ........................... 5:19 

usernames ......... .. ........................ .... .. ...... ....... .. ............... .. .. E:l 

UV22 ........................ .... .. ................ ......... ... ....... ...... ...... ... 6:18 


V 
Varispeed .......................................................... ..... .......... 6:46 


on the whole EDL ............................. .. .. .................... 3:4 
V ·cut mode ............................ .............. ............. .. .... ...... ..... 5: I 
Video input .. ......................................... .. ......................... 10:1 
View menu 

Background Recording .............................................. 2:7 

Setup window ....................................................... ..... 9: I 

Sync Monitor window ................ .. ............................ 8:6 

Toolbars .................................. ......... ...... ... ... ............ 9:10 


Viewing order burton in Trim Editor ........ .................... 5:19 


W 
WAV ........................................................................ 7:26.7:29 
Width .......................................................................... .. ... 6:17 
Width .......................................................................... .. .. 11:12 
Window menu 

Cascade. Tile, Arrange Icons .......................... .. ...... ... 9:9 
New Window ............................................................ 9:9 

Windows 



SADiE User Manual vJ.7 Index 

Q 
Quality level of Tracks ............ .... ....... .. .. .. .......... ..... ......... . 2: ... 


R 
Razor Cur .. ... .. ...... ......... ...... .... ............ ..... .. .. .... ..... ... ........ .. 4:4 
Razor Cut Region ..... .... .. .. ... .... .. ......... ... .... ........ .. .. .. ........ 5:23 
Razor,uts 

splice or v-cuts .. .... .... ...... ...... .... .... .... .... .... ..... .. .. ....... .. 5: 1 
Real·Time 

CD-R ...... ..... ........ ... ... ........ .... .... ... ..... .... .... ......... .. .... 8:44 
Real·time vs. non-real time operation .......... .... .. .......... ..... 2:5 
Recording 

levels .... .... .... ........ .. ............. ... .... ........ ..... ..... .... .... .. ..... 2:... 

multi-chanoel Tracks ................ ................................ . 2: 1 

overview ....... ...... .......... ..................... ........ ............. .... 2: 1 

source selection buttons ... ......... ........ ....................... 6:11 


Recovering lost work.. ........ ............. ....... .................... .. .. . 7:12 

Recovering lost work............. .. .............. ....... ....... .. ....... ... 7:11 

Recreate Profiles .................. ... .. ............. .......................... 7 :27 

Red DSP warning ........ .... ............... ........ .. ............... ........ 4:20 

Region 


Play Edit without region .......... ...... ............. .. .. ........ 5:23 

select region start & end ... .... .. .. ............. .................. 5:22 

z.oom tools .. ...... .. ... ...... .... ......... .. .. .. ..... .. ........ .......... . 5:22 


Region Editing .. ......... ...... ........ ......... ....... ........ .... .. ........ .. 5:20 

adjusting the region ...... .................. ... .... ............ ... .... 5:22 

defuling a region ............... ... ...... ...... ....... ...... .... .. .. ... 5:21 

enabling ....... ..... ....... ........ ......... ........ .... ... .......... .... ... 5:20 

previews ........... ... ....... .... ............ ... ....... ...... ... ....... .... 5:23 

turning it on ....... .. ... .. .. ...... ..... ............ .............. ...... .. 5:20 


Region rosen Mode ... ...... .... .. ......... ........... .......... ..... ..... .. 5:23 
Region Overwrite mode .. .... .... ..... .. ... .. .. ......... .... .. .. .... ... .. 5:23 
Renaming Entries 

in Trim Editor .... ... ......... .. .. .... ..... .. ..... .... ..... ......... ... 5:15 

Re·Organising the Mixer .. ...... ......... .. .. .. .......... .... .......... .. 6: 14 

Resampler .......... ........ .... ... ....... ..... ......... .... .. ... ... ..... .......... 6:46 

reset region markers .... ... ... .. .... .. .... ... .... .. ........ ....... ........... 5:22 

Resync Track .......... ........... ...... ........... .. .. ........ .... .. ......... .... 2:8 

Retake button ... ..... .. ..... ........ ................ .... .. .... .. ... .... .. ...... .. 2:3 

Reveal hidden strip .. ........ ..... ...... .. ......... ..... ........ ...... ... .... 6:16 

Reverb ....... ......... ...... ........ .. .. .. ......... ........ ...... ......... .... ... ... 6: 17 

Reverse ... ......... ... .... ... .... ... ... ..... .... ....... .. ............ .... ....... .... 4: 14 

Routing 

tutorial ...... .. .. ... .. ...... ........ ...... .... ...... ..... .. ........ .... ... ... 6:58 

Routing arrangements ...... .. ... ................. ..... ...... ............ .. 6: 11 

Routing toolbar ........ .... ......... ...... ........... .... ........... .. ........ 6: 12 

Rushes, syncing ... .......... .... ... ... ..... .... ........ .. .... .......... .... .... 8:10 


S 
SADiE Disk Checker.... .......... ..... .......... ........................... H :1 

SADiE Settings Files ..... ......... .......................... ........... ..... . E:1 

Sample rate and resolution .. .. ....... ......... ............. ........ 2:2, 2:4 

Sample Rate Convener.. ..... ..... ..... ...... ... ...... ........ ............ 6:40 

Saving and Loading your work ... ..... .. .... .... ... ... .. .... .. ... ...... 7: 1 

Scan Drives ...... .. .. ... ....... .... ... .......... .... ... ......... .... ........... ... 7:17 

Scissors ..... ...... .......... ................. ... ......... .............. ... ..... 4:4, 5:2 

Screen layout .. ........... ................................ ......... See Desktops 

Screen resolution and size ........ .... ...... ......... ....... ......... ..... 9:10 

scroUbars ........ ...... ..... ......... ..... .. .. ... ........ .... .. .. .. ... ... ... ..... ... A :4 


Scrolling 
Playlist ..... .. ......... ....... ... .......... ..... ......... ........ ......... ... .. 3:2 

Scrub 
turning off plug·ins ............. .. ... ... ... .. ..... .... .............. . 4:23 

Scrubbing 
Playlist .. .......... ............... ....... ....... ... .... .. ... .... ... .. ......... . 3:7 

setting mouse sensitivity ...... .... ... ... .... ........ ................ 9:6 


SCSI disk 
clearing space ... .............. .. .... ...... .. .................. .. 4: 12, 6:57 

SCSI disks .... ........... .. ................. ...... .... .. ... .... See Disks, audio 
SCSI Disks 

Choosing a disc for Recording .... ............ .. ................ 2:9 
SDll ............................................ ........................... .... ....... 7:26 
Selecting/deselecting EDL Entries 

in the Play list ................ ............. ................................ 4:5 

in the Text EDL................................... .. ....... ..... ...... 4:19 


Setup window .............. ......... ..... .......... .... ... .. ... ...... .. ..... ..... 9:1 

Show sample values ........ ... ... .. .. ... .... ....... .... .. .... ... ... ......... 5:2J 

Sh uttle ... ..... .......... ..... ........ .... ...... ......... .. ......... ................... 3:7 

Slip ... ......... ... .. ... ... .... .... .... .. ..... ... ... ..... .. .. .... ..... ........... ........... :9 


Trim ...... ................... ............ ..... .......... ..... ......... .. ..... 5:18 
Snap to Cursor .................. ... ................. ... .. .... .. ... ..... .. ........ 4:9 
Snapshot Automation.......................... .. ... ....... ................ 6:54 
Snapshot buttons 

in Trim editor ........ .... ....... ........ .. ....... .. .. ... ..... .. .... .. .. 5:19 

Software Installation.......... ..... .......... ...... ...... ... ... .. .. ........... B: I 

Software licence ....................... .. .. ... ..... ...... ........... .. ....... .. .... iii 

Solo and mute ................ ..... ..... ....... ....... ........ .................... 3:4 

Source Tracks Folder........ ....... ..... .. .. ........ ... .. ... ...... ......... 7: 12 

Source Tracks Toolbar ....... ..... .. .... .. ..... .. ......................... 7:15 

SPDIF CD-R recorders............. ............................... ........ 8:52 

Splice.cut mode .. ...... ......... .................... .. ............ ............... 5: 1 

SRC .. .... ..... .... ...... ....... ..... ..... .. ......... .. .... ............... ............ 6:40 

Starting SADiE automatically ...... .. ........................... ...... 9: 12 

Stanup options .... .. .... .. .. ...... ................ .......... .. ...... ........ .. 9: 12 

Status bar 


displays ..... ....... ........ ..... ... ....... .............. .. ........... .... ... .. 9: 1 
Stereo EDL Entries 

ungrouping to two mono Entries .......... .. .............. . 4:11 
Stereo to Mono ....... ... ..... .......... ............... .. .. .... ................ 4: 11 
Stereo Width .... ........... ............................... ...... ................ 6:17 
Streams 

adding to and removing from the Play list ............. .. . 4:2 

changing streams for EDL entries ........................ ..... 4:8 

enabling/disabling .... .... ............ ... .. ....... .. ..... .. .. .... .. .... 4:2 

merged and stereo ..... .. .. ................ .. ....... ... ... ... ....... .. .. 4:2 

renaming ............... .. .. ...................... ............. ... ....... .... 4:4 

units ... ....... ............... .......... .. .. .... ........ .... .. .... ....... .... .... 3:3 

changing Streams for EDL Entries .............. .......... .. 4: 19 


Subcode reading ........ .... .. ....... ... ...... ...... .... ... ........... .. .. .. ... 8:51 

Subgroups, Mixer.......... ..... ............ ..... ....... ..... ..... ............ 6:13 

Sub-Projects ...... ...... ........ .. .. ............ ...... ........ ................ .. . 7: 11 

Surface Scan .... ........ ... ..... ................. ..... ....... .... ...... ........... H :2 

Surround 


busses ........ .............. .... .. .. ......... ...... .... ...... ..... .. ..... ... .. 11:4 

creating a mixer ........ .... .. ....... .. ... ................... ...... .. .. 11:7 

divergence ............ ......... ........ ................. ......... .... .. .. 11: 13 

Divergence ...................... ....... .. .......................... .. ... 11:11 

enabling ..... .... ... ...... .............. ..... .. ........ ...... ........... .. .. 11:2 


lndc: :0 



lrukx 
SADiE Usn Manll4i flJ.7 

Index: flii, 



SADiE UserManualtJJ.7 Index 

moving and sizing .... .... .... .................. .... .. .. .... ... A:3, A:4 

splitting ... .. ................................................................. 9:9 


Writing Bac.k from Trim Editor ............................. 5:17, 5:18 


y 
Yellow DSP warning .. ....... .. ... ......................................... 4:20 


Z 
Zoom buttons 

Playlisr .. ................... ..... ..... .... ..... ... .... .................. ... .. .. 3:2 

Index: tJii 


